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1. Introduction

SpiraTeam® is an integrated Application
Lifecycle Management (ALM) system
that manages your project's
requirements, releases, test cases,
issues and tasks in one unified
environment:

SpiraTeam® contains all of the features
provided by SpiraTest® - our highly
acclaimed quality assurance system and
SpiraPlan® - our agile-enabled project
management solution. With integrated
customizable dashboards of key project
information, SpiraTeam® allows you to
take control of your entire project
lifecycle and synchronize the hitherto
separate worlds of development and
testing.

This user manual outlines the features
and functionality available in
SpiraTeam®, and demonstrates how to
use the application for managing the
quality assurance and project
management processes on a typical
project.

1.1. Quality Assurance

Quality Assurance is a key component
of the Software Development Life-Cycle
(SDLC), which needs to be integrated
into the planning and management of a
program or project from its inception.
Too often though, QA is implemented as
Quality Control - whereby testing that
the required functionality works as
expected, is performed at the end, when
it is most costly to make corrections and
changes.

To manage QA across a project from
day one, it is imperative that the original
requirements are documented together
with the use-cases that validate the
desired functionality. These use-cases
then form the basis of the test scripts
that can be executed to validate that the
functionality has been correctly built,
and that the requirements have been
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satisfied. During the execution of these test
scripts, failures may occur, which are recorded
as incidents - either to be fixed or documented
depending on the severity.

Typically, these activities require people to use
at least three different types of software:

» Requirements Management
» Test Script Management
>» Defect/ Issue / Bug Tracking

However, this stove-piped approach has many
limitations and drawbacks, most importantly the
fact that there is no traceability between the
different artifacts. How can the project manager
know that all the requirements have been
tested? Conversely, how can the developer
know which test script was responsible for a
recorded bug — needed to accurately reproduce
the issue?

1.2. Project Management

As described in the Agile Manifesto, traditional
waterfall software methodologies and lifecycles
have failed to delivery projects on-time and on-
budget. In addition, many systems built this way
will fail to provide the expected business value
as there is no ability to quickly refine the
requirements as the project progresses.

Consequently software development has been
transformed with these new ideas and concepts,
with new methodologies such as Extreme
Programming (XP), Scrum, Kanban, DSDM and
AUP becoming common. However the traditional
tools of project management - requirements
specifications, high level project plans, GANTT
charts, white-board schedules and top-down
task management - are too cumbersome and
not well suited.

SpiraTeam® provides a complete Agile Project
Management System in one package, that can

manages your project's requirements, releases,
iterations, tasks and issues in one environment,
fully synchronized.

This document contains Inflectra proprietary information




2. Functionality Overview

This section outlines the functionality provided by SpiraTeam® in the areas of requirements management,
test case management, release planning, iteration planning, incident tracking, task management and
project / user management.

2.1. Requirements Management

SpiraTeam® provides the ability to create, edit and delete project scope / requirements in a hierarchical
organization that resembles a typical scope matrix. Each requirement is associated with a particular
importance level (ranging from critical to low) and a status identifier that designates where the
requirement is in the development lifecycle (requested, planned, in-progress and completed). In addition,
each requirement is mapped to one or more test cases that can be used to validate that the functionality
works as expected. This mapping is called the “Requirement Test Coverage”, since the test cases “cover”
the requirement so that if all the tests can be executed successfully, then the requirement is validated.

At the same time, from a development perspective, the team begins initial estimation of the lowest-level
requirements in the requirements matrix to determine the complexity and associated resourcing. Once the
high-level release schedule has been determined, the requirements can then be prioritized and scheduled
against the appropriate release according to their business priority.

Once the release is underway, the requirements are further decomposed into their constituent low-level
project tasks that can be assigned to the project team. The system will track the progress and revised
estimates for the tasks and display them against the requirements so that risks to the schedule can be
quickly determined.

2.2. Test Case Management

SpiraTeam® provides the ability to create, edit and delete project test cases that are stored in a
hierarchical folder structure that resembles Windows Explorer ®. Each test case consists of a set of test
steps that represent the individual actions a user must take to complete the test. These test steps also
contain a description of the expected result and any sample data elements that the tester should use
when performing the action. When a user executes a test case, the results are stored in a test run that
contains the success/failure status of each test step as well as the actual observed result that the tester
experienced.

In addition each test case is mapped to one or more requirements that the test is effectively validating,
providing the test coverage for the requirement. During the execution of the test case, each failure can be
optionally used to record a new incident, which can then be managed in the incident tracking module (see
below). This provides complete traceability from a recorded incident to the underlying requirement that
was not satisfied.

To streamline the assignment and tracking of multiple test cases, SpiraTeam® allows users to select
groups of test cases and arrange them into test sets. Each test set can contain test cases from a variety
of different folders and can be associated with a specific release of the system being tested.

2.2.1. Test Automation

As well as being able to store and manage manual test cases, SpiraTeam® can be used to manage the
scheduling and execution of automated test scripts for a variety of third-party test automation engines.
This allows you to centrally plan your automated testing and monitor the results of automated unit,
functional and load testing remotely. For example, you could schedule a set of automated functional tests
to run on five different machines (each with a different browser/OS combination) at 2:00 AM and have the
results be ready for the next morning.
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2.3. Release Planning

SpiraTeam® provides the ability to track different versions / releases of the application being tested. Each
project in the system can be decomposed into an unlimited number of specific project releases, denoted
by name and version number. Requirements and Test Cases developed during the design phase can
then be assigned to these different releases. When a tester executes a series of test cases, they are able
to choose the version of the project being tested and the resulting test run information is then associated
with that release.

From a project planning perspective, the releases are the major milestones in the project, which are
further sub-divided into iterations which are separate mini-projects with associated project scope and
tasks. The project’s requirements are scheduled at a high-level against the releases and the detailed
tasks are scheduled against specific iteration within the release.

In addition, all incidents raised during the testing process are associated with this release, allowing the
development team to easily determine which version of the project is affected. Finally as the incidents are
resolved and verified during the testing phase, the appropriate release can be selected to indicate which
release the incident was resolved and/or verified in.

2.4. lteration Planning

As described in section 2.3, in addition to high-level project releases, SpiraTeam® can also track the
individual iterations that comprise a release, giving the project manager the option to manage agile
methodology projects within the SpiraTeam® environment. Unlike the release planning stage, where
high-level requirements are estimated and scheduled, the iteration planning phase involves assigning
each of the requirements, incidents and tasks in the project backlog against a specific iteration until the
available effort in the iteration has been completely allocated.

When you first create iterations, you specify the start and end-dates together with the notional number of
project resources assigned to the iteration and any non-working days. SpiraTeam® uses this information
to calculate the planned effort available to the iteration, from which it will subtract the estimated task and
incident effort values to determine how much effort is available to schedule.

2.5. Incident Tracking

SpiraTeam® provides the ability to create, edit, assign, track, manage and close incidents that are raised
during the testing of the software system under development. These incidents can be categorized into
bugs, enhancements, issues, training items, limitations, change requests, and risks, and each type has its
own specific workflow and business rules. Typically each incident is raised initially as a ‘New’ item of type
‘Incident’. Following the review by the project manager and customer, they are changed to one of the
other specific types, given a priority (critical, high, medium or low), and status changed to ‘Open’. Once it
is assigned to a developer for fixing, it is changed to status ‘Assigned’.

The developer now works to correct the incident, after which time its status changes to ‘Fixed’ or ‘Not
Reproducible’ depending on the actions taken (or not taken). Finally the project manager and customer
verify that it has indeed been fixed, and the status is changed to ‘Closed’. SpiraTeam® provides robust
sorting and filtering of all the incidents in the system, as well as the ability to view the incidents associated
with particular test cases and test runs, enabling drill-down from the requirements coverage display, right
through to the open incidents that are affecting the requirement in question.

2.6. Task Management

As described above, in addition to storing the requirements for a project, SpiraTeam® includes the
capability of drilling each lowest-level requirement down further into a series of work items called ‘Tasks'.
These tasks are the discrete activities that each member of the development team would need to carry
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out for the requirement to be fulfilled. Each task can be assigned to an individual user as well as
associated with a particular release or iteration. The system can then be used by the project manager to
track the completion of the different tasks to determine if the project is on schedule.

2.7. Projects and Users

SpiraTeam® supports the management of an unlimited number of users and projects, which can be
administered through the same web interface as the rest of the application. All artifacts (requirements,
tests and incidents) are associated with a particular project, and each user of the system can be given a
specific role for the particular project. So, a power user of one software project may be merely an
observer of another. That way, a central set of users can be managed across the enterprise, whilst
devolving project-level administration to the manager of the project. In addition to these administration
functions, each user profile and project has its own personalized dashboard view of all the pertinent and
relevant information. This feature reduces the information overload associated with managing such a rich
source of project information, and allows a single user or project snapshot to be viewable at all times for
rapid decision-making.

2.8. Document Management

SpiraTeam® includes an integrated document management collaboration system that can be used to
upload, manage and share documents between the different members of the project. This module
includes support for uploading files and URLSs, versioning of documents, the ability to organize into folders
and categorize and search using meta-tags.

2.9. Source Code Tracking

SpiraPlan® and SpiraTeam® provide the ability to browse your source code repository from within the
main web application. This is an excellent way for managers and casual users of the project to browse
the files and revisions of the software code without needing to install the version control software on their
own workstations. In addition for all users, the ability to link source code revisions with SpiraTeam®
artifacts provides traceability from requirements, incidents and tasks to the code changes that were made
to implement the required feature or fix the identified defect. Should a defect resurface later, you can view
the associated source code revisions to determine which changes were made and did they truly correct
the defect.

2.10. Build Management

SpiraTeam® includes the ability to integrate with a variety of continuous integration / automated build
servers so that the results of automated builds can be displayed in SpiraTeam linked to the associated
release or iteration. In addition, the results of automated tests and source code operations can be linked
to the build events, providing traceability from a specific build to the bugs that were fixed, tests that were
run and source code files that were modified.

2.11. Miscellaneous

2.11.1. Artifact Relationships

The sections above have outlined the different features and functions available in the system, and have
described the various artifacts managed in the system (e.g. projects, users, requirements, tests, etc.). To
aid in understanding how the information is related, the following diagrams illustrates the relationships
between the different artifacts and entities:
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Figure 2: The relationships between the various SpiraTest entities

With these overall concepts in mind, the rest of this help manual will outline the functionality in each of the
SpiraTeam® screens, and provide specific information on how to manage each of the artifacts illustrated
above. Note that this manual does not explain the Administration-level functionality of the system; for that,

please refer to the SpiraTeam® Administration Guide.

2.11.2. Artifact Naming Conventions

On various screens in the system, you will see lists of artifacts (requirements, test cases, etc.) together
with a unique identification number. In order to make it easier to recognize at a glance which type of
artifact the identification number refers to, SpiraTeam® uses a system of two-letter prefixes which help

identify the type of artifact being displayed. The current prefixes used by the system are:

Artifact Prefix Artifact Prefix
Project PR Project Group PG
User us Incident Type IT
Requirement RQ Incident Priority IP
Release RL Incident Severity v
Test Case TC Workflow WK
Test Step TS Workflow Transition WT
Test Run TR Custom Property Values PV
Test Run Step RS Project Role RX
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Incident IN Task TK
Incident Status IS Test Set TX
Custom List CL Document DC
Document Type DT Document Folder DF
Automation Host AH Build BL

In addition, certain artifacts in the system are displayed with an icon that helps distinguish them from each
other, and provides additional context on the state of the artifact:

Icon Artifact Description
Summary Requirement
Detailed Requirement
Test Folder

Test Case with Test Steps
Test Case without Test Steps
Test Set

Test Run

Test Step

Linked Test Case

Release

Iteration / Sprint

Task

Incident

Source Code Revision
Project Resource

Test Automation Host
Build

Artifact has an Attachment
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3. User/Project Management

This section outlines how you can log into SpiraTeam®, view your personalized home-page that lists the
key tasks that you need to focus on, and drill-down into each of your assigned projects in a single
dashboard view. In addition to your personal homepage, each of your projects has its own dashboard that
depicts the overall project health and status in a single comprehensive view.

3.1. Login Screen

Upon entering the SpiraTeam® URL provided by your system administrator into your browser, you will
see the following login screen:

Please enter your user name

WE'COme tD and password, then click the

log in bufton.

User Name:

Team —

|

[C] Keep me logged in

Version v3.2
Licensed To: Inflectra Corporation

. . ri
Copyright {C) 2006-2011, Inflectra Corporation Forgot vour password?

Don't have an account?

inflectra’

You need to enter your given user-name and password into the system in the appropriate boxes then
click the <Log In> button to gain access to the application. Normally you only remain logged in to the
application whilst in active use, and you will be asked to log-in again after either closing the browser or 20
minutes of inactivity. To prevent this, and stay logged-in to SpiraTeam® regardless of browser window
closing or inactivity, select the “Keep me logged in” check-box before clicking the <Log In> button. Note
that this setting is specific to each individual computer you are logging-in from, and that it will be reset
when you explicitly log-out with the log-out link (described in more detail in section 3.3).

If for any reason you are unable to login with the provided username/password combination, and error
message will be displayed. If you cannot remember the correct log-in information, click on the “Forgot
user name / password” link and your password will be emailed to the email address currently on file.

If you don’t have a SpiraTeam® account setup, clicking on the “Don’t have an account?” link will take you
to a form that you need to fill-in, which will be forwarded to the system administrator, who will actually
create your account.

In addition, the system will prevent you logging on to the system with the same username at the same
time on multiple computers. This is to avoid the system getting confused by a user trying to make
contradictory actions at the same time. If for any reason you do try and log in to the system when you
already have an active session in progress, you will see the following screen:
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Welcome to

Your user account is
currently signed into
SpiraTeam in multiple

Team'm locations.

You can either Log Out and
try a different user-name or:

Version v3.2 Sign Off The Other
Licensed To: Inflectra Corporation | ocations to force the other

Copyright (C) 2006-2011, Inflectra Corporation locations to log-out.

inflectra’

You have two choices: you can either click the “Log Out” link and try logging in as a different user, or if
you want to log-off any other active sessions (e.g. you closed the browser and the session is still listed as
active), simply click the “Sign Off The Other Locations” link, and you will be logged in to the application.

Since SpiraTeam®is licensed to organizations for a specific number of concurrent users — unless they
have purchased an unlimited Enterprise license — only a fixed number of users may be active at the same
time. So, for example if an organization has a five (5) concurrent user license and a sixth user tries to log-
in, they will be presented with the following screen:

Welcome to

You have exceeded the
allowed number of
concurrent users.

A logged in user needs

™
' eam to log-out before you can
proceed.

Change License Details

Return to Login page.

Version v2.0.1
Copyright (C) 2006-2008, Inflectra Corporation

inflectra’

This means that one of the other users who is already logged-in, needs to click the “Log Out” button so
that one of the concurrent licenses is freed for your use. If the user has logged out by closing the browser,
the system may not have detected the logout. In this case, the other user needs to log back in, and then
click the “Log Out” link.
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3.2. My Page

Once you have successfully logged in, you will initially be taken to your personalized home page called
“My Page”:

S Rt . Welcome, Fred Bloggs [Lbray ifomatin Sytem ¥ || My Profile | Administration | Log Out | =) Halp?
spiraTeam
—— My Page Project Home Planning Testing Tracking Reporting
My Page | My Timecard Role: Manager
Welcome Fred Bloggs to Your Dashboard (Modify Layout/Settings | Add tems) Display data for: @ All Projects ' Current Project
My Projects Quick Launch
Project Name Group Creation Date > Create Incident in: | Ubrary Information System v|3
Library Information System Internal Projects 1-Dec-2005
Sample Application One Intemal Projects 1-Dec-2005 My Assigned Incidents
Samgle Application Two External Projects 1-Dec-2005 Name Project Type Date Opened
B Ability to associste multiple suthors Library Information ... Enhancement 17-Hov-2003
My Saved Searches ) Test System Limitation Library Information Limitation 4-Dec-2003
Mame Project B Test Training tem Library Information ... Training 3-Dec-2003
] Critical Not-Covered Requirements Library Information System > Delate ¥ Eciting the date on a book is clunky  Library Information .. Bug 4:Nov-2003
L) Eailed Active Test Cases Library Information System >Delete  E) B Test Training ltem Library Information ... Training 3-Dec-2003
%) New Unassigned Incidents Library Information System >Delete EY ) Test Change Request Library Information ...~ Change Request 3 - Medium  7-Dec-2003
®) Al Reopened Incidents Library Information System > Delete ) Ability to im from | Library Information ... Enhancement 3-Medium  25-Nov-2003
7 High Priority Late Tasks Library Information System >Delete E) B Test System Limitation Libeary Information ... Limitation 3 - Medium  4-Dec-2003
&%) Mot Executed Test Sets Library Information System >Delete B ) Sample Risk 3 Library Information ... Risk 4-Low 10-Dec-2003
My Assigned Requirements £ My Detected Incidents &)
Name Project Importance  Status Name Project Type Priority  Date Opened
3 Ability to create different editions Library Information .. In Progress ] Cannot log into the application Library Information ... Incident 1-Nov-2003
) Aility to link authers to their contact Library i Requested ) glicking on link throws fatal error Library Information ... Incident 1-Nov-2003
) Ability to edit existing authors in the Library Planned ) Cannot install system on Windows ME  Library Informatian .. Issue 1-Dec-2003
) Aility to delete gxisting authors in th Library Infarmation igh In Progress ) cannot install system en Oracle 9 Library Information .. Bug 2-Nov-2003
1) Ability to create new users in the syste...  Library .. 3-Medium Requested B Apility to associate multiple authors Library Information ... Enhancement 17-Nov-2003
) Ability to import from legacy sysiem Libwary Infommation | (Ao Req B Cannot log into the i Sample Application 0. Incident 10-Dec-2003
B Test System Limitation Library Infermation Lirnitation 4-Dec-2003
My Assigned Test Cases B B Sample Risk 1 Library Information .. Risk 10-Dec-2003
N Project Siotus Lot Executed ) Test Training ltem Libwrary Information ... Training 3-Dac-2003
I ani — Library Information . — ) Test Change Request Library Information ... Change Request 6-Dec-2003
> Execute
£ Ability 1o edit existing book Library Information .. E 1-Dec-2003 My Assigned Tasks
PIEEEl Name Project
) 7] Develop new edition entry scre.. Library Information ...
My Assigned Test Sets B 7 ¢ e P Library nformation ..
Name Project Due Date  Status T —— Library i
%) Regression Testing for Windows XP (4)  Library Information ... - n/a - Completed 7 N Libeary Inf )
> Execute Beforto suthar sereen i nel_
%) Exploratory Testing (2) Libsary Information ... - nfa - Deferred £] Create author object delete me...  Library Information ...
> Eseaute £ wiite author object delete que... Liorary ion .
2 Testing New Functionality (4) Library Information ... 10-Feb-2007  In Progress 7Y Develop edit subject details 5. Library ion .. [ 1 3-Medium 27-0ct2004
P 73 Create subject object update m... Library Inft ion ... [ | 3-Medium  27.0ct.2004
My Pending Test Runs ¥ Wiite subject object update qu... Library e T 3-Medium 27-0ct-2004
Name Project Last Updated Progress

Note that once you have successfully logged-in and chosen a project, SpiraTeam® remembers this
selection, and on subsequent log-ins will automatically select that project, and highlight it for you in the
“My Projects” list (see 3.2.1 below).

Your homepage contains all the information relevant to you consolidated onto a single page for you to
take immediate action. By default the page lists the information for all projects that you are a member of.
However, you can choose to filter by the current project, to get a more focused list.

Next to some of the widgets is an RSS icon (ﬂ), this allows you to subscribe to the information as a
Really Simple Syndication (RSS) newsfeed. This can be useful if you want to be able to be naotified about
recently assigned items without having to setup email notifications or being logged into SpiraTeam
continuously. If you don't see an RSS icon next to the widgets on your My Page it means that you have
not enabled RSS newsfeeds in your profile. For more details on configuring your RSS preferences,
please refer to section 3.6 (My Profile).




Initially the page is loaded in ‘view mode’ which means that the various ‘widgets’ on the page are

displayed with minimum visual clutter (no toolbars or control icons) that makes it easy to scan the items
on the page and see what work has been assigned. To switch the page to ‘edit mode’, click on “Modify
Layout/Settings” hyperlink:

A o
spiraTeam
—_————

My Page | My Timecard

Welcome Fred Bloggs to Your D

Welcome, Fred Bloggs | Libery Infomaticn System ¥ | | My Profile | Administration | Log Qut | &

My Page

Project Home

d (Retum to Normal View | Add ltams)

Planning

Testing Tracking

Reporting

Display data for: @ All Projects ' Current Project

~ My Projects & ox ~ Quick Launch B ox
Project Name Group Creation Date > Create Incident in: @
Library System Internal Projects 1.Dec-2005
Sample Apglication One Intemal Projects 1.Dec-2005 7 My Assigned Incidents ") 5
s A tion T Ext P 1.Dec-2005 Name Project Type Date Opened
B Ability to associate multiple authors Library Information ... Enhancement 17-MNov-2003
~ My Saved Searches # x ¥ Test System Limitation Library Information ... Limitation 4-Dec-2003
Name Project ¥ Test Training fem Library Information ... Training 3-Dec-2003
] Cut irement Library Information System >Delete  E) ¥ Editing the date on a book is clunky Libeary Information ...~ Bug 2-High 4-Nov-2003
£ Eailed Active Test Cases Library Information System >Delete B ®) Test Training tem Library Information ... Training 2- High 3-Dec-2003
) New Unassigned Incidents Library Information System >Delete B} ¥) Test Change Request Libeary Information ... Change Request 3 - Medium  7-Dec-2003
) Al Reopened Incidents Library Information System >Delete BN ¥ Ability to import Library Information ... Enhancement 3- Medium  25-Mow-2003
71 High Priority Late Tasks Library Information System >Delete B} ¥ Test System Limitation Libeary Information ... Lirnitation 3-Medium  4-Dec-2003
53 Mot Executed Test Sets Library Information System >Delete E} ®) Sample Risk 3 Libeary Information ... Risk 4 - Low 10-Dec-2003
™ My Assigned Requirements | #ox ™ My Detected Incidents ./ B ox
Name Project Importance  Status Name Project Type Priority  Date Opened
1) Ability to create diflerent editions Library Information ... |[ASIGAGAINN In Progress W) Cannot log into the appiication Library Information .. Incident 110+-2003
Ha heir cont Library Information ... | 2= High R d ®) Clicking on link throws fatal error Library Information ... Incident 1-Hov-2003
£ Ability to edit existing authors in the Library jon ... | 2= High Planned ¥ Cannot install system on Windows ME  Library Information ...~ Issue 1-Dec-2003
) Ability to delete existing authors in th Library - |2-High In Progress ®) Cannot install system on Oracle % Library Informatian ... Bug 2-Nov-2003
T Ablity to create new users in the syste . Library . 3-Medium Requested ) ability to associate multiple authors Library Information ... Enhancemant 17-Now-2003
‘fj Ability to import from legacy system x Library . d-Low Requested ®) Cannot log into the application Sample Application O...  Incident 10-Dec-2003
®) Test System Limitation Library Information ... Lirnitation 4-Dec-2003
T My Assigned Test Cases | ® ox ®) Sample Risk 1 Library Information ... Risk 10-Dec-2003
Name Project Status  Last Executed ) Test Training Hem Library Information ... Training 3-Dec-2003
) (A v B Library Information .. | Passed  1-Dec-2003 %) Test Change Request Library Information .. Change Request |2-High | 6-Dec-2003
> Execute
3} Aty to e exsting bk Library Information . 1-Dec-2003 ™ My Assigned Tasks B x
SEETE Name Project Progress Priority Due Date
¥ My Assigned Test Sots ) H ox ¥9 Develop new edition entry scre Library Information . [ | 12-Mar-2004
Name Project Doe Date  Status ¥ Create edition object insert m... Library Information ... [N | 12-Mar.2004
BER ion Testing for Windows XP (4)  Library -nla - Comp ] Wite ednon abject insert au — . | 1 R
> 7 Refactor author scieen to incl Library [ |2-High 10-Mar-2004
£ Exploratory Testing (2) Library Information ... - n/a - Deferred 71 Create author object delete me Library Information ... [ | ' 2-High 10-Mar-2004
e - _ ) ¥ Wiite author object delete que Library Inft B 2-High 10-Mar-2004
&) Testing New Functionality (4) Library Information ... 10-Feb-2007  In Progress ;
> Execute ) Develop edit subject detailss... Library . | 3-Medum  27-Oct-2004
73 Create subject object update s Library Information .. [ | 3-Medium  27-0ct-2004
~ My Pending Test Runs. # % ¥ Write subject object update qu_. Library Infi [ ] 3-Medum 27-0ct-2004
Name Project Last Updated Progress

In this mode, each of the ‘widgets’ displayed on the page can be minimized by clicking on the arrow icon
() in the top-left of the window, or closed by clicking-on the cross icon (x) in the top-right of the window.
This allows you to customize your page to reflect the types of information that are relevant. If you have
closed a widget that you subsequently decide you want to reopen, you can add them back to the page
display by clicking the “Add Items” hyperlink at the top of the page. In addition, the various widgets have a
“settings” icon (¥#) that allows you to customize how that widget appears. The settings are specific to
each widget and in general allow you to specify how many rows of data are displayed and what columns

are displayed.

You can move and reposition the various widgets on the dashboard by clicking the mouse on the title bar
of the widget you want to move and dragging it to the desired location. This change will be remembered

when you next login to the system. Once you have the dashboard configured the way you like it, you can
click “Return to Normal View” to switch back to ‘view mode’.

When you load your ‘My Page’ for the first time it will consists of the following main elements:




My Projects

My Saved Searches

My Assigned Requirements
My Assigned Test Cases
My Assigned Test Sets

My Pending Test Runs

My Assigned Incidents

My Detected Incidents

vV VY VY VY VY VY VY VYY

My Assigned Tasks
» Quick Launch

However these are not the only widgets available. If you click on the “Add/Remove” items hyperlink it will
display the list of any additional widgets that are available:

Add/Remove ltems Close

Select the catalog you would like to browse.

Clo=ed Widgets (0}
Available Widgets (1)

Available Widgets

|:| My Saved Reports

Addto: | Left Side  [s|| Add || Close |

You can add the additional widgets by selecting the appropriate checkbox, choosing the destination
location (left side vs. right side) and then click the [Add] button. The additional widgets available in the My
Page are:

My Saved Reports
My Weather
» My Subscribed Artifacts

\4

» My News Feeds

3.2.1. My Projects

This section lists all the projects you have been given access to, together with the name, description,
project group and date of creation. To view the description of the project, simply position the mouse
pointer over the link, and a tooltip window will popup containing the description.

When you initially view the page, all of the projects will be shown as links, in normal type, with a gray
background. When you click on a project to view, you will be taken to that project’s home-page, and that
project will be set as the current project. That project will now appear in your home-page in bold-type with
a white background (see above screen-shot). To change the currently selected project, simply click on the
link of another project name. You can always change your current project by clicking on the drop-down-
list of projects displayed on the global navigation bar to the right of the “Log Out” link.
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If you are a project group member, the name of the project group will also be displayed as a hyperlink. In
which case, clicking on the project group hyperlink will take you to the Project Group dashboard (see
section 3.5).

3.2.2. My Saved Searches

This section lists any filters/searches you have saved from the various artifact list screens throughout the
application. This allows you to store specific combinations of searches that you need to perform on a
regular basis (e.g. display all newly logged incidents, display all requirements that are completed but have
no test coverage).

The name of the saved search is displayed along with an icon that depicts which artifact it's for and the
project it refers to. Clicking on the name of the saved search will take you to the appropriate screen in the
project and set the search parameters accordingly. Clicking the “Delete” link next to the saved search will
delete it. Clicking on the orange RSS icon will allow you to subscribe to the specific search so that it will
be displayed in your RSS newsreader. This allows you to setup customized lists of information that can
be displayed outside of SpiraTeam.

3.2.3. My Assigned Requirements

This section lists all the requirements you have been made owner of, across all the different projects you
are a member of. This typically means that the project manager has assigned you to be responsible for
either developing the supporting test cases or decomposing the requirement into its detailed work
breakdown structure of project tasks. The requirement name is displayed, along with its status
(requested, accepted, in-progress, etc.) and its importance.

3.2.4. My Assigned Test Cases

This section lists all the test cases you have been made owner of, across all the different projects you are
a member of. This typically means that the project manager has assigned you to be responsible for
executing the assigned test scripts. To aid in this process, the script name is displayed, along with its last
execution status (failed, passed or not-run) and date of last execution. This enables you to see how
recently the tests have been run, and whether they need to be re-run.

If you click on the test-name hyperlink, you will be taken to the details page for this test-case (see section
5.2) and the project that the test-case belongs to will be made your current project. If you click on the
“>Execute” link listed below it will actually launch the test-case in the test-case execution module (see
section 5.4) so that you can easily retest failed cases.

3.2.5. My Assigned Test Sets

This section lists all the test sets (groups of test cases) you have been made owner of, across all the
different projects you are a member of. This typically means that the project manager has assigned you to
be responsible for executing the test cases contained within the test set against a specified release of the
system under test. To aid in this process, the test set name is displayed, along with its status, the project
it belongs to, the number of remaining test cases to be executed, and the date by which all the tests need
to have been run.

If you click on the test-set name hyperlink, you will be taken to the details page for this test-set (see
section 5.6) and the project that the test-set belongs to will be made your current project. If you click on
the “>Execute” link listed below it will actually launch the test-cases contained within the test-set in the
test-case execution module (see section 5.4) so that you can easily carry out your assigned testing task.
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3.2.6. My Pending Test Runs

This section lists any test runs that you started executing in the test case module but haven't yet
completed. Once a test case or test set is executed, a pending test run entry is stored in the system so
that you can continue execution at a later date. Any pending test run can be either deleted or resumed by
clicking on the appropriate link.

3.2.7. My Assigned Tasks

This section lists all the project tasks that you have been made the owner of across all the different
projects you are a member of. This typically means that the manager of the project in question has
assigned development tasks to you that need to be completed so that a release can be completed and/or
a requirement can be fulfilled. The tasks are listed in ascending date order so that the items with the
oldest due-dates are displayed first. In addition, each task is displayed with a progress indicator that
graphically illustrates its completion against schedule. See section 8 — task management for details of the
different progress indicators.

Clicking on the task name hyperlink will take you to the task details page. This page will describe the task
in more detail, illustrate which requirement and release it is associated with, and also allow you to view
the change log of actions that have been performed on it.

3.2.8. My Assigned Incidents

This section lists all the open incidents you are the owner of, across all the different projects you are a
member of. This typically means that the project manager has assigned you to be responsible for
resolving the incident. In the case of a bug, this can mean actually fixing the problem, whereas for other
incident types (e.g. training item) it may mean simply documenting a workaround. In either event, this
section highlights the open incidents you need to manage, ranked by importance/priority and categorized
by type, with the open date displayed to give you a sense of the age of the incident.

Clicking on the incident name hyperlink takes you to the incident details page (see section 6.2) that
describes the incident in more detail, and allows you to add new information or change its status to
indicate actions taken. In addition, if you position the mouse pointer over the name of the incident, a more
detailed description is displayed as a “tooltip”.

3.2.9. My Detected Incidents

This section lists all the open incidents that you have detected, across all the different projects you are a
member of. These incidents are not necessarily ones that you need to take an active role in resolving, but
since you were the originator — either by executing a test case or just logging a standalone incident — you
can watch them to make sure that they are resolved in a timely manner.

Clicking on the incident name hyperlink takes you to the incident details page (see section 6.2) that
describes the incident in more detail, and allows you to add new information or change its status to
indicate actions taken. In addition, if you position the mouse pointer over the nhame of the incident, a more
detailed description is displayed as a “tooltip”.

3.2.10. Quick Launch

This widget allows users to quickly record a new incident in any of the projects that they belong to. It's a
shortcut that avoids having to first select a project, go to Tracking > Incidents and then click “New
Incident”. Instead you simply choose the project from the dropdown list and click the arrow icon to bring
up the new incident creation screen.
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3.2.11. My Saved Reports

This section lists any reports you have saved from the reports center. This allows you to store specific
combinations of report elements, format, filters and sorts (see the section on Reporting for more details
on how to configure a report) for reports that you need to run on a regular basis:

My Saved Reports

Name Project

v1.0 Release List Report Library Information System = Delete

3.2.12. My Weather

This “fun” widget is designed to allow users to make the SpiraTeam® homepage more useful so that the
page becomes more central in their day-to-day operations and therefore they are more likely to keep
track of the other items reflected on the page.

Weather for Silver Spring, MD
Currently in Silver Spring, MD (4 of 4:27 FM ) Tomorrow
Mostly Cloudy 50°F / 30°F

49°F ; =
N ; ..  Wind: 4mph SSE Q Partly Sunny
50°F /30°F Feels Like: 48°F Parthy =unny in the morning.. then becoming
Humidity: 27% mosthy cloudy. Highs in the upper 40=s. West
wind=s around 5 mph.

3.2.13. My Subscribed Artifacts

This widget displays a list of all the artifacts in the system that you have subscribed to (by clicking on the
Subscribe icon on the item). You can display the item by simply clicking on the hyperlink. In addition, if
changes are made to any of the artifacts an email notification will be sent to you. You can click on the
“Unsubscribe” link to remove the item from this list.

My Subscribed Artifacts &

Name Project Last Updated

“'3 Ability to add new books to the system Library Information _.. 1-Dec-2003 > Unsubscribe
Lj Ability to create new book Library Information ... 1-Dec-2003 > Unsubscribe
Ej Doesn't let me add a new categony Library Information .. 1-Dec-2003 > Unsubscribe

3.2.14. My News Feeds

This widget allows you to subscribe to an external newsfeed and have the results be displayed inside
SpiraTeam. By default it will be set to the newsfeed from the Inflectra website that displays a list of recent
company and product announcements. You can add multiple instances of the widget to the dashboard,
allowing you to read multiple news sources at once. Typical uses for this widget are to add news from
project management and testing news sites/blogs or to add information from other tools in your
organization that can display their data in RSS format.
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My News Feeds

Headline Author Publish Date
Spiraleam v3.2 to be Released on December 22nd. 20 = webmaster@inflectra.com 1216/201
Rational Functional Tester Plug-In Released for Re =& webmaster@inflectra.com 172011
Ranorex Plug-In Released for Spira Remotel aunch = webmaster@inflectra.com 10142011
Rapise Automated Functional Testing System Release = webmaster@inflectra.com 10/6/2011
SpiraTest/Team/Plan Patch 016 Released = webmaster@inflectra.com 10/372011

3.3. Global Navigation

Regardless of the page you are on, SpiraTeam® will always display the global navigation bar, consisting
of six section tabs (My Page, Project Home, Planning, Testing, Tracking and Reports) that correspond to
the main activities that take place in the system, the global search bar, and three secondary links to “My
Profile” and “Log Out” and “Help”.

Welcome, Fred Bloggs | Library Information System "| | My Profile | Administration | Log Out |

Help?

Team

My Page Project Home Planning Testing Tracking Reporting
My Page | My Timecard Rele: Manager

Under the various tabs are several secondary menu options that are displayed when you hover the
mouse over the appropriate tab as illustrated below:

> My Page

> My Page (described above)
> My Timecard (described in Section 3.7)
» Project Home
> Project Home (described in Section 3.4)
D> Project Group Home (described in Section 3.5)
> Documents (described in Section 10)
>» Planning
> Requirements (described in Section 4)
D> Releases (described in Section 7)
> Iterations (described in Section 7.3)
> Planning Board (described in Section 7.4)
» Testing
> Test Cases (described in Section 5)
> Test Sets (described in Section 5.7)
> Test Runs (described in Section 5.5)
> Automation Hosts (described in Section 5.9)
>» Tracking

> Incidents (described in Section 6)
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> Tasks (described in Section 8)

> Resources (described in Section 9)

> Source Code (described in Section 12)
» Reports (described in section 11)

Note: The main tabs will take you to the appropriate artifact type (requirement, test case, incident, etc.) for
the currently selected project. However if you haven't selected a project, then clicking on any of the tabs
will simply take you back to “My Page” so that you can select a project.

3.3.1. Global Search

SpiraTeam includes a global search bar that can be used to search across project and artifact type for
items that include the entered keywords in either the name or description field:

¥ || My Profile | Administration | Log Out ||"create book”" @

® Welcome, Fred Bloggs | Library Information System

m
! Search Results

|| The following 8 results match your keyword(s) "create book™:

‘ﬂTK? Create book object insert method (Library Information System
Code the busmess ob]ect that inserts a new book row in the database

T

‘ﬂTK:: Create book object update method (Lib nformation System
Code the busmess ob]ect that updates an e><|st|ng book record in the database

=

‘ﬂTKB Create book ob ect delete method (Library Information System

q ‘ﬂTKﬂ Create bUUk sub ect mapping insert method (Library Information System

|| ‘ﬂTK12 Create book sub ect mapping delete method (Library Information System

L4 v Decembe 20

‘ﬂTK13 Create book sub ect mapping queries (Library Information System
0 ‘ﬂTK19 Create book ob ect delete all method (Library Information Syster
i De 2

UTSQ Ability to create new book (Library Information System
User clicks link to create book

=]

T

You can search for individual keywords by simply entering them in the search box and clicking the arrow
button on the right. You can search for phrases by enclosing the words in double quotes.

For example, searching on book name will find any artifacts that include either of the two words book and
name in the name or description. Searching on “book name” will only return items that have that exact
phrase in either the name or description.

3.3.2. Log Out

Clicking on the “Log Out” link will immediately log you out of your current session and return you to the
login page illustrated in section 3.1. If you had set the “Remember Me” option during your previous login,
that setting will be reset; so if you want to avoid having to keep logging-in, you'll need to re-check that box
during your next log-in.

3.3.3. Help
Clicking on this link on any page will bring up the online version of this manual shown below:
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.f.:' http:/fsandman/ThelpUri=User Manual.x section=4.1. Reguirements List - SpiraTeam Online Help - Windows Internet Explorer

SpiraTeam Help Center

Table of Contents

1. Introduction
2. Functionality Overview
3. User/Project Management

4.1. Requirements List

When you click on the Planning = Requirements link on the global navigation bar, you will initially be
taken to the requirements list screen illustrated below:

=

[= 4. Requirements Management
4.1. Requirements List

4.1.1. Inzert r'—"-vr‘_'Team. Welcoms. "red Bloggs | M Prcfis | Log St |were recrmemn grewr | Akt L
4.1.2. Delete 7
::112 gﬂ:jrgnt e[S levd— | Bifeh | Ghomg Feme |- Showncsccmie- v T Cles e
W Brquicsmend U ot oy Tk Promprosse. o gt St Hel Miicuilty
4.1.5. Refresh ] | e ) G | g g |
4.1.6. Edit 0| |0 Logend coun leiamean Hat Caveren 1
4.1.7. Show Level ] ot Cavered 1
4.1.8. Fittering E L - :
4.1.9. Show / Hide Columns = — Lo L
4.1.10. Copying Requirements & i -
4.1.11. Moving Requirements 1 —-— (et

1
1

4.1.12. Exporting Reguirements
4.2, Requirement Details

LETT Rations TEm |
4.21. Test Coverage - anmm - g |
422 Tasks 1 |
4.2.3. Custom Properties . . :z:

424 Aftachments
425 History
4.28. Associations

CERE S T LA

Jatmal fEnadc | @i GO

5. Test Case Management
6. Incident Tracking

7. Release Management
8. Task Tracking

9. Reports Center

The requirements list consists of a hierarchical arrangement of the various requirements and functionalities
that need to be provided by the system in question. The structure is very similar to the Work Breakdown
Structure (WBS) developed in Microsoft Project®, and users of that software package will find this very M

Frnmilice Eo anco Wlacms s uons ook oo oo ook Haio ok sl il ke osxomoiss ol s s sl s ool e
= = =

Clicking on any of the [+] expand links in the left hand table of contents will open up the detailed list of
topics for each of the main areas of the system. In each area, clicking on one of the individual links will
open the appropriate section in the help manual. By default, the reading-pane will open to the help item
that is most closely related to the screen you happened to be on when you clicked the “Help” link.

3.3.4. Choose Project

Choosing a project from the list of your assigned projects in the drop-down-menu allows you to quickly
and easily jump between projects regardless of the page you happen to be on. When you choose a
project, you will be taken to the same page in the selected project (assuming that you have permissions
to view that page). You can use CTRL+click to open the new project in a separate browser tab.




3.4. Project Home

When you click on either the “Project Home” tab or the name of the project in the “My Page” project list,
you will be taken to the homepage of the specific project in question:

T . Welcome, Fred Bloggs | My Profile | | Log Out | |Libe - v Help?
spiraTeam
-_— MyPage  [ZETRULRMN  Pianning Testing Tracking Reporting
Project Group Home | Project Home | Documents Role: Manager
Library Information System (PRO00001) - Modify LayoutSettings | Add ltems. Display data for: | — All Releases — M
Project Overview Top Open Issues (view Al
Sample application that allows users to manage books, authors and lendi for a typi Priority  Owned By Date Opened
librar
Gm:p_ . Cannot install system on Windows ME 1-Dec-2003
Web Site: www librarymformationsystem org L e [ZE0gIN socpsmitn  1-Dec2003
Owner(s): System Administrator m ren's 3-Medium  Joe P Smith 1-Dec-2003
m m; i i 3 - Medum 1-Dec-2003

Requirements Summary (view Detais)

Status 1 Critical z.m;.n 3-Ihd;m| 4.|.a‘w (Hone) TOT;L Top Gpen Risks axwan
T = = B Description Prioity  OwnedBy  Date Opened
e 0 Sample Risk 1 10-Dec-2003
Accepted 0 Sample Risk 2 10.Dec-2003
Planned 1 2 3 mpie R 4-low  FredBloggs  10-Dec-2003
In Progress 1 1 2
eoreefed 1 1 8 Test Execution Status (view Detaiks)
s i 5 Total # Runs: 13
ToTAL 8 4 5 1 8
Daily Run Count:
> 121472003 - 3
Requirements Coverage (view Details) > 121372003 - 3
0] > 121212003 - 2
> 121172003 - 11
; [k
Faiked Passed  NotRun | Blocked | Caution
Release Test Summary (View Details)
0 [— - Release ! teration i #Tests  Execution Statu
Fassed Failed Blocked Cauton Not Run Not Covered el Ll UHE SIS
D1.000- Library System Release 1 1z [
Release Task Progress (view Detais) D 1010- Library System Release 1 SP1 1 | |
Release | lteration Tasks Est  Proj. TaskProgress @ 1020 - Library System Release 15P2 1 [ —
1000 - Library System Release 1 18 940h 958h | T1.1.0.0 - Library System Relgase 1.1 2 [
T 1.0.1.0 - Library System Release 1 SP1 [ 03h  03h  NoTasks 2 1.1.1.0 - Library System Release 1.1 SP1 1 ]
©1.020- Library System Release 1 P2 [ - - Mo Tasks 1.200- Library System Release 2005 1 | I—
W1100-Libn m Reloase 1.1 18 eson ssTh DN ]
T 1.11.0 - Library System Release 1.1 SP1 0 0%h 0Sh  NoTasks Incident Summary (view Details)
1200 Uibrary System Release 2005 3 tooh t00n [T Displaying for Incident Type:
Status 1-Criical  2-High  3-Medum  4-Low (None) TOTAL
Task Graphs (View Details) et : g i g g
Task’ it A\
e L : : [
B acrial Velooity ) 3 2
o MNot Reproducible 1 1
m Bl Open 3 1 2 2 4 15
Reopen [
i Resolvad 2 2 2 &
TOTAL 14 14 1 " 10 60

Incident Open Count (view Details)
o

- \\ /

1000 1910 1020 1100 L1108 1200

> Display Data Gnd | Save As: JPEG | BMP | PNG

Late Finishing Tasks (view Al)

Name Owner Progress End Date o
) Create edition abject insert method FredBloggs [N |  12-Mar2004 MNow) | 1-Crieal 2-Hoh | 3-Medum | 4-low

71 Develop new edition entry screen FredBloggs [N | 12:Mar-2004

Z) Wite author object delete query FredBloggs [ | 10-Mar-2004 Requirement Incident Count

?) Create author object delete method FredBoggs [ | 10-Mar-2004 Name #0Open  # Total

5 Abilty to add new books to the system 2 2

Late Starting Tasks (view iy T Ability to associate books with different editions 2 2

Name Owmer Start Date 1) Abilty to edit existing books in the system 1 1

73 Write edition object ingert queries Fred Bloggs 11-Mar-2004 ) Abilty to associate books vith difierant subjects 1 1

) Retactor author screen to include delete . Fred Bloggs 9-Mar-2004 D sy R ! !

73 Write author obiect updaie queries Joe P Smith 7-Mar-2004 ) Abiity o completely erase all books stored in the system w 1 1

23 Craate author object update method Joe P Smith 7-Mar-2004 ) Abiit to create new users in the system 1 1

) Develop edit author details screen Joa P Smith 7-Mar-2004 HL v g
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This page summarizes all of the information regarding the project into a comprehensive, easily digestible
form that provides a “one-stop-shop” for people interested in understanding the overall status of the
project at a glance. It contains summary-level information for all types of artifact (requirements, test
cases, incidents, etc.) that you can use to drill-down into the appropriate section of the application. In
addition to viewing the project home page, you can choose to filter by a specific release, to get the
homepage for just that release (and any child iterations).




In a similar manner to the ‘My Page’, the Project Home dashboard is initially loaded in ‘view mode’ which
means that the various ‘widgets’ on the page are displayed with minimum visual clutter (no toolbars or
control icons) that makes it easy to scan the items on the page and see the health of the status of the
project at a glance. To switch the page to ‘edit mode’, you should click on “Modify Layout/Settings”
hyperlink.

Once in ‘edit mode’, each of the ‘widgets’ displayed on the project homepage can be minimized by
clicking on the arrow icon (#) in the top-left of the window, or closed by clicking-on the cross icon () in
the top-right of the window. In addition, the widgets allow you change their settings by clicking on the
settings icon (¥¥).This allows you to customize your view of the project to reflect the types of information
that are relevant to you. If you have closed a widget that you subsequently decide you want to reopen,
you can rectify by clicking the “Add Items” hyperlink at the top of the page, and locating the closed item
from the list of ‘Closed Widgets'.

When you load your ‘Project Home’ for the first time it will consists of the following main elements:

A 4

Project Overview
Requirements Summary
Requirements Coverage
Release Task Progress
Task Graphs

Late Finishing Tasks
Late Starting Tasks

Top Open Issues

Top Open Risks

Test Execution Status
Release Test Summary
Incident Summary
Incident Open Count
Requirement Incident Count

YV VY Y VY VY VY VY VY VY VY YVYY
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However these are not the only widgets available. If you click on the “Add/Remove” items hyperlink it will
display the list of any additional widgets that are available:

Add/Remove ltems Close
Select the cataleg you would like to browse.

Closed Widgets (0}
Available Widgets (4)

Available Widgets

D Requirements Regrezzion Coverage
[ Test set Status

D Incident Aging

D Incident Test Coverage

Adl:ltu:l:|LeﬂSide v|| Add || Close |

You can add the additional widgets by selecting the appropriate checkbox, choosing the destination
location (left side vs. right side) and then click the [Add] button. The additional widgets available in the
Project Home dashboard are:

» Requirements Regression Coverage
> Test Set Status
> Incident Aging
> Incident Test Coverage
» Tag Cloud
> Recent Builds
Each of the different widgets listed is described in more detail below:

3.4.1. Project Overview

This section displays the name of the project, together with a brief description, the web-site that points to
any additional information about the project, and the names of the owners of the project.

3.4.2. Requirements Summary

This section consists of a summary table that displays the aggregate count of requirements in the system
broken-down by importance (on the x-axis) and status (on the y-axis). This allows the project manager to
determine how many critical vs. low priority enhancements are waiting to be implemented, vs. actually
being implemented. In addition, it makes a distinction between those requirements simply requested and
those actually planned for implementation, so the project manager can see what the backlog is between
the customer’s demands, and the plan in place. Clicking on the “View Details” link at the top of the table
simply brings up the project requirements list (see section 4.1), whereas clicking on the individual values
in the cells will display the requirements list with the filter set to match the importance and status of the
value.

3.4.3. Requirements Coverage

This section consists of a bar graph that displays the aggregated count of requirements test coverage for
the project. The Passed, Failed, Blocked, Caution and Not-Run bars indicate the total count of
requirements that have tests covering them, allocated across the execution status of the covering tests.
For example if a requirement is covered by four tests, two that have passed, one that has failed and one
that has not yet been run, the counts would be passed = 0.5, failed = 0.25 and not-run 0.25. These
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fractional quantities are then summed across all the requirements to give the execution status breakdown
of the covered requirements.

In addition to the five statuses for the covered requirements, the sixth (“Not Covered”) bar depicts the
total number of requirements that have no tests covering them, putting the five other bars into
perspective. Typically a project is in good health if the “Not Covered” bar is zero, and the count of
“Passed” requirements is greater than “Failed”, “Caution” or “Not Run”. The greatest risk lies with the
“Blocked”, “Not Covered” and “Not Run” status codes, since the severity/quantity of any bugs lurking
within is not yet fully known.

If you position the mouse pointer over any of the four bars, the color of the bar changes slightly and the
underlying raw data is displayed as a tooltip, together with the percentage equivalent. Clicking on the any
of the bars in the chart will take you to the requirements list page (see section 4.1) with the corresponding
filters set.

When you filter the project home by release/iteration, this widget will filter the requirements coverage
graph to only include requirements that are specifically mapped to the selected releasel/iteration.
This is useful when you want to determine the test coverage of new requirements that are being added to
the specific release/iteration. If instead you want to determine the regression test coverage for a release,
you should add the separate “Requirements Regression Coverage” widget to the page instead.

3.4.4. Requirement Incident Count

This section displays a count of the total number of incidents, and the number of open incidents mapped
against requirements in the system, sorted by the requirements that have the most open incidents first.
This section is useful for determining the parts of the application that have the most instability, as you can
look at the requirements that have yielded the greatest number of incidents. Clicking on any of the
requirements hyperlinks will take you to the detail page for the requirement in question (see section 4.2).
You can configure in the settings whether to include requirements with no open incidents, and also how
many rows of data to display.

3.4.5. Top Open Issues

This section displays a breakdown of the top issues logged against the project, in order of decreasing
priority. Note that items not given a priority are listed at the top, since critical issues could be lurking in
that list, and the project manager will want to immediately review these to assign priorities. Clicking on the
issue item hyperlink will take you to the incident details page for the issue in question (see section 6.2).
You can configure in the settings whether to use Priority or Severity for the display, and also how many
rows of data to display.

3.4.6. Top Open Risks

This section displays a breakdown of the top risks logged against the project, in order of decreasing
priority. Note that items not given a priority are listed at the top, since critical risks could be lurking in that
list, and the project manager will want to immediately review these to assign priorities. Clicking on the risk
item hyperlink will take you to the incident details page for the risk in question (see section 6.2). You can
configure in the settings whether to use Priority or Severity for the display, and also how many rows of
data to display.

3.4.7. Release Test Summary

This widget allows you to quickly ascertain the test execution status of each of the active releases that
make up the current project in one snapshot. Each release is displayed together with a graphical display
that illustrates the execution status with different colored bars. In addition, if you hover the mouse over
the graphical display it will display a tooltip that provides a more detailed description of the number of
tests in each status.
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Release Test Summary (View Details)

Release [ lteration # Tests Execution Status

[E1.0.0.0 - Library System Release 1 1

1=J

E1.01.0- Library System Release 1 SP1

1=

E1.020- Library System Release 1 SP2

[¥=]

E1.1.00- Library System Release 1.1

|=J

[E1.1.1.0 - Library System Release 1.1 SP1

=4

E1.200- Library System Release 2005

Each release will display the aggregate status of any test cases directly assigned to itself, together with
the test status of any child iterations that are contained within the Release. Clicking on one of the
releases will drill you down one level further and display the test execution status for the parent release
as well as each of the child iterations separately:

Release Test Summary (View Details)

Release [ Iteration # Tests Execution Status
E1.1.0.0 - Library System Release 1.1 3

£11.1.0.0.0001 - lteration 001 2

1 1.1.0.0.0002 - lteration 002 3

21 1.1.0.0.0003 - lteration 003 4

3.4.8. Incident Summary

This section consists of a summary table that displays the aggregate count of incidents in the system
broken-down by priority (on the x-axis) and status (on the y-axis). This allow the project manager to
determine how many critical vs. low priority incidents are waiting to be addressed, and how many new
items need to be categorized and assigned. Clicking on the “View Details” link at the top of the table
simply brings up the incident list (see section 6.1), whereas clicking on the individual values in the cells
will display the incident list with the filter set to match the priority and status of the value.

By default this summary table displays the total count of all incidents — regardless of type, however my
changing the drop-down list to a specific incident type (e.g. bug, enhancement, issue, etc.), the project
manager can filter the summary table to just items of that type. You can also configure in the settings
whether to use Priority or Severity for the x-axis

3.4.9. Test Execution Status

This section consists of a bar graph that displays the aggregated count of test cases in each execution
status for the project. Note that this graph does not consider past test-runs when calculating the totals in
each status (Passed, Failed, Not Run, etc.), it simply looks at each test-case and uses the last-run status
as the best health indicator. Thus if a test case that previously passed, has subsequently failed upon re-
execution, it will be considered a failure only.

If you position the mouse pointer over any of the five bars, the color of the bar changes slightly and the
underlying raw data is displayed as a tooltip, together with the percentage equivalent. Clicking on any of
the bars will bring up the project test case list (see section 5.1) with the appropriate filter applied.

In addition to the bar-chart, there is also a display of the total number of test runs recorded for the project,
and a list of the five most recent days of recorded test-runs, together with the daily count.
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3.4.10. Release Task Progress

This widget allows you to quickly ascertain the task progress of each of the active releases that make up
the current project in one snapshot. Each release is displayed together with a graphical display that
illustrates the completion percentage and status with different colored bars. In addition, if you hover the
mouse over the graphical display it will display a tooltip that provides a more detailed description of the
number of tasks in each status.

Release Task Progress (View Details)

Release [ Iteration Tasks Est. Proj. Task Progress
E1.0.0.0 - Library System Release 1 18 34.0h  35.8h

E1.0.1.0 - Library System Release 1 SP1 4 15.3h  15.3h

E1.0.20 - Library System Release 1 SP2 0 No Tasks
E1.1.0.0 - Library System Release 1.1 15 71.0h  70.7h

E1.1.1.0 - Library System Release 1.1 SP1 0 0.3h  0.3h Mo Tasks
E01.2.0.0 - Library System Release 2005 K| 10.0h 3.5k

Each release will display the aggregate progress of any tasks directly assigned to itself, together with the

task progress of any child iterations that are contained within the Release. Clicking on one of the releases
will drill you down one level further and display the task progress for the parent release as well as each of
the child iterations separately:

Release Task Progress (View Details)

Release [ lteration Tasks  Est. Proj.  Task Progress
E1.0.0.0 - Library System Release 1 18 94.0n  95.8h

21 1.0.0.0.0001 - lteration 001 1] 32.0h  32.0h

21 1.0.0.0.0002 - Iteration 002 B 32.0h  32.0h

211.0.0.0.0003 - Iteration 003 B 30.0h  31.8h

3.4.11. Late Finishing Tasks

This section displays the list of any project tasks that have not yet been completed, but whose scheduled
end date has already elapsed. A graphical progress bar is included with each task in the grid, so that you
can easily see which tasks are nearest completion.

3.4.12. Late Starting Tasks

This section displays the list of any project tasks that have not yet started, but whose scheduled start date
has already elapsed. Each task is listed along with its owner, priority and due-date so that you quickly
ascertain how many days late it will be starting, how important it is to the project, and who needs to be
contacted to get more information.

3.4.13. Requirements Regression Coverage

This section consists of a bar graph that displays the aggregated count of requirements test coverage for
the project in a similar fashion to the ‘Requirements Coverage’ widget:
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Requirements Regression Coverage (View Details)
.-
0  —
T T T T T 1
Passed Failed Blocked Caution Mot Run Mot Covered

However, unlike the ‘Requirements Coverage’ widget, when you filter the project home by
releasef/iteration, this widget will filter the requirements coverage graph to include all requirements
(regardless of releaseliteration), but only considering covering test cases that are associated with the
selected releasel/iteration. This is useful when you want to determine the regression requirements test
coverage of a specific release (i.e. does running all the tests relevant to this release cover all the
necessary requirements, not just new requirements).

3.4.14. Test Set Status

This section consists of a bar graph that displays the aggregated count of test cases in each execution
status for each test set in the project:

Test Set Status  (view Details)

20 |
Overdue Test Sets:

TX000001 5-Feb-2007
TX000002 7-Feb-2007

TX000005 10-Feb-2007

o | | |

T T T
Failed Passed Mot Run Blocked Caution

Therefore if you have the same test cases stored in multiple test sets, then this widget will display the
total test case count for all combinations of test set. This is useful if you have the same test cases being
executed in different environments — represented by different test sets — and you need to make sure that
the tests passed successfully in all environments.

If you position the mouse pointer over any of the five bars, the color of the bar changes slightly and the
underlying raw data is displayed as a tooltip, together with the percentage equivalent. Clicking on any of
the bars brings up the project test set list (see section 5.6) page with the appropriate filter applied. In
addition to the bar-chart, there is also a display of the five most overdue test sets in the project.

3.4.15. Incident Aging

This section displays the number of days incidents have been left open in the system. The chart is
organized as a histogram, with the count of incidents on the y-axis and different age intervals on the x-
axis.

3.4.16. Incident Test Coverage

This section displays a bar-graph that illustrates the execution status of any test cases that previously
failed and resulted in the generation of an incident that has subsequently been resolved. This is very
useful when a test case was executed in Release 1.0 and an incident was logged. That incident has now
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been resolved in Release 1.1 (and is in a closed status) but we need to know that the test case that
caused the failure has been successfully re-run. Any test cases listed as Blocked, Caution, Not-Run or
Failed in this graph need to be executed to verify that all resolved bugs in the release have truly been
fixed.

3.4.17. Task Graphs

This widget lets you quickly view the three main graphs used when measuring the progress of tasks in an
agile methodology:

1. Task Velocity — this graph shows the total estimated and actual effort delivered in each project
release and/or iteration

2. Task Burnup — this graph shows the cumulative amount of work outstanding for each
release/iteration in the project with separate lines for the estimated, remaining and completed
effort.

3. Task Burndown — this graph shows the remaining work that needs to be done for each
releasel/iteration in the project with separate lines for the estimated, remaining and completed
effort.

For each of the three graphs you can click on the “Display Data Grid” link to display a grid of the
underlying data that is represented in the graph and also there are options to save the graph in a variety
of different image formats.

3.4.18. Tag Cloud
This widget lets you see the list of document tags being used in the project:

Tag Cloud

e POOK managementerrorfunctional specification
libraries .......................stack trace t€Stin Q user

interface wireframe

The size of the tag hame indicates the relative frequency of its usage in the project. Clicking on a
document tag will open up the Document List page (see section 10.1) with the filter set to the tag you
clicked on. This will display a list of related documents that have been tagged with the same tag name.

3.4.19. Recent Builds

This widget displays a list of the most recent builds that have been performed as part of the current
release or iteration:

Recent Builds

Name Status Creation Date

#]  Build 0015 Succeeded 3/M2/2004 12:00:00 AM
#]  Build 0014 Succeeded 3/11/2004 12:00:00 AM
#  Build 0013 Failed 3/10/2004 12:00:00 AM
#1  Build 0012 Failed 3/9/2004 12:00:00 AM
#1  Build 0010 Failed 3/8/2004 12:00:00 AM
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For each build it will display whether the build succeeded or failed, the date the build occurred and the
name of the build together with a hyperlink to the build details (see section X). Note: If no release or
iteration is selected then the widget will not display any data.

3.5. Project Group Home

When you click on either the “Project Group Home” tab in the global navigation or the name of the project

group in the “My Page” project list, you will be taken to the homepage of the specific project group in
guestion:

Welcome, Fred Bloggs | My Profile | Administration | Log Out | |y ifemation System v

Help?

raTeam

My Page Project Home Planning Testing Tracking Reporting
Project Group Home | Project Home | Documents

Role: Manager
Project Group: Internal Projects (PG000002) - Modify Layout/Settings | Add Rems

Group Overview Project List
Contains the library project and sample application one Project Name Web Site Creation Date
Web Site: www.libranvinformationsystem.org = Library Information System  hitp-//uwww libearyir rstem org 1-Dec-2005
Owner{s): Fred Bloggs . System Administrater

Sample Application One hittpyflwww tempuri arg 1-Dee-2005

Requirements Coverage )
- Test Execution Status

4

g T T T T T T 1
Fassed Failed Blocked Caution Mot Run Mot Covered o] .

Project #Reqs Coverage Falled " Passed MNotRun  Blocked  Caulion
Library Information System 18 I Praject # Tests #Runs Execution Status
Sample Application One 1 T Library Information System " 19

Sample Application One 1 1

Task Progress

- Incident Aging
35
0 T T |'—ll
©On Schedule Late Finish Late Start Not Started 0 L T T T T
Project Tasks  Est. Actual Task Progress 0-13 16-30 3145 45-60 e A By
Library Information System ) 1900h  1867h | Profact Eloper QS NBHEAIoNT
Sample Application One 0 00h 00k NoTasks Llrary Information Syster 2

Sample Application One 1

This page summarizes all of the information regarding the project group into a comprehensive, easily
digestible form that provides a “one-stop-shop” for people interested in understanding the overall status of
the group as a whole as well as the relative performance of the different projects that make up the group.
It contains summary-level metrics for all types of artifact (requirements, test cases, tasks, incidents, etc.)
that you can use to drill-down into the appropriate project for more details.

In a similar manner to the ‘My Page’, the Project Group Home dashboard is initially loaded in ‘view mode’
which means that the various ‘widgets’ on the page are displayed with minimum visual clutter (no toolbars
or control icons) that makes it easy to scan the items on the page and see the health of the status of the

project at a glance. To switch the page to ‘edit mode’, you should click on “Modify Layout/Settings”
hyperlink.

Once in ‘edit mode’, each of the ‘widgets’ displayed on the project group homepage can be minimized by
clicking on the arrow icon () in the top-left of the window, or closed by clicking-on the cross icon () in
the top-right of the window. In addition, the widgets allow you change their settings by clicking on the
settings icon (¥¥).This allows you to customize your view of the project group to reflect the types of
information that are relevant to you. If you have closed a widget that you subsequently decide you want to

reopen, you can rectify by clicking the “Add Items” hyperlink at the top of the page, and locating the
closed item from the list of ‘Closed Widgets'.
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When you load the ‘Project Group Home’ for the first time it will consists of the following main elements:

» Group Overview
» Requirements Coverage
» Task Progress

> Project List

» Test Execution Status

> Incident Aging

However these are not the only widgets available. If you click on the “Add/Remove” items hyperlink it will
display the list of any additional widgets that are available:

Add/Remove Items Close

Available Widgets (2)

Available Viidgets

D Top Open lzgues
D Top Open Rigks

Al:ldtu:lLeﬂSide VH Add || Close |

You can add the additional widgets by selecting the appropriate checkbox, choosing the destination
location (left side vs. right side) and then click the [Add] button. The additional widgets available in the
Project Group Home dashboard are:

>» Top Open Issues

» Top Open Risks
Each of the different widgets listed is described in more detail below:

3.5.1. Group Overview

This section displays the name of the project group, together with a brief description, the web-site that
points to any additional information about the project group, and the names of the owners of the project
group.

3.5.2. Project List

This section lists all the active projects that make up the group, together with the name, description,
project group and date of creation. To view the description of the project, simply position the mouse
pointer over the link, and a tooltip window will popup containing the description.
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3.5.3. Requirements Coverage

This section consists of a bar graph that displays the aggregated count of requirements test coverage for
the entire project group. The Passed, Failed, Blocked, Caution and Not-Run bars indicate the total count
of requirements that have tests covering them, allocated across the execution status of the covering tests

Under the main bar graph is displayed a table containing each project in the group and a colored bar
illustrating the specific requirements coverage distribution for that project. That way you can see both the
aggregate coverage and also the relative coverage for the projects. You can configure in the widget
settings whether you want to see the aggregate bar graph, and/or the project-specific requirements
coverage.

3.5.4. Task Progress

This section consists of a bar graph that displays the aggregated count of tasks by progress category for
the entire project group. The ‘On Schedule’, ‘Late Finish’, ‘Late Start’ and ‘Not Started’ bars indicate the
total count of tasks that are in that category for all the projects in the group.

Under the main bar graph is displayed a table containing each project in the group and a colored bar
illustrating the specific task progress for that project (using the same coloring convention as the main
graph). That way you can see both the aggregate task progress and also the relative progress for each
project. You can configure in the widget settings whether you want to see the aggregate bar graph, and/or
the project-specific task progress.

3.5.5. Test Execution Status

This section consists of a bar graph that displays the aggregated count of test cases by execution status
for the entire project group. The Passed, Failed, Blocked, Caution and Not-Run bars indicate the total
count of test cases that are in that category for all the projects in the group.

Under the main bar graph is displayed a table containing each project in the group and a colored bar
illustrating the specific test case execution status for that project (using the same coloring convention as
the main graph). That way you can see both the aggregate test status and also the relative status for
each project. You can configure in the widget settings whether you want to see the aggregate bar graph,
and/or the project-specific test status.

3.5.6. Incident Aging

This section displays the number of days incidents have been left open in the system. The chart is
organized as a histogram, with the count of incidents on the y-axis (for all projects in the group) and
different age intervals on the x-axis.

Under the main bar graph is displayed a table containing each project in the group and a colored bar
illustrating the distribution of open incidents by priority for that project. That way you can see both the
aggregate aging for the group and also the relative priority of open incidents for each project. You can
configure in the widget settings whether you want to see the aggregate aging histogram, and/or the
project-specific incident count by priority.

3.5.7. Top Open Issues

This section displays a breakdown of the top issues logged against any of the projects in the group, in
order of decreasing priority. Note that items not given a priority are listed at the top, since critical issues
could be lurking in that list, and the project manager will want to immediately review these to assign
priorities. Clicking on the issue item hyperlink will take you to the incident details page for the issue in
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guestion (see section 6.2). You can configure in the settings whether to use Priority or Severity for the
display, and also how many rows of data to display.

3.5.8. Top Open Risks

This section displays a breakdown of the top risks logged against any of the projects in the group, in order
of decreasing priority. Note that items not given a priority are listed at the top, since critical risks could be
lurking in that list, and the project manager will want to immediately review these to assign priorities.
Clicking on the risk item hyperlink will take you to the incident details page for the risk in question (see
section 6.2). You can configure in the settings whether to use Priority or Severity for the display, and also
how many rows of data to display.

3.6. My Profile

When you click on either the “My Profile” link in the global navigation, you will be taken to the page in the
system that allows you to view and edit your personal profile:

Please review the information listed below and make any changes if necessary.
Click [Update] to save changes.
User Name/ID: fredbloggs [US:000002]
First Name™ ‘Fred |
Middle Initial: L]
Last Name*: ‘Bloggs |
RSS Token: /| Enable RSS Feeds
Change Password Email Preferences LDAP Seftings Regional Settings Actions

To change your password, you must enter your current password and the password you would like to change it to_

Current Password: | |

New Password: | |

Confirm Password: | |

You can change your user information including your first-name, last-name, and middle-initial. Clicking
the <Update> button will commit the changes, whereas clicking <Cancel> returns you back to either
“Project Home” or “My Page” depending on whether you have a project currently selected or not.

If you want to be able to subscribe to RSS feeds of the information assigned to you in the “My Page”,
make sure that the “Enable RSS Feeds” checkbox is selected and an RSS token has been generated in
the textbox underneath.

3.6.1. Change Password

In addition to being able to update your user information, you can optionally change your password at the
same time. To change your password, on the Change Password tab fill in the three boxes with your
current password, and your new password repeated for verification. Then when the <Update> button is
clicked, the system will update your password, otherwise you will simply get a warning message
indicating what needs to be corrected.
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Change Password Email Preferences LDAP Settings

To change your password, you must enter your current password and the password you would like to change it to.

Current Password: | |

New Password: | |

Confirm Password: | |

Note: If your SpiraTest user profile is linked to an account stored in an external LDAP server, you may
find the change password option is disabled. This is because the system uses the password held in the
external server. To change the password in this case, please contact your system administrator who will
be able to help you change the password in your LDAP environment.

3.6.2. Email Preferences

Change Password Email Preferences LD&AP Settings

Email Address™ administrator@mycompany.com

Enable Email Notifications:

If disabled, you will not get any notifications from SpiraTeam

Here you can configure the email address that the application will send notifications to, and whether or
not you want to receive email notifications.

If the Enable Notifications cannot be changed, it means that the system is either not configured to send
out notifications, or the administrator has disabled user’s ability to opt out of notifications being sent.

3.6.3. LDAP Settings

Change Password Email Preferences LDAP Settings

LDAP DN: Mot Linked

This tab will show configured LDAP options for your account. At this time, no configurable options are on
this tab, it is for reference only.

3.6.4. Regional Settings

Change Password Email Preferences LDAP Settings Regional Settings

Please choose your desired region from the list below. This setting determines which number/date formats are used as well as which language is used throughout
the application. If you don't choose a value, the application's default value will be used.

User Culture: — Use Application Default — v

This tab will display the current culture associated with your profile. By default all profiles will be set to use
the application’s default culture. This means that the language and number formats used in the
application will be the ones decided by the person who installed the system. However there are cases
where you want to use a different language or number format (for example, a German employee working
in the German office of a French company might want to use the German culture instead of French). You
can change the culture to any of the options listed in the dropdown list.
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Note: The system will only be installed with a certain number of language packs, so in some cases a
selected culture will only change the number formats and not the languages displayed.

3.6.5. Actions
This tab displays the list of recent actions that you have performed in the system (across all projects):
Change Password Email Preferences LDAP Settings Regional Settings Actions
Displaying 1 - 8 out of 8 items. Refresh | Apply Filter | Clear Filter
v Change Date AV Project AV Artifact Type 4 ¥ Artifact Name 4 ¥ Artifact ID &Y Change Type 4 ¥
B | | - Y] | [Py 7]
2-May-2006 Library Information System Incident ¥ Cannot add a new book to the system | [IN:000007] Modified
PR:1
2-May-2006 [Libran].' Information System Requirement "3 Ability to add new books to the system | [RQ:000004] Modified
PR:1
2-May-2006 [Libran].' Information System Test Step ™ Ability to create new book [TS:000003] Modified
PR:1
2-May-2006 [Libran].' Information System Release & Library Svstem Release 1 [RL:000001] Modified
PR:1
2-May-2006 |:Librar:.' Information System Test Case 23 Ability to create new book [TC-000002] Modified
PR:1
5-Mar-2005 [Libran].' Information System Incident ¥ Cannot add a new book to the system | [IN:000007] Modified
PR:1
5-Mar-2005 |:Librar:.' Information System Incident B The book listing screen doesn't sort [IN-000006] Modified
PR:1
4-Mar-2005 [Libran].' Information System Incident B The book listing screen doesnt sort [IN-000006] Modified
[PR:1]
Show rows per page Displaying page faof1

You can search and filter the grid to find changes by project, change date range, artifact type and type of
change (added, deleted, modified).

3.7. My Timecard

When you click on My Page > My Timecard the system will display a timecard that allows you to enter the
effort worked on incidents and tasks currently assigned to you (across all your projects):
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T R 4 -
spiraTeam
e

My Page | My Timecard

My Timecard - Fred Bloggs

Welcome, Fred Bloggs | My Profile | Administration | Log Out | | Library Information System A\

Wy Page Project Home Planning Tesling Tracking Reporiing

The following open artifacts are currently assigned o you
Plaase enter the hours worked and hours remaining in the appropriate effort antry boxes below

My Assigned Tasks

Task Name Priority  StatDate End Date  Project Name Effort To Date Additional Effort  Remaining Effort
¥JTK21  Develop new edition eni 11.Mar-2004 12.Mar.2004 Library Information System 7.0 hours [ hours hours
YITK22 Cr ition insert m 11-Mar-2004 12.Mar-2004 Library Information System 3.3 hours l:lbom; El hours
T3 Write editi tin 11-Mar-2004 12.Mar-2004 Library Information System :p.w, hours
¥)TK2T Refaclor auther screen to include delete bution 9.Mar-2004 | 10.Mar-2004 Library Information System [ nous hours
Z)TK28 | Create auth meth 2-High | 9Mar2004 10 Mar2004 LibraryInformation System 23howrs [ Jhours (25 |hours
Z)TK29 | White author let 2-High | 9Mar-2004 | 10-Mor-2004 Library Information System 08howrs [ Jhows (23 Jhouss
ZITKA0 Develop edit t detai n 3-Medium 26.0ct.2004 27.0ct-2004  Library Information System [ hours hours
YT | Cr Lobiect m 3-Medium 26.0ct-2004 27.0ct.2004  Library Information System [ hous hours
) TK42 Write subject object update queries 3-Medium 26.0ct-2004 27.0ct-2004  Library Information System [ nours hours

Role: Manager

My Assigned Incidents

Incident Name

Y IN21 Aty to assosiate multiple authers
) IN46 | Test System Limitation

Priority  Severity  StartDate  Project Name Effort To Date  Additional Effort
20-Nov-2003 | Library Information System | 0.1 hours

Remaining Effort

— e —

7-Dec-2003 | Library Information System | 0.7 hours [ hous hours
BIN4D Test Training ltem 4.Dec-2003 | Library Information System [ hous hours

6-Nov-2003
4.Dec-2003
8.Dec-2003

E)INg  Editing the date 0n a book is clunky |2=High' = 4 - Low Library Information System

®)IN41 | Test Training ltem 2-Hgh
®INS3 Test Change Request 3 - Medium
®)IN23 Abiity 1o import data from excel 3~ Medium
E)IN4B  Test System Limitation
®)IN61 Sample Risk 3

[ musfoz  Jnous
[ w03 Jhous
L Jrous s Jhous
[ Jreus o1 Jhous
[ Jrous o1 Jhous
[ I o1 Jhous

Library Infarmation System
Library Information System
26-Nov-2003 | Library Information System 0.3 hours
3 - Medium 3 - Medium | 7-Dec-2003 | Library Information System | 1.3 hours
4-Low

4-Low 11-Dec-2003 | Library Information System 0.8 hours

The system will only include projects that have time-tracking enabled for incidents and tasks, so if some
of your assigned incidents or tasks are missing, please check with the project owner of the projects
affected to have them enable time-tracking.

Each task or incident will be displayed along with its priority, severity, start-date, end-date, project name
effort remaining and effort expended to date. For each item you can then indicate the additional actual
effort performed (which will be added to the “actual effort”) and modify the amount of hours remaining.
Once you are satisfied, click [Submit Timecard] to commit the changes.




4. Requirements Management

This section outlines how the requirements management features of SpiraTeam® can be used to develop
a requirements / scope matrix for a project, and how you can map any existing test-cases to the
requirements. Typically when starting a project, developing the requirements list is the first activity after
the Administrator has set up the project in the system.

4.1. Requirements List

When you click on the Planning > Requirements link on the global navigation bar, you will initially be
taken to the requirements list screen illustrated below:

ety B Welcome,Fred Boggs | My Profl | Adrinisraton | Log Out | [y iemsim Sem ¥ Hop?
S - My Page Project Home Planning Testing Tracking Reporting
Requirements | Releases | llerations | Planning Board
dhlnsert 3 Delete | o indent s Outdent |—Showlewi— V| RyRefresh | [hEdit {3 Tools |- Showhide colmns— ¥| 7 Eitter
v 4 Requirement Name Test Coverage Task Progress. Importance Status Release Difficulty Req # Edit
i [-Rey- UNETE v [y ¥ |[-Am- v [y v| [-Aw- Y| ra| | [rEdt
| Eunctional System Requirements Not € i In Progress RQO0000T [ Eqit |
= 7 Online Library M System In Progress RQO0000Z [+ it
= ") Book Management | 1 -Critical - Completed RO000003 |-. Edit
) Ability to add new | c RQUO0004 [+ Edit |
& Apility Completed RQO0DO0S [+ Edit
2 iy o dete | Compieted RQUO000S [+ Edit |
) Ability 1o asac — Completed RQOODOO7 [+ ggit |
B ALty 1o s Completed RQOO000E iﬂl
&) Apility 1o ssociat = || Completed RQO00009 M
) Aility 1o con = Completed RQOOD010 iﬁl
Edition Management ve — | In Progress RQO000T1 M
Author Management In Progress RQODO0T3  [» Edit |
J Subject Management Not Lovered Planned RQ000019 |' Edit
_ Administration Functions Not C Tas Requested RQO00022 iﬁl
Show [15 ¥ rows per page 4 < Displaying page [1  |=of 1e»

The requirements list consists of a hierarchical arrangement of the various requirements and
functionalities that need to be provided by the system in question. The structure is very similar to the
Work Breakdown Structure (WBS) developed in Microsoft Project®, and users of that software package
will find this very familiar to use. When you create a new project, this list will initially be empty, and you
will have to start using the <Insert> button to start adding requirements.

Requirements come in two main flavors: summary items shown in bold-type, and detail items shown in
normal-type with a hyperlink. When you indent a requirement under an existing requirement, the parent is
changed from a detail-item to a summary-item, and when you outdent a child item, its parent will return to
a detail-item (assuming it has no other children). This behavior is important to understand, as only detail
items are assigned a status themselves; the summary items simply display an aggregate of the worst-
case assessment of their children’s status. Also, only detail items can be mapped against test-cases for
test-coverage (thus only they have hyperlinks), the summary items simply display an aggregate coverage
status of their children.

Each requirement is displayed along with its importance/priority (ranked from “Critical” to “Low”), its
completion status (from “Requested” to “Completed”), the version of the software that the requirement is
planned for, and graphical indicators that represents its test coverage status and its task progress.

For those requirements that have no test-cases covering them (i.e. validating that the requirement works
as expected) the indicator consists of a white solid bar, bearing the legend “Not Covered”. For those
requirements that have at least one test-case mapped against them, they will display block graph that
illustrates the last execution status of each of the mapped test-cases. Thus if the requirement is covered
by two test cases, one of which passed, and one of which wasn't run, the graph will display a green bar
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(50% passed) and an equal length gray bar (50% not run). To determine the exact requirements
coverage information, position the mouse pointer over the bar-chart, and the number of covering tests,
along with the pass / fail / blocked / caution / not-run breakdown will be displayed as a “tooltip”.

For those requirements that have at least one task associated with them, they will display a block graph
that illustrates the relative numbers of task that are on-schedule (green), late-starting (yellow), late-
finishing (red) or just not-started (grey). These values are weighted by the effort of the task, so that larger,
more complex tasks will be change the graph more than the smaller tasks. To determine the exact task
progress information, position the mouse pointer over the bar-chart and the number of associated tasks,
along with the details of how many are in each status will be displayed as a “tooltip”.

4.1.1. Insert

Clicking on the <Insert> icon inserts a requirement above the currently selected requirement — i.e. the one
whose check-box has been selected, at the same level in the hierarchy. If you want to insert a
requirement below an existing item, you can use the Insert > Child Requirement option instead. If you
insert a requirement without first selecting an existing requirement from the list, the new requirement will
simply be added at the end of the list.

Once the new requirement has been inserted, the item is switched to “Edit” mode so that you can rename
the default name and choose a priority, status and/or author.

4.1.2. Delete

Clicking on the <Delete> button deletes all the requirements whose check-boxes have been selected. If
any of the items are summary items, the child requirements are also deleted. If all the children are deleted
from a summary item, it changes back into a non-summary item.

4.1.3. Indent

Clicking on the <Indent> button indents all the requirements whose check-boxes have been selected. If
any of the items are made children of a requirement that had no previous children, it will be changed from
a detail item into a summary item.

4.1.4. Outdent

Clicking on the <Outdent> button de-indents all the requirements whose check-boxes have been
selected. If any of the items were the only children of a summary requirement item, then that item will be
changed back from a summary item to a detail item.

4.1.5. Refresh

Clicking on the <Refresh> button simply reloads the requirements list. This is useful as other people may
be modifying the list of requirements at the same time as you, and after stepping away from the computer
for a short-time, you should click this button to make sure you are viewing the most current requirements

list for the project.

4.1.6. Edit

Each requirement in the list has an <Edit> button display in its right-most column. When you click this
button or just double-click on any of the cells in the row, you change the item from “View” mode to “Edit”
mode. The various columns are made editable, and <Update> <Cancel> buttons are displayed in the last
column:
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If you click <Edit> on more than one row, the <Update> and <Cancel> buttons are only displayed on the
first row, and you can make changes to all the editable rows and then update the changes by clicking the
one <Update> button. Also, if you want to make the same change to multiple rows (e.g. to change five
requirements from “In Progress” status to “Completed”), you can click on the “fill” icon to the right of the
editable item, which will propagate the new value to all editable items in the same column.

If you want to edit lots of items, first select their checkboxes and then click the [Edit] button on the same
row as the Filters and it will switch all the selected items into edit mode.

When you have made your updates, you can either click <Update> to commit the changes, or <Cancel>
to revert back to the original information. Alternatively, pressing the <ENTER> key will commit the
changes and pressing the <ESCAPE> key will cancel the changes.

4.1.7. Show Level

Choosing an indent level from the ‘Show Level’ drop down box allows you to quickly and easily view the
entire requirements list at a specific indent level. For example you may want to see all requirements
drilled-down to the third level of detail. To do this you would simply choose ‘Level 3’ from the list, and the
requirements will be expanded / collapsed accordingly.

4.1.8. Filtering
You can easily filter the list of requirements as illustrated in the screen-shot below:
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To filter the list by any of the displayed columns, you either choose an item from the appropriate drop-
down list or enter a free-text phrase (depending on the type of field) then click the <Filter> icon or press
the <ENTER> key to apply the different filters. Note that the name field is searched using a “LIKE”
comparison, so that searching for “database” would include any item with the word database in the name.
The other freetext fields need to be exact matches (e.g. dates, requirement numbers). In the screen-shot
above, we are filtering on Status = Requested.

In addition, if you have a set of filters that you plan on using on a regular basis, you can choose the option
Filter > Save Filter to add the current filter to the list of saved filters that appear on your ‘My Page’. The
list of saved filters can also be retrieved by clicking Filter > Retrieve Filter:
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4.1.9. Show / Hide Columns

This drop-down list allows you to change the fields that are displayed in the requirement list as columns
for the current project. To show a column that is not already displayed, simply select that column from the
list of “Show...” column names and to hide an existing column, simply select that column from the list of
“Hide...” column names. This is stored on a per-project basis, so you can have different display settings
for each project that you are a member of. The fields can be any of the built-in fields or any of the custom
properties set up by the project owner.




4.1.10. Copying Requirements

To copy a requirement or set of requirements, simply select the check-boxes of the requirements you
want to copy and then select the Edit > Copy menu option. This will copy the current requirements
selection to the clipboard. Then you should select the place where you want the requirements to be
inserted and choose the Edit > Paste option.

The requirements will now be copied into the destination location you specified. The name of the copied
requirements will be prefixed with “Copy of...” to distinguish them from the originals. Note that copied
requirements will also include the test coverage information from the originals.

4.1.11. Moving Requirements
To move a requirement in the requirements hierarchy, there are two options:
1. Click on the icon the requirement you want to move and then drag the icon to the location you

want it moved. The border between the destination requirements will change as the icon is
dragged over it to illustrate where it will be inserted:

. . Team Welcome, System Administrator | My Profile | Administration | Log Out | | Library information System v Help?
o - My Page Project Home Planning Testing Tracking Reporting

Requirements | Releases | lterations Role: Project Owner

dhinsert  §3 Delete | <> Indent <k Ouldent | Show Level — v| @jRefresh | [HCopy @ Expot | - Showhhide columns ~ | 1 ClearFiters
« i Reguirement Hame Test Coverage Task Progress Impertance Status Author Release Req # Edit
O 1/[~any - v| [-any- v |[-any- v [-any- v] [~any- v [-any- v| RQI | » Filter
O = ) Functional System Requirements | In Progress Fred Bloggs RQO00001
O = 2l Online Library Management System Not Covered 1 In Progress Fred Bloggs RQO0000Z
O = 2l Book Management [ | 1 - Critical Completed Fred Bloggs RQOD0DO3
O ) Ability to add new boaks 1o the system 1 - Critical Complated Fred Bloggs 1.0.0.0 RQO00004
) ) Ability to edit existing books in the system 1 - Critical Completed Fred Blogas 1.0.0.0 RQO00005
|| 3 Ability to delete existing books in the system 1- Critieal Complated Fred Bloggs 1.0.00 RQO0D00E | [+ Edit
O th d s N 1 - Critical Complated Fred Bloggs 1.1.00 RQO0000T |ﬂ]
O 1 - Critical Completed Fred Bloggs 1.1.00 RQ000008 | [+ Edit ]
O L AR Laskawil ai-aditions 1 - Critical Completed Fred Bloggs 1100 RQO00009
O [S2014.10 e exieling books i e "ff"”"mh | 1- Critical Complated FredBloggs 1200 RQO00010
O # 7 Edition Management ] 1. Critical In Progress Fred Bloggs RO000011
1] % ] Author Management 1 2. High In Progress Joe P Smith RQOOOOS | = Edit
) # 2 Subject Management 3. Medium Planned Joe P Smith RQO00DIS |+ Edit
] = T Administration Functions J No Tasks 3 - Medium Requested Joe P Smith RQO0NOZ2 |- Edit_|
Show (1 v | rows per page « < Disglaying page[1_|%of 15 »

Once you have the requirement positioned at the correct place that you want it inserted, just
release the mouse button and the requirement list will be refreshed, with the requirement moved
to the desired location. To move multiple items simply select their checkboxes and then drag-and-
drop one of the selected items.

2. Alternatively you can simply select the check-boxes of the requirements you want to move and
then select the Edit > Cut menu option. This will cut the current requirements selection to the
clipboard. Then you should select the place where you want the requirements to be inserted and
choose the Edit > Paste option. The requirements will now be moved into the destination location
you specified.

4.1.12. Exporting Requirements

To export a requirement or set of requirements from the current project to another project in the system,
all you need to do is select the check-boxes of the requirement(s) you want to export and then click the
Tools > Export icon. This will then bring up a list of possible destination projects:
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Once you have chosen the destination project and clicked the <Export> button, the requirements will be
exported from the current project to the destination project. Any file attachments will also be copied to the
destination project along with the requirements.

4.1.13. Creating Test Cases from Requirements

To quickly create test cases from a group of requirements, all you need to do is select the check-boxes of
the appropriate requirements and then click Tools > Create Test Cases. This will then create new test
cases based on the selected requirements.

4.1.14. Creating a Test Set from Requirements

To quickly create a new test set from a group of requirements, all you need to do is select the check-
boxes of the appropriate requirements and then click Tools > Create Test Set. This will then create new
test set containing the test cases that are already mapped to the selected requirement(s).

4.1.15. Printing Items

To quickly print a single requirement or list of requirements you can select the items’ checkboxes and
then click Tools > Print Iltems. This will display a popup window containing a printable version of the
selected items.

4.1.16. Right-Click Context Menu

SpiraTeam® provides a shortcut — called the context menu - for accessing some of the most commonly
used functions, so that you don’t need to move your mouse up to the toolbar each time. To access the
context menu, right-click on any of the rows in the requirements list and the following menu will be
displayed:

=1 Ability to add new books to the system Completed 1.0.0.0.0001 Moderate
=] Ability to edit existing books in the system Lt Open ftem Completed 1.0.0.0.0001
o] in New Tab
= Ability to delete existing books in the system E penin ew 73 Completed 1.0.0.0.0002
= Ability to associate books with different subjects =R Insert Completed 1.1.0.0.0001
[EE] Edit It
= Ability to associate books with different authors ems Completed 1.1.0.0.0001
= £2 Delete
= Ability to associate books with different editions Completed 1.1.0.0.0002
Indent
B Ability to completely erase all books stored in th._ : Outd Completed 1200
utdent
EI Edition Management - In Progress
Copy ltems
T2 Author Management & Copy 1 In Progress
[ Cut ltems 5
(=] Subject Management 3 - Medium Planned
[} Paste ltems
= - I3 . — 1 2 Y — Ao Tocbo 2 Modium Boouocciod




You can now choose any of these options as an alternative to using the icons in the toolbar.

4.2. Requirement Details

When you click on a requirement item in the requirements list described in section 4.1, you are taken to
the requirement details page illustrated below:
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This page is made up of three areas; the left pane displays the requirements list navigation, the top of the
right pane displays the details of the selected requirement, and the bottom of the right pane can display
different information related to the requirement.

The navigation pane consists of a link that will take you back to the requirements list, as well as a list of
the peer requirements to the one selected. This latter list is useful as a navigation shortcut; you can
quickly view the coverage information of all the peer requirements by clicking on the navigation links
without having to first return to the requirements list page. The navigation list can be switched between
three different modes:

e The list of requirements matching the current filter
e The list of all requirements, irrespective of the current filter
e The list of requirements assigned to the current user

The top part of the right pane allows you to view and/or edit the details of the particular requirement. You
can edit the various fields (name, description, etc.) and once you are satisfied with them, simply click
either the <Save>, <Save and Close> or <Save and New> button at the top of the page to commit the
changes. In addition you can delete the current artifact by choosing <Delete>, make a copy of it by
choosing <Copy>, discard any changes made by clicking <Refresh> or print it by clicking <Print>.

Using the <Email> button on the toolbar, you can send an email containing details of the requirement to
an email address or another user on the system:

Email this arfifact to:

@ Project User: | Fred Bloggs v

Select a user in the project to send to.

_ Email Addresses:

A list of email addresses, separated by ;

Message Subject: | |

Leave blank for default.

Send | Cancel
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You can specify the subject line for the email, and either a list of email addresses, separated by
semicolons, or an existing project user .The content of the email is specified in the System Administration
— Notification Templates.

In addition, the bottom part of the right pane can be switched between six views: “Test Coverage”,
“Tasks”, “Comments”, “Custom Properties”, “Attachments”, “History” and “Associations”, each of which
will be described in more detail below.

4.2.1. Test Coverage
In this mode, the right pane contains the test coverage information for the requirement in question:

Test Coverage # Tasks # Custom Props # Attachments # History #* Associations #
Available Test Cases: Test Coverage:
v | Name v |Tes‘l# | Name Status
[0 =& Functional Tests i [] TCoooooz2 gjﬁ.hilit\;to create new book Failed
Ban ty to create new book ] TC000008 2£9Book management Passed
O g_-lAb\Iitytu edit existing book [ TCo00013 A.Jﬁ.ddinq new book and author to Not Run
O £ Ability to create new author [[Remove< |
O g_-lAb\Iityto edit existing autho...
O BAb\Iityto reassign book to di...
[] =& Regression Tests
[ =& Scenario Tests
b

> Create Test Case From This Reguirementl_‘l

The test coverage box indicates the test cases that are currently mapped against the requirement.
To add test cases to this requirement, choose from the list above and click [Add].
You can use the [Remove] and [Remave All] buttons to remove tests that no longer cover the requirement.

The pane consists of two lists of test cases, the one on the left being the hierarchical list of the test cases
belonging to the project arranged in test folders. The right box (which will initially be empty) contains the
list of test cases mapped to this requirement. The test cases in this box include columns for their ID,
name and execution status. Hovering the mouse over the names of the test cases in either box will
display a “tooltip” consisting of the test case nhame, place in the folder structure and a detailed description.
Clicking on the hyperlinks in right-hand box will jump you to the test case details screen for the test case
in question (see section 5.2.9).

To change the coverage for this requirement, you use the buttons (Add, Remove, Remove All) positioned
between the two list-boxes. The <Add> button will move the selected test cases from the list of available
on the left to the list of mapped on the right. Similarly the <Remove> and <Remove All> buttons will
remove either the selected or all the test cases from the right list-box and add them back to the left list-
box.

Finally, as a shortcut you can click the “Create Test Case from This Requirement” link to create a new
test case in the list of covered test cases that will be automatically linked to this requirement. This is
useful when you have created a new requirement and want to generate an initial covering test to be
fleshed-out later.

4.2.2. Tasks

In this mode, the right pane displays the list of project tasks that need to be completed for the requirement
to be satisfied:
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Test Coverage # Tasks # Comments Custom Propz # Attachments # Higtory # Associations #
= New Task | Remove | Refresh | Apply Filter | Clear Filters | | - Show/hide columns — Y| = Est. Effort: 16.0h | Proj. Effort: 16.0h
« U Task Name 4 ¥ Progress Status 4 ¥ Priority 4 ¥ Owner 4 ¥ Release 4V Task # AV Edit
0| | | g O T | | i | | I
O “ Develop new book entry screen Completed 1 - Critical Fred Bloggs 1.0.0.0.0001 THKO00001
O & Create book object insert method Completed 1 - Critical Fred Bloggs 1.0.0.0.0001 TKO00002
O 1 Write book obiect insert queries Complated 1 - Critical Fred Bloggs 1.0.0.0.0001 TKO00003 [~ Edit |
Show rows per page Displaying page %aof1

Each of the tasks is displayed together with its name, description (by hovering the mouse over the name),
progress, priority, start-date, current owner, estimated effort, projected effort and numeric task identifier.
Clicking on the task name will bring up the Task Details page which is described in more detail in section
8.2. This allows you to edit the details of an existing task.

You can perform the following actions on a task from this screen:

>

>

New Task — inserts a new task in the task list with a default set of values. The task will be
associated with the current requirement.

Remove — removes the task from this requirement without actually deleting the task

Refresh — updates the list of tasks from the server, useful if other people are adding tasks to this
requirement at the same time.

Apply Filter — Applies the entries in the filter boxes to the list of tasks

Clear Filters — Clears the current filter, so that all tasks associated with the current requirement
are shown.

Edit — Clicking the [Edit] button to the right of the task allows you to edit the task inline directly on
this screen. Only columns visible will be editable.

Show/Hide Columns — Allows you to choose which Task columns are visible

The system has a series of shortcuts that simplify the editing of requirements and tasks:

>

If you create a new task on the requirements page, the priority, release/iteration and owner are
automatically copied from the parent requirement. You can change these suggested values
before clicking [Update]

When you assign a releasel/iteration to a requirement, its status automatically changes to
“Planned”

When at least one task assigned to the requirement changes from “Not Started” to “In Progress”,
the parent requirement automatically switches from “Planned” to “In Progress”

When all the tasks under the requirement are completed, the parent requirement will switch to the
“Completed” status.

If you manually move a requirement that has no associated tasks from “Planned” to “In Progress”,
the system will automatically generate one task under the requirement and use the requirement’s
planned effort field to generate the task’s estimated effort.

4.2.3. Comments
The Comments tab allows users to add and view discussions relating to the requirement:

© Copyright 2006-2011, Inflectra Corporation Page 42 of 167 This document contains Inflectra proprietary information




Test Coverage Tasks Comments Custom Props Attachments History Associations

To add a new comment to this requirement, please enter it below and click the [Save] button:

| Tads | — e E T o B

~ Font - | |—Size— v

Existing Comments

Existing comments are displayed in order underneath the textbox in date order. To add a new comment,
simply enter it into the textbox, and click the Save button.

4.2.4. Custom Properties

In this mode, the main pane displays any custom properties that the project owner has defined for
requirements. To learn more about how to setup and configure custom properties for a project, please
refer to the SpiraTest Administration Guide. Assuming that custom properties have been defined for your
project, you will see a list of optional parameters that can be set on the requirement. These can be either
freetext or drop-down-lists. In the example below, you can enter a URL, difficulty and/or Requirement

Type.

Test Coverage # Tasks # Custom Props # Attachments # History # Aszsociations #

The following are the custom properties of this artifact:

URL: ‘http:.-".-"www.Iihraries.org ‘
Difficulty: | Moderate v |
Requirement Type: |_ None — '|

Once you are satisfied with the values for the custom properties, simply click the main [Save] or [Save
and New] to commit the changes.

4.2.5. Attachments

In this mode, the main pane displays the list of documents, screenshots or web-links (URLS) that have
been “attached” to the requirement. The documents can be in any format, though SpiraTeam® will only
display the icon for certain known types.

Test Coverage # Tasks # Comments Custom Props # Attachments # History # Associations #

= Add New | Add Existing | Remove | Refresh | Apply Filter | Clear Filter | Include Source Code Documents

v Document Name 4 ¥ Type AY Size AY Edited By 4 ¥ Edited On AV  Author A Y DAY
| [ V] | |- Y] @] [Av- v oc[ |
"] 5ok Management Functional Spec doc Functional Specification | 285 KB Joe P Smith 30-May-2006 Fred Bloggs DCO000001
8 Graphical Design Mockups.psd Screen Layout 1009 KB Joe P Smith 1-May-2006 Joe P Smith DCoo0013
€] http fiwww inflectra com Functional Specification | 0 KB Fred Bloggs 1-May-2006 Fred Bloggs DCO00015
Bipook Management Screen Wireframe.ai Screen Layout 392 KB Fred Bloggs 1-Apr-2006 Joe P Smith DCoooon

Show ToWs per page Displaying page "a of 1

The attachment list includes the filename/URL that was originally uploaded together with the file-size (in
KB), name of the person who attached it and the date uploaded. In addition, if you position the pointer
over the filename and hold it there for a few seconds, a detailed description is displayed as a tooltip:
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Book Management Functional Spec.dac

Filename: Book Management Functional Spec doc =

| Document Type: Functional Specification

Word Ll N

This document outlines the functional specification for
the book management part of the library management

| File Type:

| Description:

System.
Version: 2.0
Tags: book management | functional specification | libraries H
i Created By: Fred Bloggs (5/2/2006 12:00:00 AM)
Edited By: Joe P Smith (5/30/2006 12:00:00 AM)

Document ID: DCOo00001

= View Details | Cancel

To actually view the document, simply click on the filename hyperlink and a new web browser window will
open. Depending on the type of file, this window will either display the document / web-page or prompt
you for a place to save it on your local computer. To remove an existing attachment from a requirement,
simply click the [Remove] button and the attachment will be removed from the list. Using the standard
filter/sort options you can also sort and filter the list of attachments to make it more manageable.

If you are using SpiraPlan or SpiraTeam (but not SpiraTest) you can also choose to include file
attachments stored in a linked version control system (e.g. Subversion, CVS, Perforce, etc.) by selecting
the “Include Source Code Documents” option.

To attach a new document to the requirement, you need to first click the “Add New” link to display the
new attachment dialog box:

Add New Document

Add New Document

Add New Document

Type:" @ File O URL O Screenshat Type:* O File @ URL O Screenshot Type:* O File OURL @ Screenshot
Filename:* [ I URL:* Screenshot:*
Description Description T I
|
Document Type:" [Functans - v Document Type:”  [Funcians Speciics v|
Dacument Folder:™ | Document Folder: v > Paste imane fiom cligboard
Togs Tags [ Description r 1

> Uplgad | Cancel > Uglaad
Document Type:" | Funceona Specification b
Document Folder:” [aon: Foner x

Tags

There are three different types of item that can be attached to a requirement:

» To upload a file, choose “File” as the type and then click the Browse button and select the file
from your local computer, optionally enter a detailed description then click the <Upload> button.
The document will be copied from your computer and attached to the artifact.

» To attach a web-link (URL) to the artifact, you need to choose “URL" as the type and then enter
the fully qualified URL (e.g. http://mywebsite.com?Document=1), an optional description and then
click the <Upload> button to attach the web-link.

» To attach a screenshot to the artifact, you need to choose “Screenshot” as the type and then
copy the image to your computer’s clipboard (e.g. on Windows computers, the PRINT SCREEN
button captures the current page and adds to the clipboard). Once the image is in the clipboard,
click on the “Paste image from clipboard” hyperlink and the item will appear in the preview
window. You can then fill in the other fields and click <Upload> to attach the image.
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Note: If you are using a hon-Windows® computer (e.g. Macintosh®) that doesn't put file extensions on
filenames (e.g. .xls for an Excel sheet) automatically, then you will need to manually add the file extension
to the filename before uploading if you want it to be displayed with the correct icon in the attachment list.

You can also associate an existing document (that’s already stored in SpiraTeam) with the requirement.
To do that, click on the “Add Existing” hyperlink to bring up the add file association dialog box:

) )
Add Existing Document Add Existing Document

Choose the location of existing document that you'd like to add: Choose the location of existing document that you'd like to add:

@ Documents Source Code Documents @ Source Code

[ Folder | [ ¥ [ Document | Folder | [+ File
% O EditExistingBook - 2 Expected Result Screensh * ¥ 8 Design ] pocument Filename1.doc
# B Misc Documents " = £
B SI CU tl | & Web Page capture htm /& Development 3 Document Filename10_ppt>
=] creen Laptures = = ] tl T
S8s - ‘J'_] Date Editing Screenshot. jp =t £ Document Filename11.htm
Specifications | o = €3 Documentation =
1 3] Error Logging-in Screen-sh % 63 Training 2] Document Filename2.xls
# 63 Test Scripts N i WY E—— — o r 73] O i
> Add | Cancel Comment:

This is a related document

> Add | Cancel

You can then choose to either associate a document stored in the SpiraTeam Documents repository or
(in the case of SpiraPlan/SpiraTeam but not SpiraTest) from the linked source code repository. In either

case you first select the appropriate folder, and then pick the document(s) from the file list on the right. In
the case of a source code file association you can also add a comment.

4.2.6. History

In this mode, the main pane displays the list of changes that have been performed on the requirement
artifact since its creation. An example requirement change history is depicted below:

Test Coverage # Tasks # Comments Custom Props # Aftachments # History # Associations #
= Refresh | Apply Filter | Clear Filter
v Change D A¥ Change Date AV Field Name 4 ¥ Old Value 4 ¥ New Value 4 ¥ Changed By A¥ Change Type AV
| | ] | ||l ||l | A Y] [Av- Y]
12 2-May-2006 Status In Progress Completed Fred Bloggs Modified
4 4-Mar-2005 Status Requested In Progress Joe P Smith Modified
Show rows per page Displaying page'aof 1

The change history displays the date that each change was made, together with the fields that were
changed, the old and new values and the person who made the change. This allows a complete audit trail
to be maintained of all changes in the system. In addition, if you are logged in as a project administrator
you can also click on the “Admin View” hyperlink to revert any unwanted changes.

4.2.7. Associations

In this mode, the main pane displays a list of any incidents or other requirements that are associated with
this requirement;
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Test Coverage # Tazks # Custom Props # Aftachments # Higtory # Associations #
= Add | Delete | Refresh | Apply Filter | Clear Filters | []Include Source Code Revisions
v Artifact Name 4V Artifact Type AY Created On AV Created By AY Comment AY Artifact# AV Edit
O | cam-_ Y] | @] [caw- V]| ]
O ™1 Cannot install system on Oracle 9i Incident 14-Mar-2004 Fred Bloggs This bug IN00000S
affects the
requirement
O ) Ability to delete existing books in the system | Requirement 12-Mar-2004 Fred Bloggs These two RQO00006
requirements
are related
1 Cannot add a new book to the system Incident 4-Mov-2003 Joe P Smith Test Run: IN0D00O07
Ability to
create new
book
Show rows per page Displaying page % of 1

The requirements in this list are ones that a user has decided are relevant to the current one and has
created a direct link between them. In the case of incidents, the association can be either due to the
creator of an incident directly linking the incident to the requirement, or it can be the result of a tester
executing a test-run and creating an incident during the test run. In this latter case, the check-box to the
left of the association will be unavailable as the link is not editable.

Each association is displayed with the type of artifact (requirement vs. incident), name of the artifact being
linked-to, the name of the person who created the association, and a comment that describes why the
association was made. In the case of an indirect association due to a test run, the comment will contain
the name of the test run.

In addition, when using SpiraPlan or SpiraTeam, you can select the checkbox marked “Include Source
Code Revisions” and the system will also scan the source code repository for any revisions that are linked
to this artifact. Since that can take be slower than accessing SpiraTeam, it is provided as an option that
you can enable and disable:

Test Coverage # Tasks Custom Props # Attachments Hiztory Associations #

= Add | Delete | Refresh | Apply Filter | Clear Filters | Include Source Code Revisions

v Artifact Name A ¥ Artifact Type AY Created On AV Created By AY Comment AY Artifact# AV Edit
0| | cam-__ Y] || B] [av- ]| L]
& revo012 Revision 15-Jan-2010 Fred Bloggs The artifact
was changed
in this version
to fix th_..
& revo003 Revision 15-Jan-2010 Fred Bloggs The artifact

was changed
in this version

to fix th_..
7 | ™ The book listing screen doesn't sort Incident 15-Mar-2004 Fred Bloggs IN00000G
O ;'.jﬁ.hihtv to associate books with different subjects | Requirement 13-Mar-2004 Fred Bloggs RQ000007
Show rows per page Displaying page "a of1

You can perform the following actions on an association from this screen:

>» Delete — removes the selected association to the other artifact. This will only delete the
association, not the linked artifact itself.

» Refresh — updates the list of associations from the server, useful if other people are adding
associations to this requirement at the same time.

Apply Filter — Applies the entries in the filter boxes to the list of associations

Clear Filters — Clears the current filter, so that all associations for the current requirement are
shown.
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> Edit — Clicking the [Edit] button to the right of the associations allows you to edit the comment
field inline directly on this screen.

To create a new association, simply click the <Add> hyperlink which will display the “Add New
Association” popup dialog box:

T R e W T T B S A T A T Y ] T P — T T

Add New Association

Please choose the type of artifact that you want to add an association to:
®Incident O Requirement est Step
Please choose the artifact that you want to add an association to: H

(8)  Enter Artifact ID: N l:l ;

(b)  Choose from list:

4 ‘ Name
[l 8| Editing the date on a book is clunky ’_‘ i |
O 1 Doesnt let me add a new category 1 _E
O 1 quate handling issues throughout |
O B Permissions not updating when changed M

Y

Comment: ‘ ‘
i
= Add | Cancel

——

Once you have selected the appropriate artifact type, you will then be able to choose the specific artifact
you want to link to. In all cases, you can choose the item from a scrolling selection box, or you can either
enter the ID of the artifact directly (if known). In either case you can also add a comment that explains the
rationale for the association.




5. Test Case Management

This section outlines how the use-case / test-case management features of SpiraTest® and SpiraTeam®
can be used to develop the business use-cases for the system, which specify how the different pieces of
functionality are expected to work in practice. In addition, these use/test-cases form the basis of the
business specification of the system when associated with the underlying requirements matrix. Typically
when starting a new project:

» The requirements matrix is entered first

>» Then the list of use-cases is developed to outline the key scenarios that need to supported to
implement the requirement

» Then the use-cases are fleshed out into full test-cases by adding the detailed test-steps with the
expected result and suggested sample-data

> Finally the tests are grouped into test-sets so that they can be assigned to users in batches for
execution and tracking.

However when migrating existing projects into SpiraTeam®, you may need to migrate the test-case list
first, and then add the supporting requirements matrix afterwards.

5.1. Test Case List

When you click on the Testing > Test Cases link on the global navigation bar, you will initially be taken to
the test case list screen illustrated below:

Welcome, Fred Bloggs | My Profile | Administration | Log Out | Iflzﬂry_lr_"ol'ﬂa‘mn_SyslT'_' Help?
- - My Page Project Home Planning Testing Tracking Reporting
TestCases | TestSets | TestRuns | Automation Hosts Role: Manager
dulnsert 3 Delete | o lndent < Outdent |—Showlewl— ¥| ByRefresh | [hEdit {Tools |- Stowhide colimns— v| V7 Eilter
Displaying 10 out of 14 test case(s) for this release Display data for: | — A1 Releases — v|
+ & Test Case Name Execution Status Owner Last Executed Author Active Test # Edit
S ] I’*"*' H“ + _= A:w_ + ‘n‘ ' ‘(C[ _l _:Egi_l
= B Functional Tests (5) i Fred Bloggs 1.Dec-2003 Fred Bloggs Yes TCOO0001 Iv Edit |
"] £ Passed Fred Bloggs 1-Dec-2003 Fred Bloggs Yes TCOO00002 _-W
£ Ability to edit existing book Caution Fred Bloggs 1-Dec-2003 Fred Bloggs Yes TCO00003 ﬁ
@ &3 Abilty to create new author Failed Joe P Smith 1-Dec-2003 Fred Bloggs Yes Tcoo0004 |5 E.m"
5 abiity to gantthioe Blocked Joa P Smith 1.Dec-2003 Fred Bloggs Yes TC000005 | [mEdit |
27 Al ty 1o reass Passed Joe P Smith 1-Dec-2003 Fred Bloggs Yes TCOO0006 _-ET
1.Dec 2003 Joe P Smith Yes TC000007 | [v it |
Joe P Smith Joe P Smith Yos TCOO0010 m
Joe P Smith Jow P Smith Yes TCOO0011 .- ;dit 1
ers Not Run Joe P Smith Yes TCO00012 m
3] Adding new book and author to Mot Run Joa P Smith Yes TCO00013 .- Edit ]
= B Commeon Tests (5) 1-Dec-2003 Fred Bloggs Yes TCO00015 m
8 Open Up Wel o Mot Run 1-Dec-2003 Fred Bloggs Yes TCOO0016 .- Edit I
53| ogin o Appiica Passed 1-Dec-2003 Fred Bloggs Yes TCOOD017 .W
£New Test Case (Abilty to add new books to the sys Not Run Fred Bloggs Yes TCOOOO1E  |» Edit
Show ' 15 v: ToWs per page 4 « Displaying page '_r ‘ Lof2em

The test case list consists of a hierarchical arrangement of the various test folders and test cases that the
system being developed needs to be able to demonstrate. The structure is very similar to the folder
structure in Microsoft Windows® Explorer, and users will find this very familiar and intuitive to use. When
you create a new project, this list will initially be empty, and you will have to use the <Insert> button to
start adding test folders and test cases to the system.

The list consists of test folders shown with a folder icon and in bold-type, and test cases that are shown
with a document icon and a hyperlink. You can nest test folders and test cases under an existing test
folder, but you cannot nest anything under a test case. All of the items in the list have a name, together
with the most recent execution status (passed, failed or not-run), and owner, author, execution date,
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active flag and test case number. Clicking on a test case’s hyperlink will take you to the test case details
page for the item in question (see section 5.2).

It is important to understand that only test cases are assigned a status themselves; the test folders
instead display a test execution bar graph that illustrates the aggregate execution status of its child test-
cases. Thus if the test folder contains two test cases, one of which passed, and one of which wasn’t run,
the graph will display 50% green and 50% gray.

To determine the exact aggregate test folder execution status information, position the mouse pointer
over the bar-chart, and the number of tests in each of the execution statuses (passed, failed, not-run,
blocked, caution) will be displayed as a “tooltip”. Note that if you change the owner of a test folder, then
all the child test cases will be assigned the same owner. This allows you to more easily associate entire
folders to test cases to be executed by a specific user.

5.1.1. Insert

Hovering over the <Insert> button brings up a secondary menu that allows you to choose whether to
insert a test case or a test folder (if you just click Insert it defaults to inserting a test case). In either case,
it will insert the new test folder / test case above the currently selected item — i.e. the one whose check-
box has been selected, at the same level in the hierarchy. If you want to insert a new test case or test
folder inside an existing folder, use the Insert > Child Test Case or Insert > Sub Folder option instead. If
you insert a new test folder / test case without first selected an existing item from the list, the new test
case will simply be inserted at the end of the list.

Once the new test folder / test case has been inserted, the item is switched to “Edit” mode so that you
can rename the default name and choose an owner and/or author. Note that all new test cases are
initially set with an execution status of “Not Run”.

5.1.2. Indent / Outdent

Clicking on the <Indent> button indents all the test folders / test cases whose check-boxes have been
selected. You cannot indent a test case or folder if it is below a test case, as test cases are not allowed to
have child items. Clicking on the <Outdent> button de-indents all the test folders / test cases whose
check-boxes have been selected.

5.1.3. Delete

Clicking on the <Delete> button deletes all the test cases and/or test folders whose check-boxes have
been selected. If any of the items are test folders, then all the children are all deleted (whether test cases
or folders). This behavior is similar to that in Microsoft Windows® Explorer.

5.1.4. Execute

Clicking on the <Execute> button executes all the test cases selected, together with all the test cases
contained with any selected test folders. The test execution functionality of SpiraTeam® is explained in
more detail in section 5.3.

5.1.5. Refresh

Clicking on the <Refresh> button simply reloads the test case list. This is useful as other people may be
modifying the list of test cases at the same time as you, or executing specific test cases, and after
stepping away from the computer for a short-time, you should click this button to make sure you are
viewing the most current test case list for the project.
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5.1.6. Edit

Each test case in the list has an <Edit> button display in its right-most column. When you click this button
or just double-click on any of the cells in the row, you change the item from “View” mode to “Edit” mode.
The various columns are made editable, and <Update> <Cancel> buttons are displayed in the last
column:

— Team" Welcome, Fred Bloggs | My Profile | Log Out | [Lirary infommation System 2 Help?
My Page Project Home Planning Testing Tracking Reporting

Test Cases | Test Sets Role: Manager I
dhinset 3 Delete | o> Indemt <o Qudent |- Showlevel— |v| ByRetesn | ChEean {fToos |- Showhidecolumns~ v Y7 Fiter

Displaying 9 out of 11 test case(s) for this release Display data for: [ All Releases - T‘

¥ 4 Test Case Name Execution Status  Owner Last Executed  Author Active Test# Edit

a| | | [~ any - Y| [caw- v | B] [~aw- 7] |-any~ ¥| tc| | [sFier

O = B Functional Tests (5) | Fred Bloggs 1-Dec-2003 Fred Bloggs Yes TCO00001 | » Edit

O g 3] :Ab\hty o create newbock B Failed [ None - v:@ 4-Dec-2003 :Fren Bloggs V:E :’es v]j » Update ||~ Cancel
(] 3] Ability to edit existing book Caution Fred Bloggs ¥ 1-Dec-2003 FredBloggs ¥ Yes v

0o |e ) Ability to create new auther Failed Joe P Smith 1-Dec-2003 Fred Bloggs Yes TC000004  [“Edit |

O b5 'A._,,m.‘ 1o edit existing uthor Blocked Joe P Smith 1-Dec-2003 Fred Bloggs Yes TCO00005  [vEdi |

O £ ability 10 reassign book to different auther Passed Joe P Smith 1-Dec-2003 Fred Bloggs Yes TC000006  [> Edit |

0 © €2 Reqression Tests (2) 1-Dec-2003 Joe P Smith Yes TCO00007 [+ Edit |

0 = B Scenario Tests (2) Joe P Smith Joe P Smith Yes TC000010 [+ Edit |

=] =B Exception Scenario Tests (1) Joe P Smith Joe P Smith Yes TCO00011 [+ Eant |

O £1Person loses book and needs 1o report loss Not Run Joe P Smith Yes TC000012 [+ Edit |

0 3 Adding new book and author to library Not Run Joe P Smith Yes TC000013 [ Edit |

a = B Common Tests (2) 1-Dec-2003 Fred Bloggs Yes TC000015 E

[m] £9 0pen Up Web Browser Passed 1-Dec-2003 Fred Bloggs Yes TC000016  [sEait |

0O 29 Login to Application Not Run 1-Dec-2003 Fred Bloggs Yes TCO00017 [+ Edit

Show [15 ¥ | rows per page  « Displaying page |1 ]'a of 10w

If you click <Edit> on more than one row, the <Update> and <Cancel> buttons are only displayed on the
first row, and you can make changes to all the editable rows and then update the changes by clicking the
one <Update> button. Also, if you want to make the same change to multiple rows (e.g. to change the
owner of five test cases from “Fred Bloggs” to “Joe Smith”), you can click on the “fill” icon to the right of
the editable item, which will propagate the new value to all editable items in the same column.

If you want to edit lots of items, first select their checkboxes and then click the [Edit] button on the same
row as the Filters and it will switch all the selected items into edit mode.

When you have made your updates, you can either click <Update> to commit the changes, or <Cancel>
to revert back to the original information. Alternatively, pressing the <ENTER> key will commit the
changes and pressing the <ESCAPE> key will cancel the changes.

5.1.7. Show Level

Choosing an indent level from the ‘Show Level’ drop down box allows you to quickly and easily view the
entire test case list at a specific indent level. For example you may want to see all test cases drilled-down
to the third level of detail. To do this you would simply choose ‘Level 3’ from the list, and the test cases
will be expanded accordingly

5.1.8. Show / Hide Columns

This drop-down list allows you to change the fields that are displayed in the test case list as columns for
the current project. To show a column that is not already displayed, simply select that column from the list
of “Show...” column names and to hide an existing column, simply select that column from the list of
“Hide...” column names. This is stored on a per-project basis, so you can have different display settings
for each project that you are a member of. The fields can be any of the built-in fields or any of the custom
properties set up by the project owner.

5.1.9. Filtering
You can easily filter the list of test cases as illustrated in the screen-shot below:
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e~ . , System i | Ubrary infomation System ¥ | | My Profile | Admanistration | Log Out || Search & Help?
sp:raTeam E 2 =
e My Page Project Home Planning Tasting Tracking Reporting
s | TestBuns | Automation Role: Project Owner
Disglaying 6 out of 11 test case(s) for this release Display data for: | = Al Folpases — ¥
v 0 TestCase Name Status  Owner Last Author Active Test# Edit
] |- v] [Mom ¥ [ =] [- v [~ v 7] |
= B Regression Tests (2) 1.Dec-2003 Joe P Smith Yes TCO00007
L) Book management Passed 1-Dec-2003 Joe P Smith Ys TC000008
£ puthor management Passed 1-Dec-2003 Joe P Smith Yes TC000009
=8 Scenario Tasts (2) Joe P Smith Joe P Smith Yes TCO0O010
=8> Exception Scenario Tests (1) Joe P Smith Joe P Smith Yes TCO000T
£ Person lgses book and needs 1o raport loss Mot Run Joe P Smith Yes TCO00O12
3 Agding new book and author 1o ligeary Not Run Joe P Smith Yes TCO00013
=B Common Tests (2) 1.Dec-2003 Fred Bloggs Yes TCO00015
23 Open Up Web Browser Mot Run 1-Dec-2003 Fred Bloggs Yes TCO00016
F £ Login to Apgiication Passed 1-Dec-2003 Fred Bloggs Yes TCO00017
Show (15 ¥ | rows per page -Ilesplaymgpage!]__'%pob

To filter the list by any of the displayed columns, you either choose an item from the appropriate drop-
down list or enter a free-text phrase (depending on the type of field) then click <Filter> or press the
<ENTER> key to apply the different filters. Note that the name field is searched using a “LIKE”
comparison, so that searching for “database” would include any item with the word database in the name.
The other freetext fields need to be exact matches (e.g. dates, test case numbers). In the screen-shot
above, we are filtering on Owner = (None).

In addition, if you have a set of filters that you plan on using on a regular basis, you can choose the option
Filter > Save Filter to add the current filter to the list of saved filters that appear on your ‘My Page’. The
list of saved filters can also be retrieved by clicking Filter > Retrieve Filter:

—~ - Wlcome, Fred Bogge | Ly Prfe | LogOut | ag?

spiraTeam
— My Page Project Home Planning Testing Tracking Reporting

Test Cases | Test Sets Role: Manager
ohinset  §3 Delete | o indent <o Outdent R Refresh | GhEdit $FTools |- Showimide coumns — Y| ¥ Fiter
Dizplaying 4 out of 11 test case(s) for this release Display v Apply Filter — "I

¥ ¢ TestCase Name Save Filter st Executed Test# Edit

i | Please choose a name for this filter ] Ttl:l

O =@ Functional Tests (5) ‘ | |Dec.2003 TCO00001

] £ Ability to reassign book to different author Dec-2003 TCO00006

O = Regression Tests (2) > Save | Cancel |Dec-2003 Joe P Smith Yes TCO00007

O £1 Book management TFassed “Dec-2003 Joe P Smith Yes TC000008

0o £ Author management Passed 1-Dec-2003 Joe P Smith Yes TCO00009

3] =@ Common Tests (2) 1.Dec-2003 Fred Bloggs Yes TC000015

O | Open Up Web Browser Passed 1-Dec-2003 Fred Bloggs Yes TC000016
Show |15 ¥ | rows per page 4 < Displaying page (1 |%of 1»
dhinsert  §3Delete | o indent <h Quident | [> Exenute

5.1.10. Copying Test Cases

To copy one or more test cases, simply select the check-boxes of the test cases you want to copy and
then select the Edit > Copy menu option. This will copy the current test case selection to the clipboard.
Then you should select the place where you want the test cases to be inserted and choose the Edit >
Paste option.

The test cases will now be copied into the destination location you specified. The name of the copied test
cases will be prefixed with “Copy of...” to distinguish them from the originals.

5.1.11. Moving Test Cases
To move test cases in the hierarchy, there are two options:




1. Click on the icon the test case/folder you want to move and then drag the icon to the location you
want it moved. The background of the destination location will change as the icon is dragged over
it to illustrate where it will be inserted:

.‘_.w"_,-;_‘éream- Welcome, System Adminictrator | My Profile | Administration | Log Out | Help?
R My Page Project Home Planning Testing Tracking Reporting

Test Cases | TestSets

fhimsen  §3Dekte | o> indent < Ouident |... Showlevel v| BjRefiesh | {fTools [> Exeate W Clear Fiters

Displaying 9 out of 13 test case(s) for this release Display data for: — All Releases — E
« @ TestCase Name Execution Status Owner LastExecuted  Author Active Test# Edit
o | |Ca— v] [aw— ¥] | B - v [aw- v e[ |
0 = B Functional Tests (5) | Fred Bloggs 1-Dec.2003 Fred Bloggs Yes TCOD0001
0 |e LY ppdtine 15, araata now haa Passed Fred Bloggs 1-Dec-2003 Fred Bloggs Yes TC000002
o [Caution  Fred Blaggs 1-Dec-2003 Fred Bloggs Yes TCO00003
O @ £ apiityto create new author [Feiled S Joe P Smith 1-Dec-2003 Fred Bloggs Yes TC000004
0 L) aility to edit existing author Blocked Joe P Smith 1-Dec-2003 Fred Bloggs Yes TCO00005
O &Y pbility to reassign book to different auther Passed Joe P Smith 1-Dec-2003 Fred Bloggs Yes TCO00006
] = B Regression Tests (2) 1.Dec.2003 Joe P Smith Yes TCOD00OT
O LY Book management Passed 1-Dec-2003 Joe P Smith Yes TC000008
O L3 Author management Passed 1-Dec-2003 Joe P Smith Yes TC000009
o 69 Scenario Tests (2) Joe P Smith Joe P Smith Yes TC000010
O = B Common Tests {2) 1.Dec.2003 Fred Bloggs Yes TCO00015
O %) Open Up Web Browser Hot Run 1-Dec-2003 Fred Blogge Yes TC000016
] &3 Login to Application Passed 1-Dec.2003 Fred Bloggs Yae TC000017
Show[1s W] rows perpage /4« Displaying page 1 |%aof 1>

et §3Delte | o> indent < Oudent | [> Exemute

Once you have the test case/folder positioned at the correct place that you want it inserted, just
release the mouse button and the test case list will be refreshed, with the item moved to the
desired location. To move multiple items simply select their checkboxes and then drag-and-drop
one of the selected items.

2. Alternatively you can simply select the check-boxes of the test cases you want to move and then
select the Edit > Cut menu option. This will cut the current test case selection to the clipboard.
Then you should select the place where you want the test cases to be inserted and choose the
Edit > Paste option. The test cases will now be moved into the destination location you specified.

5.1.12. Exporting Test Cases

To export a test case or set of test cases from the current project to another project in the system, all you
need to do is select the check-boxes of the test case(s) you want to export and then click Tools > Export
Tests. This will then bring up a list of possible destination projects:




s}")‘}?-é_ream. Welcome, Fred Bloggs | My Profile | Administration | Log Qut | | Library Information System | Help?
— My Page Project Home: Planning Testing
Test Cases | Tes | wtomat
fhlnsent 3 Delete | o indent < Quident
Displaying 10 out of 14 test case(s) for this release [ S \] Display data for: |~ Al Fiskeases — v
V4 TestCase Name LastExecuted  Author Active Test# Edit
i | Please select the project you want 1o export to: ¥ ] - Ay = v ~Any=- | TC
B Lhﬂmﬁmﬂm&ﬁ) ‘ [~ Select Project — 'l [ ]1-nnc-2003 ‘ lI’:-l"-:;:'.l-\Bium]s | ‘Yﬂ Tﬂﬂgl
@@ 1Aty to create new book 1-Dec-2003 Fred Bloggs Yes TCO00002
i £ Abifity to edt exisling ook 1-Dec-2003 Fred Bloggs Yes TCD00003
@8 EIAbilty to create new author 1-Dec-2003 Fred Bloggs Yes TCO000D4
] £ Abifity to adit existing author Blocked Joo P Smith 1-Dec-2003 Fred Blogas Yes TCO00005
B £ Abiity 1o reassign bock 1o different suthor Passed Joe P Smith 1-Dec-2003 Fred Blogas. Yes TCODBO0S
B =6 Regression Tesis (2) 1.Dec-2003 Joe P Smith Yes TCO00007
=@ Scenario Tests (2) Joe P Smith Joe P Smith Yos TCON0O10 @
B = B Exception Scenario Tests (1) Joe P Smith Joe P Smith Yes TCO00011
B &) parson loses book and needs 1o repod lass Not Run Joa P Smith Yes TCO00012
[a] 3 Adchiog nrew biook and suthor to Kwary Not Run Joa P Smith Yes TCO00013
E =B Commen Tests (5) 1.Dec-2003 Fred Bloggs Yes TCODOO15
B £ Open Up Web Browser Not Run 1-Dec-2003 Fred Bloggs Yes TCODBO16
53 | ogin 1o Application Passed 1-Dec-2003 Fred Bloggs Yes TCO0001T
£ New Test Case (Ability to add new books to the sys Not Run I | Fred Bioggs Yes TCODOO1E |
Show 15 ¥ | rows per page < Displaying page [1_|%of 20 b

Once you have chosen the destination project and clicked the <Export> button, the test cases will be
exported from the current project to the destination project. Any file attachments will also be copied to the
destination project along with the test cases.

5.1.13. Adding Test Cases to a Release, Test Set or Requirement

To quickly add a series of test cases to a Release, Test Set or Requirement, all you need to do is select
the check-boxes of the appropriate test cases and then click Tools > Add to Release / Test Set /
Requirement. This will then bring up a dialog box displaying either a list of available releases, test sets or
requirements (depending on which option was chosen):

oy . Welcome, Fred Bloggs | My Profile | Log Out | Help?
spiraTest
— My Page Project Home Planning Testing Tracking Reparting

Test Cases | Test Sets Role: Manager
cfnsert  £3 Delete | > indent b Quident |-~ Showlevel— v| BjRefresh | {fiTools [> Execute [ Showjhide columns~ w| Y Clear Fiters
Displaying T out of T test case(s) for this release Display data for: | 1.0.1.0- Library System Release 15P1 -
+ @ TestCase Name Add To Test Set [Executed Author Active Test & Edit
- ANY - v — ARY - v
= | Please select the test set you want to add to: o 001 | | 4 ‘ l L | TCl:l
&) = B> Functional Tests (5) £-2003 Fred Bloggs Yes TCO00001
F @ 29 Ability to create new book i I~ o3 Fred Bloggs Yes TCO00002
= estSet
8 £) iy o ot xising book Testing Cyck or Relesss 10 200 FedBoggs  Yes Teoouey
B 8| E)asiiny to ereate new author Testing Cycle for Release 1.1 roet-2003 Fred Bloggs Yes TC000004
: = Regression Testing for Windows XP
] 3 asilty to edit existing author B Roaression Tasing for Windowa Vista | 022003 Fred Bloggs Yes TC000005
B &) Ability to reassign book to different author P Testing New Functionality Dec-2003 Fred Bloggs Yes TCO00006
B & B Regression Tests [2) Exloratory Testing 500 2003 Joe P Smith Yes TC000007
4] £ Book management Passed 1-Dec-2003 Joe P Smith Yes TC000008
a8 23 author management Nat Run 1-Dec-2003 Joe P Smith Yes TC000009
B E B Common Tests [0) 1.Dec-2003 Fred Bloggs Yes TCO00015

pnset {3 Delele | <> indent <o Outdent | [> Exeute

Once you have chosen the destination release / test set / requirement, clicking <Add> will add the
selected test cases to the destination release / test set / requirement.

5.1.14. Viewing the Test Status for a Release

By default, when you view the list of test case cases, it will display an aggregate status for all releases of
the project. l.e. the test list will include all the test cases in the system (regardless of which release they
apply to) and the execution status will reflect the most recent test run — regardless of which release it was
for.




To change the test case list to just display test cases and execution status for a particular release, simply
change the release selected in the drop-down list located below the toolbar (on the right-hand side) from
“Any” to a specific release:

- . Welcome, Fred Bloggs | My Profile | Administrstion | Log Qut | |Lbrry Infomation System A Help?
spiraTeam
— My Page Project Home Planning Testing Tracking Reporting
Test Cases | Test Sets Role: Manager
diosert 3Deiete | indent <o Ouient [-Sewlew- V] ByRefesh | GhEdt fiToos [-Sewhdecobrns- V| Y Fter
Displaying 7 out of 7 test case(s) for this release Display data for: ||0.|.0. Lit v.
+ @ Test Case Name Execution Status Owner Last Executed Author Active Test # Edit
O [Eo- 3] - v 8 [ ] [ ] %[ ]
(@] =& Functional Tests (5) Fred Bloggs Fred Bloggs Yes TCO00001 |ﬂ]
0o |e &) Ability to create new book Passed Fred Bloggs 1-Dec-2003 Fred Bloggs Yes TCO00002
] &7 Ability to edit existin Not Run Fred Bloggs Fred Bloggs Yes TC000003
o |e £1 pbility to ereate new author Not Run Joe P Smith Fred Bloggs Yes TCO00004 [» Eait |
O £ avility to edit exicting authar Blocked Joe P Smith 1-Dec-2003 Fred Bloggs Yes TC000005 » Edit
0 £ Ability to reassign book to different author Passed Joe P Smith 1-Dec-2003 Fred Bloggs Yes TCO00006
0o =8> Regression Tests (2) Joe P Smith Yes TC000007
O £ Book management Passed 1.Dec-2003 Joe P Smith Yes TCO00003 [ Ean |
@] £ author management hiot Run Joe P Smith Yes TCO00003 [+ Eant_|
Show[15_ ] rows per page < <« Displaying page[1_|%of 1> »
dFinset  §3Delete | < indent <o Ouent | [> Execute

As illustrated in the example above, when the drop-down list is changed to select a specific release, the
list of test cases is filtered to just those mapped to the release in question. In addition, the execution
status for the test releases will only reflect test runs for that specific release (and any child iterations if
applicable). As can be seen in our example, many test cases that have been run for other releases now
show the “Not Run” status since they've not been run for this specific release.

As a shortcut, when you select a specific release for viewing, subsequent execution of any of the test
cases via the Tools > Execute menu option will default the test run to the selected release.

5.1.15. Printing Items

To quickly print a single test case, test folder or list of test cases you can select the items’ checkboxes
and then click Tools > Print Items. This will display a popup window containing a printable version of the
selected items.

5.1.16. Right-Click Context Menu

SpiraTeam® provides a shortcut — called the context menu - for accessing some of the most commonly
used functions, so that you don’t need to move your mouse up to the toolbar each time. To access the
context menu, right-click on any of the rows in the test case list and the following menu will be displayed:

gj Ability to create new book % Open ltem Passed Fred Bloggs 1-Dec-2003 Fred Bloggs

L3 Ability to edit existing book E Open in New Tab Caution Fred Bloggs 1-Dec-2003 Fred Bloggs

| Ability to create new author | £ New Test Case Failed Joe P Smith 1-Dec-2003 Fred Bloggs

53 Ability to edit existing author | €3 New Folder Blocked Joe P Smith 1-Dec-2003 Fred Bloggs

£ Ability to reassign book to giff = Coi tems Passed Joe P Smith 1-Dec-2003 Fred Bloggs

£3 Regression Tests (2) e 1-Dec-2003 Joe P Smith
= = Scenario Tests (2) => Indent Joe P Smith Joe P Smith
El B Exception Scenario Tests ( Co@uitnl Joe P Smith Joe P Smith
%1 Person loses book and neef [ Copy ltems Not Run Joe P Smith

3] Adding new book and author ) Cut fems Not Run Joe P Smith
I=E =T Tocie [R) % [Pes [ome 1 Do 'J-'m'l Cood Blogoe

You can now choose any of these options as an alternative to using the icons in the toolbar.
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5.2. Test Case Details

When you click on a test case item in the test case list described in section 5.1, you are taken to the test
case details page illustrated below:

. Tea - Welcome, Fred Bloggs | My Profile | Administration | Log Out | | Libary Information System v Help?
b My Page Project Home Planning Testing Tracking Reporting
Test Cases > Test Case Details | TestSets | TestRuns | Automation Hosts Role: Manager
Save Copy Refresh Delete Execute Pring Email  § Subscribe
<< Back to Test List - '8 2 & = B ® - L
Display: | Current Filter ¥ Test Case: 21 Ability to create new book [TC-000002]
=1 bl;unclinnal Tests Name*: [Ablhty o creat new book |
Ability to create new book
'ElAbcllryloedltexlsnngbuok Description: —~ Font - Y| | -See- "l B I ;[|EII|§EE':‘{_!¢|T&%|—wnD<>@
£ Ability to create new author Tests that the user can creale a new book in the system
‘ﬂ Abdlity to edst existing author
8 Ability 1o reassign book to different
+ B> Regression Tests
= B> Scenario Tests P = - —————
= B Exception Scenario Tests T Fred Bloggs Est Dur. 02 hours
£1Person loses book and needs to Crwner: Fred Bloggs v Creaticn Date: 12/1/2003 12:00:00 AM
b5 . - )
=) Adding new book and author to libr Priority: 1~ Critical v Execution Status Passed
= B Common Tests === |
£ 0Open Up Web Browser Active®: [Yes v Last Executed: 12/1/2003 12:00:00 AM
"ﬂ Login to Application
L) New Test Case (Ability to add new Bt . Lo e e Custom Props ¥ Test Runs ® Releases ¥ Atachments History &

This page is made up of three areas; the left pane is the navigation window, the upper part of the right
pane contains the test case detailed information itself, and the bottom part of the right pane contains
related information about the test case.

The navigation pane consists of a link that will take you back to the test case list, as well as a list of the
peer test case to the one selected. This latter list is useful as a navigation shortcut; you can quickly view
the detailed information of all the peer test cases by clicking on the navigation links without having to first
return to the test cases list page. The navigation list can be switched between three different modes:

e The list of test cases matching the current filter
e The list of all test cases, irrespective of the current filter
e The list of test cases assigned to the current user

The top part of the right pane allows you to view and/or edit the details of the particular test case. You can
edit the various fields (name, description, etc.) and once you are satisfied with them, simply click either
the <Save> or <Save and New> button at the top of the page to commit the changes. In addition you can
delete the current artifact by choosing <Delete>, discard any changes made by clicking <Refresh> or print
it by clicking <Print>.

Using the <Email> button on the toolbar, you can send an email containing details of the test case to an
email address or another user on the system:

Email this artifact to:

@ Project User: | Fred Bloggs v

Select a user in the project to send to.

) Email Addresses:

A list of email addresses, separated by ;

Message Subject: |

Leave blank for default.

Send | Cancel
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You can specify the subject line for the email, and either a list of email addresses, separated by
semicolons, or an existing project user .The content of the email is specified in the System Administration
— Notification Templates.

The lower part of the right pane can be switched between six different views by clicking the appropriate
tab. Initially the pane will be in “Test Steps” mode, but it can be switched to “Requirements Coverage”,
“Automation”, “Comments”, “Custom Properties”, “Test Runs”, “Releases”, “Attachments” and “History”
modes if so desired. Each of the views is described separately below. In addition there is a shortcut link
“Execute This Test” that allows you to execute this test (see section 5.3) without having to return to the
Test Case list.

5.2.1. Test Steps

This view displays the name of the test case together with all the defined test steps that a tester would
need to perform to verify that the functionality works as expected. The list of test steps displays the
position number, the description, the expected result, some suggested sample data and the most recent
execution status of the individual test step:

Test Steps * Req Coverage # Custom Props # Test Runs # Releazes # Attachments # History #

= Insert Step | Insert Link | Delete | Copy | Refresh | | — Show/hide columns — v | Edit Parameters

[0 @ Step# Test Step Description Expected Result Sample Data Status  Step Id Edit

O |®istep1 Call'Login to Apolication' (TC17) &7 M/A, TS000001

[ | ®stepa Userclicks link to create book User taken to first screen in wizard Passed TS000002

O 0 L] Step 3 User enters books name and author, then User taken to next screen in wizard Macbeth, William Passed TS000003
clicks Mext Shakespeare

O L) Step 4 User chooses book's genre and sub-genre User sees screen displaying all entered | Play. Tragedy Passed TS000004
from list information

O [} Step 5 User clicks submit button Confirmation screen is displayed Passed TS000005

ShUW Tows per page Displaying page EI'J of 1

To change the order of the test steps. please click on the test step/link icon and drag it to the appropriate place in the list.

Note: Test steps that are marked with a hyperlink and test case icon (e.g. “Call Login to Application” in the
screen shot above) are in fact linked test cases. Linked test cases are a useful way of reusing existing
test steps from other test cases. For example if you want to have a set of steps be in more than one test
case (e.g. a login step) then you would create a separate test case just containing these steps, then have
all the other test cases just link to it. This avoids the need to have duplicate test steps throughout the
project.

In addition, if you click on the step number hyperlink (e.g. Step 2) you will be taken to the test step details
page which allows you to perform additional editing of a specific test step as well as attach documents,
associate pre-existing incidents and view the change history.

5.2.1.1. Insert Step

Clicking on the <Insert Step> button inserts a new test step before the currently selected (by means of the
check-box) test step. Clicking the <Insert Step> button without selecting a test step will insert a new step
at the end of the list. When a new step is inserted, the fields are displayed in “Edit” mode, so the
description, expected result and sample data fields are editable, allowing you to enter the appropriate
data:
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Test Steps # Req Coverage # Custom Props % Test Runs # Releases # Attachments # History #

= Insert Step | Insert Link | Delete | Copy | Refresh | [ _ snowsnide columns — v | Edit Parameters

[ © Step# Test Step Description Expected Result Sample Data Status  Step Id Edit
O ) Step 1 | Call Login to Application’ (TC17) £ MIA TS000001
B [} Step 2 | User clicks link to create book User taken to first screen in wizard Passed TS000002

O o m Step 3 User enters books name and author, | User taken to next screen in wizard | Macbeth, William Shakespeare Passed TS000003
then clicks MNext

B [} Step 4 | User chooses book’s genre and sub- | User sees screen displaying all Play. Tragedy Passed TS000004
genre from list entered information
E Q.“j Step 5 User clicks submit button Confirmation screen is displayed Passed TS000005
O ®steps B 7 UTy|e=[l<>[A B 7 UTs|e=[ <A B s UTy|e=[ <@ Mot Run
(Mew Test Step) (Expected Result)
=1 =] =]
Show rows per page Displaying page % of 1

Once you have entered the necessary information, you can click either <Insert> or <Update> to commit
the changes. If you choose <Insert>, another new row will be inserted which is useful if you intend on
entering lots of rows at once, whereas clicking <Update> will simply commit the current row only.

5.2.1.2. Insert Link

Clicking on the <Insert Link> button brings up the following dialog box that allows you to choose the test
case to be inserted:

Add Linked Test Case
Choose the test case to add as a link in the test step list:
o
v | Test Case
# &3 Functional Tests
£3 Regression Tests
23 Scenario Tests
E &3 Common Tests
Q g_'l Open Up Web Browser 3
0] = Login to Application

Please fill out the parameters for this linked test case:

url: |

> Add | Cancel

You need to then select the name of the test case you want to insert as a link. If the test case has
declared parameters (see the section on Parameters below for more details) you will be given a list of
parameters that needed to be filled out.

You need to fill out the values of the parameters for the linked test case and then click the <Add> button
to complete the operation. The system will then insert the test case as a link just before the currently
selected test step. If no existing test step was selected, the link will be added at the end of the test step
list.
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5.2.1.3. Delete

Clicking on the <Delete> button deletes the currently selected test steps, and reorders the test step
position numbers to close any gaps in numbering.

5.2.1.4. Copy

Clicking on the <Copy> button makes a copy of the current test step or linked test case and inserts the
copied version directly above the original one.

5.2.1.5. Refresh

Clicking on the <Refresh> button simply reloads the list of test steps. This is useful if other people are
making changes to the test list and you want to make sure that you have the most current version.

5.2.1.6. Show / Hide Columns

By default the test step list screen will display the Description, Expected Result and Sample Data fields.
However the Expected Result and Sample Data fields are optional and can be hidden if necessary to
make more space. If you have configured custom properties for test steps, you can use the Show/Hide
features to display one or more of your custom properties instead. These fields will then be editable in this
grid-view.

5.2.1.7. Editing Test Steps

To modify an existing Test Step you simply need to click on the <Edit> button to the right of the step, or
just double-click on the cells in the row. That will switch the selected row into Edit mode. The various
columns are turned into editable text-boxes, and <Update> <Cancel> buttons are displayed in the last
column:
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Test Steps # Req Coverage # Custom Props # Test Runs #* Releases #* Attachments # History #

= Insert Step | Insert Link | Delete | Copy | Refresh | | __ Show/hide columns — v | Edit Parameters

[ © Step# Test Step Description Expected Result Sample Data Status  Step Id Edit

O | ®istep 1 Call Login to Application’ (TC17) £7 MIA, TS000001

0 @step2 Bz 1Ts|emo@ Bl UL |=pod BZUTg|lepo@ Passed
User clicks link to create User taken to first screen
book =l in wizard =| =l

O o [} Step 3 | User enters books name and author, | User taken ta next screen in wizard | Macbeth, William Shakespeare Passed TS000003
then clicks MNext

B [} Step 4 | User chooses book’s genre and sub- | User sees screen displaying all Play, Tragedy Passed TS000004
genre from list entered information

O ) Step 5 | User clicks submit button Confirmation screen is displayed Passed TS000005

Show TOWs per page Displaying page of 1

If you click <Edit> on more than one row, the <Update> and <Cancel> buttons are only displayed on the
first row, and you can make changes to all the editable rows and then update the changes by clicking the
one <Update> button. Also, if you want to make the same change to multiple rows, you can click on the
“fill” icon to the right of the editable item, which will propagate the new value to all editable items in the
same column. When you have made your updates, you can either click <Update> to commit the changes,
or <Cancel> to revert back to the original information.

5.2.1.7. Editing Test Steps

To modify an existing Test Link you simply need to click on the <Edit> button to the right of the step, or
just click on the cells in the row. That will open up the special dialog box used for editing the parameter
values associated with a specific linked test case:

Page 58 of 167

This document contains Inflectra proprietary information




Edit Linked Test Case Parameters ]

Please fill out the parameters for this linked test case:

login: |Iibrarian |

password: |passw0rd1 |

= Update | Cancel

This allows you to edit the parameters being passed from the current test step to the linked test case
without having to recreate the test link from scratch. To commit the change click <Update> to close the
dialog box, or click <Cancel> to revert back to the original information.

5.2.1.9. Moving Test Steps

To move test steps in the list, click on the icon the test step/link you want to move and then drag the icon
to the location you want it moved. The border of the destination location will change as the icon is
dragged over it to illustrate where it will be inserted.

5.2.1.10. Parameters

Test cases can have parameters associated with them. This enables one test case to be called several
times by another test case (as a link) and have different parameters passed in each case, making the
operation different. E.g. you could have a generic “login to application” test case that others call as an
initial step, which could be provided with different login information depending on the calling test case.

To view / change the parameters associated with the current test case, click on the <Parameters> icon in
the toolbar and the list of current parameters will be displayed:

Edit Test Case Parameters ]

The following parameters have been defined for this test case:

Name Default Value Operations
B{login} Copy To Clipboard | Delete
${password} Copy To Clipboard | Delete

Add a new parameter to this test case:
Name:* | |

1 Default Value: | |

r

The list of existing parameters is displayed in a grid, followed by the option to add a new parameter and
default value (used when the test case is run directly rather than being called by another test case). You
can delete an existing parameter and also copy the parameter token to your computer’s clipboard. The
latter option is useful so that you can insert the parameter token (in the format ${parameter name}) in the
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test step description, expected result or sample data fields and have it converted into the parameter value
during test execution.

5.2.2. Requirements Coverage

This view displays the name of the test case together with the requirements coverage information for the
test case in question:

Test Steps # Req Coverage # Custom Props # Test Runs # Releazes # Aftachments % History #
Available Requirements: Requirements Coverage:

v | Name v | Test # | Name Status

[J = = Functional System Requirements ™ [] RQO00004 ] Ability to add new books toth.  Completed

O == online Library Management Syst...

O = = Book Management

T Ability to add new books to th |—|RE""°“ =
Ability to edit existing books. .. R

B i g

JAbnny to delete existing boo...

ESO . .

.jAblhty to associate books wit...

9 Ahilite tn acenriate hnnlee wit

“J|lo|o|o

> Create Requirement From This Test Case ﬁ

The requirements coverage box indicates the requirements that are currently mapped against the test case.
To add requirements to this test case, choose from the list above and click [Add].
You can use the [Remove] and [Remove All] buttons to remove requirements that are no longer covered by the test case.

The pane consists of two lists of requirements, the one on the left being the complete hierarchical list of
requirements in the project. The right box (which will initially be empty) contains the list of requirements
mapped to this test case. The requirements in this box include columns for their ID, name and status.
Hovering the mouse over the names of the requirements in either box will display a “tooltip” consisting of
the requirement name, place in the hierarchical structure and a detailed description. Clicking on the
hyperlinks in right-hand box will jump you to the requirement details screen for the requirement in
guestion (see section 4.2).

To change the coverage for this test case, you use the buttons (Add, Remove, Remove All) positioned
between the two list-boxes. The <Add> button will move the selected requirements from the list of
available on the left to the list of mapped on the right. Similarly the <Remove> and <Remove All> buttons
will remove either the selected or all the requirements from the right list-box and add them back to the left
list-box.

Finally, as a shortcut you can click the “Create Requirement from This Test Case” link to create a new
requirement in the list of covered requirements that will be automatically linked to this test case. This is
useful when you have created a new test case and want to generate an initial placeholder requirement to
be fleshed-out later.

5.2.3. Automation
The Automation tab displays any automated test scripts associated with the current test case. There are
three types of automated test:

e Attached - this is when SpiraTeam physically stores the test script as an attachment in the
system. This is only available for test automation tools that store their test scripts as plain text
files. Examples of such tools are Selenium-RC and Squish.

e Linked - this is when SpiraTeam stores the location of the test script stored on the automation
host itself or on an external network drive.
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e Repository — This is a special option only available when using Rapise™, the test automation
system from Inflectra. This allows you to store an entire folder of automated test script files in
SpiraTeam and have them linked to the test case.

The screenshot below illustrates a sample Rapise automated test script attached to a test case:

Test Steps #* Req. Coverage # A ion # [ Custom Props # Test Runs # Releases # Aftachments # History #
This section defines the automated test script associated with this test case:
Automation Engine*: | Rapise v
Script Type™: Attached  Linked @ Repository
Filename*: [R] CreateNewBook\CreateNewBook sstest
Document Type*: | Functional Specfication v ‘
Document Folder*: | Root Folder Y‘
Version: -
> Edit Parameters
Test Script™:

The automation screen includes the following fields that you should populate when using SpiraTeam® to
store an automated test script:

» Automation Engine — this should be the name of the test automation engine that the test script
should be executed with. This list is populated by a system administrator using the administration
section of the application (as described in the SpiraTeam Administration Guide)

» Script Type — This should be set to either “attached” or “linked”. If you choose to attach the test
script, the large text box at the bottom will be enabled, allowing you enter/edit the test script
directly in SpiraTeam. If you choose linked, the test script is stored externally and SpiraTeam just
stores a reference to it. The “repository” option is never selectable within SpiraTeam and will be
automatically set by Rapise when it attaches a test script to the test case.

>» Filename — If you are attaching the test script to the test case then this field just needs to contain
the filename of the test script (no folders or path needed), whereas if you are choosing to link the
test script, you need to follow the exact format that will be expected by the test automation
engine. For details, please refer to the specific test automation engine in the SpiraTest/Team
Automated Test Integration Guide.

» Document Type (SpiraTeam only) - This should be set to the document type that you want the
test script associated with.

>» Document Folder (SpiraTeam only) - This should be set to the document folder that you want
the test script to be stored in.

Version — This should contain the version number of the test script.

>» Test Script — If you are attaching a test script, this should contain the actual program code for
executing the test script. The language and syntax will be dependent on the test automation
engine being used. If you are linking the test script, this section will be disabled.

>» Parameters — You can enter the various test case parameters by clicking on this hyperlink. Most
of the automation tools that SpiraTeam integrates with will support the passing of parameter
values from SpiraTeam to the automation tool.
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5.2.4. Comments
The Comments tab allows users to add and view discussions related to the Test Case:

Test Steps # Req Coverage Automation Comments Custom Props # Test Runs # Releases # A

To add a new comment to this requirement, please enter it below and click the [Save] button:

2| %] —eEmo@

1]
il
Il
111
111
art
L]
[Tl
L]

~ Fort - v] [-Sze- V¥ BI U

Existing Comments

Existing comments are displayed by date underneath the text box. To add a comment to the Test Case,
enter your text into the textbox, then click the Save button to save.

5.2.5. Custom Properties

In this mode, the main pane displays any custom properties that the project owner has defined for test
cases. To learn more about how to setup and configure custom properties for a project, please refer to
the SpiraTest Administration Guide. Assuming that custom properties have been defined for your project,
you will see a list of optional parameters that can be set on the test case. These can be either freetext or
drop-down-lists. In the example below, you can enter a URL and/or Test Type.

Test Steps # Req Coverage % Custom Props # Test Runs # Releases # Attachments #* History #
The following are the custom properties of this artifact:
URL: http:/fwww_libraryreferences.org
Test Type:  [Functional Test v]

Once you are satisfied with the values for the custom properties, simply click [Save] or [Save and New] to
commit the changes.

5.2.6. Test Runs

This view displays the name of the test case together with a list of the previous execution runs that the
test case has been put through. Each test run is listed together with the date of execution, the name of
the test case, the name of the test set (if applicable), the name of the tester, the release/version of the
system that the test was executed against, the overall execution status for the test case in that run and a
link to the actual test run details (see section 5.6). In addition, you can choose to display any of the
custom properties associated with the test run.
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Test Steps * Req Coverage ® Custom Props ® Test Runs * Reiases * Atachments History #
= Refresh | Apply Filter | Clear Filters - Show,/hide columna v
v @ Test Run Name &4V Execution Date AV Test Set AV Release AV Status AV Est. Dur. A¥ Act. Dur. A¥Y Web Browser A¥Y Operating System 4Y Run# AY
0| | ] [ — Any — V| [y I v] [ i || [ e - v [ g = ¥ TR
(| B) Ability to create ; | 4-Dec-2003 1.1.0.0.0003 Failed 0.0n 1.2h TRO00013
O Bl abiity to 3-Dec-2003 11000002 | Passed 0.0h 1.2h TROO0015
O/ B asiiyto sk | 2-Dec-2003 1.1.0.0.0001 Passed 0.0h 1.2h TROD0013
(| B3 Ability to create 1-Dec-2003 Testing Cycle 1010 Passed 0.2h 1.5h Mozilla / Firefox Windows 2000 TRO0O0002
for Release 1.1

(] B an lity to create nev 1-Dec-2003 1.000 Failed 0.2h 1.2h Opera Windows 2003 TROOO012
0O ;‘_]_:‘h lity to create ne 1-Dec-2003 Testing Cycle 1000 Failed 0.2h 1.3h Internet Explorer Windows XP TRO000O1

b fior Release 1.0
Show |15 ¥ | rows per page " 4 Displaying page {1 |%of 10 &

The “customize columns” drop-down list allows you to change the fields that are displayed in the test run
list as columns. To show a column that is not already displayed, simply select that column from the list of
“Show...” column names and to hide an existing column, simply select that column from the list of
“Hide...” column names. The displayed columns can be any standard field or custom property.

You can also filter the results by choosing items from the filter options displayed in the sub-header row of
each field and clicking the “Apply Filter” link. In addition, you can quickly sort the list by clicking on one of
the directional arrow icons displayed in the header row of the appropriate field.

5.2.7. Release Mapping

This view displays the name of the test case together with the release mapping information for the test
case in question:

Test Steps # Req Coverage % Custom Props # Test Runs % Releases * Attachments # History #
Available Releases: Mapped Releases:
v |Test# |Name Status
[] RLO0000T [E4.0.0.0- Library System Relea Active
- [] RLO00002 [E1.0.1.0- Library System Relea Active
B1o020- Library System Relea [] RLO00003 [E4.020- Library System Relea Active
0 211.0.0.0.0001 - lteration 001 [Remove<| [ RL000004 11.1.0.0- Library System Relea Active
O 21100 00002 - lteration 002 [ RL000017 £ 1 0 0 0001 - lteration 001 Active
0 211.0.0.0.0003 - lteration 003 O RL000018 591 1.0.0.0002 - lteration 002 Active
1.1.0.0 - Library System Relea ] RLO00019 T34 1.0.0.0003 - Iteration 003 Active
O E1200- Library System Relea...

The release coverage box indicates the releases that are currently mapped against the test case.
To associate releases with this test case, choose from the list above and click [Add].
“ou can use the [Remove] and [Remove All] buttons to remove releases that are no longer covered by the test case.

The pane consists of two lists of releases/iterations, the one on the left being the complete hierarchical list
of releases and iterations in the project. The right box (which will initially be empty) contains the list of
releases/iterations mapped to this test case. The releases in this box include columns for their ID, name
and active status. Hovering the mouse over the names of the releasesl/iterations in either box will display
a “tooltip” consisting of the release/iteration name, place in the hierarchical structure and a detailed
description. Clicking on the hyperlinks in right-hand box will jump you to the details screen for the
release/iteration in question (see section 7.2).

To change the release mapping for this test case, you use the buttons (Add, Remove, Remove All)
positioned between the two list-boxes. The <Add> button will move the selected releases from the list of
available on the left to the list of mapped on the right. Similarly the <Remove> and <Remove All> buttons
will remove either the selected or all the releases from the right list-box and add them back to the left list-
box.
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5.2.8. Attachments

In this mode, the main pane displays the list of documents that have been “attached” to the test case. The
documents can be in any format, though SpiraTeam® will only display the icon for certain known types.

Test Steps # Req. Coverage # ion # C Custom Props # Test Runs # Rel * * History #

= Add New | Add Existing | Remove | Refresh | Apply Filter | Clear Filter | [ | Include Source Code Documents

v Document Name 4 ¥ Type 4 ¥ Size A Y Edited By 4 ¥ Edited On AV Author AY DAY
| [ T I —- T e
X Sequence Diagram for Book Mat.pdf UML Diagram 35 KB Joe P Smith 10-May-2006 Fred Bloggs DCo00007

Show rows per page Displaying page faof1

The attachment list includes the filename that was originally uploaded together with the file-size (in KB),
name of the person who attached it and the date uploaded. In addition, if you position the pointer over the
filename and hold it there for a few seconds, a detailed description is displayed as a tooltip.

To actually view the document, simply click on the filename hyperlink and a new web browser window will
open. Depending on the type of file, this window will either display the document or prompt you for a
place to save it on your local computer. To delete an existing attachment from a test case, simply click the
<Delete> button and the attachment will be removed from the list.

If you are using SpiraPlan or SpiraTeam (but not SpiraTest) you can also choose to include file
attachments stored in a linked version control system (e.g. Subversion, CVS, Perforce, etc.) by selecting
the “Include Source Code Documents” option.

To attach a new document to the test case, you need to first click the “Add New” link to display the new
attachment dialog box:

] X X
Add New Document Add New Document Add New Document
Type:® ® Fle O URL O Screenshot Type:* O File @ URL © Screenshot Type® QO File O URL @ Screenshat
Filename:* [ e URL:* Screenshot:*
Descrption | Descriplion

Document Type:* [r v Document Type:"  |Funcsonal Specification v|

Daocument Folder:" | v Document Folder:" |aoot Foue v

Tags [ | Tags Description
Ugload | Cancel

Document Type:"

Document Folder*

Tags

There are three different types of item that can be attached to a test case:

» To upload a file, choose “File” as the type and then click the Browse button and select the file
from your local computer, optionally enter a detailed description then click the <Upload> button.
The document will be copied from your computer and attached to the artifact.

» To attach a web-link (URL) to the artifact, you need to choose “URL" as the type and then enter
the fully qualified URL (e.g. http://mywebsite.com?Document=1), an optional description and then
click the <Upload> button to attach the web-link.

» To attach a screenshot to the artifact, you need to choose “Screenshot” as the type and then
copy the image to your computer’s clipboard (e.g. on Windows computers, the PRINT SCREEN
button captures the current page and adds to the clipboard). Once the image is in the clipboard,
click on the “Paste image from clipboard” hyperlink and the item will appear in the preview
window. You can then fill in the other fields and click <Upload> to attach the image.
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Note: If you are using a non-Windows® computer (e.g. Macintosh®) that doesn’t put file extensions on
filenames (e.g. .xIs for an Excel sheet) automatically, then you will need to manually add the file extension
to the filename before uploading if you want it to be displayed with the correct icon in the attachment list.

You can also associate an existing document (that’s already stored in SpiraTeam) with the test case. To
do that, click on the “Add Existing” hyperlink to bring up the add file association dialog box:

X X
Add Existing Document Add Existing Document
Choose the location of existing document that you'd like to add: Choose the location of existing document that you'd like to add:

@ Documents Source Code Documents @ Source Code

[ Folder | [ ¥ [ Document | Folder | [+ File
% O EditExistingBook - 2 Expected Result Screensh * ¥ 8 Design ] pocument Filename1.doc
# B Misc Documents " = £
e SI CU : | &) Web Page capturehtm | _ /& Development 3 Document Filename10_ppt>
creen Captures J—_] ~ = w1 632 Test B -
63 Specificatis Date Editing Screenshot.jp, Document Filename11.htm
Specifications | o = €3 Documentation =
1 3] Error Logging-in Screen-sh % 63 Training 2] Document Filename2.xls
# 63 Test Scripts N i WY E—— — o r 73] O i
> Add | Cancel Comment:

This is a related document

> Add | Cancel

You can then choose to either associate a document stored in the SpiraTeam Documents repository or
(in the case of SpiraPlan/SpiraTeam but not SpiraTest) from the linked source code repository. In either

case you first select the appropriate folder, and then pick the document(s) from the file list on the right. In
the case of a source code file association you can also add a comment.

5.2.9. History

In this mode, the main pane displays the list of changes that have been performed on the test case
artifact since its creation. An example test case change history is depicted below:

Test Steps # Req. Coverage # ion # C Custom Props # Test Runs # Releases # Attachments # History #
= Refresh | Apply Filter | Clear Filter | Admin View
Change ID 4 ¥ Change Date AV Field Name 4 ¥ Old Value 4 ¥ New Value 4 ¥ Changed By 4¥ Change Type 4 ¥
Il =100 | | || | [Aw- Y] [ ¥
il 2-May-2006 [Step] Expected Result | User taken to first screen | User taken to next screen in wizard | Fred Bloggs Modified
9 2-May-2006 Name Library System v1.0.0 Library System Release 1 Fred Bloggs Modified
3 4-Mar-2005 [Step] Expected Result User taken to first screen Joe P Smith Modified
2 4-Mar-2005 Owner Fred Bloggs Joe P Smith Modified
Show rows per page Displaying page 'a of 1

The change history displays the date that each change was made, together with the fields that were
changed, the old and new values and the person who made the change. This allows a complete audit trail
to be maintained of all changes in the system. In addition, if you are logged in as a project administrator
you can also click on the “Admin View” hyperlink to revert any unwanted changes.
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5.3. Test Step Details

When you click on one of the hyperlinks next to a test step in the test step list (see above), you will be
taken to the test step details screen illustrated below:

- 0 Welcome, System i |vam Infumation System ¥ | | My Profile | Administration | Log Out | [« Halp?
iTeam -
. My Page Project Home Planning Testing Tracking Reporting

Test Cases > Test Step Details | TestSets | TestRuns | Automation Hosts Role: Project Owner
Blsave [HCopy RRefiesh | & Delete

=< Back to Test Step List i
Display: | Al hems v Test Step 3 [TS:000003] - Test Case #TC000002 L7
= &9 Abili N
T;illlulnrjlw(:u:all:ru:wlmok Description’ [~Font - v| [-Se- v| B2 U|EEE|EEEE| T —egOe@
N Step 2 (TS000002) User enters books name and author, then clicks Next
ill Step 3 ¥
@ step 4 (TS000004)
1) s1ep 5 (TS000005) Expected ~Font - v| [-Se- v] Bz u|EEE|SEEE|EE|—eAOC@

Result™: !
User taken to next screen in wizard

Sample Data; [;m '| [--Sln - Yl BIU [E’ll iEEE{F{Pl"[‘sgl ] =[] <>@
Macbeth, William Shakespeare

Incident * [+ ps * b History *

This page is made up of three areas; the left pane is the navigation window, the upper part of the right
pane contains the test step detailed information itself, and the bottom part of the right pane contains
related information about the test step.

The navigation pane consists of a link that will take you back to the test step list, as well as a list of the
peer test steps to the one selected. This latter list is useful as a navigation shortcut; you can quickly view
the detailed information of all the peer test steps by clicking on the navigation links without having to first
return to the test step list page. You can also switch between seeing the list of test steps with the current
filter applier or simply unfiltered.

The top part of the right pane allows you to view and/or edit the details of the particular test step. You can
edit the various fields (description, expected result and sample data) and once you are satisfied with
them, simply click the <Save> button just below the fields to commit the changes. If you want to add a
new test step to the test case, you should click <Save and New> instead.

The lower part of the right pane can be switched between four different views by clicking the appropriate
tab. Initially the pane will be in “Incident Associations” mode, but it can be switched to “Custom
Properties”, “Attachments” and “History” modes if so desired. Each of the views is described separately
below.

5.3.1. Incident Associations

In this mode, the main pane displays a list of any incidents that are associated with this test step. They
can either be linked indirectly due to being logged during a test run, or directly linked after the fact:

Incident Associations # Custom Properties # Attachments # History #

= Add | Delete | Refresh | Apply Filter | Clear Filters | Include Source Code Revisions

v Artifact Name A ¥ Artifact Type AY Created On AV Created By AY Comment AY Artifact# &Y Edit
O | S B] [y Y]] |\
Eﬂ Cannat add a new book to the system | Incident 4-Mov-2003 Joe P Smith Test Run- Ability to create new INODOOoO7
book
Show rows per page Displaying page %of1
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Each incident is displayed with its name, the name of the person who executed the test run or made the
direct association, and a comment that describes why the association was made. In the case of a test
run, the comment will simply contain the name of the test run.

You can perform the following actions on an incident association from this screen:

> Delete — removes the selected incident association. This will only delete the association, not the
incident itself.

>» Refresh — updates the list of associated incidents from the server, useful if other people are
linking incidents to this test step at the same time.

Apply Filter — Applies the entries in the filter boxes to the list of associations

» Clear Filters — Clears the current filter, so that all associations for the current test step are
shown.

> Edit — Clicking the [Edit] button to the right of the associations allows you to edit the comment
field inline directly on this screen.

To create a new association between this test step and an existing incident, simply click the <Add>
hyperlink which will display the “Add New Association” popup dialog box:

X

Add New Association
| Please choose the type of artifact that you want to add an association to:
@ Incident

Please choose the artifact that you want to add an association to:

(a)  Enter Artifact ID: N l:l

(b)  Choose from list:

v [Name
Editing the date on a book is clunky

Doesn't let me add a new category

Quote handling issues throughout

O
[m]
[m]
[m]

] Permissions not updating when changed M

Comment:

> Add | Cancel

You need to choose the specific incident you want to link to, either by choosing the item from a scrolling
selection box, or entering the ID of the incident directly (if known). In either case you can also add a
comment that explains the rationale for the association.

Finally, to delete an existing incident association (except for those due to test runs) select the check-box
next to its name and click the <Delete> hyperlink. This will only delete the association, not the linked
incident itself.

5.3.2. Custom Properties

In this mode, the main pane displays any custom properties that the project owner has defined for test
steps. To learn more about how to setup and configure custom properties for a project, please refer to the
SpiraTest Administration Guide. Assuming that custom properties have been defined for your project, you
will see a list of optional parameters that can be set on the test step. These can be either freetext or drop-
down-lists.
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Incident Associations * Custom Properties # Aftachments # History #

The following are the custom properties of this artifact:

Additional Data:  [ggme Data

Step Type: | Step Type 1 v |

Once you are satisfied with the values for the custom properties, simply click [Save] or [Save and New] to
commit the changes.

5.3.3. Attachments

In this mode, the lower section of the screen displays the list of documents that have been “attached” to
the test step. The documents can be in any format, though SpiraTeam® will only display the icon for
certain known types.

Incident Associations + Custom Props # Altachments # History #

= Add | Delete | Refresh | Apply Filter | Clear Filter | | |Include Source Code Revisions

v Artifact Name AV Artifact Type AY  Creation Date AV Creator 4 ¥ Comment 4 ¥ DAY Edit
| |- Y] B [ Y] | L]
™ Cannot add a new book to the system Incident 4-Mov-2003 Joe P Smith Test Run: Ability to create new book INO000OT

Show rows per page Displaying page "a of 1

The attachment list includes the filename that was originally uploaded together with the file-size (in KB),
name of the person who attached it and the date uploaded. In addition, if you position the pointer over the
filename and hold it there for a few seconds, a detailed description is displayed as a tooltip.

To actually view the document, simply click on the filename hyperlink and a new web browser window will
open. Depending on the type of file, this window will either display the document or prompt you for a
place to save it on your local computer. To remove an existing attachment from a test step, simply click
the <Remove> button and the attachment will be removed from the list.

If you are using SpiraPlan or SpiraTeam (but not SpiraTest) you can also choose to include file
attachments stored in a linked version control system (e.g. Subversion, CVS, Perforce, etc.) by selecting
the “Include Source Code Documents” option.

To attach a new document to the test step, you need to first click the <Add Attachment> link to display the
new attachment dialog box:

%] ] X
Add New Document Add New Document Add New Document
Type:® ® Fle O URL O Screenshot Type:* O File ® URL O Screenshat Type® QO File O URL @ Screenshat
Filename:* e URL:* Screenshot:*
Descrption | Descriplion
Document Type:* v Document Type:™ | Funcoonsl Specification M|
Document Folder: 5 v Document Felder:" |aoot Fode v > Paste image fiom cliphoar
Tags [ ] Tags

Description

> Upload | Cancel > Uload | Cancal |

Document Type: |

Document Fold

Tags

There are three different types of item that can be attached to a test step:
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» To upload a file, choose “File” as the type and then click the Browse button and select the file
from your local computer, optionally enter a detailed description then click the <Upload> button.
The document will be copied from your computer and attached to the artifact.

» To attach a web-link (URL) to the artifact, you need to choose “URL" as the type and then enter

the fully qualified URL (e.g. http://mywebsite.com?Document=1), an optional description and then
click the <Upload> button to attach the web-link.

» To attach a screenshot to the artifact, you need to choose “Screenshot” as the type and then
copy the image to your computer’s clipboard (e.g. on Windows computers, the PRINT SCREEN
button captures the current page and adds to the clipboard). Once the image is in the clipboard,
click on the “Paste image from clipboard” hyperlink and the item will appear in the preview
window. You can then fill in the other fields and click <Upload> to attach the image.

Note: If you are using a hon-Windows® computer (e.g. Macintosh®) that doesn'’t put file extensions on
filenames (e.g. .xls for an Excel sheet) automatically, then you will need to manually add the file extension
to the filename before uploading if you want it to be displayed with the correct icon in the attachment list.

You can also associate an existing document (that's already stored in SpiraTeam) with the test step. To
do that, click on the “Add Existing” hyperlink to bring up the add file association dialog box:

X X
Add Existing Document Add Existing Document
Choose the location of existing document that you'd like to add: Choose the location of existing document that you'd like to add:
@ Documents Source Code Documents @ Source Code
[ Folder | [ ¥ [ Document | Folder | [+ File
% O EditExistingBook - 2 Expected Result Screensh * % 83 Design ] Document Filenamet.doc

# B Misc Documents

= B> Sereen Captures ! £ Web Page capture.htm L = & Development | 3 Document Filename10_ppt> -

‘ i b + 0 Test -
| i atinn e 2 pate Editing Screenshot.jp & 2 Document Filename 11 htm
1 B3 Specifications = (3 Documentation
A} ; e [T
% B3 Test Res 2 Error Logging-in Screen-sh % 63 Training Document Filename2 xls
# 3 Test Scripts N P — [ P ———— -
> Add | Cancel Comment:

This is a related document

> Add | Cancel

You can then choose to either associate a document stored in the SpiraTeam Documents repository or
(in the case of SpiraPlan/SpiraTeam but not SpiraTest) from the linked source code repository. In either
case you first select the appropriate folder, and then pick the document(s) from the file list on the right. In
the case of a source code file association you can also add a comment.

5.3.4. History

In this mode, the main pane displays the list of changes that have been performed on the test step artifact
since its creation. An example test step change history is depicted below:

Incident Associations # Custom Props # Aftachments # History #
= Refresh | Apply Filter | Clear Filter
v ChangelD AY Change Date AV Field Name A ¥ Old Value 4 ¥ New Value 4 ¥ Changed By 4 ¥ Change Type A Y

| | | 2] | | | il | [Aw- Y] [P ¥

11 2-May-2006 Expected Result User taken to first User taken to next screen in Fred Bloggs Modified

screen wizard

3 4-Mar-2005 Expected Result User taken to first screen Joe P Smith Modified

Shuwrows per page Displaying page"aoH
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The change history displays the date that each change was made, together with the fields that were
changed, the old and new values and the person who made the change. This allows a complete audit trail
to be maintained of all changes in the system. In addition, if you are logged in as a project administrator
you can also click on the “Admin View” hyperlink to revert any unwanted changes.

5.4. Execute Test Case(s)

This section describes how a tester can follow the steps defined for a series of test cases and record
what actually happened in the process. In addition, recorded failures of test cases can be used to
automatically generate new incidents that will be added to the incident tracking module (see section 6).

You start test case execution in SpiraTeam by either selecting test cases or test sets on their respective
page(s) and then clicking the <Execute> button, or by clicking the “Execute” link on the test cases / test
sets listed on your personalized home page under “My Test Cases” or “My Test Sets”. If you execute a
test set then the values of the selected release and custom list properties for the test run are
automatically populated from the test set, whereas if you directly execute a test case itself, those values
can be chosen by the tester.

Regardless of the route taken to launch the test execution module, the first screen that will be displayed
will look like the following:

Welcome, System Administrator | Library irformation System "J | My Profile | Administration | Log Cut | ) Help?

raTeam

. My Page Project Home Planning Testing Tracking Reporting
Test Cases > Test Case Execution | TestSets | TestRuns | Automation Hosts Role: Project Owner

pass | [Pass All | | Blocked ©| | Caution | [* Pause | [» Finsh_| Reiease # 1.2.0.0

Test Execution Wizard

=< Back To Tests
=1 &%) Testing New Functionality (TX5)
=[] B Ability to create new author |

= "}1 Step 1 - (TC16) Please Choose the Release To Execute Against
[ {9 Step 2 - (TCAT
T o

Release”

Build: = Mo - ¥|
[ Now enter the following properties for this test run:
= O L"_] Person loses book and need:
["1 B3 Adding new book and author Nates:
Web Browser. | - None - ~
Operating Systermn | Hone - =

{Note: Any custom properties that are read-only have already been populated from the Test Set.)

| Cancel |[» Mext

Before actually executing the test scripts, you need to select the release (and optionally the specific build)
of the system that you will be testing against and any test run custom properties that have been defined
by the project owner. This ensures that the resulting test runs and incidents are associated with the
correct release of the system, and that the test runs are mapped to the appropriate custom properties
(e.g. operating system, platform, browser, etc.).

If you have not configured any releases for the project, then the release drop-down list will be disabled
and the test runs/incidents will not be associated with any particular release. If the test run was launched
from a test set, the release and any list custom properties will be pre-populated from the test set itself and
will not be changeable on this screen (unless they weren't set by the test set).

Once you have chosen the appropriate release name and/or custom properties, click the <Next> button to
begin executing test steps:
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Welcome, System Administrator | Library Information System "| | My Profile | Administration | Log Out | | Searc <]

spiraTeam’

My Page Project Home Planning Tracking
Test Cases > Test Case Execution | Test Sets | Test Runs | Automation Hosts

T Blocked ©| [Caution I| [Fail X| | [~ Pause | [> Finish | Release # 1.2.0.0

= %5 Testing New Functionality (TX5) Ability to create new author (TC000004)
208 Ability to create new author | Tests that the user can create a new author record in the system
[71 0% step 1 - (TC16)
] ¥ Step 2 - (TC17)

Reporting

: ﬂ;] Step 3 - (TC4) Step 1 - Please follow the directions outlined in the box below:
. T Stepd - 1C4) User opens up browser and enters application URL: http:/fwww.libraryinformationsystem.com/beta

[T Step s - (TC4)

[ @) step 6 - (TC4)
# [] & Ability to reassign book to dil
a[d D_] Person loses book and needs

0@ Step 1 - (TC16) Expected Result: Sample Data:
[ @ Step 2 - (TC17 The browser loads the login web page http://www.libraryinformationsystem.com/beta

[ ®) step 3 - TC12)
[ @ step d - (TC12)
[ ¥ step 5 - (TC12)

s - Actual Result - Please enter the actual test result if it differs, then click the appropriate button:
Ca _]ﬂddll’lg new book and author

~ Fort - v ~Sze- ¥ B U|EEE|EEEE e —egdo@

The screen is divided up into four main elements:

» The left-hand navigation pane contains the list of test cases and test steps for the currently
executing test case. You can click on the various links to move between the test cases and/or test
steps. In addition, each test case and test step has a colored square next to the name that
indicates its status (green = “Passed”, yellow = “Blocked”, orange = “Caution”, red = “Failed”, gray
= “Not Run”) in the current test run. If any of the steps are marked as “Failed”, "Blocked”, or
“Caution” then the overall test case is marked with that status; if all the test steps passed, then
the overall test case is marked as “Passed”; any other case results in the test case being marked
as “Not Run”.

» The main pane displays the details of the test case together with the current test step. As the
tester you would read the name and description of the test case, then read the description of the
test step, carry out the instructions on the system you are testing, and then compare the results
with those listed as expected. As described below, depending on how the actual system
responds, you will use the buttons on the page to record what actually happened.

> Below the main pane there are two optional sections. The first one allows you to log an incident in
the system associated with the test step. For failures this will typically be used to log a bug
relating to the failure. However even if you pass a step you can still log an incident, which may be
useful for logging non-critical cosmetic items that are not serious enough for a failure to be
recorded. This tab also displays any pre-existing incidents that were associated with the test step
being viewed.

>» The second tab displays a list of attachments that are related to the current test case and/or test
step. This list initially contains any documents that have been attached to either the test case in
general or the test step in particular. However as you perform the testing, you can attach
additional documents to this list that are relevant to the test results (e.g. screenshots of an error
page); these attached documents will be associated with both the test run itself and any incidents
that are created.
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If the expected results are indeed observed, then you simply need to click the <Pass> button to mark the
test step as passed, and advance to the next test step, or if all the steps have passed, you can click
<Pass All> to pass all the steps at once. This is illustrated in the screen shot below:

A~ . Welcome, System Admini | Ubrary kformation Sysem ¥ | | My Profile | Administration | Log Out |[Search | &)
spiraTeam

My Page Project Home Planning Testing Tracking Reporting

Test Cases > Test Case Execution | Test Sets | Test Runs | Automatio

<< Back To Tests o | [Passv] [passin o] LFail x| Release # 1.2.0.0

%5 Testing New Functionality (TX5) Person loses book and needs to report loss (TC000012)
= M 7] Ability to create new author (
¥ () Step 1 - (TC16)
¥ ) step 2 - TC17)
W@ step3 - rca) Step 1 - Please follow the directions outlined in the box below:

Q| Stepd - (TC4) User opens up browser and enters application URL: hitp:/fwww.libraryinformationsystem.com/beta
M @) Step 5 - (TC4)
¥ @ steps - (1)
&[] & Ability to reassign book to dil
=[] 1 Person loses book and needs

[71 49 Step 1 - (TC16) Expected Result: Sample Data:
[ (¥ Step 2 - CA7 The browser loads the login web page http:/fwnw. libraryinformationsystem.com/beta
Step 3 - (TC12)
[ ¥ stepa - rC12)
C1 @) Steps - IC12 Actual Result - Please enter the actual test result if it differs. then click the appropriate button:
# ] ¥ Adding new book and author |-|.—m- ‘r| |.§m. V| B I U l!’l E;;{t{t"}?ﬁ.Q'_WEDo

This will change the icon in the left-hand navigation bar into a green square with a check mark in it. Once
all the test steps have passed, you will be automatically be taken to the first step in the next test; if it is the
last test case being executed, the <Finish> button will be displayed instead.

If the actual results differ from those expected, you need to enter a description of the result observed and
click the <Fail>, <Blocked> or <Caution> button; this is illustrated in the screen-shot below:

A T o Welcome, System Admini [ Lbrary nformation System ¥ | My Profile | Administration | Log Out | [Search | &)
spiraTeam
— My Page Project Home Planning Testing Tracking Reporting

Test Cases > Test Case Execution | Tes s | TestRuns | Awutomation Hosts

<< Back To Tests v [passv] [passn y] [rai] | Release # 1.20.0

& &) Testing New Functionality (TX5) Person loses book and needs to report loss (TC000012)
= & B Ability to create new author (
¥ @) step 1 - (1C16)
W ™ step2 - 17
¥ @) step3 - (1C4) Step 1 - Please follow the directions outlined in the box below:
¥l @) step4 - rC4) User opens up browser and enters application URL: http:/fwww libraryinformationsystem.com/beta

Step 5 - (TC4)
¥ ) step 6 - (TC4)
=[] ) Ability to reassign book to dil
= 71 Person loses book and needs
[ ¥ step 1 - (TC16) Expected Result: Sample Data:
O m Step 2 - (ICAT The browser loads the login web page http:/fwww library tem. ta
Cl @ step3-(1C12)
[ ® stepd - (TC12)
O Step 5 - (TC12) Actual Result - Please enter the actual test result if it differs, then click the appropriate button:
(7] £ Adding new book and author [ ort - v [se- v] Bru|EE=E|EEEE|hE|—epgOo@

The screen displays a 404 error message page.




Unlike the <Pass> button, if you don't enter a description of the actual result, the system will display an
error message and re-prompt you again for input. In the case of a failure, both the individual test step and
the overall test case will be marked with a red square containing a cross. Similarly, in the case of a
blocked test case, they will be marked with a yellow square, and in the case of a caution, they will be
marked with an orange square. Once marking a test step as <Failed>, <Caution>, or <Blocked>, you will
automatically be taken to the first test step in the next test case; or if it is the last test case being
executed, the <Finish> button will be displayed instead.

In addition to logging the failure, you can optionally choose to have the failure automatically result in the
creation of a new incident. This is achieved by clicking on the Incident tab and entering a name, type,
priority, severity (and any custom properties) for the new incident before clicking the
<Fail/Caution/Blocked> button:

Actual Result - Please enter the actual test result if it differs, then click the appropriate button:
[~ Fornt - M [-Sz=- v] Bl U|E==|SitEE || —epdo@

"

The screen displays a 404 error message page

Logged Incidents Attachments

Please enter the following information to log an incident with this test step:

Name:* |Cannot login to the web page correctly |

Type:* |Bug v Priarity- |1-Crihc:a| "|

Severity: |2 - High v |

Also enter the following custom properties for this new incident:

Operating System: | Windaows Vista v |

The other information needed for the new incident is automatically populated from the test step details.
The newly created incident will also be linked to the test step, allowing traceability from within the
incidents module. The functionality for managing incidents is described in more detail in section 6.

If you need to attach documents to the test run (e.g. screenshots of the error message), you just need to
select the Attachments tab and then choose the option to upload the necessary documents, attach the
appropriate URLS, or paste in the appropriate screen capture.

Note that the entire test run is saved once you first start execution, so you can always step away from
your computer and then resume testing at a later date by locating the test run on your ‘My Page’ under
‘My Pending Test Runs’ and choosing to resume testing.

5.5. Test Run List

When you click on the Testing > Test Runs global navigation link, you will initially be taken to the test run
list screen illustrated below:
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Role: Manager
Displaying 1 - 15 out of 19 test run(s) for this project
v 4 TestRunName A Y EndDate AV TestSet AY  Release AY  Execution Status AY Est.Dur. A¥ Act. Dur. A¥ Web Browser A¥ Operating System AY TestRun# AY
B | I 8 [- v] [ v [ ] | I [ ] [ ][]
1| 'ED Aty to create new book 4-Dec-2003 “ailed 12 TRO00018
B | | Aty 1o ed existing book 4Dec-2003 (120 TRO0DO13
71| D ability to create new author 4.Dec2003 12 TRO0D020
B | B apiity to create new author 3Dec-2003 120 TROODD1T
| 0 Aty 1o <o existing book 3.Dec-2003 [ 1.2n TRODDO16
T B2 atulity to craate new boak 3-Dec-2003 1.2n TROODD1S
[ | .hAQh;}( to ed existing book 2-Dec-2003 RED TRO00014
F1| B Ability to crsate new book 2Dec-2003 1.2h TRO00013
P1| | Aty to e existing aahor 1.Dec-2003 [ 1.6n TRO0DOT1
7| B Aility to edit existing book 1-Dec-2003 0.8h TRO0DO10
71| |3 author management 1-Dec-2003 1.5 TRODDDOS
7 'B)Bosk management 1.Dec-2003 sty Jo for 10,10 Passed 01h 150 TRO0DOOT
Relegae 1.1
|2 Abilty to reassion book to diferent author | 1-Dec-2003 | Testing Cycle for | 10,10 Passed 0.h EED TRODDO0G
Release 1.1
B | B Ability to adit existing author 1-Dec-2003 1020 Passed 0.1h 1.5h TRO0000S
P | [T Aty to create new author 1Dec2003 | Testing Cyclefor 1000 _ 0.1h 15k TRODDO04
Relesse 1.0
Show (15 | rows per page 4 « Displaying page [1  |=of2em

The test run list screen displays all the individual test executions performed in the current project, in a
filterable, sortable grid. The grid displays the test run number together with fields such as execution
status, name, assigned tester, execution date, test set, specified release, etc. The choice of columns
displayed is configurable per-user, per-project, giving extensive flexibility when it comes to viewing and
searching test runs.

In addition, you can view a more detailed description of the test run by positioning the mouse pointer
over the test run name hyperlink and waiting for the popup “tooltip” to appear. If you click on the test run
hyperlink, you will be taken to the test run details page described in the next section. Clicking on any of
the pagination links at the bottom of the page will advance you to the next set of test runs in the list
according to the applied filter and sort-order. There is also a drop-down-list at the bottom of the page
which allows you to specify how many rows should be displayed in each page, helping accommodate
different user preferences.

5.5.1. Sorting and Filtering
You can easily filter and sort the list of test runs as illustrated in the screen-shot below:

e » ‘Welcome, System Administrator | My Profile | Administration | Log.Qut | Help?
spiraTeam S
— My Page Project Home Planning Testing Tracking Reparting

s | TestSets | TestRuns Role: Project Owner

Te
=y V

Displaying 1 - 5 out of 5 test run{s) for this project

« 4 TestRun Name &Y Execution Date oY TestSet AY  Type &Y Tester AY  Releose AY  Status A¥ Est. Dur. AY Act.Dur. AY Run# AY  Edit

C3) [ Il B  [aw- v] [y v [y ][ ey v][re Y] I | vr[ ] |[=her ]

O B3 bty to create new book | 1-Dec-2003 Automated Fred Bloggs 1000 0.2h 12h TRO0DO12

O B Ability to craate new author | 1-Dec-2003 Testing Cycle for | Manual Joe P Smith 1000 0.1h 15h TROOGO04

| Release 10 |
1 g | BD Abilty 1o create new book | 1-Dec-2003 Testing Cycle for | Manual JoePSmith 1000 0.2h 1.3 TRO00001
Release 110

0 | ') Ability to edit existing book | 4-Dec-2003 Automated Fred Bloggs 1.1.0.0.0003 0.1h 12h TRO00019
|01 | 2 abilty 1o creste new book | 4-Dec-2003 [ |Automated  Fred Bloggs | 1.1.0.0.0003 0.0 120 TRO00018
Show 15 ¥ | rows per page 4 Displaying page | 7o 1 b

%) Refresh  £3 Delete

To filter the list by any of the visible fields, you simply choose an item from the appropriate drop-down list,
and for the other fields, you enter a free-text phrase then click <Filter> or press the <ENTER> key to




apply the different filters. Note that the name field is searched using a “LIKE” comparison, so that
searching for “database” would include any item with the word database in the name.

To change the column that is sorted, or to change the direction of the current sort, simply click on the
up/down arrow icon in the appropriate column. The currently sorted column is indicated by the larger,
white arrow with the back-border. In the screen-shot above, we have filtered on test runs that have failed,
sorted in order of increasing release version number.

Clicking on Filter > Clear Filter removes any set filters and expands the test run list to display all test runs
for the current project, and clicking on Filter > Save Filter allows you to save the filter to your ‘My Page’
for use in the future. The list of saved filters can also be retrieved by clicking Filter > Retrieve Filter.

5.5.2. Printing Items

To quickly print a single test run or list of test runs you can select the items’ checkboxes and then click
the Print icon. This will display a popup window containing a printable version of the selected items.

5.6. Test Run Details

When you click on any of the individual test runs in the test run list, you are taken to the Test Run details
page (not to be confused with the Test Case details page!) shown below:

T " Welcome, System Administrator | Library Information System "J | My Profile | Administration | Log Out | 3 Help?

My Page Project Home Planning Testing Tracking Reporting

TestCases | Test Sets | Test Runs > Test Run Details | Automation Hosts Role: Project Owner

<< Back to Test Run List il
Display: | Curent Fiter b Test Run: 21 Ability to create new book [TR:000001]

83 2003 (TR 1) Tests that the user can create a new book in the system
%1 1.06c-2003 (TRO00D12)
B 1.0ec-2003 (TRO0000Z)

E—] 1-Dec-2003 (TRO00003) Release # | 1.0.0.0 - Library System Flelease 1 Y& Estimated Duration: |0.2 | hours
21 1-Dec-2003 (TRO00004) ) y

1 1.Dec-2003 (TR000005) jlestn Nam e Joe P S M| Actual Duration: 13 [ hours
L:’_] 1-Dec-2003 (TROODO0E) Test Set Testing Cycle for Release 1.0 & Execution Date: 12M1/2003 10:45:20 AM
B

=] 1:Dec-2003 (TR0000D7) Test Case #:7 TC000002 B3 Execution Status:*

2] 1-Dec-2003 (TROD000S)

B 1-Dec-2003 (TROGO010) Build: ~MNane - v Test Run Type:* Manual

¥ 1.0ec-2003 TR000011)

B 2.0ec-2003 (TRO00013) TestRun Steps * Autoemation Custom Props * Atiachments %

EAETRRETLEREIEELTY

This page consists of three panes:

» The left hand navigation pane displays a list of related test runs. The display dropdown will let you
choose whether the list contains test runs that are for the same release, test case or test set, or
are just a filtered/unfiltered list based on your last search in the main test run list page.

» The main pane displays the details of the test run itself (hame, description, release, test set,
estimated and actual duration, tester name, test run type, automation host, etc.)

» The tab-control displays the list of test run steps (populated if a manual run executed by a user),
the automated test results (populated by an test automation engine such as NUnit, JUnit,
QuickTest Pro, etc.), any custom properties set for the run, and a list of any
documents/URLs/screenshots that were attached to the test results.

5.6.1. Editing a Test Run

When reviewing the test run, you may find that you need to change the results of the test run (e.g. the
user selected the wrong release or custom property value). Many of the fields are editable at a later date,
and to make changes, just modify the appropriate fields and click [Save].
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5.6.2. Deleting the Test Run

If you need to delete a test run that was erroneously captured, all you need to do is click on the link to
access the invalid test run and then click the <Delete> button to remove it from the system. This will then
force the system to update the status of the test case itself from the other logged test runs.

5.6.3. Test Run Steps

In the case of a manual test run, this tab displays all the steps of the test case as they appeared during
the test run in question. This means that if the test steps were changed after running the test, the list here
will reflect the original information.

Test Run Steps # Automation Custom Properties % Attachments #

Run Step # Test Step Description Expected Result Sample Data Test Case/Step Actual Result Status

RS000001 | User logs in to application User taken to main TCO00017 / TS000019 Passed
menu screen

RS000002 | User clicks link to create book User taken to first TC000002 / TS000002 Passed
screen in wizard

RS000003 | User enters books name and User taken to next Macheth, William TCO00002 / TSO00003 | An error page is displayed - "No such object [Failed

author, then clicks Next screen in wizard Shakespeare or with block variable at line 473"
=View Incidents

Each test run step is displayed along with the description, expected result, suggested sample data, a link
back to the current version of the test step in question, the actual result and the execution status for this
step in this particular test run. Where an actual result was recorded, you will have an additional hyperlink
“View Incidents” displayed. This allows you to view any incidents that are associated with this particular
test run step:

Incidents List for Test Run Step: RS000003 X

Incident# Name Type Status Priority Severity Owned By Detected On Detected By
IN000007 | % Cannot add a new book to the system | Bug | Assigned |1 - Critical 3 - Medium | Joe P Smith | 4-Nov-2003 Joe P Smith

Clicking on the link will open up a popup dialog box that displays a list of all the incidents associated with
the selected test run step. Each of the incidents listed will reflect the most up-to-date information
regarding that incident, including its type, status, priority, name, assigned owner, detection date and who
first detected it. Clicking on the incident number hyperlink will take you to the details page for that
incident, which is described in section 6.2.

5.6.4. Automation

In the case of an automated test run, this tab will display the details of the test run as reported from the
test runner application. These details will vary depending on the type of automated tool being used, but
typically they include the name of the automated test runner, the number of assertions raised, the name
of the corresponding test case in the tool, the status of the test run and a detailed error message, and
stack-trace in the case of a failure. An example test run as reported from the NUnit automated test runner
is illustrated below:
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Test Run Steps Automation # Custom Properties # Attachments

Runner Name: NUnit Assert Count: 1
Message: Expected 1 but 2 was found Test Name: _01_TestCreateBook
Details: Object variable or With block variable not set

Description: An unhandled exception occurred during the execution of the current web request. Please review the stack
trace for more information about the error and where it originated in the code

Exception Details: System. NullReferenceException: Object variable or With block variable not set

Source Error

Line 215: Response Write ("<option selected value="" & MonthCheck(MonthCount) & ">" & MonthCount & "</option="
& vbCrLf)

Line 216:Else

Line 217: Response.Write ("<option value=""" & MonthCheck(MonthCount) & "">" & MonthCount & "</option=" & vbCrLf)
Line 218:End If

Line 219

Details on how to use SpiraTeam® in conjunction with an automated testing tool are provided in the
SpiraTeam® Automated Testing Integration Guide, which can be downloaded from the Inflectra® website.

5.6.5. Custom Properties

In this mode, the tab displays any custom properties that the project owner has defined for test runs. To
learn more about how to setup and configure custom properties for a project, please refer to the
SpiraTest Administration Guide. Assuming that custom properties have been defined for your project, you
will see a list of optional parameters that have been set during the test run:

Test Run Steps Automation # Custom Properties # Aftachments

The following are the custom properties of this artifact:

Notes:
Web Browser: |Opem V|
Operating System: |Windows 2003 V|

For test runs, custom properties are most commonly used to capture and record the system configuration
that the test was performed on — for example the operating system, hardware platform, and web-browser.

5.6.6. Attachments

In this mode, the lower section of the screen displays the list of documents that have been “attached” to
the test run. The documents can be in any format, though SpiraTeam® will only display the icon for
certain known types.

Test Run Steps # Automation Custom Props # Attachments #
= Add New | Add Existing | | Refresh | Apply Filter | Clear Filter | Include Source Code Documents
v Document Name 4 ¥ Type AY Size AV Edited By 4 ¥ Edited On AV Author AV DAY
| | S B | [P Y] ] B [ Y] oc[ ]
B Error Loaging-in Screen-shot.gif Screen Shot 48 KB Fred Bloggs 24-Apr-2006 Fred Bloggs DCOo00003
Show TowWs per page Displaying page "a of 1

The attachment list includes the filename that was originally uploaded together with the file-size (in KB),
name of the person who attached it and the date uploaded. In addition, if you position the pointer over the
filename and hold it there for a few seconds, a detailed description is displayed as a tooltip.
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To actually view the document, simply click on the filename hyperlink and a new web browser window will
open. Depending on the type of file, this window will either display the document or prompt you for a
place to save it on your local computer. To remove an existing attachment from a test run, simply click the
<Remove> button and the attachment will be removed from the list.

If you are using SpiraPlan or SpiraTeam (but not SpiraTest) you can also choose to include file
attachments stored in a linked version control system (e.g. Subversion, CVS, Perforce, etc.) by selecting
the “Include Source Code Documents” option.

To attach a new document or web link to the test run, you need to click on the “Add New” hyperlink to
open the “Add Attachment” dialog box. There are three different types of item that can be attached to a
test run:

» To upload a file, choose “File” as the type and then click the Browse button and select the file
from your local computer, optionally enter a detailed description then click the <Upload> button.
The document will be copied from your computer and attached to the artifact.

» To attach a web-link (URL) to the artifact, you need to choose “URL" as the type and then enter
the fully qualified URL (e.g. http://mywebsite.com?Document=1), an optional description and then
click the <Upload> button to attach the web-link.

» To attach a screenshot to the artifact, you need to choose “Screenshot” as the type and then
copy the image to your computer’s clipboard (e.g. on Windows computers, the PRINT SCREEN
button captures the current page and adds to the clipboard). Once the image is in the clipboard,
click on the “Paste image from clipboard” hyperlink and the item will appear in the preview
window. You can then fill in the other fields and click <Upload> to attach the image.

Note: If you are using a hon-Windows® computer (e.g. Macintosh®) that doesn’t put file extensions on
filenames (e.g. .xls for an Excel sheet) automatically, then you will need to manually add the file extension
to the filename before uploading if you want it to be displayed with the correct icon in the attachment list.

You can also associate an existing document (that's already stored in SpiraTeam) with the test run. To do
that, click on the “Add Existing” hyperlink to bring up the add file association dialog box. You can then
choose to either associate a document stored in the SpiraTeam Documents repository or (in the case of
SpiraPlan/SpiraTeam but not SpiraTest) from the linked source code repository. In either case you first
select the appropriate folder, and then pick the document(s) from the file list on the right. In the case of a
source code file association you can also add a comment.
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http://mywebsite.com/?Document=1

5.7. Test Set List

As well as being able to organize test cases into folders, you can also create separate groupings of test
cases called test sets which can then be assigned to testers as a package. To view the list of test sets for
a project, click on Testing > Test Sets in the global navigation:

Welcome, System Administrator | Ubrary information System v| | My Profile | Admanistration | Log Qut || S¢ 2 Help?

Tracking

Project Home Reporting

Planning

Execution Status  Planned Date Last Executed Cwmer Status o Edit

[ [ v] | m [ m [F= ] [y~ 7] ™ | [fem]
' 5.Fob-2007 In Progress TX000008 [+ Edit |
5-Feb-2007 1-Dec-2003 Joe P Smith In Progress THO0000 » Edit |

7-Feb-2007 1-Dec-2003 Jae P Smith Mot Started TH000002 [+ Edit |

= 10-Feb-2007 19-Dec-2011 Fred Bloggs In Progress TX000005 |= EdT_

Fred Bloggs Deferred TX000006 '+ Edit |

Completed TX00000% hggig_

J Fred Bloggs Completed TX000003
3 [ Completed THODOOO4 s it

sion Testing for ¥

Show [15 7| rows per page < « Displaying page |1 |wof 19 »

The test set list consists of hierarchical list of all the test sets in the current project organized into folders.
When you create a new project, this list will initially be empty, and you will have to use the <Insert> button
to start adding test sets to the system.

Each test set is listed along with the number of test cases contained (in parenthesis), the aggregate
execution status of the contained test cases (using a graphical bar-chart), the date that the test set has
been scheduled to be executed (planned date), the date that it was last executed, the person currently
assigned to execute the test set, the status and the test set id. Clicking on a test set’s hyperlink will take
you to the test set details page for the item in question.

5.7.1. Insert

Hovering over the <Insert> button brings up a secondary menu that allows you to choose whether to
insert a test set or a test set folder (if you just click Insert it defaults to inserting a test set). In either case,
it will insert the new folder / test set above the currently selected item — i.e. the one whose check-box has
been selected, at the same level in the hierarchy. If you want to insert a new test set or sub-folder inside
an existing folder, use the Insert > Child Test Set or Insert > Sub Folder option instead. If you insert a new
folder / test set without first selected an existing item from the list, the new test set will simply be inserted
at the end of the list.

5.7.2. Indent / Outdent

Clicking on the <Indent> button indents all the test folders / test sets whose check-boxes have been
selected. You cannot indent a test set or folder if it is below a test set, as test sets are not allowed to have
child items. Clicking on the <Outdent> button de-indents all the test folders / test sets whose check-boxes
have been selected.

5.7.3. Delete

Clicking on the <Delete> button deletes the currently selected test sets. It will delete the association
between the test set and its contained test cases, but it will not delete the test cases themselves.

5.7.4. Execute

Clicking on the <Execute> button executes all the test sets selected. The test execution functionality of
SpiraTeam® is explained in more detail in section 5.3.
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5.7.5. Refresh

Clicking on the <Refresh> button simply reloads the list of test sets. This is useful if other people are
making changes to the test set list and you want to make sure that you have the most current version.

5.7.6. Edit

Each test set in the list has an <Edit> button display in its right-most column. When you click this button
or just double-click on any of the cells in the row, you change the item from “View” mode to “Edit” mode.
The various columns are made editable, and <Update> <Cancel> buttons are displayed in the last
column:

Welcome, System Adminisirator | Ubrary Information System '! | My Profile | Administration | Log Out || Se (<)

— My Page Project Home Planning Testing Tracking Reporting
TestCases | Test Sets | TestRuns | Automation Hosts Role: Project Owner

« @ Test Set Name Execution Status  Planned Date Last Executed  Owner Status i Edit
] ) — - N — "3 D .
= By Functional Test Sets 5.Feb-2007 In Progress TX000008 m
7 g 54 [ Testing Cycle for Release 10 = i | !2_5‘?99?_?_E 1-Dec-2003 [JoePSmth ¥|[m] [Pogess ¥ =2 [+ update ||+ cancel
i [rawr E]  [10ec2M3 [[loPSmii V]  [[WeSahd V]
10-Feb-2007 19-Dec-2011 Fred Bloggs In Progress THOO0005 [ Edi |
Fred Bloggs Deferred THO00006  [“Edet |
Completed TX000009 [+ Edit |
Fred Bloggs Completed TA000003 » Edit |
5 Completed TAOOO004 m]
Show i 1 'I rows per page <4 Displaying page 1 [mof 10>

If you click <Edit> on more than one row, the <Update> and <Cancel> buttons are only displayed on the
first row, and you can make changes to all the editable rows and then update the changes by clicking the
one <Update> button. Also, if you want to make the same change to multiple rows (e.g. to change the
owner of five test sets from “Fred Bloggs” to “Joe Smith”), you can click on the “fill” icon to the right of the
editable item, which will propagate the new value to all editable items in the same column.

If you want to edit lots of items, first select their checkboxes and then click the [Edit] button on the same
row as the Filters and it will switch all the selected items into edit mode.

When you have made your updates, you can either click <Update> to commit the changes, or <Cancel>
to revert back to the original information. Alternatively, pressing the <ENTER> key will commit the
changes and pressing the <ESCAPE> key will cancel the changes.

5.7.7. Show Level

Choosing an indent level from the ‘Show Level’ drop down box allows you to quickly and easily view the
entire test set list at a specific indent level. For example you may want to see all test sets drilled-down to
the third level of detail. To do this you would simply choose ‘Level 3’ from the list, and the test sets will be
expanded accordingly

5.7.8. Show / Hide Columns

This drop-down list allows you to change the fields that are displayed in the test set list as columns for the
current project. To show a column that is not already displayed, simply select that column from the list of
“Show...” column names and to hide an existing column, simply select that column from the list of
“Hide...” column names. This is stored on a per-project basis, so you can have different display settings
for each project that you are a member of. The fields can be any of the built-in fields or any of the custom
properties set up by the project owner.

5.7.9. Filtering
You can easily filter the list of test sets as illustrated in the screen-shot below:
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Welcome, System Administrator [ Ubrary fomation System

My Page Project Home Planning Testing Tracking Reporting
Test Cases | Test Sets | TestBuns | Automation Hosts

¥ 4 Test Set Name Execution Status Planned Date Last Executed Owner Status V] Edit
— |posred v] [ I [ @& [ v [#- ¥ w | [eEa]
= B Functional Test Sets 5.Fab-2007 In Progress TX000008  Edit |

X o E

5-Feb-2007 +Dec-2003 Joe P Smith In Frogress THO00001 [+ Edit |
¥ 10-Feb-2007 19-Dec-2011 Fred Bloggs In Progress TXODDOOS - Ed't_i
= B= Regression Test Sets Completed TXO00009 v Edit |

Show 15 ?irows per page <« Displaying page [1 | %ol 1»»

To filter the list by any of the displayed columns, you either choose an item from the appropriate drop-
down list or enter a free-text phrase (depending on the type of field) then click <Filter> or press the
<ENTER> key to apply the different filters. Note that the name field is searched using a “LIKE”
comparison, so that searching for “database” would include any item with the word database in the name.
The other freetext fields need to be exact matches (e.g. dates, test set numbers). In the screen-shot
above, we are filtering on test sets that contain at least one failed test case.

In addition, if you have a set of filters that you plan on using on a regular basis, you can choose the option
Filter > Save Filter to add the current filter to the list of saved filters that appear on your ‘My Page’. The
list of saved filters can also be retrieved by clicking Filter > Retrieve Filter.

5.7.10. Copying Test Sets

To copy one or more test sets, simply select the check-boxes of the test sets you want to copy and then
select the Edit > Copy menu option. This will copy the current test set selection to the clipboard. Then you
should select the place where you want the test sets to be inserted and choose the Edit > Paste option.

The test sets will now be copied into the destination location you specified. The name of the copied test
sets will be prefixed with “Copy of...” to distinguish them from the originals.

5.7.11. Moving Test Sets
To move test sets in the hierarchy, there are two options:

1. Click on the icon the test set/folder you want to move and then drag the icon to the location you
want it moved. The background of the destination location will change as the icon is dragged over
it to illustrate where it will be inserted.

Once you have the test set/folder positioned at the correct place that you want it inserted, just
release the mouse button and the test set list will be refreshed, with the item moved to the
desired location. To move multiple items simply select their checkboxes and then drag-and-drop
one of the selected items.

2. Alternatively you can simply select the check-boxes of the test sets you want to move and then
select the Edit > Cut menu option. This will cut the current test set selection to the clipboard.
Then you should select the place where you want the test sets to be inserted and choose the Edit
> Paste option. The test sets will now be moved into the destination location you specified.

5.7.12. Printing Items

To quickly print a single test set, test set folder or list of test sets you can select the items’ checkboxes
and then click Tools > Print Items. This will display a popup window containing a printable version of the
selected items.
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5.7.13. Right-Click Context Menu

SpiraTeam® provides a shortcut — called the context menu - for accessing some of the most commonly
used functions, so that you don’t need to move your mouse up to the toolbar each time. To access the
context menu, right-click on any of the rows in the test set list and the following menu will be displayed:

EE Functional Test Sets

& Testing Cycle for Release 1

I} Open ltem
L{%f Open in New Tab

=] Testing Cycle for Release 1
L_] Testing New Functionality (4
X5 Exploratory Testing (2)

ElE> Regression Test Sets

&2 New Test Set
£ New Folder
Edit Items
£3 Delete

& Regression Testing for Wing

=] Regression Testing for Wing

> Indent
<p Qutdent

EI rows per page

[} Copy ltems

5-Feb-2007
5-Feb-2007
T-Feb-2007

10-Feb-2007

1-Dec-2003
1-Dec-2003

Joa P Smith
Joe P Smith
Fred Bloggs
Fred Bloggs

Fred Bloggs
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You can now choose any of these options as an alternative to using the icons in the toolbar.

5.8. Test Set Details

When you click on a test set item in the test set list described in the previous section, you are taken to the
test set details page illustrated below:

Welcome, System ‘me Information System "l | My Profile | Administration | Log Qut | |Se &) Help?
—— My Page Project Home Flanning Testing Tracking Reporting
TestCases | Test Sets > Test Set Details | Test Runs | Automation Hosts Role: Project Owner
Save Copy Refresh Delete Execute Print Email ) Subscribe
<< Back to Test Set List e e & B 8 > @ 8 L
Display: | Cuent Fiter v Test Set 2 Testing Cycle for Release 1.0 [TX:000001]
= & Functional T‘_”‘ Se_“ _ Hame*: Testing Cycle for Release 1.0
Mesting Cycle for Release
LTesting Cycle for Release 1.1 Descrtion: - ot - V] [Se- v] B U|EEE|SEEE|EE|—epOoBD
"‘_Teshng New Functionality This tests the functionality introduced in release 1.0 of the library system
"’_Expluralory Testing
= B> Regression Test Sets
LiRegression Testing for Windows XP
.5 3 h ————————————————
IRegression Testing for Windows Vig Owmer: Jou P Senth v Creator*: Fred Bloggs v
Release: [1.0.0.0+ Lbrary System Releasa 1 7| & Type [Manuat v|
Automation Host: | - Nene - v| Creation Date: /272007 12:00:00 AM
Status®- [in Progress v Last Executed: -
Planned Date 252007 [0 | |12:00.00 AM | [Housty v Last Updated 1/2/2007 12:00:00 AM
Test Cases Test Runs * Comments Custom Props * Aachments * History

This page is made up of three areas; the left pane is the navigation window, the upper part of the right
pane contains the test set detailed information itself, and the bottom part of the right pane contains
related information about the test set.

The navigation pane consists of a link that will take you back to the test set list, as well as a list of the
peer test sets to the one selected. This latter list is useful as a navigation shortcut; you can quickly view
the detailed information of all the peer test sets by clicking on the navigation links without having to first
return to the test sets list page. The navigation list can be switched between three different modes:

e The list of test sets matching the current filter
e The list of all test sets, irrespective of the current filter

e The list of test sets assigned to the current user
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The top part of the right pane allows you to view and/or edit the details of the particular test set. You can
edit the various fields (name, description, etc.) and once you are satisfied with them, simply click either
the <Save> or <Save and New> button at the top of the page to commit the changes. In addition you can
delete the current artifact by choosing <Delete>, discard any changes made by clicking <Refresh> or print
it by clicking <Print>.

Test Sets can be specified as being either for “Manual” or “Automated” test runs. If you choose Manual,
then the test set can be executed by a tester from their “My Page.” However if you choose “Automated”,
the test set will be executed by the automation host you specified. In this case, the planned date and time
will be used by the automated test engine to know when to execute the automated test scripts. For
manual test sets, only the date component is used. In addition, you can specify a recurrence schedule for
the test set by changing the recurrence dropdown from “One Time” to “Hourly”, “Daily”, etc. so that
SpiraTeam executes the same test set according to the specified frequency.

The lower part of the right pane can be switched between different views by clicking the appropriate tab.
Initially the pane will be in “Test Cases” mode, but it can be switched to “Test Runs”, “Comments”,
“Custom Properties”, “Attachments” and “History” modes if so desired. Each of the views is described
separately below. In addition there is a shortcut link “Execute This Test Set” that allows you to execute all

the tests in the set against the release specified in the test set.

5.8.1. Test Cases

In this mode, the main pane displays the list of test cases contained within the test set. You can add,
remove, reposition and remove test cases from the list. The execution status displayed next to each test
case is the most recent execution status of the test case when run in the context of the current test set.

Test Cases # Test Runs # Comments Custom Props # Attachments History
= Add Tests | Remove Tests | Refresh | Edit Parameters | ExecuteTests Est Duration® 0 Th [ Actual Duration® 4 3h
[ @ TestCase Name Owner Priority Est. Duration Act. Duration Last Executed Execution Status Test Case # Edit
O @ | & ability to create new book 1 - Critical  0.2h 1.3h 1-Dec-2003 Failed TC000002
O L3 apility to sdit existing book 1 - Crtical 0.1h 1.5h 1-Dec-2003 Passed TC000003
O 0| &3 Ability ta create new author 1 - Critical 0.1h 1.5h 1-Dec-2003 Failed TC000004
O = Ability to edit existing author 2-High  0.1h Mot Run TC000005
O L3 pnility to reassign book to different author 2 - High 0.1h Mot Run TC000006
O £ Book management 2-High  0.1h Mot Run TC000008
O £ Author management 2-High  0.1h Mot Run TC000009
Show rows per page Displaying page '!- of 1
To change the order of the test cases, please click on the test case icon and drag it to the appropriate place in the list.

To move the test cases, you simply need to click the test case icon and drag it to the appropriate position
in the list. Whilst you are dragging the icon, the border in the list will change color to indicate where it will
be moved to.

To modify an existing Test Case you simply need to click on the <Edit> button in the right-most column,
or just double-click on the cells in the row. That will switch the selected row into Edit mode. The owner
field can then be set at the test case level. This is useful in situations where you want the different test
cases in the set to be executed by different testers (e.g. in integrated, scenario tests)
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Test Cases # Test Runs # Comments Custom Props # Attachments Higtory
= Add Tests | Remove Tests | Refresh | Edit Parameters | ExecuteTests Est. Duration: 0.7h / Actual Duration: 4_.3h
[F] - Est. Act. Last Execution  Test Case .
Y TEEites e L [T Duration Duration Executed Status # Eili

O |y &2 Ability to create new beok 1- 0.2h 1.3h 1-Dec-2003 | Failed TC000002
Critical

O &) Ability to edit existing book s - oin 1.5h 1-Dec-2003  Passed TC000003
ritical

Oy £ Ability to create new author 1- 0.1h 1.5h 1-Dec-2003  [Failed TCO000004

O £ pbility to edit existing author 2-High 0.1h Mot Run TC000005

O L9 Ability to reassign book to different author 2-High 01h Not Run TCO00006

OJ L Book management 2-High  0.1h Mot Run TC000008

O £ Author management 2-High 0.1h Mot Run TC000009

Show |18 ¥ | rows per page Displaying page |1 Taof1

To add a new test case to the Test Set, you need to click on the “Add Test Cases” hyperlink to display the
popup dialog box:

[] Add Test Case to the Test Set

Choose the test case(s) to add to the current test set:

v | Test Case
[] =& Functional Tests 2

8 Ability to create new book

O £ Ability to edit existing book

O = Ability to create new author

O 5 Ability to edit existing author

O 3| Ability to reassign book to different author =
E = Add | Cancel

You can then select the checkboxes of the individual test cases or whole folders of test cases that you
want to add to the test set. Once you have selected the desired items, click the <Add> button to actually
add them to the test set.

Test cases in SpiraTeam can have parameters defined which are available to specify the text that should
be used to replace certain tokens in the test case. In addition these parameters may be used by certain
test automation engines. In addition to being able to specify the parameter values when linking the test
cases as test steps of a parent test case, you can also specify the parameter values from the Test Set.

To view/edit the parameter values being set by the test case, you should either select the checkbox of a
test set and click “Edit Parameters” at the top of the section, or right-click on the test case and choose
“Edit Parameters”:
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[ @ Test Case Name Owner Priority  Est. Duration Act. Duration Last Executed Execution Status Test Case #
O | @ | &3 Ability to create new book 1- Crtical 0.2h 1.3h 1-Dec-2003 Failed TCO00002
4 Ability to edit existing book : — B 0.1h 1.5h 1-Dec-2003 Passed TCO00003
- Insert Test Case
O | @ £ Ability to create new author ical 0.1h 1.5h 1-Dec-2003 Failed TCO00004
—_—t— - Remove Test Case
O & Ability to edit existing author _Edit Pa TC000005
O £ Ability 1o reassign book to differer = Edit Test Case Parameters TC000006
= Erecd TC000008
o = Book management Please fill out the parameters for this test case entry: &
O £ Author management 3 ¥ | | TC000009
rowserName: safari
Show {15 ¥ | rows per page splaying page |1 L |
= login: [fred1 |
To change the order of the test cases. please click on the password: |unkn0wn |
ion | SpiraTeam v3.0 (Beta) it |wwnw.testing.com] | inf’m
> Update | Cancel

You can then specify the values of the parameters that the test set will pass to the test case. Once you
have entered / modified the values, click [Update] to commit the changes.

5.8.2. Test Runs

This view displays the list of all the test runs executed against the test set. Each test run is listed together
with the date of execution, the name of the test case, the name of the tester, the release/version of the
system that the test was executed against, the overall execution status for the test case in that run and a
link to the actual test run details (see section 5.6). In addition, you can choose to display any of the
custom properties associated with the test run.

Test Cases # TestRuns * Custom Props Attachments History:

> Refresh | Apply Filter | Clear Filters | = Show/hide columns — v]

+ & TestRun Name AV Execution Date AV Test Set A Y Release A ¥ Status 4F Est. Dur. AY Act. Dur. AY Web Browser A¥ Operating System AY Run# 4Y
all [ m| TestngCyce t V| [—any— ¥ |[-Ay- v] | ] | [~y ¥ - Ay - v wR[ ]

O | % ability to create new auther | 1-Dec-2003 C Failet 0.1h 1.5h TRO00004

O ook 1-Dec-2003 Passed 0.1h 1.5h TRO00003

0O g B Ability 1o creste new book | 1-Dec-2003 Fildd 0.2h 1.3h Intemet Explorer Windows XP TROO0001

Show [15 | rows per page 4 « Displaying page [. 'ibof‘\ >

The “customize columns” drop-down list allows you to change the fields that are displayed in the test run
list as columns. To show a column that is not already displayed, simply select that column from the list of
“Show...” column names and to hide an existing column, simply select that column from the list of
“Hide...” column names. The displayed columns can be any standard field or custom property.

You can also filter the results by choosing items from the filter options displayed in the sub-header row of
each field and clicking the “Apply Filter” link. In addition, you can quickly sort the list by clicking on one of
the directional arrow icons displayed in the header row of the appropriate field.

5.8.3. Comments
The Comments tab allows users to add and view discussions relating to the test set:
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Test Cases # Test Runs # Comments Custom Props # Attachments History

To add a new comment to this requirement, please enter it below and click the [Save] button:

= | Ty | — @03

—~ Font - v| |—Size— v BIU|E

Existing Comments

Existing comments are displayed in order underneath the textbox in date order. To add a new comment,
simply enter it into the textbox, and click the Save button.

5.8.4. Custom Properties

In this mode, the main pane displays any custom properties that the project owner has defined for test
sets. To learn more about how to setup and configure custom properties for a project, please refer to the
SpiraTest Administration Guide.

Test Cases # Test Runs # Comments Custom Props # Atftachments History

The following are the custom properties of this artifact:

MNotes:

Operating System: |".'u'indows 7 vl

Assuming that custom properties have been defined for your project, you will see a list of optional
parameters that can be set on the test set. These can be either freetext or drop-down-lists. If you want
any of the custom list properties to prepopulate the corresponding value of the test run (e.g. you want all
test runs to be marked with Operating System = Windows XP) make sure that both the test set and the
test run are configured to use the same custom list.

5.8.5. Attachments

In this mode, the main pane displays the list of documents that have been “attached” to the test set. The
documents can be in any format, though SpiraTeam® will only display the icon for certain known types.

Test Cases # Test Runs # Comments Custom Props # Attachments History

= Add New | Add Existing | Remove | Refresh | Apply Filter | Clear Filter | Include Source Code Documents

+  Document Name AY Type AY Size AV Edited By A ¥ Edited On AV  Author A ¥ DAY
| | e Al | — ) — .
€] http-/www. mycompany.com/Relatedinformation Stack Trace 0 KB Fred Bloggs 19-Dec-2011 Fred Bloggs DCo00047
Show Tows per page Displaying page "a of 1

The attachment list includes the filename that was originally uploaded together with the file-size (in KB),
name of the person who attached it and the date uploaded. In addition, if you position the pointer over the
filename and hold it there for a few seconds, a detailed description is displayed as a tooltip.

To actually view the document, simply click on the filename hyperlink and a new web browser window will
open. Depending on the type of file, this window will either display the document or prompt you for a
place to save it on your local computer. To remove an existing attachment from a test set, simply click the
<Remove> button and the attachment will be removed from the list.
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If you are using SpiraPlan or SpiraTeam (but not SpiraTest) you can also choose to include file
attachments stored in a linked version control system (e.g. Subversion, CVS, Perforce, etc.) by selecting
the “Include Source Code Documents” option.

To attach a new document or web link to the test set, you need to click on the “Add New” hyperlink to
open the “Add Attachment” dialog box.

Add New Document

Type:" @ File URL
Filename:* [

Description

Document Type:* [

Document Folder: |

Tags

() Screenshot

Browse.

Xl

Add New Document

Type:* O File & URL
URL:=

2 Screenshot

Description

Document Type:" |Functonal Specification M|
Document Folder: [au Faus ud

Tags

Add New Document

Type:* File O URL
Screenshot:®

Description

Document Type:*

Document Folder.*

Tags

%) Screenshot

There are three different types of item that can be attached to a test set:

» To upload a file, choose “File” as the type and then click the Browse button and select the file
from your local computer, optionally enter a detailed description then click the <Upload> button.
The document will be copied from your computer and attached to the artifact.

» To attach a web-link (URL) to the artifact, you need to choose “URL" as the type and then enter
the fully qualified URL (e.g. http://mywebsite.com?Document=1), an optional description and then
click the <Upload> button to attach the web-link.

» To attach a screenshot to the artifact, you need to choose “Screenshot” as the type and then
copy the image to your computer’s clipboard (e.g. on Windows computers, the PRINT SCREEN
button captures the current page and adds to the clipboard). Once the image is in the clipboard,
click on the “Paste image from clipboard” hyperlink and the item will appear in the preview
window. You can then fill in the other fields and click <Upload> to attach the image.

Note: If you are using a hon-Windows® computer (e.g. Macintosh®) that doesn't put file extensions on
filenames (e.g. .xls for an Excel sheet) automatically, then you will need to manually add the file extension
to the filename before uploading if you want it to be displayed with the correct icon in the attachment list.

You can also associate an existing document (that's already stored in SpiraTeam) with the test set. To do

that, click on the “Add Existing” hyperlink to bring up the add file association dialog box:
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http://mywebsite.com/?Document=1
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X x
Add Existing Document Add Existing Document
Choose the location of existing document that you'd like to add: Choose the location of existing document that you'd like to add:
@ Documents ) Source Code Documents @ Source Code
Folder | [+ _-Documem | Folder | [v | File
% O EditExistingBook - 4 Expected Result Screensh * 5 63 Design ] pocument Filenamet.doc
# 6 Misc Documents = = E
e Sb CJ . | & Web Page capture htm /& Development B Document Filename10_ppt>
= creen Captures £ 162
2] Date Editing Screenshot j o Test £ Document Filename11.htm
1 B3 Specifications L a ing P & €3 Documentation e : : I
@ 2 Test Results 1 2] Error Logging-in Screen-shi 5 €3 Trainin 2] Document Filename2.xls
% 3 Test Scripts N o —— - = [ E R SR - X
> Add | Cancel Comment:
This is a related document
> Add | Cancel

You can then choose to either associate a document stored in the SpiraTeam Documents repository or
(in the case of SpiraPlan/SpiraTeam but not SpiraTest) from the linked source code repository. In either
case you first select the appropriate folder, and then pick the document(s) from the file list on the right. In
the case of a source code file association you can also add a comment.

5.8.6. History

In this mode, the main pane displays the list of changes that have been performed on the test set artifact
since its creation. The change history displays the date that each change was made, together with the
fields that were changed, the old and new values and the person who made the change. This allows a
complete audit trail to be maintained of all changes in the system. In addition, if you are logged in as a
project administrator you can also click on the “Admin View” hyperlink to revert any unwanted changes.

5.9. Automation Host List

This section outlines how to use the Automation Host Management features of SpiraTeam® to manage
the different host systems that will be running automated tests in your environment. Typically when
scheduling automated tests you will want to execute the same tests on multiple computers running
different environments.

SpiraTeam allows you to build a master list of automation hosts in each project, which can be used to
schedule test sets containing automated test cases against. Please refer to the Test Set section of this
manual for more information on managing and scheduling test sets.

When you click on the Testing > Automation Hosts global navigation link, you will initially be taken to the
automation host list screen illustrated below:

Welcome, Fred Bloggs | My Profile | Administration | Log Out | | Lbrry Information System v

Testing

viraTeam’

My Page Projact Home Planning Tracking Reporting

Role: Manager

Test Cases | TestSets | TestRuns | Automation Hosts

%) Refresh Showihide columns - v| Y Fiter

Displaying 1 - 4 out of 4 automation hosts(s) for this project

b New Host  §3 Delete

¥ & HostName oY Token AY Active AY Last Medified 4 Y Host # AY Web Browser AY Operating System oY
m] | 1 ‘ [~ Any - v| ‘ I:l AHJ [~ Any - v [« By = v|

B M \Windows ¥P Host WinXpP Yes 1-May-2009 AHO00001 Internet Explorer Windows XP

O -, WinVistal Yes 2-May-2009 AHO00002 Internet Explorer Windows Vista

O WinVista2 Yes 3-ay-2009 AHO00003 Mozilla / Firefox Windows Vista

B WinT Yes 4-May-200% AH000004 Internet Explorer Windows 7

Show 15 ¥ | rows per page 4 < Displaying page 1 Laof 10 »
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The automation host list screen displays all the automation hosts entered for the current project, in a
filterable, sortable grid. The grid displays the automation host ID together with fields such as name,
description, last modified, token, and any custom properties. The choice of columns displayed is
configurable per-user, per-project, giving extensive flexibility when it comes to viewing and searching
automation hosts.

In addition, you can view a more detailed description of the automation host by positioning the mouse
pointer over the host name hyperlink and waiting for the popup “tooltip” to appear. If you click on the host
name hyperlink, you will be taken to the automation host details page described in section 5.9.2. Clicking
on any of the pagination links at the bottom of the page will advance you to the next set of hosts in the list
according to the applied filter and sort-order. There is also a drop-down-list at the bottom of the page
which allows you to specify how many rows should be displayed in each page, helping accommodate
different user preferences.

One special column that is unique to automation hosts is the “Token” field. This needs to contain a short
textual identifier that uniquely identifies each automation host in the project. This will be used by each
host computer to identify itself to SpiraTeam.

5.9.1. Sorting and Filtering
You can easily filter and sort the list of automation hosts as illustrated in the screen-shot below:

T ® Welcome, Fred Bloggs | My Prafile | Administration | Log Out | |Lbrary information System v| Help?
o eam My Page Project Home Planning Tracking Reporting

Test Cases | TestSets | TestRuns | Automation Hosts Role: Manager
T New Host  £3 Delete ) Refresh Show,hide cokimna v| Y Fiter
Displaying 1 - 3 out of 3 automation hasts(s) for this project

+ 4 HostName AV Token A ¥ Active AT Last Medified AY Host# AV Web Browser AY Operating System A ¥

O | ‘ [~ Ay v| ‘ [‘| AH _I [Inmemet Explc v] [~ Ay - v

1] WinXpP Yes 1-May-2009 AHO00001 Internet Explorer Windows XP

B WinVistal Yes 2-May-2009 AH000002 Intarmet Explorer Windows Vista

B W Win7 Yes 4-May-2009 AHO00004 Intemet Explorer Windows 7
Show [15 7| rows per page -« < Displaying page[]_ % of 1

To filter the list by one of the displayed fields, you simply choose an item from the appropriate drop-down
list or enter a free-text phrase then click <Filter> or press the <ENTER> key to apply the different filters.
Note that the name field is searched using a “LIKE” comparison, so that searching for “database” would
include any item with the word database in the name. The other freetext fields need to be exact matches
(e.g. dates, incident numbers).

To change the column that is sorted, or to change the direction of the current sort, simply click on the
up/down arrow icon in the appropriate column. The currently sorted column is indicated by the larger,
white arrow with the back-border.

Clicking on Filter > Clear Filter removes any set filters and expands the host list to display all automation
hosts in the current project, and clicking on Filter > Save Filter allows you to save the filter to your ‘My
Page’ for use in the future. The list of saved filters can also be retrieved by clicking Filter > Retrieve Filter.

5.9.2. New Host
Clicking on the <New Host> button adds a new automation host to the list with a default name and token.

5.9.3. Delete

Clicking on the <Delete> button deletes the automation hosts whose check-boxes have been selected in
the host list.
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5.9.4. Refresh

Clicking on the <Refresh> button simply reloads the list of automation hosts; this is useful when new
hosts are being added by other users, and you want to make sure you have the most up-to-date list
displayed.

5.9.5. Show / Hide Columns

This drop-down list allows you to change the fields that are displayed in the host list as columns for the
current project. To show a column that is not already displayed, simply select that column from the list of
“Show...” column names and to hide an existing column, simply select that column from the list of
“Hide...” column names. This is stored on a per-project basis, so you can have different display settings
for each project that you are a member of. The fields can be any of the built-in fields or any of the custom
properties set up by the project owner.

5.9.6. Edit

Each automation host in the list has an <Edit> button display in its right-most column. When you click this
button or just double-click on any of the cells in the row, you change the item from “View” mode to “Edit”
mode. The various columns are made editable, and <Update> <Cancel> buttons are displayed in the last
column

If you click <Edit> on more than one row, the <Update> and <Cancel> buttons are only displayed on the
first row, and you can make changes to all the editable rows and then update the changes by clicking the
one <Update> button. Also, if you want to make the same change to multiple rows (e.g. to change five
automation hosts from Active = No to Active = Yes), you can click on the “fill” icon to the right of the
editable item, which will propagate the new value to all editable items in the same column.

If you want to edit lots of items, first select their checkboxes and then click the [Edit] button on the same
row as the Filters and it will switch all the selected items into edit mode.

When you have made your updates, you can either click <Update> to commit the changes, or <Cancel>
to revert back to the original information. Alternatively, pressing the <ENTER> key will commit the
changes and pressing the <ESCAPE> key will cancel the changes.

5.10. Automation Host Details

When you click on an automation host entry in the host list, you are taken to the automation host details
page illustrated below:

Welcome, Fred Bloggs | Library Information System "‘ | My Profile | Administration | Log Out || Searc

Team

My Page Project Home Planning Testing Tracking Reporting
Test Cases | Test Sets | Test Runs | Automation Hosts > Automation Host Details

‘ [E Save [ Refresh | $3 Delete

<< Back to Host List

Display: Host Name: ™ Windows XP Host [AH-000001]
B Windows XP Host
M Windows Vista Host #1 Hamer |Windcws AP Host ‘
= \Windows Vista Host #2 Description: |_F0m_ v| |_5.ze_ v| BEIU|=== %EEE§§§§|TE‘E|—D<>

il .
= Windows T Host Windows XP with [E7, Firefox 2, Chrome and Safari 3

Token™: Active™: Yes v

Last Updated: 5/1/2009 12:00:00 AM

Test Runs Custom Props # Attachments History
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This page is made up of three areas; the left pane is the navigation window, the upper part of the right
pane contains the automation host detailed information itself, and the bottom part of the right pane
displays different information associated with the automation host.

The navigation pane consists of a link that will take you back to the host list, as well as a list of the peer
automation hosts to the one selected. This latter list is useful as a navigation shortcut; you can quickly
view the peer hosts by clicking on the navigation links without having to first return to the host list page.
The navigation list can be switched between two different modes:

e The list of hosts matching the current filter
e The list of all hosts, irrespective of the current filter

The top part of the right pane allows you to view and/or edit the details of the particular automation host.
You can edit the various fields (hame, description, token, etc.) and once you are satisfied with them,
simply click either the <Save> or <Save and New> button at the top of the page to commit the changes.
In addition you can delete the current artifact by choosing <Delete>, or discard any changes made by
clicking <Refresh>.

5.10.1. Test Runs

This view displays the list of all the test runs executed against the automation host. Each test run is listed
together with the date of execution, the name of the test case, the name of the tester, the release/version
of the system that the test was executed against, the name of the test set (if applicable), the overall
execution status for the test case in that run and a link to the actual test run details (see section 5.6). In
addition, you can choose to display any of the custom properties associated with the test run.

TestRuns # Custom Properties # Attachments History
= Refresh | Apply Filter | Clear Filters | | ~ Show/hide columns — Y‘
v Test Run Name 4 ¥ Execution Date AV Test Set AV Type AY¥ Release AV Status A W Est. Dur. 4 ¥ Act. Dur. A¥ Web Brows|
o | =] R T || S S || SR | i |
O B Ability to create new author | 4-Dec-2003 Automated 1.1.0.0.0003 Caution 0.2h 1.2h
O B Ability to edit existing baok | 4-Dec-2003 Automated 1.1.0.0.0003 Failed 0.1h 1.2h
O B Ability to create new book | 4-Dec-2003 Automated 1.1.0.0.0003 Failed 0.0h 1.2h

The “customize columns” drop-down list allows you to change the fields that are displayed in the test run
list as columns. To show a column that is not already displayed, simply select that column from the list of
“Show...” column names and to hide an existing column, simply select that column from the list of
“Hide...” column names. The displayed columns can be any standard field or custom property.

You can also filter the results by choosing items from the filter options displayed in the sub-header row of
each field and clicking the “Apply Filter” link. In addition, you can quickly sort the list by clicking on one of
the directional arrow icons displayed in the header row of the appropriate field.

5.10.2. Custom Properties

In this mode, the main pane displays any custom properties that the project owner has defined for
automation hosts. To learn more about how to setup and configure custom properties for a project, please
refer to the SpiraTest Administration Guide. Assuming that custom properties have been defined for your
project, you will see a list of optional parameters that can be set on the host. These can be either freetext
or drop-down-lists.
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Test Runs # Custom Properties # Attachments Higtory

The following are the custom properties of this artifact:

Web Browser: | Intemet Explorer v |

Operating System:

Windows 7 v |

Once you are satisfied with the values for the custom properties, simply click [Save] or [Save and New] to
commit the changes.

5.10.3. Attachments

In this mode, the main pane displays the list of documents, screenshots or web-links (URLS) that have
been “attached” to the automation host. The documents can be in any format, though SpiraTeam® wiill
only display the icon for certain known types.

If you are using SpiraPlan or SpiraTeam (but not SpiraTest) you can also choose to include file
attachments stored in a linked version control system (e.g. Subversion, CVS, Perforce, etc.) by selecting
the “Include Source Code Documents” option.

To attach a new document to the automation host, you need to first click the “Add New” hyperlink to
display the new attachment dialog box. There are three different types of item that can be attached to an
automation host:

» To upload a file, choose “File” as the type and then click the Browse button and select the file
from your local computer, optionally enter a detailed description then click the <Upload> button.
The document will be copied from your computer and attached to the artifact.

>» To attach a web-link (URL) to the artifact, you need to choose “URL” as the type and then enter
the fully qualified URL (e.g. http://mywebsite.com?Document=1), an optional description and then
click the <Upload> button to attach the web-link.

» To attach a screenshot to the artifact, you need to choose “Screenshot” as the type and then
copy the image to your computer’s clipboard (e.g. on Windows computers, the PRINT SCREEN
button captures the current page and adds to the clipboard). Once the image is in the clipboard,
click on the “Paste image from clipboard” hyperlink and the item will appear in the preview
window. You can then fill in the other fields and click <Upload> to attach the image.

Note: If you are using a hon-Windows® computer (e.g. Macintosh®) that doesn't put file extensions on
filenames (e.g. .xIs for an Excel sheet) automatically, then you will need to manually add the file extension
to the filename before uploading if you want it to be displayed with the correct icon in the attachment list.

You can also associate an existing document (that's already stored in SpiraTeam) with the automation
host. To do that, click on the “Add Existing” hyperlink to bring up the add file association dialog box. You
can then choose to either associate a document stored in the SpiraTeam Documents repository or (in the
case of SpiraPlan/SpiraTeam but not SpiraTest) from the linked source code repository. In either case
you first select the appropriate folder, and then pick the document(s) from the file list on the right. In the
case of a source code file association you can also add a comment.
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5.10.4. History

In this mode, the main pane displays the list of changes that have been performed on the automation host
artifact since its creation. The change history displays the date that each change was made, together with
the fields that were changed, the old and new values and the person who made the change. This allows a
complete audit trail to be maintained of all changes in the system. In addition, if you are logged in as a
project administrator you can also click on the “Admin View” hyperlink to revert any unwanted changes.




6. Incident Tracking

This section outlines how the incident/defect tracking features of SpiraTeam® can be used to manage
key project artifacts during the software development lifecycle. In addition to managing the defects raised
during the execution of test cases in the test management module, the Incident Tracker is also a powerful
risk/issue/bug tracking system in its own right. When coupled with the project dashboard (see section 3.4)
it is a powerful tool for representing all the key risks and issues associated with a project in a single,
graphical format.

Unlike a standalone bug/issue tracking tool however, you can trace the incidents/defects back to the test
case and the underlying requirement that generated them, giving the project manager unprecedented
power in analyzing the “in-process” quality of a system during its lifecycle. This power is clearly illustrated
in the “Requirement Incident Count” pane in the Project Home dashboard (see section 3.4.4).

6.1. Incident List

When you click on the Tracking > Incidents global navigation link, you will initially be taken to the
incidents list screen illustrated below:

Welcome, System Administrator | My Profile | Administration | Log Out | ILbf'\l‘W&_ﬂET_Y Help?
N — My Page Project Home Planning Testing Tracking Reporting
Incidents | Tasks | Resources | Source Code Role: Project Owner
b New Incident  §} Delete | @ Refresh | [}Copy §%Tools |- Showhide colmns - | 7 Eilter
Displaying 16 - 30 out of 60 incident(s) for this project
+ @ Incident Name AW Type AT Status AT Detected By 4 ¥ Creation Date AV Owmner &Y DAY Edit
| T R R | o] I S O 1 I =51
Enhancement Resolved Joe P Smith 25-Nov-2003 Joe P Smith INODDO2S [ Edit |
Enhancement Dupficate | Fred Bloggs 25-Nov-2003 INODDD29 [+ Edit |
lssus Closed 1 Fred Bioggs 2.Dec-2003 Joe P Smith IN000036 [ Eait |
Training Assigned Fred Bloggs 3-Dec-2003 Fred Bloggs INODDO40 [:_gl__i
Limitation Open " Fred Bloggs 4-Dec-2003 INDODO45 » Edit
Limitation Assigned i Joe P Smith 4-Dec-2003 Fred Bloggs INDDDD46 * Edit
Limitation Duplicate Joe P Smith 5-Dec-2003 Fred Bloggs INDDOOSD E@Z
Change Request Closed | Fred Bloggs 5-Dec-2003 Joe P Smith INDDODSS @|
Risk Open ’ - Fred Bloggs 10-Dec-2003 INODOOSS kgg[_J
Enhancement Resolved 2 - High Joe P Smith 25-Nov-2003 Joa P Smith INDDDOD26 + Edit |
Enhancement Assigned 2 - High Joe P Smith 18-Nov-2003 Joe P Smith INDDDO22 lid_]
1 Enhancement Open 2 - High Fred Bloggs 17-Nov-2003 INDDDD19 * Edit
®) The homepage hangs whilst lpading Bug Not Reproducible 2- High Joe P Smith 15-Nov-2003 Fred Bloggs INODOOT6 [+ Edit |
) Quote handling issues throughout Bug Resolved 2 - High Fred Bloggs 15-Nov-2003 Fred Bloggs INODDD12 [+ Edit |
@ B Ediing the date on a book is clunky Bug Assigned 2-High Joe P Smith 4-Nov-2003 Fred Bloggs INODOOOB [+ Edit |
Show i‘s_" Tows per page 4 Displaying page ?_‘ mofdem

The incident list screen displays all the incidents entered for the current project, in a filterable, sortable
grid. The grid displays the incident number together with fields such as incident type (bug, issue, risk,
etc.), status (new, open, etc.), priority, name, assigned owner, detection date, detector, closed date, etc.
The choice of columns displayed is configurable per-user, per-project, giving extensive flexibility when it
comes to viewing and searching incidents.

In addition, you can view a more detailed description of the incident (along with a resolution if any) by
positioning the mouse pointer over the incident name hyperlink and waiting for the popup “tooltip” to
appear. If you click on the incident name hyperlink, you will be taken to the incident details page
described in section 6.2. Clicking on any of the pagination links at the bottom of the page will advance
you to the next set of incidents in the list according to the applied filter and sort-order. There is also a
drop-down-list at the bottom of the page which allows you to specify how many rows should be displayed
in each page, helping accommodate different user preferences.
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6.1.1. Sorting and Filtering
You can easily filter and sort the list of incidents as illustrated in the screen-shot below:

- Team Welcome, Fred Bloggs | My Profile | Log Out | [Lbray bienmation System | »] Help?
T My Page Project Home Planning Testing Tracking Reporting
Incidents | Tasks Role: Manager
pMNewmnodent  §3Doste | RyReresh | [hCopy ([ Expot |- Showndecolumns - v Y/ Eter
Displaying 1 - 14 out of 14 incident(s) for this project
¥ Incident Name 4 ¥ Type AV Status AV Priority AY Detected By A¥ Owned By AY Closed On AY Operating System A¥ Inc.# A¥  Edit
O | [pua v| [-anw- v [-any - ¥ [-any- v [-anw- v] [ @] [-aw- v| m | [+ Fitter |
O B Cannot sdd 2 new book to the system | Bug Duplicate Fred Bloggs Fred Bloggs INODODT | [+ Eait
O ®patabase not backing up correctly Bug Open Joe P Smith 1N00D004
O ® Cannot install system on Oracle 8 Bug Open 1- Critical Fred Bloggs IN000O0S
O |8 ®) cannot 2dd a new book to the system | Bug Asgigned 1 - Critical Joa P Smith Joa P Smith Windows XP INO00DOOT
O ) validation on the edit book page Bug Resolved 1 - Critical Fred Bloggs Joe P Smith IN0D0O11
O ®) Session handling Bug Closed 1 - Critical Joe P Smith Joe P Smith 21-Nov-2003 IN0O0015
O ) The homepage hangs whilst loading Bug Mot 2 - High Joe P Smith Fred Bloggs IN000016
Reproducible
O ™) Quote handiing issues throughout Bug Resolved 2 - High Fred Bloggs Fred Bloggs 1N000012 | [+ Edit
Oe R_] Editing the date on a baok is clunky Bug Assigned 2 - High Joe P Smith Fred Bloggs INDOODOZ | | » Edit
O @ B The book I isting screen doesn't sort Bug Open 3 - Medium Joe P Smith Windows 2003 INDDDOOG | |~ Edi
0 R_] Editing the date on an author is clunky Bug Assigned 3 - Medium Joe P Smith Joe P Smith INOO000S
O ) The tables get cutoff on low-res modes | Bug Closed 3 - Medium Joa P Smith Joa P Smith 20-Mov-2003 IMO00013
O ®p s not updating when changed Bug Closed 4 - Low Joe P Smith Fred Bloggs 21-Nov-2003 IMDo0014
0 ¥ Doesnt let me add a new category Bug Resolved 4-Low Fred Bloggs Fred Bloggs INOO0O10 Edi
Show ’\_v rows per page < < Displaying page [1 | % of 15 »

To filter the list by incident type, status, priority, owner or detector name, you simply choose an item from
the appropriate drop-down list, and for the other fields, you enter a free-text phrase then click <Filter> or
press the <ENTER> key to apply the different filters. Note that the name field is searched using a “LIKE”
comparison, so that searching for “database” would include any item with the word database in the name.
The other freetext fields need to be exact matches (e.g. dates, incident numbers). There are also several
aggregate filters that are used to filter on multiple values at once (e.qg. filtering status on (All Open) will
return any incident that is in one of the open statuses — new, open, assigned, reopen).

To change the column that is sorted, or to change the direction of the current sort, simply click on the
up/down arrow icon in the appropriate column. The currently sorted column is indicated by the larger,
white arrow with the back-border. In the screen-shot above, we are filtering on type=bug and sorting by
decreasing priority.

Clicking on Filter > Clear Filter removes any set filters and expands the incident list to display all incidents
for the current project, and clicking on Filter > Save Filter allows you to save the filter to your ‘My Page’
for use in the future. The list of saved filters can also be retrieved by clicking Filter > Retrieve Filter.

6.1.2. New Incident

Clicking on the <New Incident> button takes you to the new incident screen. This is essentially the same
screen as the incident details screen shown in section 6.2 except that the <Update> button is replaced by
an <Insert> button, and depending on how the workflow has been configured for your project, certain
fields may be disabled. For more details on setting and up configuring workflow for your project, please
refer to the SpiraTest Administration Guide.

6.1.3. Delete

Clicking on the <Delete> button deletes the incidents whose check-boxes have been selected in the
incident list.

6.1.4. Refresh

Clicking on the <Refresh> button simply reloads the list of incidents; this is useful when new incidents are
being added by other users, and you want to make sure you have the most up-to-date list displayed.
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6.1.5. Show / Hide Columns

This drop-down list allows you to change the fields that are displayed in the incident list as columns for
the current project. To show a column that is not already displayed, simply select that column from the list
of “Show...” column names and to hide an existing column, simply select that column from the list of
“Hide...” column names. This is stored on a per-project basis, so you can have different display settings
for each project that you are a member of. The fields can be any of the built-in fields or any of the custom
properties set up by the project owner.

6.1.6. Edit

Each incident in the list has an <Edit> button display in its right-most column. When you click this button
or just double-click on any of the cells in the row, you change the item from “View” mode to “Edit” mode.
The various columns are made editable, and <Update> <Cancel> buttons are displayed in the last
column:

- Team Welcome, System Administrator | My Profile | Administration | Log Out | .L|£:y Infomation System v Help?
My Page Project Home Planning Testing Tracking Reporting
Incidents | Tasks Role: Project Owner
df Newincident  §3 Delete | [ Refresh | GhCopy (& Expot |- Show/ndecolumns - v| Y Fiter
Displaying 1 - 14 out of 14 incident(s) for this project
¥ U Incident Name A Y Type &Y Status &Y Priority AY Detected By A¥Y  Detected On AY Owned By AY Inc. #AY Edit
0O [eug v [-any- v [-any- T v [ B] [-any- Y[ om “
O ) Cannot 2dd 2 new book to the system Bug Duplicate Fred Bloggs 15-Nov-2003 Fred Bloggs IN000017 |- Edit |
O ¥ Database not backing up correctly Bug Open Joe P Smith 2-Nov-2003 IMO00004 |- Edit_|
O ®)[Cannotinstall system on Oracle 3i [ED |[pug VD [osen Y)ED fr-criical ¥ [Eil [Freabhges ¥ E] 2Now-2003 [FHoe= V|ED [+ Update
|* Cancel |
O » ®|[Cannotadd anewbooktothe system | |[Bug V| [Assigmed V) [JoePsmn  ¥] 4-Nov-2003 [foepsmn ¥]
O ) validation on the edit book page Bug Resolved 1 - Critical Fred Bloggs 15-Now-2003 Joe P Smith MO00011 | [~ Edit
0| ™ gession handiing Bug Closed 1 - Critical Joe P Smith 15-Nov-2003 Joe P Smith IN000015 | [+ Edit |
O ™) The homepage hangs whilst loading Bug Mot Reproducible | 2= High Joz P Smith 15-Now-2003 Fred Bloggs IN0O0O1G | [~ Edit_|
O ™ guote handiing issues throughout Bug Resolved 2 - High Fred Bloggs 15-Now-2003 Fred Bloggs IN000012 | [~ Edit |
0 @ B Editing the date Bug Assigned 2- High Joe P Smith 4-how-2003 Fred Bloggs 1M000008 | [~ Eain |
O @ ) The book listing sereen doesnt sort Bug Open 3 - Medium Joe P Smith 2-Nov-2003 INOD000G [~ Edin |
0 = Editing the date on an authar is clunky Bug Assigned 3 - Medium Joe P Smith 4-Mov-2003 Joe P Smith INO00009 |> Edit |
O 'ﬂ The tables get cutsf Bug Closed 3 - Medium Joe P Smith 15-Now-2003 Joe P Smith IM000013 |- Edit \
O B permissions not updatir Bug Closed 4-Low Joe P Smith 15-Now-2003 Fred Bloggs IN0O0014 | [+ Edit_|
0 -] Doesn't let me add a new category Bug Resolved 4-Low Fred Bloggs 4-Hov-2003 Fred Bloggs INO00010 |— Edit |
Show “_' FOWS per page 4 4 Displaying page ’1_ Tof b b

If you click <Edit> on more than one row, the <Update> and <Cancel> buttons are only displayed on the
first row, and you can make changes to all the editable rows and then update the changes by clicking the
one <Update> button. Also, if you want to make the same change to multiple rows (e.g. to change five
incidents from “Resolved” status to “Closed”), you can click on the “fill” icon to the right of the editable
item, which will propagate the new value to all editable items in the same column.

If you want to edit lots of items, first select their checkboxes and then click the [Edit] button on the same
row as the Filters and it will switch all the selected items into edit mode.

When you have made your updates, you can either click <Update> to commit the changes, or <Cancel>
to revert back to the original information. Alternatively, pressing the <ENTER> key will commit the
changes and pressing the <ESCAPE> key will cancel the changes.

Note that in the case of incidents, you need to have Project Owner permissions for the project to make
bulk changes using the <Edit> button as such changes can override the workflow business rules
established.

6.1.7. Copying Incidents

To copy an incident or set of incidents, simply select the check-boxes of the incidents you want to copy
and then click <Copy>. This will make a copy of the current incident with its name prefixed ‘Copy of ...." to
distinguish itself from the original. Any file attachments will also be copied along with the incident itself.
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6.1.8. Exporting Incidents

To export an incident or set of incidents from the current project to another project in the system, all you
need to do is select the check-boxes of the incident(s) you want to export and then click the Tools >
Export icon. This will then bring up a list of possible destination projects:

Welcome. System Adi | My Profile | Administration | Log Cut | ILMI\ Information System v| Halp?
My Page Project Home Planning Testing Tracking
Source Code Role: Project Ownar
o Newineident §3Delete | 2Refresh | [jCopy {fTools |~Stowhbecumms— 7| Y Filter
Displaying 16 - 30 out of 60 incident(s) for this project

4@ Incident Name A ¥ | EXport ttems | Detocted By AV Croation Date A¥  Owner A ¥ DAY
[ | [<8ay— | Please select the project you want to export to |'—'Arn-'- v | ]| [~ ey~ v| N !_/
B Ability to generate customized reperts Enhanceme| Samghs Apvlication One = I Joe P Smith 25-Nov-2003 Joe P Smith INDODO25
B bty 1o associate mulliple authors Enhancemel " " | Fred Bloggs 25-Nov-2003 INODDD29
¥ Section 508 compliance Issue BT Bloggs 2-Dec-2003 Joe P Smith INODOD35
v ¥ Teet Training tem Training >Export | Cancdl | F o Eigoe 3Dec-2003 Fred Bloggs INDOOD4D
8 %) Test System Limitation Limitation Open ical | Fred Bloggs 4-Dec-2003 INDDOD4S
&l hﬂLesl_.‘.v‘jﬂ smitation Limitation Asgigned : Joe P Smith 4-Dec-2003 Fred Bloggs INDODD4E
“_17_.-1_.§&_|.-.m mitation Limitation Duplicate Joe P Smith 5-Dec-2003 Fred Bloggs INDDODS0
Change Request Closed S Fred Bloggs 8-Dec-2003 Joe P Smith INDODOSS
Risk Open | Fred Bloggs 10-Dec-2003 INODDOSS
- Enhancement Resolved Joe P Smith 26-Nov-2003 Joe P Smith INDDOO26
’E]__._,g__« tion of security with NTLMIPK] Enhancemeant Assigned 2 - High Joe P Smith 18-Nov-2003 Joe P Smith INDDOD22
x—]SUEE:"? for |IBM DBZ Enhancement Open 2 -High Fred Bloggs 17-Nov-2003 INODOD1S
B The homepage h; Ta Bug Not Reproducible 2 -High Joe P Smith 15-Nov-2003 Fred Bloggs INDDDOD16
. Bug Resolved 2 - High Fred Bloggs 15-Nov-2003 Fred Bloggs INODO012
[ “_'l Editing the date on a book is clunky Bug Assigned 2 - High Joe P Smith 4-Nov-2003 Fred Bloggs INDDDOOS

Show 15 ¥ rows per page W < Displaying page (2 |%of 4 »m

Once you have chosen the destination project and clicked the <Export> button, the incidents will be
exported from the current project to the destination project. Any file attachments will also be copied to the
destination project along with the incidents.

6.1.9. Creating Requirement from Incidents

Sometimes you may have a situation where an enhancement has been logged in the incident tracker and
now that it has been approved, it needs to be converted into a formal requirement so that test cases and
tasks can be generated from it. To aid this process, there is a shortcut that allows you to create new
requirement from selected incidents and have it be automatically added to the requirements list. When
that is performed an association is automatically added that links this new requirement to the original
incident.

To activate this feature, select the checkboxes of the incidents you want to convert and then click Tools >
Convert Into Requirements.

6.1.10. Printing Items

To quickly print a single incident or list of incidents you can select the items’ checkboxes and then click
Tools > Print Items. This will display a popup window containing a printable version of the selected items.

6.2. Incident Details

When you click on an incident item in the incident list, or click the <New Incident> button (as described in
section 6.1), you are taken to the incident details page illustrated below:
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Welcome, Fred Bloggs | Library Information System Y‘ | My Profile | Administration | Log Out | |Search

Team

My Page Project Home Planning Testing Tracking Reporting

Incidents > Incident Details | Tasks | Resources | Source Code

& Save Copy Refresh | £3 Delete | IN > Find || (Print | (gEmail %5 Subscribe
Workflow Operations E & & &
= Resolve Incident Incident Name: ®1 Cannot add a new book to the system [IN-000007]
> Unable to Reprod x
na. €10 meproduce Name*: |Cannoladd a new book to the system ‘
> Duplicate Incident
Status™: > Assigned Detected By*: |Jne P Smith Y|

<< Back to Incident List > Type*: [Bug v| Detected Release: [ 1.0.0.0- Lbmy System Release 1 MIE
Display: Priority™: [1-Crtical v] Resolved Release. [1.0.1.0- Lbray System Relaase 151 v|®

X . -

E‘g Cannat log into the application Severity: |3- Medium Y| Verified Release: &)

®1 Not able to add new author

B Clicking on link throws fatal error Owner*: |FrEd Hloggs ‘| hiced Eha

1 Database not backing up correctly Creation Date: 11/4/2003 12:00:00 AM Last Updated: 12/20/2011 11:46:59 AM

E.j Cannot install system on Oracle 9i Description*:

B The book listing screen doesn't sort |_Fm_ Y| |—5ize— '| ¢ Egggg“ﬁ@‘ —epOo@

) Cannot add a new book to the sys
E.j Editing the date on a book is clunky
] Editing the date on an author is clunk
™ Dosent let me 2dd a new category
] validation on the edit book page

] Quote handling issues throughout

B The tables get cutoff on low-res mode
E,j Permissions not updating when chani Comments Schedule # Custom Props # Attachments # History # Associations #

S-S

When | click on the button to add a book, enter the new information and click submit, | get a subscript out of range error

This page is made up of three areas; the left pane is the navigation window where you can quickly jump
to other incidents as well as execute workflow transitions (see below), the upper part of the right pane
contains the incident detailed information itself, and the bottom part of the right pane displays different
information associated with the incident.

The navigation pane consists of a link that will take you back to the incidents list, as well as a list of the
peer incidents to the one selected. This latter list is useful as a navigation shortcut; you can quickly view
the peer incidents by clicking on the navigation links without having to first return to the incidents list
page. The navigation list can be switched between four different modes:

e The list of incidents matching the current filter

e The list of all incidents, irrespective of the current filter
e The list of incidents assigned to the current user

e The list of incidents detected/found by the current user

In addition to the left hand navigation, you can enter a specific incident number in the text-box in the
toolbar and click the <Find> button. In the same toolbar, there is also a shortcut for creating a new
incident without having to first return to the incident list page. In addition, the lower section of the incident
details page can be switched been four different views: “Comments”, “Schedule”, “Custom Properties”,
“Attachments”, “History”, and “Associations”. These are described later.

6.2.1. Editing an Existing Incident

If you are editing an existing incident, the fields that are available and the fields that are required will
depend on your stage in the incident workflow. For example an open incident might not require a
“Resolved Version” whereas a resolved incident could well do. The types of change allowed and the
email notifications that are sent will depend on how your project administrator has setup the system for
you. Administrators should refer to the SpiraTeam Administration Guide for details on configuring the
incident workflows to meet their needs.
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Depending on the user’s role and whether they are listed as the owner or detector of the incident or not,
displayed in the left hand side of the page, above the navigation list is a set of allowed workflow
operations:

Workflow Operations

= Resalve Incident ‘—‘ Statuss . Assianed
atus: szigne
= UUnable to Reproduce g

= Duplicate Incident

These workflow transitions allow the user to move the incident from one status to another. For example
when the incident is in the Assigned status, you will be given the options to:

» Resolve the Incident — changes status to “Resolved”
>» Unable to Reproduce — changes the status to “Not Reproducible”
>» Duplicate Incident - changes the status to “Duplicate”

After changing the status of the incident by clicking on the workflow link, you can then fill in the additional
fields that are now enabled and/or required. Once you’'ve made the changes to the appropriate incident
fields, you can either click <Save>, <Save and Close>, or <Save and New> to commit the changes or
<Refresh> to discard the changes and reload the incident from the database. In addition you can print the
current incident by clicking <Print>, which will display a printable version of the page in a separate
window.

6.2.2. Inserting a New Incident

If you are creating a new incident, the fields that are available and the fields that are required will depend
on how your project has been for configured. For example, some projects may require that all incidents
be started with Status=New and Type=Incident, others may allow you to specify the incident type. The
types of change allowed will depend on how your project administrator has setup the system for you.
Administrators should refer to the SpiraTeam Administration Guide for details on configuring the incident
workflows to meet their needs.

Once you've filled out the appropriate incident fields, you can either click <Save>, <Save and Close> or
<Save and New> to commit the new item or click on the “Back to Incident List” to discard the insertion
and return back to the incident list.

6.2.3. Comments

In this mode, the lower section of the screen displays a threaded list of resolutions that have been logged
against this incident:
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Comments # Schedule # Custom Props # Attachments History Associations

To add a new comment to this requirement, please enter it below and click the [Save] button:*

~ Fort ~ v| |—Siza— v BZ U = H _5|Tg<tﬁ|—|:|<>

= Existing Comments
= Joe P Smith (21-Nov-2003 )
Exception code retested and error no longer occurs
=  Fred Bloggs (20-Mov-2003 )

There was an erroneous exception throw in the module - removed

You can expand or collapse the list of existing resolutions by clicking the appropriate expand or collapse
icon. To add a new resolution to an incident, all you need to do is enter the new resolution / comment in

the text box above the list and then click <Save>. Your resolution will now be added to the existing items
in the list.

6.2.4. Schedule

In this mode, the main pane displays the general schedule and completion status of the specific incident.
You can enter/edit the start-date, closed-date (i.e. the due-date), estimate, actual and remaining effort.
From these values, the system will display the calculated percent completion, progress indicator and
projected final effort.

Comments Schedule # Custom Props # Attachments % Hiztory # Aszsociations #*
Start Date:*
Progress:* Estimated Effort:* hours
Projected Effort: 0.3 hours Actual Effort: I:I T
hours

6.2.5. Custom Properties

In this mode, the main pane displays any custom properties that the project owner has defined for
incidents. To learn more about how to setup and configure custom properties for a project, please refer to
the SpiraTest Administration Guide. Assuming that custom properties have been defined for your project,
you will see a list of optional parameters that can be set on the incident. These can be either freetext or
drop-down-lists. In the example below, you can enter Notes, and/or the Operating System that the
incident was observed on.

Reszolution Schedule # Custom Props # Aftachments % History # Associations #

The following are the custom properties of this artifact:

Notes: May be an array bounds issue

Operating System: |'-,-\-'in:|o-.v3 P '|

Once you are satisfied with the values for the custom properties, simply click [Save], [Save and New] or
[Save and Close] to commit the changes.
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6.2.6. Attachments

In this mode, the lower section of the screen displays the list of documents, screenshots or web links
(URLSs) that have been “attached” to the incident. The documents can be in any format, though
SpiraTeam® will only display the icon for certain known types.

Comments Schedule * Custom Props # Attachments * History Associations #
= Add New | Add Existing | Remove | Refresh | Apply Filter | Clear Filter | Include Source Code Documents
v Document Name 4 ¥ Type AV Size AV Edited By A ¥ Edited On AV Author A¥ DAY
| |[-Av- Y] | [P Y] @ [A-  v] oc[ |
B Bug Stack Trace txt Stack Trace 1 KB Joe P Smith 4-May-2006 Joe P Smith DCO00010
B Error Logaing-in Screen-shot.aif Screen Shot 45 KB Fred Bloggs 24-Apr-2006 Fred Bloggs DCo00003
Show rows per page Displaying page "- of 1

The attachment list includes the filename that was originally uploaded together with the file-size (in KB),
name of the person who attached it and the date uploaded. In addition, if you position the pointer over the
filename and hold it there for a few seconds, a detailed description is displayed as a tooltip.

To actually view the document, simply click on the filename hyperlink and a new web browser window will
open. Depending on the type of file, this window will either display the document or prompt you for a
place to save it on your local computer. To remove an existing attachment from an incident, simply click
the <Remove> button and the attachment will be removed from the list.

If you are using SpiraPlan or SpiraTeam (but not SpiraTest) you can also choose to include file
attachments stored in a linked version control system (e.g. Subversion, CVS, Perforce, etc.) by selecting
the “Include Source Code Documents” option.

To attach a new document or web link to the incident, you need to click on the “Add New” hyperlink to
open the “Add Attachment” dialog box. There are three different types of item that can be attached to an
incident:

» To upload a file, choose “File” as the type and then click the Browse button and select the file
from your local computer, optionally enter a detailed description then click the <Upload> button.
The document will be copied from your computer and attached to the artifact.

» To attach a web-link (URL) to the artifact, you need to choose “URL" as the type and then enter
the fully qualified URL (e.g. http://mywebsite.com?Document=1), an optional description and then
click the <Upload> button to attach the web-link.

» To attach a screenshot to the artifact, you need to choose “Screenshot” as the type and then
copy the image to your computer’s clipboard (e.g. on Windows computers, the PRINT SCREEN
button captures the current page and adds to the clipboard). Once the image is in the clipboard,
click on the “Paste image from clipboard” hyperlink and the item will appear in the preview
window. You can then fill in the other fields and click <Upload> to attach the image.

Note: If you are using a hon-Windows® computer (e.g. Macintosh®) that doesn't put file extensions on
filenames (e.g. .xls for an Excel sheet) automatically, then you will need to manually add the file extension
to the filename before uploading if you want it to be displayed with the correct icon in the attachment list.

You can also associate an existing document (that’s already stored in SpiraTeam) with the incident. To do
that, click on the “Add Existing” hyperlink to bring up the add file association dialog box. You can then
choose to either associate a document stored in the SpiraTeam Documents repository or (in the case of
SpiraPlan/SpiraTeam but not SpiraTest) from the linked source code repository. In either case you first
select the appropriate folder, and then pick the document(s) from the file list on the right. In the case of a
source code file association you can also add a comment.
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http://mywebsite.com/?Document=1

6.2.7. History

In this mode, the main pane displays the list of changes that have been performed on the incident artifact
since its creation. An example incident change history is depicted below:

Comments Schedule # Custom Props # Aftachments # History # Associations #*
= Refresh | Apply Filter | Clear Filter
v ChangelD AY Change Date AV  Field Name 4 ¥ Old Value 4 ¥ New Value 4 ¥ Changed By A¥ Change Type A ¥
||l =] ||l ||l | [[Ay- Y] Ay ¥
17 2-Jun-2011 Owner Joe P Smith Fred Bloggs Fred Bloggs Modified
17 2-Jun-2011 % Complete 25 0 Fred Bloggs Modified
17 2-Jun-2011 Est. Effort 20 18 Fred Bloggs Modified
17 2-Jun-2011 Projected Effort 20 18 Fred Bloggs Modified
17 2-Jun-2011 Remaining Effort 15 18 Fred Bloggs Modified
13 2-May-2006 Status Open Assigned Fred Bloggs Modified
8 5-Mar-2005 Status New Open Fred Bloggs Modified
6 4-Mar-2005 Type Incident Bug Joe P Smith Modified
Show rows per page Displaying page faof1

The change history displays the date that each change was made, together with the fields that were
changed, the old and new values and the person who made the change. This allows a complete audit trail
to be maintained of all changes in the system.

6.2.8. Associations

In this mode, the main pane displays a list of any requirements, test runs, test steps or other incidents
that are associated with this incident:

© Copyright 2006-2011, Inflectra Corporation

Resolution Schedule # Custom Props # Aftachments # History # Associations *
= Add | Delete | Refresh | Apply Filter | Clear Filters | [ |Include Source Code Revisions
v Artifact Name 4V Artifact Type AY Created On AV Created By A¥ Comment AV Artifact # A ¥ Edit
D | [ E— ) — " ]
O 1 Ability to associate books with different editions  Requirement 19-Mar-2004 Joe P Smith RQ0O00009
O L_-Iﬁ.hi\it\’to create new book (Step 2) Test Step 19-Mar-2004 Fred Bloggs This incident is related to | TS000002
the test step
O ™ The book listing screen doesn't sort Incident 17-Mar-2004 Joe P Smith IN0D000E
B Ahility to create new book Test Run 1-Dec-2003 Joe P Smith Test Run: Ability to create | TRO00001
new book
= Ability to add new books to the system Requirement 1-Dec-2003 Fred Bloggs Test Run: Ability to create | RQ0O00004
new book
Show rows per page Displaying page Taof1
= Create a new requirement from this incident =]

The incidents in this list are ones that a user has decided are relevant to the current one and has created
a direct link between them. In the case of requirements and test cases, the association can be either due
to the creator of an incident directly linking the incident to the requirement or test step, or it can be the
result of a tester executing a test-run and creating an incident during the test run. In this latter case, the
check-box to the left of the association will be unavailable as the link is not editable.

Each association is displayed with the type of artifact (requirement, test step, test run, incident), the name
of the artifact being linked-to, the name of the person who created the association, and a comment that
describes why the association was made. In the case of an indirect association due to a test run, the
comment will contain the name of the test run.

In addition, when using SpiraPlan or SpiraTeam, you can select the checkbox marked “Include Source
Code Revisions” and the system will also scan the source code repository for any revisions that are linked
to this artifact. Since that can take be slower than accessing SpiraTeam, it is provided as an option that
you can enable and disable:
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Resolution Schedule # Custom Props # Attachments # History # Associations #
= Add | Delete | Refresh | Apply Filter | Clear Filters | Include Source Code Revisions
v Artifact Name AV Artifact Type A ¥ Created On AV Created By AY Comment A Y Artifact # A Edit
O [eam- Y] 8] [av- Y] [
@ rev0005 Revision 16-Jan-2010 Fred Bloggs The artifact was changed in | -
this version to fix th...
B 1000003 Revision 16-Jan-2010 Fred Bloggs The artifact was changed in | -
this version to fix th...
[0 | B Ability to associate books with different editions | Requiremant 19-Mar-2004 Jog P Smith RQ000009
7 | 23 Ability to create new book (Step 2) Test Step 19-Mar-2004 Fred Bloggs Tr:wis incident is related to | TS000002
the test step
O | ™) The book listing screen doesn't sort Incident 17-Mar-2004 Joe P Smith IN000O0E
2 Ability to create new book Test Run 1-Dec-2003 Joe P Smith Test Run: Ability to create | TRO00001
new book
ﬁ,&_hi\itvtg add new books to the system Requirement 1-Dec-2003 Fred Bloggs Test Run: Ability to create = RQ000004
new book
Show Tows per page Displaying page EI faof1
= Create a new requirement from this incident =)

You can perform the following actions on an association from this screen:

» Delete — removes the selected association to the other artifact. This will only delete the
association, not the linked artifact itself.

>» Refresh — updates the list of associations from the server, useful if other people are adding
associations to this incident at the same time.

> Apply Filter — Applies the entries in the filter boxes to the list of associations

Clear Filters — Clears the current filter, so that all associations for the current incident are shown.

Edit — Clicking the [Edit] button to the right of the associations allows you to edit the comment
field inline directly on this screen.

To create a new association, simply click the <Add> hyperlink which will display the “Add New
Association” popup dialog box:

[| Add New Association B
Please choose the type of artifact that you want to add an association to:
Olncident  C'Requirement (@ Test Step
Please choose the artifact that you want to add an association to:
(a)  Enter Artifact ID: TS I:I
(b)  Choose from list: 7 |Test£ase 7 |Test Step
E &2 Functional Tests | & i3] Step 1 &
O Elabilityta ) step 2
crea; new book 0 @JSIepS
© Existi_r;luAttr::Jllllthm . O mStepd [
L Comment: a comment|
| > Add | Cancel

A=Ay
—_— —

Once you have selected the appropriate artifact type, you will then be able to choose the specific artifact
you want to link to. In all cases, you can choose the item from a scrolling selection box, or you can either
enter the ID of the artifact directly (if known). In either case you can also add a comment that explains the
rationale for the association. If you're adding an association to a test step, then there are actually two
selection boxes, one to choose the overall test case and the other to choose the specific test step.
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6.2.9. Creating a Requirement from an Incident

Sometimes you may have a situation where an enhancement has been logged in the incident tracker and
now that it has been approved, it needs to be converted into a formal requirement so that test cases and
tasks can be generated from it. To aid this process, there is a shortcut link on the Associations tab that
allows you to create a new requirement from the current incident and have it be automatically added to
the requirements list. When that is performed an association is automatically added that links this new

requirement to the original incident.

6.2.10. Emailing the Incident

Using the <Email> button on the toolbar, you can send an email containing details of the incident to an

email address or another user on the system:

Email this artifact to:

@ Project User: | Fred Bloggs ¥

Select a user in the projedt to send to.

Email Addresses:

A list of email addresses, separated by ;

X

Message Subject:

Leave blank for default.

Send | Cancel

You can specify the subject line for the email, and either a list of email addresses, separated by
semicolons, or an existing project user .The content of the email body is specified by the email template

configured in the Administration > Notification Templates screen.
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7. Release Management

This section outlines how to use the Release Management features of SpiraTeam® to manage different
versions of the system being tested in a particular project. This is an optional feature of the system, and
you can manage the testing for a project successfully without tracking individual releases. Typically when
you develop a system, it is important to ensure that features introduced in successive versions do not
impair existing functionality - this is known as regression testing.

In such situations, you will want to be able to execute the same set of test scripts against multiple
versions of the system and be able to track failures by version. A feature that works correctly in version
1.0 may fail in version 1.1, and the maintenance team may be testing the existing lifecycle of v1.0 in
parallel with the development team testing v1.1. Therefore by developing a master set of
releases/versions in the Release Management module, you can have the different testing teams correctly
assign their testing actions to the appropriate version.

There are two types of release artifact in SpiraTeam® - major project releases that are displayed with the
blue release icon and represent major versions of the system, and release Iterations (aka builds) that are
displayed with a yellow icon and represent intermediate builds/iterations of the system. Note: Iterations
can be contained within a Release, but not the other way round.

The main differences between releases and iterations are as follows:

> Releases are independent versions of the system being tested and as such, you can map a
requirement directly to a release, indicating the release of the system that the requirement will be
fulfilled in.

» When you report on a release (e.g. on the project home or in one of the reports) any child
iterations are automatically taken into account, and test runs and incidents that are related to the
child iterations will get included in the release reports. Child releases on the other hand are not
aggregated up into the parent release.

7.1. Release List

When you click on the Planning > Releases global navigation link, you will initially be taken to the release
list screen illustrated below:

nionmation System ¥ Help?

My Page Project Home Planning Testing Tracking Reporting

Requirements | Releases | lierafions | Planning Board Role: Manager
dhlnsert  $3 Delete | & lndent <sOuident |—Showlew— ¥| RyRefresh | [} Edit i%iTools |- Showhide colnuns - Y| 7 Filter
+ o Release Name Version # Test Coverage Task Progress Start Date End Date Plan Effort Task Effort heration? 1D
[ 0 [ | B SR | i N[ vlfme] |
= T Library System Release 1 1.00.0 =5 ] 1-Mar2004  12.Mar-2004  216.0h 94.0h No RLO0000A
1.0.1.0 No Tasks 13.Mar.2004  30.Mar.2004  176.0h 0.3h No RLODOOOZ |
1.0.1.0.0001 Test No Task 13-Mar-2004  20-Mar-2004 | 30.0h Yes RLODOD11 |
1.0.1.0.0002 No Test N sk 21-Mar-2004  24-Mar-2004  46.0h Yas RLODDD12 |
1.0.1.0.0003 N 1s No Task 25-Mar-2004  30-Mar-2004  54.0h Yes RLODOD13 |
1.0.20 No Tasks 1-Apr-2004 30-Apr-2004  352.0h No RLO000O3 [+ |
B naration 001 1.0.2.0.0001 B Mo Task 1-Apr-2004 10-Apr-2004 | 112.0n Yes RLODDD14
1.0.2.0.0002 N ! Mo Ta M-Apr2004  20-Apr2004 1120k Yes RLODOO1S
1.0.2.0,0003 No Test No Task 21-Apr-2004 30-Apr-2004 128.0h Yes RLODOD16 |
1.0.0.0.0001 No Test 1-Mar-2004 d-Mar-2004 96.0h 32.0h Yes RLODOOOB
B iteration 007 1.0.0.0.0002 No Test 5-Mar-2004  6Mar2004  24.0h 32.0n Yos RLODODOS
7 hterai 3 1.0.0.0.0003 N 1 | — 9-Mar-2004 12-Mar-2004  T2.0h 30.0h Yes RLODOOO [+ Edit |
= @ Library System Releass 1.1 1100 [ 15.0ct-2004  27-0ct2004  168.0h 86.0h No RLOD00O4 [+ Edit |
B Library System Release 2005 1200 1-Apr-2005 2-Apr-2005 16.0n 10.0n No RLO0O0OG [+ Edit |
Show |L! ToWs per page 4 - Displaying page 1_; Gof 1w

The release list will contain all the releases and iterations associated with current project. When you
create a new project, this list will initially be empty, and you will have to use the <Insert> button to start
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adding releases and iterations to the project. The hierarchical organization of releases in the list is
configurable, so you can organize the various releases in the way that makes most sense for a particular
project. Typically you have the major releases as the top-level items, with sub-releases, builds and
iterations as the lower-level items.

All of the releases in the list have a release-name, together with the assigned version number for that
release, the start-date and end-date for the release, the number of estimated project personnel working
on that release, the planned effort for the release, the total effort currently scheduled (as tasks), the
available effort for new tasking, the release id, and a set of custom properties defined by the project
owner.

For those releases that have test cases mapped against them, the execution status of the various test
cases associated with the release is displayed in aggregate for each item as a graphical bar diagram. If
you position the mouse over the execution status indicator you will see the detailed execution information
displayed as a tooltip.

For those releases that have at least one requirement task associated with them, they will display a block
graph that illustrates the relative numbers of task that are on-schedule (green), late-starting (yellow), late-
finishing (red) or just not-started (grey). These values are weighted by the effort of the task, so that larger,
more complex tasks will be change the graph more than the smaller tasks. To determine the exact task
progress information, position the mouse pointer over the bar-chart and the number of associated tasks,
along with the details of how many are in each status will be displayed as a “tooltip”.

Clicking on a release’s hyperlink will take you to the release details page for the item in question (see
section 7.2).

7.1.1. Filtering
You can easily filter the list of releases as illustrated in the screen-shot below:
- - Welcome, System | My Profile | Administration | Log Out | [Ubresy bfomaion System  [w] Help?
Team
My Page Project Home Planning Testing Tracking Reporting
Requirements | Releases | ltesations Role: Project Owner
e (3osee | hoen oW |-Srowleve- v] @Rsten | iEs @Egxt |- Showhcecoumes- |v] Y fer
+ ¢ Release Name Version # Test Statug Task Progress Start Date End Date Plan Effort Task Effort Ieration? Release ld  Edit
| ] | [am— ] [-an il @ || o] [ [ Ho | RL + Filter
O | = @ Library System Release 1 1.0.0.0 I | | 1-Mar-2004 12Mar-2004  216.0h 94.0h No RLO0ODMT [+ Edit
0 = ) Library System Release 1 5P1 1.0.1.0 No Tasks 13-Mar-2004  30-Mar-2004  176.0h o RLODG0OZ
O = T Library System Release 1 5P2 1.0.2.0 No Tasks 1-Apr-2004 30.Apr2004  352.0h No RLODD00Z
O | = T Library System Release 1.1 1.1.0.0 [ 15.0ct-2004  27.0ct2004  168.0h 86.0h No RLODOD04 [+ Edit |
O 2l Library System Release 1.1 5P1 1110 N 1-Mov-2004 30-Nov-2004 336.0h Na RLODO0OS  |» Edit
(] 3 Library  Rel spz 1120 I N 1-Dec-2004 31-Dec-2004 320 0h Mo RLODODOT
4] B Library Sys e 2005 1200 ] 1-Apr-2005 2-Api-2005 16.0h 10.0h o RLO0000E [+ Edit
Show |15 ¥ | rows per page 4 4 Displaying page"._ Gof1em
dhinsert {3 Delete | <> Indent <o Outdent

To filter the list by any of the displayed columns, you either choose an item from the appropriate drop-
down list or enter a free-text phrase (depending on the type of field) then click <Filter> or press the
<ENTER> key to apply the different filters. Note that the name field is searched using a “LIKE”
comparison, so that searching for “database” would include any item with the word database in the name.
The other freetext fields need to be exact matches (e.g. dates, release numbers). In the screen-shot
above, we are filtering on Iteration = No. Clicking on <Clear Filters> clears all the set filters and displays
all the releases for the project.

In addition, if you have a set of filters that you plan on using on a regular basis, you can choose the option
Filter > Save Filter to add the current filter to the list of saved filters that appear on your ‘My Page’. The
list of saved filters can also be retrieved by clicking Filter > Retrieve Filter:
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. . Welcome, Fred Bloggs | My Profile | Log Out | Library Infarmation System v Help?
iraTeam : :
- My Page Project Home Planning Testing Tracking Reporting
Reguirements | Releases | ltesations Role: Manager
iser 3Delete | <> ndent < Ouient [—Sowlewi— V| RiRefiesh | GhEd (@FEgon [-Stewndecowms- Y] Y Fu
v ¢ Release Name Version # Test Sta End Date Plan Efig U Apply Filter Iteration?  Release Id  Edit
o | — any | Save Filter I [=] £ clearFiter tio v R | [rFmer
[0 & @ Library System Release 1 1.000 BT | Please choose a name for this filter 12Mar2004  216.0h | &> Ratrieve Filter No RLODOOO1
O & T Library System Release 1 5P1 1.0.1.0 [All non feration releases | 30.Mar.2004  176.0h S o RLODO0OZ  [» Edit |
O = J Library System Release 1 5p2 1.0.2.0 30-Apr-2004 352.0h * No RLO0D003  |» Edit
O = @ Library System Release 1.1 1:1.0.0 | > Save |Cancel | 57002004  168.0h 86.0h No RLO0000A
O 3 Library System Release 1.1 81 1.1.1.0 N 1-Nov-2004 30-Hev-2004 336.0h Na RLO000OS
O O Library System Release 1.1 §P2 1.1.2.0 N N 1-Dec-2004 31-Dec-2004 320.0h Mo RLO00DOT [+ Edit |
m] 0 Library System Release 2005 1200 1Apr2005 | 2-Apr-2005 16.0n 10.0h No RLO0000G [~ Edit |
Show _:I faws par page « 4 Displaying pagel]_ Lof 15
dbinset €3 Delete | o Indent <o Outdent

]
7.1.2. Insert

Hovering over the <Insert> button brings up a secondary menu that allows you to choose whether to
insert a release or iteration (if you just click Insert it defaults to inserting a release). In either case, it will
insert the new release / iteration above the currently selected item — i.e. the one whose check-box has
been selected, at the same level in the hierarchy. If you want to insert a releasel/iteration below a
summary item, you need to insert it first, then indent it with the <Indent> button. If you insert a release
without first selecting an existing release from the list, the new release will simply be inserted at the end
of the list.

Once the new release has been inserted, the item is switched to “Edit” mode so that you can change the
default name, active flag, version number and creator.

7.1.3. Delete

Clicking on the <Delete> button deletes all the releases whose check-boxes have been selected. If any of
the items are summary items, then the child releases and iterations are also deleted. In addition, if all the
children are deleted from a summary item, it changes back into a detail item.

7.1.4. Indent

Clicking on the <Indent> button indents all the releases whose check-boxes have been selected. If any of
the items are made children of a release that had no previous children, it will be changed from a detail
item into a summary item. Note: you cannot indent a release or iteration if it is below an iteration, as
iterations are not allowed to have child items

7.1.5. Outdent

Clicking on the <Outdent> button de-indents all the releases whose check-boxes have been selected. If
any of the items were the only children of a summary release item, then that item will be changed back
from a summary item to a detail item.

7.1.6. Refresh

Clicking on the <Refresh> button simply reloads the release list. This is useful as other people may be
modifying the list of releases at the same time as you, and after stepping away from the computer for a
short-time, you should click this button to make sure you are viewing the most current release list for the
project.
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7.1.7. Edit

Each releasel/iteration in the list has an <Edit> button display in its right-most column. When you click this
button or click on any of the cells in the row, you change the item from “View” mode to “Edit” mode. The
various columns are made editable, and <Update> <Cancel> buttons are displayed in the last column:

. Team Welcome, Fred Bloggs | My Profile | Log Out | [Lbrery rfomation System (] Help?
B My Page Project Home Planning Testing Tracking Reporting
Requirements | Releases | lteralions Role: Manager
o Inset  £3 Delete | <> Indent < Ouldent - Show Level - |»| [ Refresh [hcopy [ Export |- Showhide columns ~ |v| Y7 Clear Filters
v & Release Name Version # Test Status Task Progress Start Date End Date Plan Effort Release Id Edit
0 | | [Fan— ¥] [zamy- v | =1l =1 | R[]
] = 3 Library System Release 1 1.0.0.0 | 1-Mar-2004 12-Mar-2004 216.0h RLO000O1
(] T [Library System Release 1 SP1 El [1010 (=] No Tasks iy @ |E (202004 @|ED 17600 %
» Cancel
O 3 Library System Release 1 5P2 ] [1020 | No Tasks e @] |[woze @] 3920h
O 2 eration 001 1.0.0.0.0001 lo Test 1-Mar-2004 4-Mar-2004 96.0h RLO0000S
O 2 neration 002 1.0.0.0.0002 lo Test 5-Mar-2004 8-Mar-2004 24.0h RLO0000% | [ Edit
[m] 3 iteration 003 1.0.0.0.0008 lo Test N 9-Mar-2004 12-Mar-2004 72.0n RLOODO10 | [+ Edit
(] 2 QL ibrary System Release 1.1 1.1.0.0 | 15-0¢1-2004 27-0ct-2004 168.0h RLOODOO4  |= Edit
O 2 Library System Release 1.1 SP1 1110 T 1-Mov-2004 30-Now-2004 336.0h RLO0O0005 |- Edit |
O T Library System Release 1.1 SP2 1120 Mo Test T 1-Dec-2004 H-Dec-2004 320.0h RLO0OOOT |- Edit |
O 2 neration 001 1.1.0.0.0001 15-0ct-2004 18-Oct-2004 24.0h RLO0OD1T | Edit |
B 2] neration 002 1.1.0.0.0002 19-0ct-2004 23-0ct-2004 72.0h RLOO0D13 |- Edit |
[ 2 neration 003 1.1.0.0.0003 | 24-Oct-2004 27-0ct-2004 72.0h RLO0001S | [FEdit |
0 Ol Library System Release 2005 12.0.0 1-Apr-2005 2-Apr-2005 16.0h RLO0000G |- Edit |
Show 1 ¥ rows per page i« Displaying page[1 |% of 1w
oplnsert 3 Delete | o Indent < Outdent

_— e —_ _, ,_—_mM e _memm_mem m e e i

If you click <Edit> on more than one row, the <Update> and <Cancel> buttons are only displayed on the
first row, and you can make changes to all the editable rows and then update the changes by clicking the
one <Update> button. Also, if you want to make the same change to multiple rows (e.g. to change five
releases from “active” to “inactive”), you can click on the “fill” icon to the right of the editable item, which
will propagate the new value to all editable items in the same column.

If you want to edit lots of items, first select their checkboxes and then click the [Edit] button on the same
row as the Filters and it will switch all the selected items into edit mode.

When you have made your updates, you can either click <Update> to commit the changes, or <Cancel>
to revert back to the original information. Alternatively, pressing the <ENTER> key will commit the
changes and pressing the <ESCAPE> key will cancel the changes.

7.1.8. Show Level

Choosing an indent level from the ‘Show Level’ drop down box allows you to quickly and easily view the
entire release list at a specific indent level. For example you may want to see all releases drilled-down to
the third level of detail. To do this you would simply choose ‘Level 3’ from the list, and the releases will be
expanded / collapsed accordingly.

7.1.9. Show / Hide Columns

This drop-down list allows you to change the fields that are displayed in the release list as columns for the
current project. To show a column that is not already displayed, simply select that column from the list of
“Show...” column names and to hide an existing column, simply select that column from the list of
“Hide...” column names. This is stored on a per-project basis, so you can have different display settings
for each project that you are a member of. The fields can be any of the built-in fields or any of the custom
properties set up by the project owner.
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7.1.10. Copying Releases/Iterations

To copy a releaseliteration or set of releases/iterations, simply select the check-boxes of the
releasel/iteration you want to copy and then select the Edit > Copy menu option. This will copy the current
releasef/iteration selection to the clipboard. Then you should select the place where you want the
releasesl/iterations to be inserted and choose the Edit > Paste option.

The releases/iterations will now be copied into the destination location you specified. The name of the
copied releases/iterations will be prefixed with “Copy of...” to distinguish them from the originals. Note
that copied releases/iterations will also include the test mapping information from the originals.

7.1.11. Moving Releases/Iterations

To move a release/iteration in the hierarchy, there are two options:

1. Click on the icon the releasel/iteration you want to move and then drag the icon to the location you
want it moved. The border between the destination releases/iterations will change as the icon is

dragged over it to illustrate where it will be inserted:

e Team Welcome, System | My Profile | Administration | Log Qut | | Library information Systeem i Help?
7 I My Page Project Home Planning Testing Tracking Reporting
Requirements | Releases | Iterations Role: Project Owner
dbinsert §3Delete | o> indent b Outdent | .. Show Level -~ v| @iRefresh | ChCopy [ Expot |- Showhide columns - |v| Y Clear Filters
+ 4 Release Name Version # Test Status Task Progress Start Date End Date Plan Effort  Task Effort  Release Id Edit
o I Lan—_ v] [aw-_¥] | @ ] J R[]
] & T Library System Release 1 1.0.0.0 [ ] 1.Mar-2004 12-Mar-2004 216.0h 94.0h RLOD000T [+ Edit |
) = O Library System Release 1 SP1 1.0.1.0 No Tasks 13-Mar-2004 30-Mar-2004 176.0h RLO0000Z [+ Edit |
] = 3 Library System Release 1 SP2 1.0.2.0 o Ta 1-Apr-2004 30-Apr-2004 352.0h RLO0000O3
] = tergtion 001 1.0.0.0.0001 1-Mar-2004 4-Mar-2004 96.0h 32.0h RLOD0OOS
] 2 ttesation 002 1.0.0.0.0002 5-Mar-2004 8-Mar-2004 24.0h 32.0h RLOD0ODS
a 2 iteration 003 1.0.0.0.0003 [ 9.Mar-2004 12-Mar-2004 72.0h 30.0h RLOD0O10 » Edit
] N P 1.1.0.0 [ 15.0ct-2004 27-0ct-2004 168.0h 86.0h RLO00004 [ Edit |
o o brary System Release 13720 1110 1.ov-2004 30-Hov-2004 336.0n RLOD000S
] B Library System Release 1.1 SP2 1120 1-Dec-2004 31-Dec-2004 320.0h RLODDOOT
] B htecation 001 1.1.0.0.0001 15-0ct-2004 18-Dct-2004 24.0n 29.0h RLOOOOTT [V Edit |
] 2 htesation 002 1.1.0.0.0002 19-Oct-2004 23-0ct-2004 72.0h 27.0h RLO00DTS  [FEdit |
| & jeation 003 11000003 | 24-Oct-2004 27-0ct-2004 T2.0h 30.0h RLODOO1S
O & Library System Release 2005 1.200 1-Ape-2005 2-Apr-2005 16.0h 10.0h RLO0000S
Show ‘: fows per page < < Displaying page \Zl'a of 1=
gpinsent £} Delete | <> indemt <> Outgent

_—=

Once you have the release/iteration positioned at the correct place that you want it inserted, just
release the mouse button and the release list will be refreshed, with the releasel/iteration moved
to the desired location. To move multiple items simply select their checkboxes and then drag-and-

drop one of the selected items.

2. Alternatively you can simply select the check-boxes of the release/iteration you want to move and
then select the Edit > Cut menu option. This will cut the current release/iteration selection to the
clipboard. Then you should select the place where you want the releasel/iteration to be inserted
and choose the Edit > Paste option. The release/iteration will now be moved into the destination

location you specified.

7.1.12. Exporting Releases/Iterations

To export releases/iterations from the current project to another project in the system, all you need to do
is select the check-boxes of the releases/iterations you want to export and then click the Tools > Export
icon. This will then bring up a list of possible destination projects:
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Requirements | Releases | lterations | Planning Board Role: Manager
dhinsert 3 Delete | o Indent s Outdent |—Showlevl— ¥| RyRefresh | [jEdit {%jTools |- Showhide colimns— ¥| Y Eitter

v o Release Name __\fersion! _‘Je! Export ltems | _ End Date : _Phn Effort s Task Effort ) _Imarhm? ’ (1] 3
| | i 2l @] Il eiid L
= B Library System Release 1 1.00.0 [ P sukect tho project you wank b oiport Lo 12-Mar-2004  216.0h 94.0n No RLO000OT
F) = T Library System Release 1 5P1 1010 | [Samete Appiication Gne Y| 3 30Mar2004  176.0h 0.3h No RLO00O02 |
0 1.0.1.0.0001 Nl } o 20-Mar2004 | 30.0h Yes RLODOD11 |
1.0.1.0.0002 > Expart| Gancel I 24-Mar-2004  45.0h Yes RLOBO012
i 1.0.1.0.0003 1 30-Mar-2004  64.0h Yes RLOO0D13 |
= B Library System Release 1 5P2 1.02.0 No Tasks 1.Apr2004  30.Apr2004  352.0h No RLO00DO3 [
atiin 001 1.0.2.0.0001 b t No Task 1-Apr-2004 10-Apr-2004 | 112.0n Yes RLOODD14
1.0.2.0.0002 No Test Mo Tasks 11-Apr-2004 20-Apr-2004 112.0h Yas RLOOOO15
1.0.2.0.0003 No Tests No Task 21-Apr-2004 30-Apr-2004 128.0h Yes RLODOD1E |+ Edit
) hteration 001 1.0.0.0.0001 No Test 1-Mar-2004 4-Mar-2004 9%.0h 32.0h Yes RLO0ODOB |>_Edll_J
) taration 002 1.0.0.0.0002 1 5-Mar-2004 g-Mar-2004 24.0n 32.0h Yes RLOD0ODS [+ Edit |
2 nerati 0 1.0.0.0.0003 No Tests ] 9-Mar-2004 12-Mar-2004  72.0h 30.0h Yes RLODOO10 |:E£“|
@ @ Library System Release 1.1 1.1.0.0 = 15.0c1.2004  27.0c1:2004  168.0h 86.0h No RLOD0D04 [+ Edit
8 Library System Release 2005 1200 1-Apr-2005 2-Apr-2005 16.0n 10.0h No RLODOOOE [+ Edit |
Show |15_! roWs per page 4 4 Displaying page 1._i Tofimm

Once you have chosen the destination project and clicked the <Export> button, the releases/iterations will
be exported from the current project to the destination project. Any file attachments will also be copied to
the destination project along with the release/iteration.

7.1.13. Creating Test Sets from Releases

As a shortcut you can click the Tools > Create Test Sets option to create new test sets from the list of
selected releases. The created test sets will include all of the test cases associated with this release. This
is useful in regression testing when you have created a new release and want to be able to quickly assign
a tester to ensure that all the functionality in the release works as expected.

7.1.14. Printing Items

To quickly print a single release/iteration or list of releases/iterations you can select the items’
checkboxes and then click Tools > Print Items. This will display a popup window containing a printable
version of the selected items.

7.1.15. Right-Click Context Menu

SpiraTeam® provides a shortcut — called the context menu - for accessing some of the most commonly
used functions, so that you don’t need to move your mouse up to the toolbar each time. To access the
context menu, right-click on any of the rows in the release list and the following menu will be displayed:

ZLE! Library System Release 1 SP1 1.0.1.0 No Tasks 13-Mar-2004 30-Mar-2004 176.0h
2 lteration 001 I} Open ltem No Tests No Tasks 13-Mar-2004 20-Mar-2004 80.0h
ﬂm IZ? Open in New Tab No Tests No Tasks 21-Mar-2004 24-Mar-2004 48.0h
™ Iteration 003 [E| New Release No Tests No Tasks 25-Mar-2004 30-Mar-2004 64.0h

=] Library System Releas ] New lteration No Tasks 1-Apr-2004 30-Apr-2004 352.0n
2 Jteration 001 Edit ltems No Tests No Tasks 1-Apr-2004 10-Apr-2004 112.0h
2 lteration 002 £3 Delete No Tests 11-Apr-2004 20-Apr-2004 112.0h
2 lteration 003 2> Indent No Tests 21-Apr-2004 30-Apr-2004 128.0h

2 lteration 001 <5 Qutdent No Tests 1-Mar-2004 4-Mar-2004 96.0h
& lteration 002 I Copy ltems No Tests 5-Mar-2004 8-Mar-2004 24.0h
2 lteration 003 [ Cut ltems No Tests 9-Mar-2004 12-Mar-2004  72.0h
LE] Library System Release| [} Paste ltems 15-0ct-2004 27-0ct-2004 168.0h
= 4200 4 A ETTatd LY SO0 Ao b

You can now choose any of these options as an alternative to using the icons in the toolbar
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7.2. Release Details

When you click on release item in the release list described in section 7.1, you are taken to the release
details page illustrated below:

Welcome, Fred Bloggs | Library Information System ¥ | | My Profile | Administration | Log Out | |S

My Page Project Home Planning Testing Tracking Reporting

Team

Requirements | Releases = Release Details | lterations | Planning Board
| B Save [hCopy [ Refresh | $2 Delete | (g Print

<< Back to Release List

Display: | Curent Fiter v

Release: [ Library System Release 1 [RL-000001]

21 iteration 002
1 tteration 003
ELE] Library System Release 1 SP2
1 tteration 001
1 teration 002

cl 'ﬁ:‘f—f—L brary System Release 1 Name*: ‘Library System Release 1 |
= = Library System Release 1 SP1 Description: - R
21 iteration 001 EELIE |'FE'"1' Yl |‘5'ZE‘ Yl BJ U= EE | Ty ds ‘ —eOc@

This is the initial release of the Library Management System
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Version #: 1.0.00 Creator*: ‘ Fred Bloggs v
1 iteration 003
Start/End Date™: \ 31204 D\ = \ 3122004 D\ Creation Date:  15-Feb-2004
21 iteration 001
B Iteration 002 # Resources™ Active™ Yes v
__ﬂ Iteration 003 Non-Working®™: person days Iteration™ No v
=l Library System Release 1.1 o —_ AR —
[El Library System Release 2005 an Effort: : vailable Effort: :
Incidents # Reqs & Tasks # Test Cases # Comments Custom Props # Test Runs # Builds Aftachments # History #

This page is made up of three areas; the left pane is the navigation window, the upper part of the right
pane contains the release detailed information itself, and the bottom part of the right pane displays
different information associated with the release.

The navigation pane consists of a link that will take you back to the release list, as well as a list of the
other releases in the current project. This latter list is useful as a navigation shortcut; you can quickly view
the test run information of all the other releases by clicking on the navigation links without having to first
return to the release list page. The navigation list can be switched between two different modes:

e The list of releases matching the current filter
e The list of all releases, irrespective of the current filter

The top part of the right pane allows you to view and/or edit the details of the particular release. You can
edit the various fields (name, description, etc.) and once you are satisfied with them, simply click either
the <Save> or <Save and New> button at the top of the page to commit the changes. In addition you can
delete the current artifact by choosing <Delete>, discard any changes made by clicking <Refresh> or print
it by clicking <Print>.

When you make changes to the release/iteration’s start-date, end-date, number of project personnel
resources, or number of non-working person days, the system will automatically calculate how many
hours of effort (planned effort) are available in the release/iteration for assigning tasks. As you begin
assigning tasks — either through the Tasks tab or the Iteration Planning screen — the total estimated effort
of the tasks is subtracted from this planned effort to give the “available effort”.

The lower part of the right pane can be in one of eight possible modes that can be selected: “Incidents”,
“Reqgs & Tasks”, “Test Cases”, “Comments”, “Custom Properties”, “Test Runs”, “Builds”, “Attachments”,
and “History”. Each of the different views is described separately below.

7.2.1. Incidents

This is the default view for the release details page. It displays the incidents associated with the selected
release. The incident list can be one of three modes:
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» Detected in this Release — this will display a list of all the incidents that were detected during the
testing of the selected release. This is useful in determining if there are open incidents associated
with a release that need to be dealt with.

» Resolved in this Release — This will display a list of all the incidents that have been reportedly
resolved in this release. This is useful for double-checking that all the resolved incidents for a
release have indeed been fixed.

» Verified in this Release — This will display a list of the incidents that have been verified as being
fixed in this release. This is useful for generating release notes for a specific release indicating
what changes and enhancements have been made in the release.

Regardless of the mode, each incident is listed together with the type, status, priority, name, owner,
detector, detection date and a link to the actual incident details (see section 6.2):

Incidents # Tasks # Test Cases # Custom Props # Test Runs # Aftachments History #
Display List of Incidents: Detected in This Release v‘ = Refresh | Apply Filter | Clear Filters | ‘ — Show/hide columns — v|
v U Incident Name A ¥ Type AY Status AV Priority A¥ Detected By AY Detected On AY Owned By AY Inc. #AY Edit
O | ||—Any— '| |—Any— "| |—Any— " |—Any_ "| | D| |—Any_ '| ml:l » Filter
1| @ | ™ cannot log into the application Incident Mew Fred Bloggs 1-Nov-2003 IM000001
O Mot able to add new author Incident New Joe P Smith 1-Nov-2003 IND00002
1|9 ™ cannot add a new book to the system  Bug Assigned 1 - Critical Joe P Smith 4-Nov-2003 Fred Bloggs IM000007
ShDW rows per page Displaying page El"a of 1

To change between the three modes outlined above, simply select the desired mode from the drop-down
list contained within the header of the incident list table.

You can perform the following actions:

>» Refresh — updates the list of incidents from the server, useful if other people are adding incidents
to this release at the same time.

Apply Filter — Applies the entries in the filter boxes to the list of incidents

Clear Filters — Clears the current filter, so that all incidents associated with the current release
are shown.

>» Edit — Clicking the [Edit] button to the right of the incident allows you to edit the incident inline
directly on this screen. This functionality is limited to project owners.

» Show/Hide Columns — Allows you to choose which incident columns are visible

7.2.2. Regs & Tasks

In this mode, the lower part of the right pane displays the list of requirements and their associated child
tasks that need to be completed for the release/iteration to be completed:
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Incidents # Regs & Tasks # Test Cases # Comments Custom Props # Test Runs # Attachments History %
= Insert Task | Delete Task | Refresh | Apply Filter | Clear Filters | = Est. Effort: 94.0h / Act. Effort: 61.0h / Proj. Effort: 95.8h
v U RequirementTask Name Importance Progress Owner Est. Effort Act. Effort Proj. Effort Edit
0 | | oo ) o | -
O | @ == Ability to add new books to the system 1- Critical Joe P Smith 16.0h 15.5h 16.0h
O = Ability to edit existing books in the system  FISEritical Joe P Smith 16.0h 16.8h 16.0h
O = Ability to delete existing books in the system (1= Critical Fred Bloggs 16.0h 15.2h 16.0h
(] =2 Ability to create different editions 1 - Critical Fred Bloggs 16.0h 10.3h 17.8h
O 1 Develop new edition entry screen 1- Critical Fred Bloggs 8.0h 7.0h 9.0h
O E Create edition object insert method 1 - Critical Fred Bloggs 5.0h 33h 5.8h
| E1 Wrrite edition object insert queries 1 - Critical Fred Bloggs 3.0h 3.0h
0w ;ﬂ Ability to edit existing authors in the system 2 - High Fred Bloggs 16.0h 16.0h
0w ;ﬂ Ability to edit existing authors in the system 2 - High Fred Bloggs 16.0h 16.0h
Show rows per page Displaying page %of 1

Each of the requirements and associated tasks is displayed together with its name, description (by
hovering the mouse over the name), priority, progress indicator, current owner, estimated effort, actual
effort, projected effort and numeric task identifier. Clicking on the task name will bring up the Task Details
page which is described in more detail in section 8.2. This allows you to edit the details of an existing
task.

You can perform the following actions on a task from this screen:

» New Task — inserts a new task in the task list under the specified requirement, with a default set
of values. The task will be associated with the specified requirement and current release/iteration.

>» Delete Task — deletes the task from the project.

Refresh — updates the list of requirements and tasks from the server, useful if other people are
adding requirements and/or tasks to this release/iteration at the same time.

> Apply Filter — Applies the entries in the filter boxes to the list of requirements and all their
associated tasks (it does not filter the tasks themselves).

» Clear Filters — Clears the current filter, so that all requirements associated with the current
release/iteration are shown.

>» Edit — Clicking the [Edit] button to the right of the requirement or task allows you to edit the item
inline directly on this screen. Only columns visible will be editable.

> Show Level — Allows you to quickly expand/collapse all the requirements in the list.
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7.2.3. Test Case Mapping
This mode displays the test case mapping information for the release in question:

Incidents # Tasks # Test Cases # Custom Props # Test Runs # Attachments Hiztory #
Available Test Cases: Test Coverage:
v | Name v | Test # | Name Status
[0 E=&2 Functional Tests ) [ TCo00004 ‘E_'I,ﬂ.hilit\,rto create new author MNIA
4 Ability to create new b [0 TCo00002 ‘B_-I,ﬂ.hilit\,.'to create new book N/A
g_'l Ability to edit existing K [ TCo00005 ‘E_'Iﬁ.hilit\,'to edit existing autho /A
£ Ability to create new author | Remove < | [0 TC000003 £ Apility to edit existing book N/A
g_-l Ahility to edit existing autho Remove All (] TCooooos ‘E.jﬁ.hilit\,.'to reassign book to di N/A
£ Avility to reassign baok to di O TC000009 £ Author management N/A
[ =& Regression Tests [] TC000008 29 Baok management /A,
[] =& Scenario Tests
'
Create Test Set From This Release I3
The test coverage box indicates the test cases that are currently mapped against the release.
To add test cases to this release, choose from the list above and click [Add].
You can use the [Remove] and [Remove All] buttons to remove tests that no longer cover the release.

The pane consists of two lists of test cases, the one on the left being the hierarchical list of the test cases
belonging to the project arranged in test folders. The right box (which will initially be empty) contains the
list of test cases mapped to this release/iteration. The test cases in this box include columns for their ID
and name. Hovering the mouse over the names of the test cases in either box will display a “tooltip”
consisting of the test case name, place in the folder structure and a detailed description. Clicking on the
hyperlinks in right-hand box will jump you to the test case details screen for the test case in question (see
section 5.2.9).

To change the test case mapping for this release, you use the buttons (Add, Remove, Remove All)
positioned between the two list-boxes. The <Add> button will move the selected test cases from the list of
available on the left to the list of mapped on the right. Similarly the <Remove> and <Remove All> buttons
will remove either the selected or all the test cases from the right list-box and add them back to the left
list-box.

Finally, as a shortcut you can click the “Create Test Set from This Release” link to create a new test set
from this release, that will include all of the test cases associated with this release. This is useful in
regression testing when you have created a new release and want to be able to quickly assign a tester to
ensure that all the functionality in the release works as expected.

7.2.4. Comments
The Comments tab shows the current discussion thread made on this release:

Incidents # Regs & Tasks Test Cases # Comments Custom Props # Test Runs Attachments

To add a new comment to this requirement, please enter it below and click the [Save] button:

5| B | —=noo D

- Fort - Y| |—Size— v

Existing Comments

All existing comments are listed in order by entered date. To create a new comment, enter the text into
the text box, and then click the Save button.
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7.2.5. Custom Properties

In this mode, the main pane displays any custom properties that the project owner has defined for
releases. To learn more about how to setup and configure custom properties for a project, please refer to
the SpiraTest Administration Guide. Assuming that custom properties have been defined for your project,
you will see a list of optional parameters that can be set on the release. These can be either freetext or
drop-down-lists. In the example below, you can enter Notes and/or the Operating System that the release
is intended for.

Incidents # Tazks # Test Cazes # Custom Props # Test Runz # Attachments History #

The following are the custom properties of this artifact:

MNotes: This is the first version of the system

Operating System:  [windows Vista v

Once you are satisfied with the values for the custom properties, simply click [Save] or [Save and New] to
commit the changes.

7.2.6. Test Runs

This view displays the list of all the test runs executed against the release. Each test run is listed together
with the date of execution, the name of the test case, the name of the tester, the release/version of the
system that the test was executed against, the name of the test set (if applicable), the overall execution
status for the test case in that run and a link to the actual test run details (see section 5.6). In addition,
you can choose to display any of the custom properties associated with the test run.

Incidents * Tasks # Test Cases Cusiom Progs ® TestRuns # Attachments History *

> Refresh | Apply Filter | Clear Filters | | - Show/nde cokenns - 'I

& TestRRun Name A Y Execution Date AV Test Set AY Release 4 Y Status &Y Est. Dur. 4Y Act. Dur. AY Web Browser AY Operating System AY Run# AY

] | ]| [~any— ¥] [1000-Loran ¥] [~y - v | [-Por v [Aw v| wr[
g 1-Dec-2003 1.0.00 Caution 0.1h 0.8h TRO0DO10

oo

or | 1-Dec-2003 ye 1.0.00 Failed ) 01h 15h TRO0D004

Passed 01k 15h TRO00003

] 1-Dec-2003

O 1-Dec-2003 Failed 0.2h 12h Opera Windows 2003 TRO00012
n|, 1-Dec-2003 Failed 0.2h 1.3h Intemet Explorer Windows XP TRO000M1
Show[15 ¥ | rows per page 4 < Displaying page%‘; i'aaf Thp

The “customize columns” drop-down list allows you to change the fields that are displayed in the test run
list as columns. To show a column that is not already displayed, simply select that column from the list of
“Show...” column names and to hide an existing column, simply select that column from the list of
“Hide...” column names. The displayed columns can be any standard field or custom property.

You can also filter the results by choosing items from the filter options displayed in the sub-header row of
each field and clicking the “Apply Filter” link. In addition, you can quickly sort the list by clicking on one of
the directional arrow icons displayed in the header row of the appropriate field.

7.2.7. Builds

This view displays the list of builds associated with the current release/iteration. Each build is listed
together with its name, creation date, status (whether the build succeeded or failed), and last updated
date. Clicking on the hyperlink for the build name will open up the Build Details page which is described in
section 7.5. of this manual.
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Incidents # Regs & Tasks # Test Cases # Comments Custom Props # Test Runs # Builds Attachments # History #
= Refresh | Apply Filter | Clear Filter
Build Name 4 ¥ Creation Date 4V Status A ¥ Last Updated 4 ¥ DAY
| | ‘»3;432004 |:|| Ay - v Ijl BLI:I
# Build 0015 12-Mar-2004 Succeeded 12-Mar-2004 BLO00015
) Build 0014 11-Mar-2004 Succeeded 11-Mar-2004 BLO00014
# Build 0013 10-Mar-2004 Failed 10-Mar-2004 BL0O00013
) Build 0012 9-Mar-2004 Failed 9-Mar-2004 BLO00012
1 Build 0010 8-Mar-2004 Failed 8-Mar-2004 BLO00010
# Build 0011 8-Mar-2004 Succeeded 8-Mar-2004 BLO00011
# Build 0009 7-Mar-2004 Succeeded 7-Mar-2004 BLO0000Y
) Build 0008 6-Mar-2004 Succeeded 6-Mar-2004 BLO000O0S
# Build 0007 5-Mar-2004 Failed 5-Mar-2004 BLO000OT
) Build 0005 4-Mar-2004 Failed 4-Mar-2004 BLO0000S
# Build 0008 4-Mar-2004 Succeeded 4-Mar-2004 BLO0000G
Show rows per page Displaying page %of1

You can also filter the results by choosing items from the filter options displayed in the sub-header row of
each field and clicking the “Apply Filter” link. In addition, you can quickly sort the list by clicking on one of
the directional arrow icons displayed in the header row of the appropriate field.

7.2.8. Attachments

In this mode, the lower section of the screen displays the list of documents that have been “attached” to
the release. The documents can be in any format, though SpiraTeam® will only display the icon for
certain known types.

Incidents # Regs & Tasks # Test Cases # Comments Custom Props # Test Runs # Builds Attachments History #

= Add New | Add Existing | Remove | Refresh | Apply Filter | Clear Filter | [/|Include Source Code Documents

v Document Name &4V Type AY Size AY Edited By 4 ¥ Edited On AV Author &Y DAY
| | S | [Av- Y] @B [ Y] oc[ |
B8 pocument Filename10 optx Source Code 105 KB Fred Bloggs 19-Dec-2011 Fred Bloggs DC-000009
4] Bug Stack Trace txt Stack Trace 1KB Joe P Smith 4-May-2006 Joe P Smith DC000010
B £1ror Stackirace doc Stack Trace 24 KB Fred Bloggs 1-May-2006 Fred Bloggs DCO00004
Show rows per page Displaying page "a of 1

The attachment list includes the filename that was originally uploaded together with the file-size (in KB),
name of the person who attached it and the date uploaded. In addition, if you position the pointer over the
filename and hold it there for a few seconds, a detailed description is displayed as a tooltip.

To actually view the document, simply click on the filename hyperlink and a new web browser window will
open. Depending on the type of file, this window will either display the document or prompt you for a
place to save it on your local computer. To remove an existing attachment from a release/iteration, simply
click the <Remove> button and the attachment will be removed from the list.

If you are using SpiraPlan or SpiraTeam (but not SpiraTest) you can also choose to include file
attachments stored in a linked version control system (e.g. Subversion, CVS, Perforce, etc.) by selecting
the “Include Source Code Documents” option.

To attach a new document or web link to the releasel/iteration, you need to click on the “Add New”
hyperlink to open the “Add Attachment” dialog box. There are three different types of item that can be
attached to a release or iteration:

» To upload a file, choose “File” as the type and then click the Browse button and select the file
from your local computer, optionally enter a detailed description then click the <Upload> button.
The document will be copied from your computer and attached to the artifact.
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» To attach a web-link (URL) to the artifact, you need to choose “URL” as the type and then enter
the fully qualified URL (e.g. http://mywebsite.com?Document=1), an optional description and then
click the <Upload> button to attach the web-link.

» To attach a screenshot to the artifact, you need to choose “Screenshot” as the type and then
copy the image to your computer’s clipboard (e.g. on Windows computers, the PRINT SCREEN
button captures the current page and adds to the clipboard). Once the image is in the clipboard,
click on the “Paste image from clipboard” hyperlink and the item will appear in the preview
window. You can then fill in the other fields and click <Upload> to attach the image.

Note: If you are using a hon-Windows® computer (e.g. Macintosh®) that doesn't put file extensions on
filenames (e.g. .xls for an Excel sheet) automatically, then you will need to manually add the file extension
to the filename before uploading if you want it to be displayed with the correct icon in the attachment list.

You can also associate an existing document (that’s already stored in SpiraTeam) with the release. To do
that, click on the “Add Existing” hyperlink to bring up the add file association dialog box. You can then
choose to either associate a document stored in the SpiraTeam Documents repository or (in the case of
SpiraPlan/SpiraTeam but not SpiraTest) from the linked source code repository. In either case you first
select the appropriate folder, and then pick the document(s) from the file list on the right. In the case of a
source code file association you can also add a comment.

7.2.9. View History

In this mode, the main pane displays the list of changes that have been performed on the release artifact
since its creation. An example release change history is depicted below:

Incidents # Reqgs & Tasks # Test Cases # Comments Custom Props # Test Runs # Builds Atftachments # History #

= Refresh | Apply Filter | Clear Filter | Admin View

Change ID A Y Change Date 4V Field Name 4 ¥ Old Value 4 ¥ New Value 4 ¥ Changed By 4¥ Change Type A ¥
| Il ] |l | [[Av- ] [Aw- V]
10 2-May-2006 MName Need to create new book | Ability to create new book | Fred Bloggs Modified

1 4-Mar-2005 Version # 1.0.0 1.0.0.0 Joa P Smith Modified

Show Tows per page Displaying page "- of 1

The change history displays the date that each change was made, together with the fields that were
changed, the old and new values and the person who made the change. This allows a complete audit trail
to be maintained of all changes in the system. In addition, if you are logged in as a project administrator
you can also click on the “Admin View” hyperlink to revert any unwanted changes.
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http://mywebsite.com/?Document=1

7.3. Iteration Planning

As well as being able to assign requirements, tasks and incidents to releases and iterations individually
through the Release/lteration details page (see above), you can also do this on the Iteration Planning
screen. When you are first planning the iteration, and need to batch assign requirements, tasks and
incidents from the backlog of unscheduled items to the iterations, it is usually more convenient to use the

Iteration Planning screen. To access this screen, go to Planning > Iterations, choose the current release
and the following screen will be displayed:

= T =— —
Displaying the iteration plan for the selected release: ( ¥l Include Tasks) Selected Release: |1.0.00-Liey System Release 1 Y@
= Available Utilized Remaining
| Release 1.0.0.0 (3/1/2004 - 3/12/2004) - Refrash 216.0h ‘ 95 8h ‘ 120.3h
M4 7]1.0.0.0.0001 (3/1/2004 - 3/4/2004) 1211.0.0.0.0002 (3/5/2004 - 3/8/2004) £ 1.0.0.0.0003 (3/9/2004 - 3/12/2004)
Available Utilized Remaining Available Utilized Remaining Available LUtilized Remaining
96.0n 320h B4.0h 24.0n 32.0h B.0h 72.0n 31.8h 403h
[0 ] Ability to edit existing authers in the system 16.0h
Refact t 1 [ 73 Refactor author screen to include delete button 6.0h
[7] ¥ Develop edit author details screen 8.0h
[] #] Create author object update mathod 5.0n > ion obj sert
[1 £ Write author object update queries 3.0n [ ) Wiite edition object ingert queries 3.0n
Reas & Tasks incidents
= Insert Task | Delete Task | Refresh —Shaw Level — v | Apply Filter | Clear Filters
v i RequirementTask Name Importance Pragress Owner Est. Effort Act. Effort Proj. Effort Edit
0 bt : I|7,1.y7 e ': |”‘"f i d ‘ZA'\.? i Cim - | .. ] il ] ]
0 | &%) Ability to edit existing subjects in the system | 3 - Medium Joe P Smith  3.0h 15.0h [~ Eait |
) = ] Ability to completaly backup the datahase | 3 - Medium No Tasks Joe P Smith [FEait |
[0 @ =2 Ability to import from legacy system x 4-Low Fred Bloggs [=Edit |
O @ Ability to ereate ne in the system 3 - Medium Fred Bloggs [+ Eait |
O] @2 Ability to modify existing users in the system 3 - Medium dou P it [+ Eait_|
—

This screen is divided into two sections:

» The top part of the screen displays the iterations contained within the current release (up-to three
per page) together with the list of requirements, tasks and incidents currently assigned to the

iteration. Also any of these item directly associated with the release itself are displayed in the first
panel.

>» The bottom part of the screen displays the list of accepted, unplanned (not started) requirements
and tasks and unplanned, open incidents that need to be scheduled for a specific iteration. This is
essentially the backlog of requirements and their associated tasks, together with any outstanding

incidents that need to be scheduled. The requirements and tasks are shown in one tab and the
incidents are shown in the other

To navigate around the release, you use the small black arrow buttons located at the top of the iteration
panels. These allow you to quickly move to the previous/next iteration in the currently selected release.

To change the release itself, you use the drop-down-list at the top-right of the page to change to a
different release.

7.3.1. Scheduling Requirements / Tasks / Incidents to Iterations

To assign a new requirement, task, or incident to the iteration schedule, you either position the mouse
pointer over a single item’s icon, dragging it to the desired iteration or you select several checkboxes in
the requirements / tasks / incident list and then drag all the selected items in one go. Once the
requirement / task / incident(s) have been added to the iteration, the utilized effort for the iteration will
increase, and the available effort will decrease by the same amount.
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Displaying the iteration plan for the selected release: { MInclude Tasks) Selected Release: | 1.0.0.0- Library System Release 1 ML

= Available Utilized Remaining
ElRelease 1.0.0.0 (3/1/2004 - 3/12/2004) - Refresh 216.0h 95 ah ‘ 120.3h
M4 171.0.0.0.0001 (3/1/2004 - 3/4/2004) 1 1.0.0.0.0002 (3/5/2004 - 3/8/2004) 1 1.0.0.0.0003 (3/9/2004 - 3/12/2004)

Available Utilized Remaining Available Utilized Remaining Available Utilized Remaining

96.0h 32.0n 64.0h 24.0h 32.0n -8.0h 72.0h 31.8h 40.3h

=] Abi =] Ability to delete existing books in the system 16.0h _‘\1.: tv to create different editions

= Ab [] & Ability to edit existing authors in the system 16.0h ‘ ] Ability to edit axisting authors in the system},

& De gR 8.0 [0 £ Refactor author screen to include delete button 6.0n

ac ac

| a Write 3

] De [ % Develop edit author details screen 8.0h

“c [] ¥ Create author object update method 5.0h | 58

an [ &3 Write author object update queries 3.0h [0 &) Write edition object insert queries 3.0h

If you schedule a requirement for a specific iteration, all the child tasks that have not yet been started, will
follow the parent requirement in being associated with the iteration.

Note: The system will allow you to assigh more tasks/incidents to an iteration than is possible to
complete, however this will result in a negative value for ‘available effort’. If this happens, the “Available
Effort” value will be displayed in red, and you need to rebalance the items, extend the iteration length or
add project personnel resources to the iteration.

7.3.2. Rescheduling Requirements / Tasks / Incidents

To move planned items from one iteration to another, you either position the mouse pointer over a single
item’s icon, dragging it to the desired new iteration or you select several checkboxes in the existing
iteration and then drag all the selected items to the destination iteration in one go. To remove a
requirement / task / incident from an iteration, you should just drag and drop it from the iteration panel
back to the requirement / task / incident task list at the bottom of the page. This will return the item to the
list of unplanned items at the bottom of the page.

If you reschedule a requirement to a new iteration, all the child tasks that have not yet been started, will
follow the parent requirement in being associated with the new iteration. The tasks that have already
started will remain associated to the old iteration.

Note: Once a task has changed status from ‘not-started’ to any of the other statuses, its checkbox will be
disabled and you will need to return it to the ‘not started’ status before attempting to reassign it. This is a
safety feature that prevents you from accidentally rescheduling a task that is currently being worked on.

7.3.3. Task Assighment Rules
When you move a task from one iteration to another or assign a new task to the iteration, the system
makes the following changes to the task automatically:

» The releaseliteration that the task is assigned-to is updated

» The start-date and end-date of the task is changed to match that of the iteration if the dates lie
outside the bounds of the iteration. This means that the task may change from being on-schedule
to late-starting depending on whether the iteration is already in progress

7.3.4. Editing the Requirement / Task / Incident List

As well as being able to schedule the requirements, incidents and tasks with the various iterations in the
upper portion of the screen, the incident and requirement / task lists displayed on the bottom half of the
screen include the same editing functions found in the Requirements, Task, and Incident List pages.
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7.4. Planning Board

The SpiraTeam Planning Board is a great way to visualize the requirements, tasks and incidents planned
for each iteration in your project. Based on the principles of the Scrum and Kanban methodologies, the
Planning Board lets you see each task, requirement or task as a virtual “card” that is grouped by the
iteration it's been scheduled for:

—— - Welcome, Fred Bloggs | My Profile | Administration | Log Out | | Lbrary Information System ¥ Helg?
spiraTeam i S
— My Page Project Home Planning Testing Tracking Reporting
s | lerations | Planning Board
Displaying the teration plan for the selected release { ¥ Include Tasks, ! Include Incidents) Selected Release: | 1.1.0.0-Libeary System Release 1.1 v
~ (Unassigned ltams) |
ey L [ Doz O e ST
Ability to add naw subjects to the system |Abwhlylnedul exisling subjects in the system Ability to integrate with other systems Ability to remember passwords b
Ownar Joe P Smith Ownar Joe P Smith Ownar: Cwner
Estimated Effort 3.0n Estimated Effort 300 Estimated Effort Estmated Effort
Projected Effort 15.00 Projected Effort 15.0n Projected Effort Projected Effort
I o] [Ewa =N | 5 al
™ Release 1.1.0.0 (10/15/2004 - 10/27/2004) : Avaiable: 166.0n / Utized: 85.7h 123h |

s

Hims

Owner
Estimated Effort
Projected Effort

Cannot install system on Oracle i

Owner.
Estimated Effort
Projected Effort

The book listing screen doesn't sort

¥ 2 heration 1,1.0,0.0001 (10/15/2004 - 10/18:2004) | View

Avaiable: 24 0n / Utized: 29.0h /Remaining: 500 [ | |

—1RQ?

ZIRQ8 21 1KI0
Ability to associate books with different subjects Ability to associzte books with different author elop book-subject associat sen pping insert mathod
2 T1K12 2 IK13 2 IK14 21 TK1S
Crpate hook.syhiget mansinn delote methard PP L o iy e T Dofarct s Aoty baok ingestiiinciale ougrigs to inc e 20 dhor B
™ Dteration 1.1.0.0.0002 (10/19/2004 - 10/23/2004) | View Available: 72.0h / Utlized: 26.7h/ Remaining- 45.30 | | '|
-1RQ3 _1Ra1a L1 TK16 Z1THKAT
Ability to associate books with different editions Abifity 4 Refactor book details sereen to inglu p-d Madify book insertiupdate queries
) 1K33 1 1K34 JIK35 21 TK36
- Deuelon sathorsubiect associalan screen L & Create authorsubiect maocoa msed mathod cale oo delete mathod = Creats autbansubeect nanomo cusnes oy
™ Cliteration 1.1.0.0.0003 (102412004 - 10/27/2004) | View Available: 72.0h / Utitzed: 30.0h / Remaining. 42.0h J
Srair SINIEE | [ O] D1
Ability o link authors to their contact information | || Develop new subject enfry screen Create subject object insert method Write subject object insert queries
Owner Fred Bloggs Owner Joa P Smith Owner Joa P Smith Owner Joe P Smith =
Estimated Effort Estimated Effort 7.0k Estmated Effort 50h Estimated Effort 30h
Projected Effort Projected Effart T.0h Projected Effart 50h Projected Effort 30h
I i— ] — =
[ 1840 :"Iﬂ A1Ka1 SINIESTT =]
| it subiect datails seeean_| || Ceaate subisct ohiset undate method | it subiact ahise! undata auerias ¢

When you first click on Planning > Planning Board the system will ask you to select a Release. Upon
selecting a Release, the system will display all the requirements, tasks and incidents planned for the
release, grouped by the iteration they've been assigned-to. Any items not assigned to any release or
iteration will be listed in the (Unassigned Items) section. You can click on the expand/collapse icons to
hide any releases/iterations that are not relevant.

Each item will be displayed with the name and ID of the artifact, together with the owner, estimated effort
and projected effort. In addition, the left border will display a color based on the priority of the item and a
progress bar will be displayed that illustrates the current progress of that item.




You can easily move items from one iteration to another by simply drag and dropping them. To move
multiple items, you just need to select their checkboxes and then drag one of the items.

To view the resource assignments of a particular iteration, click on the “View” hyperlink next to the
iteration and the system will display the list of items in the iteration, grouped by the resource they are

assigned to:
< - Welcome, Fred Bloggs | My Profile | Adminisiration | Log Out | [Library Information Sysem ¥ Help?
Team —
S — My Page Project Home Planning Testing Tracking Reporting
Reguirements | Releases | Herations | Planning Board Role: Manager
Displaying the iteration plan for the selected release: { ¥l Include Tasks, ! include Incidents) Selected Release: | 1.10.00001 - kerstion 001 Y|
¥ (Unassigned ltems)
~ & Resource: Fred Bloggs [ Back ] Avaitable: 16.0h / Utiized: 16,00 / Remaining: 0.0h |
K10 TH11 1 TK12
~ & Resource: Joe P Smith [ Back | Available: 16.0h / Utilized: 13.0h / Remaining: 3.0h
] TK14 TK15
* & Resource: System Administrator [ Back | Available: 16.0h / Utiized: 0.0h / Remaining 16.0h |

Any items not assigned to a resource will be listed in the (Unassigned Items) section. You can click on the
expand/collapse icons to hide any resources that are not relevant. The system will display a progress bar
for each resource to illustrate the allocation for that resource. Any resource that has a progress bar that is
completely green has been fully scheduled and should not have any additional items assigned. If the
progress bar for that resource turns red, it means that they have been over-scheduled and you need to
reassign some of the items.

Each item will be displayed with the name and ID of the artifact, together with the owner, estimated effort
and projected effort. In addition, the left border will display a color based on the priority of the item and a
progress bar will be displayed that illustrates the current progress of that item.

You can easily move items from one resource to another by simply drag and dropping them. To move
multiple items, you just need to select their checkboxes and then drag one of the items.

7.5. Build Details
When you click on a build entry in the build list, you are taken to the build details page illustrated below:

Welcome, Fred Bloggs | Lbrary Information System ¥ | | My Profile | Administration | Log Out | €]

My Page Project Home Planning Testing Tracking Reporting

Team

Requirements | Releases > Build Details | lterations | Planning Board

<< Back To Build List e Build: 1 Build 0015 [BL:000015]
& Heration 013 Name: Build 0015
#) Build 0015
& Build 0014 Description:
#1 Build 0013
& Build 0012
Status: Creation Date: 3/12/2004 12:00:00 AM

Last Updated: 3/12/2004 12:00:00 AM

Incidents Revisions % Test Runs.
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This page is made up of three areas; the left pane is the navigation window, the upper part of the right
pane contains the build detailed information itself, and the bottom part of the right pane displays different
information associated with the build.

The navigation pane consists of a link that will take you back to the build list, as well as a list of the other
builds that belong to the same release/iteration as the current one. The top part of the right pane allows
you to view the details of the build including a detailed description of why it succeeded or failed. Since
builds are populated from an external Continuous Integration server the build information will always be
read-only inside the SpiraTeam user interface.

The lower part of the right pane contains tabs that can display different information associated with the
build. Each of the tabs - “Incidents”, “Revisions”, and “Test Runs” - is described separately below.

7.5.1. Incidents

This tab displays the list of incidents that have been fixed in the current build. The grid can be sorted and
filtered by using the appropriate controls:

Incidents # Revisions # Test Runs
= Refresh | Apply Filter | Clear Filter | | ~ Show/hide columns — Y‘
v 0 Incident Name 4 ¥ Type 4V Status AV Priority 4 ¥ Detected By AY Owner 4V Closed On AY Operating System AY DAY
\ [[Pv- YA Y] [-Aw- v][-Av- ] [Av- Y] ] | R m ]
¥ Ability to be accessed by Mozilla | 1ssue Assigned 2 - High Joe P Smith Joe P Smith INO00032
xj Management of children's loans | Issue Assigned 3 - Medium Joe P Smith Joe P Smith IND00033
Show rows per page Displaying page "a of 1

7.5.2. Revisions

This tab displays a list of the source code revisions that were included in the current build. The grid can
be sorted and filtered by using the appropriate controls:

Incidents Revisions * Test Runs.

= Refresh | Apply Filter | Clear Filter

v Revision 4Y¥ Author A ¥ Summary A ¥ Commit Date AV  Content A &Y  Properties A 4 Y
| | | | L @] [Av- v]  [Av- v
& rev0016 Fred Bloggs The artifact was changed in this version to fix th... 20-Dec-2011 Yes Mo

Show rows per page Displaying page of1

7.5.3. Test Runs

This tab displays a list of all the tests that have been executed against the current build. The grid can be
sorted and filtered by using the appropriate controls:

Incidents % Revisions * Test Runs *
= Refresh | Apply Filter | Clear Filter |
¥ U TestRun Name A ¥ End Date AV  Test Set &A¥ Release AY Execution Status A¥ Est. Dur. A¥ Act. Dur. AY Build AV Web Browser AY Operating System AY Test Run # AV
| I ] R | T | S i | [Bacoom  wji|-mm-  v] [-A- v ®[ |
) Ability to create new book | 3-Dec-2003 11000002  |Passed 0.0n 12h Build 0001 TRO00015
1 Ability to edit existing book | 2-Dec-2003 1.1.0.0.0001 Passed 0.1h 1.2h Build 0001 TRO00014
B Ability to create new book | 2-Dec-2003 1.1.0.0 0001 Passed 0.0n 12h Build 0001 TRO00013
Show rows per page Displaying page Laof 1
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8. Task Tracking

8.1. Task List

When you click on the Tracking > Tasks global navigation link, you will initially be taken to the tasks list
screen illustrated below:

___________________________________ 2 Help?
My Page Project Home Planning
dellewlnk $SDelete | @iBefiesh | DiComy (iTocks [-Sowhdechms- V] V7 Eiler
Displaying 16 - 30 out of 43 task(s) for this project
@ Task Name AT Progress Staws AV Priority 4 ¥ Owner AV Release AY DAY
¥ 1=y - v’i — Ay — v| |—.=q-'—' v — Ay — v| 7%/ |
Mot Started Joe P Smith TKO0D026
Mot Started Frad Blogas TKO00027
Mot Started Fred Bloggs TKO00023
In Progress Fred Bloggs TKO00022
] In Progress Fred Bloggs TKO00021
1 In Progress Fred Bloggs THOD0O2E
In Progress Fred Blogas TKOO0029
Completed Joe P Smith TKO00015
Completed Joe P Smith TKOOD014
Completed | Joe P Smath TKO00013
oot mapcing delasts method Completed " Fred Bloggs TK000D12
mapping insert method Completed Fred Bloggs TKO00011
Completed | Fred Bloggs TK000010
Completed Fred Bloggs D02 TKOG0017
Completed Fred Bloggs 11000002 THOMO016
Show |75 ; fows per page 4 Displaying page 2_; BofIem

The task list screen displays all the tasks entered for the current project, in a filterable, sortable grid. The
grid displays the task number together with fields such as priority, name, assigned owner, start date, end
date, scheduled release, etc. The choice of columns displayed is configurable per-user, per-project,
giving extensive flexibility when it comes to viewing and searching tasks.

In addition, you can view a more detailed description of the task by positioning the mouse pointer over
the task name hyperlink and waiting for the popup “tooltip” to appear. If you click on the task name
hyperlink, you will be taken to the task details page described in section 8.2. Clicking on any of the
pagination links at the bottom of the page will advance you to the next set of tasks in the list according to
the applied filter and sort-order. There is also a drop-down-list at the bottom of the page which allows you
to specify how many rows should be displayed in each page, helping accommodate different user
preferences.

One special column that is unique to tasks is the ‘progress indicator’. This illustrates graphically both the
percentage completion of the task and also if the task is either starting late or finishing late. The following
table illustrates the different type of status that can be conveyed by the indicator:

Indicator Display Progress Description

Task has not yet started, but the scheduled start date is
still in the future.

Task has not yet started, and the start date has elapsed.
This is considered a ‘Late Starting Task’

Task has started, and is approximately 25% complete.
The scheduled end date is still in the future.

Task has started, and is approximately 25% complete.
However the scheduled end date has elapsed already.
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This is a considered a ‘Late Finishing Task’.

Task has been 100% completed.

Essentially, the gray section of the bar indicates the % of the task yet to be completed, and the green/red
section of the bar indicates the % of the task that has already been completed. If the bar changes from
green to red it means that the end date has been reached and the task is not yet complete, and if the
background changes from gray to yellow it means that the task has not yet started, but the scheduled
start date has passed.

8.1.1. Sorting and Filtering
You can easily filter and sort the list of tasks as illustrated in the screen-shot below:

- — . Welcame, Fred Bloggs | Ubeary nfomation System 'i | My Profile | Administration | Log Out | [Searcn | @ Help?
spir: Tea m
e My Page Project Home Planning Testing Tracking Reporting
Incients | Tasks | Resources | Source Cods
dhNewTask ¢} Delete | ByRefresh | [Copy §5iTools |- Show/hide cohmns - v 7 Filter
Displaying 1 - 4 out of 4 taskis) for this project
+ 4 TaskName &Y Progress Status AV Owmer &Y Release 4 Y DAY
| | Funning Late ¥ | I—;ny— v| |- hy - v: |- Aoy = v TH |
1 Create edition o & T In Progress Fred Bloggs 1.0.0.0.0003 TKDE@
Ap In Progress Fred Bloggs THDD0D21
By In Progress Fred Bloggs THO00029
1 £ o [ | In Progress Fred Bloggs TKO00028 Edit |
Show i'l"i_ W | rows per page < « Displaying page [1 | of 1»»

To filter the list by progress, status, priority, owner or release, you simply choose an item from the
appropriate drop-down list, and for the other fields, you enter a free-text phrase then click <Filter> or
press the <ENTER> key to apply the different filters. Note that the name field is searched using a “LIKE”
comparison, so that searching for “database” would include any item with the word database in the name.
The other freetext fields need to be exact matches (e.g. dates, task numbers).

To change the column that is sorted, or to change the direction of the current sort, simply click on the
up/down arrow icon in the appropriate column. The currently sorted column is indicated by the larger,
white arrow with the back-border. In the screen-shot above, we have filtered on tasks that are finishing
late, sorted in order of decreasing priority.

Clicking on Filter > Clear Filter removes any set filters and expands the task list to display all tasks for the
current project, and clicking on Filter > Save Filter allows you to save the filter to your ‘My Page’ for use in
the future. The list of saved filters can also be retrieved by clicking Filter > Retrieve Filter.

8.1.2. New Task

Clicking on the <New Task> button creates a new task in the grid with an initial set of information. You
can click on the name of the task to edit its information.

8.1.3. Delete
Clicking on the <Delete> button deletes the tasks whose check-boxes have been selected in the task list.

8.1.4. Refresh

Clicking on the <Refresh> button simply reloads the list of tasks; this is useful when new tasks are being
added by other users, and you want to make sure you have the most up-to-date list displayed.
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8.1.5. Show / Hide Columns

This drop-down list allows you to change the fields that are displayed in the task list as columns for the
current project. To show a column that is not already displayed, simply select that column from the list of
“Show...” column names and to hide an existing column, simply select that column from the list of
“Hide...” column names. This is stored on a per-project basis, so you can have different display settings
for each project that you are a member of. The fields can be any of the built-in fields or any of the custom
properties set up by the project owner.

8.1.6. Edit

Each task in the list has an <Edit> button display in its right-most column. When you click this button or
just click on any of the cells in the row, you change the item from “View” mode to “Edit” mode. The various
columns are made editable, and <Update> <Cancel> buttons are displayed in the last column:

Welcome. System Ad | My Profile | Administration | Log Out | UWD‘HE"“W" _s:.:g_h_-f. y} Helg?

spiraTeam

My Page Project Home Planning Testing Tracking Reporting

Incidents | Tasks Role: Project Owner
oh NewTask 3 Delete ) Refresh Cheopy [ Empot |-Showhidecalumns—- v| T Fiter

Displaying 1 - 4 out of 4 taskis) for this project

v 4 Task Name A Y Progress Status AY Priority AY Owner AY Release AW Task# AV Edit
Bl [Running Late ¥ !.__Ln'_g = v| —any— V| [anv— v [Fanv= v ™ |: [= Fier |

| 73 Create edition object insent method E In Progress I ] . Fred Bloggs 1.0.0.0.0003 TK00D0Z2 [+ Edit |

0 D[Develop newediton enty screen = | [wpwress v]= [Fredmops_ v]Ey [ro00oms v]E] [ Upaate | [+ Gancer |
O | #3{Write suthor object delete query ] [nProress 7] FredBloggs Y|  [10000003 V|

O | £ Ceate author obiect delete method = In Progress 2- High Fred Bloggs 1.0.0.0.0003 TKO00028 [+ Edit |

Shaw [15_ ¥ | rows per page 14« Displaying page[1 |%of 15 »

If you click <Edit> on more than one row, the <Update> and <Cancel> buttons are only displayed on the
first row, and you can make changes to all the editable rows and then update the changes by clicking the
one <Update> button. Also, if you want to make the same change to multiple rows (e.g. to change five
tasks from “Not Started” status to “In Progress”), you can click on the “fill” icon to the right of the editable
item, which will propagate the new value to all editable items in the same column.

If you want to edit lots of items, first select their checkboxes and then click the [Edit] button on the same
row as the Filters and it will switch all the selected items into edit mode.

When you have made your updates, you can either click <Update> to commit the changes, or <Cancel>
to revert back to the original information. Alternatively, pressing the <ENTER> key will commit the
changes and pressing the <ESCAPE> key will cancel the changes.

8.1.7. Copying Tasks

To copy a task or set of tasks, simply select the check-boxes of the tasks you want to copy and then click
<Copy>. This will make a copy of the current task with its name prefixed ‘Copy of ...." to distinguish itself
from the original. Any file attachments will also be copied along with the task itself.

8.1.8. Exporting Tasks

To export a task or set of tasks from the current project to another project in the system, all you need to
do is select the check-boxes of the task(s) you want to export and then click Tools > Export. This will then
bring up a list of possible destination projects:
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Welcome, Fred Bloggs _.Lh'a')rﬂamuw Sysiem V[ | My Profile | Adma tion | Log Out |[Search | @ Helg?
—— My Page Project Home Planning Testing Tracking Reporting
dpMewlosk {3Delete | @Refiosh = (yCopy {ffTook [-Swehdechms-  ¥] Y7 Filler
Displaying 1 - 4 out of 4 taskis) for this project
v 4 TaskName AV gy Expod Hams AT Owner AY Release AY DAY
| | 1’- Please select the project you want to export Lo | b | [~ ey - ' | Ay - v| TK _|
) Create edition ohject insen method L-n:j [Sampie Appication Ore v . . Fred Bloggs 1.0.0.0.0003 THODOD22
vl 1 Devalop new edition antry screen [i= ) 3 ' Fred Bloggs 1.0.0.0.0003 TKOD0D21
7 1 irite auther oby ety Iﬁ [ Fred Bloggs 1.0.0.0.0003 TKOD0029
7Y Cueate author object delete method m » Expon | Cance| ) Fred Blaggs 1.0.0.0.0003 THO00028 [Fean |
Show I-ﬁ = ;I fows per page < « Displaying page [1 | %aof 10

Once you have chosen the destination project and clicked the <Export> button, the tasks will be exported
from the current project to the destination project. Any file attachments will also be copied to the
destination project along with the tasks.

8.1.9. Printing Items

To quickly print a single task or list of tasks you can select the items’ checkboxes and then click Tools >
Print Items. This will display a popup window containing a printable version of the selected items.

8.2. Task Details

When you click on a task item in the lists displayed on either the main task list page or on the requirement
/ release details pages, you are taken to the task details page illustrated below:

T ® Welcome, Fred Bloggs ||-|bEW Information System V| | My Profile | Administration | Log Out | &)
My Page Project Home Planning Testing Tracking Reporting

Incidents | Tasks = Task Details | Resources | Source Code

| [B Save [}Copy [ZRefresh ‘ 42 Delete | [z Print | B Email ‘¥ Subscribe

<< Back to Task List

Display: | Al kems v Task: Refactor book details screen to include edition drop-down [TK:000016]
- . R
= %Ab"'w to associate books with diff Name™: |Refactor book details screen to include edition drop-down ‘
& Refactor book details screen to | 3 .
) A ) escription: — Fort —  Size — = P — &=
a Modify book insert/update queries t Pt | Fort ‘| | Size '| W w | = =R 1 | T ‘ e e
=28 Ability to associate authors with st
g Develop author-subject association
A Create author-subject mapping inse
A Create author-subject mapping dele
s ] .
“ Create author-subject mapping quer Priority: 1 - Critical v Qwner: | Fred Bloggs Y|
Requirement: | Abity to associate books with different editions v | =] Last Updated: 12/1/2003 12:00:00 AM
Release / [ 1.1.0.0.0002 - heration 002 ME Creator*: [ Fred Blogas v]
Iteration: {10/19/2004 - 10/23/2004) {12/1/2003 12:00:00 AM)
Schedule * Comments Custom Props. Attachments History Associations #

This page is made up of three areas; the left pane is the navigation window, the upper part of the right
pane contains the task detailed information itself, and the bottom part of the right pane displays different
information associated with the task.

The navigation pane consists of a link that will take you back to the task list, as well as a list of the other
related tasks, nested under their parent requirement. This latter list is useful as a navigation shortcut; you
can quickly view the peer requirements or tasks by clicking on the navigation links without having to first
return to the requirements or tasks list pages. The navigation list can be switched between three different
modes:

e The list of tasks matching the current filter

e The list of all tasks, irrespective of the current filter, grouped by their parent requirement
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e The list of tasks assigned to the current user

The top part of the right pane allows you to view and/or edit the details of the particular task. You can edit
the various fields (hname, description, etc.) and once you are satisfied with them, simply click either the
<Save> or <Save and New> button at the top of the page to commit the changes. In addition you can
delete the current artifact by choosing <Delete>, discard any changes made by clicking <Refresh> or print
it by clicking <Print>.

Using the <Email> button on the toolbar, you can send an email containing details of the task to an email
address or another user on the system:

X

Email this artifact to:

@ Project User: | Fred Bloggs v

Select a user in the project to send to.

Email Addresses:
A list of email addresses, separated by |

Message Subject: |

Leave blank for default.

Send | Cancel

You can specify the subject line for the email, and either a list of email addresses, separated by
semicolons, or an existing project user .The content of the email is specified in the System Administration
— Notification Templates.

The lower part of the right pane can be in one of five possible modes that can be selected: “Schedule”,
“Custom Properties”, “Attachments”, “History” and “Revision Associations”. Each of the different views is
described separately below.

8.2.1. Schedule

In this mode, the main pane displays the general schedule and completion status of the specific task. You
can enter/edit the start-date, end-date (i.e. the due-date), estimated, actual and remaining effort. From
this the system will calculate the progress, percentage complete and projected final effort.

Schedule # Comments Custom Properties Attachments History Revision Asszociations
Status:* Estimated Effort: hours
Progress: (100%) Actual Effort: hours
Projected Effort: 3.0 hours Remaining Effort: hours
Start Date: End Date: 10/20/2004 [

The different effort values mean the following:
>» Estimated Effort — This is the original estimate for how long the task would take to complete.

» Actual Effort — This is the current amount of effort that has been expended in completing the
task. This does not indicate the completion progress

» Remaining Effort — This is the estimate for how it will take from the current state to complete the
task. The % complete is calculated from this value in conjunction with the estimated effort:
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% Complete = 100% - (Remaining Effort / Estimated Effort)

» Projected Effort — This is value that the system is projecting it will take to complete the task. This
is calculated from the Actual Effort and Remaining Effort:

Projected Effort = (Actual Effort + Remaining Effort)

If the actual effort is not specified, the projected effort will be the same as the estimated effort.

Note that if this task is currently assigned to a release or iteration, the start-date and end-date of the task
must lie within the date-range of the parent release/iteration. If your task looks like it will not be completed
in the available timeframe, you will need to contact the project manager to get them to either extend the
date-range of the task, or consider moving the task to the next iteration.

8.2.2. Comments
The comments tab will display the comments associated with the task:

Schedule # Comments Custom Properties Attachments History Revision Associa

To add a new comment to this requirement, please enter it below and click the [Save] button:

Pl

EE | % —epOo@

~ Fort ~ M |[-Szz- ¥ BIU|E=

Existing Comments

All existing comments are displayed in date entered underneath the textbox. To enter a new comment,
enter the text into the textbox, and then click the Save button.

8.2.3. Custom Properties

In this mode, the main pane displays any custom properties that the project owner has defined for tasks.
To learn more about how to setup and configure custom properties for a project, please refer to the
SpiraTest Administration Guide. Assuming that custom properties have been defined for your project, you
will see a list of optional parameters that can be set on the task. These can be either freetext or drop-
down-lists. In the example below, you can enter Notes and/or the project track that the task is associated
with.

Schedule # Custom Properties # Attachmentz Higtory Revizion As=ociations #*

The following are the custom properties of this artifact:

Motes:

Track: |_ None — 1’|

Once you are satisfied with the values for the custom properties, simply click [Save] or [Save and New] to
commit the changes.
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8.2.4. Attachments

In this mode, the lower section of the screen displays the list of documents that have been “attached” to
the task. The documents can be in any format, though SpiraTeam® will only display the icon for certain
known types.

Schedule # Comments Custom Props Attachments History Associations

= Add New | Add Existing | Remove | Refresh | Apply Filter | Clear Filter | [/]Include Source Code Documents

v/ Document Name 4V Type AY Size AV Edited By 4 ¥ Edited On 4V Author A¥ DAY
| |- Y] | |- Y] | @] [Av-  v] oc[ ]
] Document Filename22 vb Source Code 150 KB Fred Bloggs 19-Dec-2011 Fred Bloggs DC-000010
] Document Filename24.java Source Code 100 KB Fred Bloggs 19-Dec-2011 Fred Bloggs DC-000011
Show Tows per page Displaying page "a of 1

The attachment list includes the filename that was originally uploaded together with the file-size (in KB),
name of the person who attached it and the date uploaded. In addition, if you position the pointer over the
filename and hold it there for a few seconds, a detailed description is displayed as a tooltip.

To actually view the document, simply click on the filename hyperlink and a new web browser window will
open. Depending on the type of file, this window will either display the document or prompt you for a
place to save it on your local computer. To remove an existing attachment from a task, simply click the
<Remove> button and the attachment will be removed from the list.

If you are using SpiraPlan or SpiraTeam (but not SpiraTest) you can also choose to include file
attachments stored in a linked version control system (e.g. Subversion, CVS, Perforce, etc.) by selecting
the “Include Source Code Documents” option.

To attach a new document or web link to the task, you need to click on the “Add New” hyperlink to open
the “Add Attachment” dialog box. There are three different types of item that can be attached to a task:

» To upload a file, choose “File” as the type and then click the Browse button and select the file
from your local computer, optionally enter a detailed description then click the <Upload> button.
The document will be copied from your computer and attached to the artifact.

» To attach a web-link (URL) to the artifact, you need to choose “URL" as the type and then enter
the fully qualified URL (e.g. http://mywebsite.com?Document=1), an optional description and then
click the <Upload> button to attach the web-link.

» To attach a screenshot to the artifact, you need to choose “Screenshot” as the type and then
copy the image to your computer’s clipboard (e.g. on Windows computers, the PRINT SCREEN
button captures the current page and adds to the clipboard). Once the image is in the clipboard,
click on the “Paste image from clipboard” hyperlink and the item will appear in the preview
window. You can then fill in the other fields and click <Upload> to attach the image.

Note: If you are using a hon-Windows® computer (e.g. Macintosh®) that doesn’t put file extensions on
filenames (e.g. .xls for an Excel sheet) automatically, then you will need to manually add the file extension
to the filename before uploading if you want it to be displayed with the correct icon in the attachment list.

You can also associate an existing document (that's already stored in SpiraTeam) with the task. To do
that, click on the “Add Existing” hyperlink to bring up the add file association dialog box. You can then
choose to either associate a document stored in the SpiraTeam Documents repository or (in the case of
SpiraPlan/SpiraTeam but not SpiraTest) from the linked source code repository. In either case you first
select the appropriate folder, and then pick the document(s) from the file list on the right. In the case of a
source code file association you can also add a comment.
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8.2.5. View History

In this mode, the main pane displays the list of changes that have been performed on the task artifact
since its creation. An example task change history is depicted below:

Schedule * Comments Custom Props Atftachments History # Associations #

= Refresh | Apply Filter | Clear Filter |

Change ID A ¥ Change Date AY  Field Name A ¥ Old Value 4 ¥ New Value 4F Changed By A¥  Change Type 4 ¥
| ] | | Il [ Y] Ao Y

16 19-Dec-2011 Actual Effort 438 420 Fred Bloggs Modified

16 19-Dec-2011 Projected Effort 438 420 Fred Bloggs Modified

15 19-Dec-2011 Priority 1 - Critical 2 - High Fred Bloggs Modified

14 19-Dec-2011 Release 1.0.0.0.0001 1.0.0.0.0002 Fred Bloggs Modified

14 19-Dec-2011 Start Date 3/1/2004 12:00:00 AM 3/5/2004 12:00:00 AM Fred Bloggs Modified

14 19-Dec-2011 End Date 3/2/2004 12:00:00 AM 3/6/2004 12:00:00 AM Fred Bloggs Modified

14 19-Dec-2011 Actual Effort 440 438 Fred Bloggs Modified

14 19-Dec-2011 Projected Effort 480 438 Fred Bloggs Modified

Show rows per page Displaying page 'a of 1

The change history displays the date that each change was made, together with the fields that were
changed, the old and new values and the person who made the change. This allows a complete audit trail
to be maintained of all changes in the system. In addition, if you are logged in as a project administrator
you can also click on the “Admin View” hyperlink to revert any unwanted changes.

8.2.6. Associations

In this mode, the main pane displays a list of any source code revisions that are associated with this task:

Schedule # Comments Custom Props Atftachments History Associations #
= | | Refresh | Apply Filter | Clear Filter | || Include Source Code Revisions
v Artifact Name AV Artifact Type AY Creation Date AV Creator 4 ¥ Comment AV DAY
\ |- Y] | @] [av- Y] | | [
& rev0012 Rewvision 19-Dec-2011 Fred Bloggs The artifact was changed in this version to fix th... -
Show rows per page Displaying page '!- of 1

This feature allows you to display the list of any changes in the source code repository that were the
result of implementing the functionality described in the task. Clicking on the revision name takes you to
the revision details page which is described in more detail in the “Source Code” section of this guide.

You can perform the following actions:

>» Refresh — updates the list of revisions from the server, useful if other people are adding revisions

connected to this task at the same time.

> Apply Filter — Applies the entries in the filter boxes to the list of revisions.

Clear Filters — Clears the current filter, so that all revisions for the current task are shown.
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9. Resource Tracking

This section outlines how you can use the Resource Tracking features of SpiraPlan® and SpiraTeam® to
view the total workload for each of the project personnel resources assigned to a specific project. This
allows you to verify that the work is evenly distributed amongst the project members and that no individual
resource is overloaded.

When you click on the Tracking > Resources link on the global navigation bar, you will initially be taken to
the project resources list screen illustrated below:

— . Welcome, Fred Bloggs | My Profile | Administration | Log Qut | Ubrary Informaton System ¥ Help?
spiraTeam
= - My Page Project Home Planning Testing Tracking Reporting
Incidents | Tasks | Resources | Source Coda Role: Manager
2 Refresh Y7 Ellter
Displaying the resource usage for the curent project or selected release Display data for: |_1D\'IDL-bmerSwre:rF‘cicm| v|®
+  Resource Name AY Role A Y Allocation Avallable Effort A Y Task Effort 4 ¥ Incident Effort A¥ Total Effort A¥ Remaining Effort AF DAY
iatlod = g i vl E“-_*‘*"Y'_ T — = e = el = Sl =L n el R 17
Manager 80.0h 54.0h 0.0h 54.0h 26.0h Usoo0o02
Observer 80.0h 40.0h 0.0h 40.0h 40.0h Us000003
Project Crwhner 80.0h 0.0h 0.0h 0.0h 80.0h US000001
Show (15 ¥ rows per page 4 4 Displaying page [1 | %of 15 »

This screen lists all the personnel (project resources) that belong to the current project together with the
total value of the projected effort of all the work assigned to them, the available effort based on the length
of the current release/iteration, and the remaining effort (the difference between the previous two values).
The effort is shown for tasks and incidents as well as a total of the two together. You can display the
workload for the project as a whole, for a specific release (including all child iterations) or for a specific
iteration.

There is a colored progress bar column called “Allocation” that graphically illustrates the % of the person’s
available effort that has been scheduled. If a person is over-scheduled, this bar will turn red. In addition, if
any project resources have been assigned more work that they have time to complete during the length of
the release/iteration, the background color of the remaining effort value will be also be colored in red,
indicating that you need to offload some of the work to other project resources.

Clicking on a resource name will take you to the Resource Details page.

9.1 Resource Details

The resource details page will show you what a resource has been assigned, and time values for the
items. A small table on the left will show current configured values for the project for # of hours per
workday, # of days per week, and how many non-work hours per month there are.

Resource Details:
Name: System Administrator Current Project Planning Settings
E-Mail: administrator@mycompany.com Hours / Day: 8
Department: Days / Week: 5
Project Role: Project Owner Nen-Work Hours / Month: 0
Reqs & Tasks Incidents * Test Cases # Test Sets
v U Requirement/Task Name Importance Progress Owner Est. Effort
| [Av- Y] flAw- Y] - Y]

Show rows per page
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Tabs along the bottom will show assigned requirements and tasks, incidents, test cases and test sets.
The views for each item are a subset of available columns, to show progress and completion information
for all items listed. Clicking on an artifact’s name will take you to the artifact details page:

9.1.1. Regs & Tasks

This tab displays the list of requirements and child tasks that are assigned to the current resource:

Reqgs & Tasks # Incidents # Test Cazes # Test Sets #

v U Requirement/Task Name Importance Progress QOwner Est. Effort Act. Effort Proj. Effort Edit

o | e e e | —
O = Ability to delete existing books in the system 1 - Critical Fred Bloggs 16.0n 15.2h 16.0h
O ;'.j Ability to completely erase all books stored in th... 1 - Critical Fred Bloggs 10.0h 9.5h 9.5h
O =] ;j Ability to create different editions 1 - Critical Fred Bloggs 16.0n 10.3h 17.8h
O 1 Develop new edition entry screen 1 - Critical Fred Bloggs 8.0h 7.0h 9.0h
] A Create edition ohject insert method 1 - Critical Fred Bloggs 5.0h 33h 5.8h
O O write etﬂmw object insert queries 1 - Critical Fred Bloggs 3.0n 3.0h m

9.1.2. Incidents

This tab displays the list of incidents that are assigned to the current resource:

Regs & Tasks # Incidents + Test Cazes # Test Sets #
1D/ Name Date Opened  Status Priority Severity % Complete Est. Effort (hrs) Projected Effort (hrs)
3 | Cannot add a new book to the system | [IN:000007] | 4-Nov-2003 Assigned 1 -Critical | 3 - Medium 0% 0.3 0.3
Eﬂ Ability to associate multiple authors [IMN:-000021] | 17-Mov-2003 Assigned [1-Catical 1 - Crtical  25% 0.3 04
B | Test System Limitation [IN-:000046] | 4-Dec-2003 Assigned = Critical 75% 07 03
Eﬂ Test Training Item [IN:000040] | 3-Dec-2003 Assigned [ 1-Catical 2 - High 25% 0.5 0.5
% | Editing the date on a book is clunky [IN-000008] | 4-MNov-2003 Assigned 2 - High 4 - Low 50% 04 04
H | Test Training Item [IN:000041] | 3-Dec-2003 Assigned 2 -High 50% 0.7 0.7
% | Test Change Request [IN:000053] | 7-Dec-2003 Assigned | 3 - Medium 25% 0.4 0.5
B | Ability to import data from excel [IN:000023] | 25-Mov-2003 Assigned 3 - Medium 2 - High 75% 0.5 0.5
Eﬂ Test System Limitation [IN:000048] | 4-Dec-2003 Assigned | 3 - Medium 3 - Medium  90% 1.3 15
B | Sample Risk 3 [IN-000061] | 10-Dec-2003 Assigned | 4 - Low 4-Low 90% 07 09

9.1.3. Test Cases

This tab displays the list of test cases that are assigned to the current resource:

Reqs & Tasks # Incidents # Test Cases # Test Setz #
ID f Name Last Executed Last Execution Status Priority Estimated Duration
L9 Ability to create new book [TC:000002] 1-Dec-2003 Passed 1 - Critical 0.2h
&9 Ability to edit existing book [TC:000003] 1-Dec-2003 Caution 1 - Critical 0.1h
9.1.4. Test Sets
This tab displays the list of test sets that are assigned to the current resource:
Reqs & Tasks #* Incidents #* Test Cases # Test Sets *
ID / Name Status Planned Date Execution Status Last Executed Est. Duration  Act. Duration
22| | Testing New Functionality [TX:000005] | In Progress  10-Feb-2007 28-Sep-2010 0.3h 0.8h
22 | Exploratory Testing [TX:000006] | Deferred 0.0h 0.0h
X2 | Regression Testing for Windows XP [TX:000003] | Completed 0.3h 0.0h
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10. Document Management

This section outlines the document management features of SpiraTeam® that can be used to upload,
manage and share documents between the different members of the project. This module includes
support for uploading files and URLSs, versioning of documents, the ability to organize into folders and
categorize and search using meta-tags.

In addition the document management features are fully integrated into the rest of the system, so that
documents attached to other artifacts (e.g. requirements, test cases, etc.) are automatically connected to
the project documentation repository.

10.1. Document List

When you click on the Project Home > Documents link on the global navigation bar, you will initially be
taken to the project documents list screen illustrated below:

= o Welcome, Fred Bloggs | My Profile | Administration | Log Out | | Lbrary Informaticn System ¥ Help?
piraTeam et
My Page Project Home Planning Testing Tracking Reporting
Project Group Home | Project Home | Documents
Add Document Delete Refresh Export Filte v
Document Folders | Refresh dh 2 2 & W Filter | | hemsinCunent Foider 7|
= B Root Folder + Document Name A'Y Type AT Size AY Edited By AY  Edited On AV Author AT DAY
= B Design Documents [ | [~ v | [-Aw- | | @] [~Amw- v| oc[ |
% 02 Mise Documents T8 sequence Diagram for Book Mgt pdf UML Diagram 35 KB Joe P Smith 10-May-2006 Fred Bloggs DCO00007
18 Screen Captures B Graphical Design Mockups psd Screen Layout 1009 KB Joe P Smith 1-May-2006 Joa P Smith DCO00D13
382 Spoificalions UML Diagram 43 KB Fred Bloggs 23.Apr2006 | Fred Bloggs DCO00012
# €3 Test Results -
hor Managemer an Wireframe vsd Sereen Layout 533KB Fred Bloggs 2-Apr-2006 Joe P Smith DCO0000E
W ook t Screen Wireframe a Screen Layout 392 KB Fred Bloggs 1-Apr-2006 Joe P Smith DCooo011
Show |15 ¥ rows per page t « Displaying page [1  |%of 1+ »

Tag Cloud

e.boOOK
mana%ement

error functional .
specification libraries
stack frace testing

user interface wireframe

This screen consists of three main sections:

» The top left-hand pane displays a hierarchical list of the various folders that have been setup for
the current project. Clicking on the [+] expand icon will expand the child folders and clicking on
the name of the folder will display the list of documents in the folder in the main pane to the right.

» The main right-hand pane displays a list of all the documents contained within the currently
selected folder. This list can be filtered and sorted, and you can choose how many rows of
documents to display on the page at one time.

>» The bottom left-hand pane contains the “Tag Cloud”. This is a list of all the tag names associated
with documents in the project. The size of the font is proportional to the number of documents
associated with the tag. Clicking on a tag name will automatically filter the list of documents to
find items that contain the selected tag.

The main toolbar contains icons for all the operations that can be performed on the document list. You
can add documents to the current folder, delete existing documents from the project, refresh the list of
documents, export documents to another project, apply a filter, and clear the current filter. In addition
there is the option to either display just the documents in the current folder or all documents in all folders.
The latter is useful when you want to search for a specific document by keyword or tag name.
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10.1.1. Add New Document

To add a new document to the project, you just need to click on the <Add Document> icon in the toolbar,
and the ‘Add New Document’ dialog box will be displayed:

Add New Document

*

Type @ File URL Screenshot
Filename™: I Browse._
Description:

Document Type*: | Functional Speciiication Y|
Version

Tags: | |

> Upload | Cancel

X

X

Add New Document
Type® File URL @ Screenshot
Screenshot™:

> Paste image from clipboard
Description:
Document Type*: | Functional Specification Y|
Verson
Tags: | |

> Upload | Cancel

There are three different types of item that can be uploaded into the document repository:

» To upload a file, choose “File” as the type and then click the Browse button and select the file
from your local computer, optionally enter a detailed description then click the <Upload> button.
The document will be copied from your computer and added to the current folder.

» To add a web-link (URL) to the current folder, you need to choose “URL” as the type and then

enter the fully qualified URL (e.g. http://mywebsite.com?Document=1), an optional description
and then click the <Upload> button to add the web-link.

» To add a screenshot to the current folder, you need to choose “Screenshot” as the type and then
copy the image to your computer’s clipboard (e.g. on Windows computers, the PRINT SCREEN
button captures the current page and adds to the clipboard). Once the image is in the clipboard,
click on the “Paste image from clipboard” hyperlink and the item will appear in the preview
window. You can then fill in the other fields and click <Upload> to upload the image.

10.1.2. View Document Information

When you hover the mouse pointer over any of the documents displayed in the document list, an
information panel will be displayed that contains the name, description, version, document type and meta-

tags of the document:
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http://mywebsite.com/?Document=1

.~ -
spiraTeam
—

Document Folders | Refresh

= B Root Folder

user interface wireframe

My Page
Project Group Home | Project Home | Documents

Welcome, Fred Bloggs | My Profile | Ad

| Log Qut | [Lbrary Infomation Sysiem ¥ |

Project Home

Document Name 4 ¥

Pianning Testing Tracking Reporting

| ¢naddDocument ¢} Delete @ Refresh | (@ Eaport Y Eilter | [temsinCorentfoder 7]

Type AY Size AV Edited By AY  Edited On AV  Author AT DAY
/B Design Documents B | [~ Any - v] | [ Aay~ v] | m] | [-fay- v| oc[ |
8 6 Misg Documents B | '™ sequence Diagram foe B fusn: Lamuc L E mith 10-May-2006 | Fred Bloggs DCO00D0T
B 83 Sereen Captures 1 "B Graphical Design Mocky] Sequence Diagram for Book Mgt pdf mith 1-May-2006 Joe P Smith DCO00013
& Specfications B | @ e case Dingram ved lggs  23Apr2006  FredBloggs  DC000012
B 62 Test Resulls : Filename: Sequence Diagram for Book Mgt pdf =
& Author Management Serl TS LEteD lags 2-Apr-2008 Joe P Smith DCO00008
5 | B Book Management Scred  File Type: Acrobatpng % lags 1-Apr-2006 Joe P Smith DCO00011
Show| 15 ¥ |rows per page Description: Sequence diagram in UML format that provides 4 < Displaying page [1_|%of 15
i detail ding the book
use-case | l@st case
Version: 12
Tag Cloud Tags: diagram | bogk
bOOK Created By: Fred Bloggs (5/3/2006 12:00-00 AM)
S ——— Edited By: Joa P Smith (5/10/2006 12:00:00 AM)
management 1D: [DC:000007]
error functional . > Vigw Details | Cancel
specification libraries
VD CeEncE KNG OTERA 30T SIGT W
stack trace t@Sting

You can click on the document URL to actually open the document itself in a new window, click on the
meta-tag links to find related documents that contain the same meta-tag, or click on “View Details” to see
more information regarding the document, including an ability to edit its meta-information and see the
different versions of the document.

10.2. Document Details

When you click on an item in the document list described above, you are taken to the document details

page illustrated below:

————— L]
spiraTeam
—

-

<< Back to Document List
Disly:
= B Design Documents
ﬁq Sequence Diagram for Book Mgt
L Graphical Design Mockups.psd
& Use case Diagram.vsd
2 Author Management Screen Wirefr:
‘ Book Management Screen Wirefran

Welcome, Fred Bloggs | Library Information System

My Page

Projec!

t Home Planning Testing

Project Group Home | Project Home | Documents > Document Details
| ESave $3Delete | Refresh

Document: Sequence Diagram for Book Mat.pdf (DC000007)

Filename:*

Description:

Document Folder*:
Document Type*:
Tags:

File Type (Size):

v | | My Profile | Administration | Log Out | €]

Tracking

Reporting

| Sequence Diagram for Book Mgt pdf

[ Fort - V] [See- v] B U|EEE|EEEE|EE|—=gOo@
Sequence diagram in UML format that provides additional detail surrounding the book managament use-case / test
case

| Design Documents v | Creator": | Fred Bloggs v |
|UMLDiagram v| Edited By*: |JoeP5mm v|

|sequence diagram, book management |

Acrobat Y] (35 KB)

Creation Date:  5/3/2006 12:00:00 AM

Last Edited: 5/10/2006 12:00:00 AM
Current 12
Version:

This page is made up of three areas; the left pane is for navigation, the upper part of the main pane
contains the details of the document, and the bottom part of the right pane contains the list of document
versions and the list of artifacts that the document is associated with.

The navigation pane consists of a link that will take you back to the project document list, as well as a list
of other documents in the current folder. This latter list is useful as a navigation shortcut; you can quickly




view the detailed information of all the peer documents by clicking on the navigation links without having
to first return to the main document list page.

The top part of the main pane allows you to view and/or edit the details of the particular document. You
can edit the various fields (name, description, etc.) and once you are satisfied with them, simply click the
<Save> button at the top of the page to commit the changes. In addition you can delete the current
document by choosing <Delete>, or discard any changes made by clicking <Refresh>.

The lower part of the main pane can be switched between two different views by clicking the appropriate
tab. Initially the pane will be in “Versions” mode, but it can be switched to “Association” as well. The
functionality in each of these two views is described below:

10.2.1. Edit Document Versions

This view displays the list of different versions that exist for the current document. When you initially
create a new document there will be only a single version (e.g. v1.0), however as revisions are made to
the document, rather than having to create a whole new document, you can just upload the new revision
as a new version (e.g. v1.1) and it will be added to the list of versions.

Each version in the list is displayed with its name, a description of what changed in the version, the
version number assigned to the revision, the file-size, who uploaded the new version and a link to actually
open the new version:

Versions # Associations #
Active Version Version Comments Size Uploaded By Uploaded On ¥ Operations
v ) Version 1.2 % | Sequence diagram in UML format that provides additional 35 KB | Fred Bloggs | 10-May-2006

detail surrounding the book managament use-case / test
case

) Version 1.1 | Sequence diagram in UML format that provides additional 30 KB | Fred Bloggs | 5-May-2006 » Make Active | Delete
detail surrounding the book managament use-case / test
case

) Version 1.0% | Sequence diagram in UML format that provides additional 28 KB  Joe P Smith | 3-May-2006 » Make Active | Delete
detail surrounding the book managament use-case / test
case

Upload New Version

Filename:* | Browse...
Description: — Font - v| Sz [v] BT U E|Tﬁ<ﬁ|—|:|<>

Version:* I:l Make this the active version

On this page, you have the option to delete an existing version, make a different version the active one
(the one that users see when they view the document list and click on the link) and upload a new revision.
If you upload a new version, you need to provide a description of the changes made, a new version
number and whether the new version should be made the active one. Note: If the original document was
a file (instead of a URL) then all revisions will need to be files, similarly if the original document was a
URL, all revisions will need to be URLSs.
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10.2.2. Edit Document Associations

This view displays a list of the artifacts in the current project that are associated with the current
document. If you originally uploaded the document as an attachment to a requirement, test case, etc.
then an initial association will be already listed, otherwise it will be empty.

Verzions #* Associations #
Date Artifact Name Created By Artifact Type Artifact # Operations
1-Dec-2003 &7 Ability to create new book2 Fred Bloggs Test Case TC000002 = Delete

Add New Association

Please choose the artifact that you want to add an association to:

Artifact Type:* ‘quuirement v

Artifact ID:* :|

From this screen you can either delete an existing artifact association or add a new association from the
current document to a pre-existing artifact in the system. To add the association, you just need to select
the type of artifact being associated (requirement, test case, incident, etc.) and the numeric ID of the
artifact.

For example to add an association to Requirement RQ00005 you would choose Artifact Type =
Requirement and Artifact ID = 5.
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11. Reports Center

This section describes the reporting features of SpiraTeam®, including an overview of each of the report
types that are available. When you click on the “Reports” tab on the global navigation bar, you will initially
be taken to the reports home page illustrated below:

A — . Welcome, Fred Bloggs | My Profile | | Log Out | | Libeary Information Sysem v| Helg?
spiraTeam
S— My Page Project Home Planning Testing Tracking Reporting

Reporting

Library Information System | Reports Center (Add lems)

I~ SewedRepors  ® X v Incldsmt Dato Ranga Graphs D ) . mx
None Available Graph Name: Incidern Progress Raie ¥| Fidter: [-an- '| Data Range:
T— ——— Incident Progress Rate

~ Create Report # x 24

W Discovered Coune
Requirement Reports
> Requirements Summary

> Reqirements Detailed 0
> Requirements Plan

> Requirements Traceabiity s

5| B Omescoum

Test Case Reports . -
> Tes! Case Summary Sep 1, 01 et 1, 03 Hew 1, 03 Dac 1,01 a1,
» Test Case Dolailed > Display Data Grig | Resel Zoom | Save As: JPEG | BMP | NG -
» Teat Set Summary e .

» Tast Set Detailed

> Printable Test Scripts
> Test R I'IS_UI[ME! L}
> Test Run Detailed

» Test Case Traceabilly . R

¥| Filter | AlReleases — v Date Range: [81:2-1201 [3

Test Run Progress Rate

Incident Reports . Hia
> Incident Summary S

> Incident Detailed - M Cauion ~ :
Task Reports ) ) . = \ R

> Tagk Summary sep 1,03 o1, a3 e 1,03 Dee 1, 02 san,
> Task Detailed > Display Data Grid | Resel Zoom | Save As: JPEG | BMP | PNG &

Release Reports —— e — = =
i -Axis |Imporiance v Group-By: Ismm v X-Axis |Executon Sttus ¥ Group-By: | Priorry v

Req_utremem Summar\:Graph Test Case Summary Graph

> Release Plan

3 - iaciorn
[ S S
B i-crtia

Harie) 1 - Crieal 2-ign - Medium 4elow Biocked Caution Filed ot R Faused
> Display Data Grid | Save As: JPEG | BMP | PNG > Display Data Grid | Save As: JPEG | BMP | ENG
Graph Name: |IncdentAging  ¥|  Fiter: [—AI- ¥] Graph Name: | TaskBumdown V| Filter: [ 1.1.0.0- Library Sysiem Release 1.1 ¥ |
Incident Aging Task Burndovm
5 »
B iseaeron
= n Estimatsagiton
Ramaining Etfart
= Complated Effort
2 e
-
s u
o ]
07 B4 1831 108 2538 A2 4145 3096 5183 A TLIT THE 8690 350 1.8.0.0.0001 1100000 1.1.9.0.0003
> Display Data Gnd | Save As: JPEG | BMP | PNG > Display Data Grid | Save As: JPEG | BMP | PNG

This page consists of three main areas:

>» The top left hand pane displays a list of any reports that have either been saved by the currently
logged in user, or those reports created by other members of the project, that have been marked
(by that user) as ‘shareable’.

> The bottom left-hand main pane displays a list of the printable reports available in the system,
categorized by the artifact they primarily relate to (requirements, test cases, incidents and




releases). Clicking on any of the report hyperlinks will take you to the configuration page for the
report in question (see section 11.1 below for details).

» The right-hand pane is a dashboard that contains the set of graph widgets configured by the
current user. By default the dashboard will display: the Incident Progress Rate, Test Run
Progress Rate, Requirement Summary, Test Case Summary, Incident Aging and Task
Burndown.

In addition to the graphs displayed by default, you can click on the “Add Items” hyperlink to add additional
graphs to the reporting dashboard:

Add/Remove tems Close -
Choose which items you'd like o add:

g Closed Widgets (D)
Avsilable Widgets (11)

Available Widgets -

Incident Date Range Graphs - |
Testing Date Range Graphs
Requirement Summary Graph

Test Case Summary Graph ik
Test Run Summary Graph

Test Set Summary Graph

Task Summary Graph

Incident Summary Graph

Requirement Graphs

Incident Graphs

Task Graphs

-

Add to: [ Side Bar [+ |[ Add |[ Close | |

Each of the graphs is described in more detail in sections 11.7 — 11.9.

11.1. Reports Configuration
The configuration page for each report differs slightly, but the general format is illustrated below:




- o
piraTeam
Reporting > Requirements Detailed Report Role: Manager

<< Back to Reports Home

> Requirements Summary

> Requirements Detailed You can filter the results displayed by various parameters as well as choose which elements of the report are displayed
> Requirements Plan

> Requirements Traceability

Welcome, Fred Bloggs | My Profile | Administration | Log Qut | |Lbrary information System 'J Help?

My Page Project Home Planning Testing Tracking Reporting
Requirements Detailed Report
Please choose from the various options below to specify how you would like this report to appear

Report Format

Format:

®

) HIML &
) MS-Word 2003+ ]
) AL [E)

o)

Report Elements

Requirements Details: [ Astifact Change History
[] Associated Tasks

[ Linked Incidents

[ Linked Requirements
O

List of Attached Documents

[[] Test Case Coverage

Requirements Details . Standard Field Filtars

Author: -l 03
Importance: A =
Owner: A =
Status: -l 3
Created On: =]

Last Modified: =

Requirement #:

Task Progress: - Al - v
Test Coverage: o Bl = v

Requirement Name:

Actual Effort:
Plan Effort:
Task Effort:

Release: — Al— "

Requirements Details - Custom Property Filters

URL |

Difficulty: ~ A~ v

Requirement Type: - A - v

If would like ta save this repont for future use, please give it a name below before clicking the [Create Repont] buttan

Report Name: |

[ | would like to share this report with other members of the project

> Create Report | [» Cancel |

You can configure the reports in the following ways:

>
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Report Format — This allows you to specify the display format of the report. Depending on the
specific report, they can be displayed as a web-page (HTML), downloaded as a Microsoft Word
document, downloaded as a Microsoft Excel spreadsheet or downloaded as a Microsoft Project
file. In addition there is a raw-XML format that allows you to export the underlying report data into
any external reporting system that supports XML import.

Report Elements — This allows you to determine which types of information to include in the
report. This varies by report type, but includes the dependent items related to the artifact being
reported on (attachments, test steps, coverage, history, etc.)

Standard Field Filters — This allows you to constrain the range of data being reported on, based
on the various fields associated with the artifact in question. These filters are typically selections
from multi-valued-dropdown lists and date-ranges.

Custom Property Filters — This allows you to constrain the range of data being reported on,
based on the custom fields associated with the artifact by your project administrator. These filters
can be either freetext or drop-down lists.

Sort Options - This option is only available for the non-hierarchical data reports (i.e. for test runs,
incidents and tasks only) and allows you to specify the sort order of the results returned in the
report. For the hierarchical-data based reports the sort order is always the order of the hierarchy.




>» Report Name — If you would like to save the report configuration so that you can quickly re-run it
at a later date, you just need to enter a name for the report and indicate (by selecting the
checkbox or not) whether you want this report to be private or shared by all members of the
project.

Once you have selected the format, elements and filters, clicking the <Create Report> button launches
the report in a new window. Each of the reports is described in sections 11.2 — 11.6 below:

11.2. Requirement Reports

11.2.1. Requirements Summary Report

This report displays all of the requirements defined for the current project in the order they appear in the
requirements list. The requirement's details and coverage status are displayed in a summary list form:

= Print Report
Requirements Summary Report

This report displays all of the requirements defined for the current project in the order they appear in the requirements list. The requirement’s details and coverage status are displayed in a summary list form._

Project 1: Library Information System

Sample application that allows users to manage books. authors and lending records for a typical branch library

Req #Name Description  Priority Status Author Owner Creation Date Test Coverage Task Progress Last Modified Release # Planned Effort Task Effort Actual Effort URL
42 Tasks:
60% On
0 Caovering. Schedule
Functional 0 Failed, 6% Running
1| System n Fred 01-Dec2003 0 Passed,  Late, 01-Dec-2003 145 hours 0| 190 hours | 185 fours
Requirements rogress 0998 0 Blocked, 4% Starting mins mins mins
0 Caution Late,
29% Mot
Started
42 Tasks:
60% On
0 Covering. Schedule,
QOnline Library 0 Failed. 6% Running
2 | Management n Fred 01-Dec2003 0 Passed,  Late, 01-Dec-2003 145 haurs 0| 190 hours | 185 hours
System rogress 0998 0 Blocked, 4% Starting mins mins mins
0 Caution Late,
29% Mot
Started

11.2.2. Requirements Detailed Report

This printable report displays all of the requirements defined for the current project in the order they
appear in the requirements list. For each individual requirement, the name, priority, author, status and
coverage status are displayed, along with tables containing the list of covering test cases, linked
incidents/requirements, associated tasks, attached documents, and the change history:

Req #4 - Ability to add new books to the system
The ability te add new books into the system. complete with ISBN, publisher and other related information

Priority: 1 - Critical Status: Complated
Author: Fred Bloggs Creation Date: 01-Dec-2003
Coverage: 3 Covering, 1 Failed, 1 Passed 0 Blocked 0 Caution Last Modified: 01-Dec-2003
Owner: Joe P Smith Planned Effort: 15 hours 0 mins:
Release #: 1.0.0.0 Task Est. Effort: 16 hours 0 mins
Task Actual Effort: 15 hours 30 mins
URL: hittp: /o libraries. arg
Difficulty: Moderate

Requirement Type:

Test Coverage:

Test # Name Status Est. Duration Last Execution Date
TC2 Ability to create new book Failed 0 hours 10 mins 04-Dec-2003

TCs Bock management Passed 0 hours 4 mins 01-Dec-2003

TC13 Adding new book and author te library Mot Run - -

Linked Requirements

Name Created By Comment Date Req Id
Ability 1o delete existing books in the system Fred Bloggs These two requirements are ralated 12-Mar-2004 RQ&

Associated Incidents

Name Created By Comment Date Inc Id

Cannet install system on Oracle 9i Fred Bloggs This bug affects the requirement 14-Mar-2004 N5

Cannot add a new book to the system Joe P Smith Test Run: Ability to create new book 04-Nov-2003 N7
Associated Tasks:
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11.2.3. Requirements Plan

This report displays a complete work breakdown structure of the project from a requirements perspective,
including all requirements and tasks organized by schedule:

Requirements Plan Report

This report displays a complete work breakdown structure of the project, including all requirements and tasks organized by schedule

Project 1: Library Information System
Sample application that allows users to manage books, authors and lending records for a typical branch library

1D # Name Type Status Priority Owner Start Date End Date Release # % Complete Plan Effort Est. Effort Actual Effort
1 Functional System Requi Reaui :;1 1{5 hours 0 1‘3_0 hours 0 18.8 hours 40
rogress mins mins mins
: . . In 145 hours 0 190 hours 0 188 hours 40
2 Online Library Management System Requirement Progress mins mins mins
3 Book Management Requirement Completed ": . W hours 0 %. hours 0 gﬁ. hours 0
ritical mins mins mins
) . Joe P 15 hours 0 16 hours 0 15 hours 30
4 Ability to add new books to the system Requirement  Completed | 1-Critical g 1.000 mins mins mins
1 Develop new Book entry screen Task 1-Criical | Fred Bioggs | 01-Mar2004 02-Mar-2004 | 1.0.0.0.0001 Shours Omins | 7 hours 20 mins
2 Create book oject insert metnog Task 1-Criical | FredBioggs | O1-Mar2004 02-Mar.2004 | 1.0.0.0.0001 Shours Oming | S hours 20 mins
3 Virile Book GhECt Neen quenss Task 1-Critical | Fred Bloggs | 01-Mar-2004  02-Mar-2004 | 1.0.0.0.0001 3nours O ming | 2 hours SO mins
- . 1
5 Ability to edit existing baoks in the system  Requirement | Completed | 1 - Critical | 2027 1.0.00 Bhourad | 16Ghours 0 | 16 hours 50
Smith mins ming ming
s Devekop edt book detais screen Task Completed 1-Critcal | Fred Bioggs | 03-Mar-2004 04-Mar-2004 | 1.0.0.0.0001 | 100% Bhours Omins | 7 hours 20 mins
5 Create book object update method Task 1-Critcal | JoePSmith | 03-Mar-2004 04-Mar-2004 | 1.0.0.0.0001 | 100% Shours Dmins | & hours 0 mins
& Virite book object update queries Task Compieted 1-Crtcal | JoePSmth | 03-Mar-2004 04-Mar-2004 | 1.0.0.0.0001 | 100% 3hours Dmins | 3 hours 30 mins
& Ability to delete existing books in the Requirement | Completed | 1 - Critical Fred 1000 14 hours 0 16 hours 0 15 hours 10
system Bloggs mins mins mins

11.2.4. Requirements Traceability Matrix

This report displays a matrix of the requirements in the system with their list of covering test cases and
associated, mapped requirements:

Project 1: Library Information System

Sample application that allows users to manage books. authors and lending records for a typical branch library

Requirements Forward Traceability

This section displays a list of all the requirements with the associated test cases/requirements.
Req# Name Importance  Status Release # TestT bili Requi Tr: bility
RQ1 Functional System Requirements In Progress
RQ2 Online Library Management System In Progress
RQ3 Book Management 1 - Critical Completed
RQ4 Ability to add new books to the system 1 - Critical Completed 1000 TC2, TC8, TC13 RQ6
RQ5 Ability to edit existing books in the system 1 - Critical Completed 1.0.0.0 TC3, TCB RQ7
RQ6 Ability to delete existing books in the system 1 - Critical Completed 1.0.0.0 TC8. TC12 RQ4
RQ7 Ability to associate books with different subjects 1 - Critical Completed 1100 TC4, TCB RQ5
RQB Ability to associate books with different authors 1 - Critical Completed 1100 TCB, TC13
RQ9 Ability to associate books with different editions 1 - Critical Completed 1.1.0.0 TC4, TCB, TC12
RQ10 Ability to completely erase all books stored in the system with one click 1 - Critical Completed 1.2.0.0 TC4, TC8, TC12
RQ11 Edition Management 1 - Critical In Progress
RQ12 Ability to create different editions 1 - Critical In Progress 1000

11.3. Test Case Reports

11.3.1. Test Case Summary Report

This report displays all of the test cases defined for the current project in the order they appear in the test
case list. The test case's details and execution status are displayed in a summary grid form with the test
steps optionally displayed:
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Project 1: Library Information System
Sample application that allows users to manage books, authors and lending records for a typical branch library
Test # Name Description Priority Test Step Test Step Description Test Step Expected Result Test Step Sample Data Status  Author Owner Est. Duration Created On Last Modified|
1 Functional WA Fred Fred 01-Dec- 13-Oct-2009
Tests Bloggs | Blogas 2003 15:07:47
Tests that
Ability to the user can
1- Fred | Fred 01-Dec- 13-0ct-2009
2 create new  create a o Failed 0
book new book in Critical Bloggs | Bloggs 2003 15:07:47
the system

Call Login to

1 Application Not Run
User clicks link to User taken to first screen

2 create book in wizard Hot Run
User enters books s

User taken to next screen  Macbeth, William

3 n;’:i;:ﬁ:ﬁ::;" in wizard Shakespeare Hot Run
User chooses book's | User sees screen

4 genre and sub-genre | displaying all entered Play, Tragedy Mot Run
from list infarmation
User clicks submit Confirmation screen is

5 button displayed Hot Run

11.3.2. Test Case Detailed Report

This report displays all of the test cases defined for the current project in the order they appear in the test
case list. The test case's details and execution status are displayed, along with sub-tables containing the
list of test steps, test runs, attached documents, the change history, and a list of any associated open

incidents:
Test #2 - Ability to create new book
Tests that the user can create a new book in the system
Status: Failed Priority: 1 - Critical
Author: Fred Bloggs Creation Date: 01-Dec-2003
Owner: Fred Bloggs Last Execution: 04-Dec-2003
URL: hittp:fivewer libraryreferences.org
Test Type: Functional Test
Step Description Expected Result Sample Data Last Status
1 Call Login to Application Net Run
2 User clicks link to create book User taken to first screen in wizard Net Run
3 User enters books name and author, then clicks Next User taken to next screen in wizard Macbeth, William Shakespeare Mot Run
4 User chooses book's genre and sub-genre from list User sees screen displaying all entered information Play. Tragedy Mot Run
5 User clicks submit button Confirmation screen is displayed Mot Run
Test Runs:
Run# Tester Test Set Release Version Status Est. Duration Actual Duration Execution Date
TR18  Fred Bloggs Iteration 003 1.1.0.0.0003 Failed 2 mins 70 ming 04-Dec-2003
TR15  Joe P Smith Iteration 002 1.1.0.0.0002 Passed | 2mins 70 mins 03-Dec-2003
TR13  Fred Bloggs Iteration 001 1.1.0.0.0001 Passed 2 ming 70 mins 02-Dec-2003
TR12 Fred Bloggs Library System Release 1 1.0.0.0 Failed 10 mins: T0 mins 01-Dec-2003
TR2 Fred Bloggs Testing Cycle for Release 1.1 Library System Release 1 SP1 1.0.1.0 Passed 10 mins 90 mins 01-Dec-2003
TR1 Joe P Smith Testing Cycle for Release 1.0 Library System Release 1 1.0.0.0 Failed 10 ming 75 mine 01-Dec-2003
Req # HName Status Priority
RQ4 Ability to add new books to the system Completed 1 - Critical
pen Incidents:

11.3.3. Test Set Summary Report

This report displays all of the test sets defined for the current project in the order they appear in the test
set list. The test set's details and execution status are displayed in a summary list form:




Test Set Summary Report

This report displays all of the test sets defined for the current project in the order they appear in the test set list. The test set's details and execution status are displayed in & summary list form

Project 1: Library Information System

Sample application that allows users to manage books, authors and lending records for a typical branch library

Test Set# Name Description Status Release Creator Owner Created On Planned Date Last Modified Last Executed # Passed # Failed # Caution # Blocked # Not Run Notes
Functional In Fred 02-Jan- £
TX8 Test Sets Progress Bloggs 2007 05-Feb-2007 | 13-Oct-2009 - 0 ] o o 0
This tests
the
Testing functionality
™ Cyclefor  mroduced IFT 1.0.0.0 E'Ed JS“E P gzaj;”' 05-Feb-2007 | 13-0ct-2009  01-Dec-2003 |1 2 0 [ 1
Release 10 M release rogress loggs | Smith | 20
1.0 of the
library
system
This tests
the
Testing functionality
e Cyclefor  Imroduced | 1ot 1100 FPd (ool 1034a007Feb2007 13-0ct2009 | 01-Dec2003 3 0 0 0 6
Releage 1.1 N release Started Bloggs | Smith | 200
2.0 of the
library
system
-

11.3.4. Test Set Detailed Report

This report displays all of the test sets defined for the current project in the order they appear in the test
set list. The test set's details and execution status are displayed, along with sub-tables containing the list
of test cases, test runs, attached documents, and the change history:

Test Set #1 - Testing Cycle for Release 1.0
This tests the functionality introduced in release 1.0 of the library system
Owner: Joe P Smith Creator: Fred Bloggs
Release: 1000 Creation Date: 02-Jan-2007
Status: In Progress Last Execution: 01-Dec-2003
Planned Date: 05-Feb-2007 Last Updated: 13-0ct-2009
Hotes:
Operating System
Test Cases:
Test # Name Priority Est. Duration Status Last Execution Date
TC2 Ability to create new book 1 - Critical 10 mins Failed 01-Dec-2003
TC3 Ability to edit existing book 1 - Critical 5 ming Passed 01-Dec-2003
TC4 Ability to create new author 1 - Critical 8 mins Failed 01-Dec-2003
TCS Ability to edit existing author 2 . High 5 ming Mot Run -
TCE Ability to reassign book to different author 2 - High & ming Mot Run
TC8 Book management 2 - High 4 mins Hot Run
TC9 Author management 2 - High 4 ming Mot Run
Test Runs:
Run # Tester Release Version Status Est. Duration Actual Duration Execution Date
TR4 Joe P Smith Library System Release 1 1000 Failed 8 mins 90 mins 01-Dec-2003
TR3 Fred Bloggs Library System Release 1 1.0.0.0 Passad & mins 90 mins 01-Dec-2003
TR1 Jog P Smith Library System Release 1 1000 Failed 10 mins 75 minzs 01-Dec-2003

11.3.5. Printable Test Scripts

This printable report is useful when you want to be able to conduct the testing activities offline on paper,
or when testers need paper copies of the test script in addition to using the online test execution wizard.

In either case, this report simply displays all of the test cases defined for the current project in the order
they appear in the test case list together with their detailed test steps and a list of any attached
documents.
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Project 1: Library Information System
Sample application that allows users to manage books. authors and lending records for a typical branch library

Test #2 - Ability to create new book

Tests that the user can create a new book in the system

Test Steps:

Step Description Expected Result Sample Data Status
[IPassed [1Failed
[Blocked []Caution
[IPassed [IFailed
[Blocked [ Caution
[IPassed [IFailed
[IBlocked []Caution
[IPassed []Failed
[CIBlocked [ Caution

[Passed [IFailed

User opens up browser and enters application URL:
hitp:#www libraryinformationsystem_com/beta

The browser loads the login

! web page

http:/fwww libraryinformationsystem com/beta

User taken to main menu
screen

2 Userlogs in to application Login=librarian, Password=password1

User taken to first screen in

User clicks link to create book wizard

User taken to next screen in

User enters books name and author. then clicks Next wizard Macbeth, William Shakespeare

User sees screen displaying

4 User chooses book’s genre and sub-genre from list all entered information Play, Tragedy CIBlocked Tl Caution
i p Confirmation screen is [OPassed [1Failed
5 Userclicks submit button displayed DlBlocked T Caution
File Attachments:
Filename Description
Sequence Diagram for Book Mgt pdf Sequence diagram in UML format that prondes detail the book use-case / test case

Actual Result
Author Date Uploaded
Fred Bloggs  03-May-2006

11.3.6. Test Run Summary Report

This report displays all of the test runs defined for the current project. The test run's details and execution

status are displayed in a summary grid form:

Test Run Summary Report
This report displays all of the test runs defined for the cument project in date order (most recent first). The test run's details and status are displ ina y list form
Project 1: Library Information System
Sample application that allows users to manage books, authors and lending records for a typical branch library
Test Run # Name Test Case # Release Test Set Type Tester Est. Duration Actual Duration Start Date End Date Status ~ Runner
Adbility to
TR0 edit existng | TC3 1000 Menual  EfEd  Ohous - Dhous$0 - O1Dec  O1Dec: gqpq,
ok oggs | mins mins 2003 2003
i owityte s 1000 putomated F16d | Ohous 0 | thows 10 OtDec 0iDec poo o v
create new o om Bloggs | ming ming 2003 2003 a n was
found
TR ﬁ:‘lﬁ new | T2 1.1.0.0.0001 Automateg 1ed  Ohours2 1 hours 10 02Dec- 02Dec- gy Junit f’;ﬁ?ﬂ
T Bloggs | ming ming 2003 2003 was
found
Abilty to Fred | OhowsS | Thows10  02-Dec- | 02D v
e T ours ours c- -Dec- ] u
TR14 ﬁ:ksxmmg TC3 1.1.0.0.0001 Automated Blogge | mine rmins 2003 2003 Passed | JUnit was
found

Message Notes Web Browser Operating Syste}

Opera Windows 2003

11.3.7. Test Run Detailed Report

This report displays all of the test runs defined for the current project in date order (most recent first). The
test run's details and execution status are displayed, along with sub-tables containing the list of test run
steps, and a list of any associated open incidents:




Test Run #1 - Ability to create new book
Tests that the user can create 3 new boek in the system
Test Case #: TC2
Release #: 1.0.0.0 Status: Failed
Tester: Joe P Smith Execution Date: 01-Dec-2003
Type: Manual Test Set Testing Cycle for Release 1.0
Est. Duration: 0 hours 10 mins Actual Duration: 1 hours 15 mins
Notes:
Web Browser: Intemnet Explorer
Operating System: Windows XP
Step Description Expected Result Sample Data ActualResult Status
1 | Userlogs in to application User taken 1o main menu sereen Pagsed
2 | User clicks link to create book UMsZe;rLaken tofirst sereen in Passed
3 User enters books name and author, then clicks User taken to next screen in Macbeth, William An error page 15 displayed - "Mo such object or wath block vanable at line Failed
Mext wizard Shakespeare 473" al
Associated Incidents:
Inc#  Type Status Priority Severity Hame Owned By Detected On
T Bug Assigned 1 - Critical 3 - Medium Cannot add a new book to the system Joe P Smith 04-Now-2003
File Attachments:
Filename Description Author Date Uploaded
Error Logging-in Screen-shot gif Captured screen-shot of the error that was raised when attempling o log in to the library application Fred Bloggs 24-Apr-2006

and test sets:

11.3.8. Test Case Traceability

2Print Report
Test Case Traceability Matrix

TC13 Adding new book and author to library
TC15 Common Tests

TC16 Open Up Web Browser

TC17 Login to Application

This report displays a matrix of the test cases in the system with the list of mapped releases. incidents and test sets.

Test Case Forward Traceability
This section displays a list of all the lest cases with the associated releases, incidents and test sets.
Test# Name Priority Releases Test Sets Incidents
TC1 Functional Tests
TC2 Ability to create new book 1 - Critical RL1, RLZ, RL3, RL4, RL17, RL18. RL19 TX1, TX2 INT
TC3 Ability to edit existing book 1 - Critical RL1, RL2, RL3, RL4, RL17. RL18. RL1S, RLE TX1. TX2
TC4 Ability to create new author 1 - Critical RL1, RLZ, RL3, RL4, RL5, RL18, RL1%, RLE TX1,TX2, TXS INZ
TCS Ability to edit existing author 2 -High RL1, RLZ, RL3, RL4, RL5, RL19, RL6 TX1, TX2
TCE Ability 1o reassign book to different author 2 - High RL1, RL2. RL3, RL4, RLS, RLE TX1.TX2, TXS
TC? Regression Tests
TCB Book management 2 -High RL1, RLZ, RL3, RL4, RLS TX1, TX2, TX3_ TXd
TC9 Author management 2 - High RL1, RL2, RL3, RL4, RLS, RLG TX1, TX2, TX3, TX4
TC10 Scenario Tests
Tcn Exception Scenario Tests 3 - Medium
TC12 Person loses book and needs to report loss

3 - Medium RL4, RL5, RLE
3 - Medium RL4, RL5. RLE

TC18 New Test Case (Ability to add new books to the system)
TC19 Mew Test Case (Ability 1o edit axisting books in the system)
TC20 New Test Case {Ability to delete existing books in the system)

TX2, TX5, TX6
TX2. TXS, TX6

11.4. Incident Reports

11.4.1. Incident Summary Report

This report displays all of the incidents tracked for the current project. The incident's details are displayed
in a summary list form:

This report displays a matrix of the test cases in the system with the list of mapped releases, incidents




Status

MNew

MNew

MNew

Priority Severity Detected By Owned By Detected On Last Modified Closed On Detected Release Resolved Release|

Incident Summary Report
Project 1: Library Information System
Sample application that allows users to manage books, authers and lending records for a typical branch library
Inc # Name Description Resolution Type
When trying to
log into the
application with a
Cannot log
walid usemname Fred 01-Mow-
Dec2003  —
1 :\tohl::m" and password, Incident Bloggs 2003 01-Dec-2003 1.000 1.01.0
e the system
throws a fatal
exception
When | try and
click on the
button to add &
Mot able to
) new author the Joa P 01-Now-
2 ::?n:rah system simply Incident Smith 2003 01-Dec-2003 - 1.000 1.01.0
displays the
main screen and
does nothing
When | click on
- the logout link,
3 iy | nstead of Incidant Fred OtHov- 01.Dec.2003 1010 1020
fatal W"r legging out, | get Bloggs 2003
ABEMC an ASP session
net valid emor
—

This report displays all of the incidents tracked for the current project. The incident’s details are displayed in a summary list form

11.4.2. Incident Detailed Report

This printable report displays all of the incidents tracked for the current project sorted by incident number.
For each individual incident, the name, type, priority, status, opener, owner and close date are displayed,
along with tables containing the detailed description and resolutions as well as a tabular list of attached
documents, linked requirements/incidents and the change history:

Project 1: Library Information System

Sample application that allows users to manage books, authors and lending recerds for a typical branch library
Inc #1 - Cannot log into the application

When trying to log inta the application with a valid usemame and password, the system throws a fatal exception

Type: Incident Priority:

Status: MNew Severity:

Opened By: Fred Bloggs Opened On: 01-Mow-2003

Assigned To: Last Modified: 01-Dec-2003

Detected In Release:  1.0.0.0 Closed On: -

Resolved In Release:  1.0.1.0 Verified In Release: 1.01.0

Notes:

Operating System:

Associations:

Artifact Type Name Created By Comment Date Artifact Id
Test Run Sample Test Fred Blogas Test Run: Sample Test 01-Nov-2006 TRY
Incident The book listing screen doesn't sort Joe P Smith This incident and bug are related 16-Mar-2004 N6
Requirement Ability to create new users in the system Joe P Smith Test Run: Sample Test 01-Dec-2003 RQ 26

File Attachments:

Filename Description Author Date Uploaded
Bug Stack Trace txt Joe P Smith 04-May-2006
Errar Logging-in Screen-shot.gif Captured screen-shat of the error that was raised when attempting to log in to the library application Fred Bloggs 24-Apr-2006

11.5. Task Reports

11.5.1. Task Summary Report

This report displays all of the tasks tracked for the current project. The task's details are displayed in a

summary list form:
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Project 1: Library Information System
Sample application that allows users to manage books, authors and lending records for a typical branch library
Task & Name Description Status Priority Owned By Created On Last Modified Release #
Write edition object Mot 1- Fred 01-Dec-
B insen queries Started Critical  Bloggs 2003 01-Dec-2003 | 1.0.0.0.0003 | RQ12
4 Develop edit author Mot . Joe P 01-Dec- X
2 details screen Started 2-High Smith 2003 01-Dsc-2003 | 1.0.0.0.0002| RQ15
Create author
Net Joe P 01-Dec-
25 | object update Sraned 2-High goen 2003 01-Dec-2003  1.0.0.0.0002 RQ15
method
Wirite author abject Not Joe P 01-Dec-
2| pdate queries Soteg  2-Migh oel on) 01Dec-2003  1.0.0.0.0002 RQ1S
Refactor author
27 | screen to include gm g 2-High E{“ gabg“' 01-Dec-2003 1.0.0.0.0003 RQ16
delete hutton arte 09as

2004

07-Mar-

2004

07-Mar-

2004

07-Mar-

2004

09.Mar-

2004

12-Mar-

2004

08-Mar-

2004

08-Mar-

2004

08-Mar-

2004

10-Mar-

2004

0%

0%

0%

Requirement # Start Date End Date % Complete Est. Effort Actual Effort|
11-Mar-

3 hours 0
mins
8 hours 0
mins

5 hours 0
ming
3 hours 0
mins

6 hours 0
mins

Page 147 of 167

This document contains Inflectra proprietary information




11.5.2. Task Detailed Report

This report displays all of the tasks tracked for the current project. The task's details are displayed, along
with a tabular list of attached documents and the change history:

Task Detailed Report

This report displays all of the tasks tracked for the current project. The task's details are displayed, along with a tabular list of attached documents and the change history.

Project 1: Library Information System

Sample application that allows users to manage books, authors and lending records for a typical branch library

Task #23 - Write edition object insert queries

Requirement ID: RQ 12 Status: Mot Started
Release #: 1.0.0.0.0003 Priority: 1 - Critical
Assigned To: Fred Bloggs Created On: 01-Dec-2003
Start Date: 11-Mar-2004 Last Meodified: 01-Dec-2003
End Date: 12-Mar-2004 Estimated Effort: 3 hours 0 mins
% Complete: 0% Actual Effort: -

11.6. Release Reports

11.6.1. Release Summary Report

This report displays all of the releases and iterations defined for the current project in the order they
appear in the releasel/iteration hierarchy. The release's details are displayed in a summary list form:

Release Summary Report
This report displays all of the releases and iterations defined for the current project in the order they appear in the release/iteration hierarchy. The release’s details are displayed in a summary list form.
Project 1: Library Information System
Sample application that allows users to manage books, authors and lending records for a typical branch library
General Testing Information
Rel # Name Version Number Description  Creator Creation Date Iteration Active Start Date End Date # Failed # Passed & Blocked # Caution # Not Run Task Progress Planned Effort
18 Tasks:
. 50% On
This is the 2
Library initial ?;r:dnl.f:ning
1 System 1000 re[eage of Fred 15.Feb2004 N v 01-Mar- | 12-Mar- 2 0 0 1 n Late 216 hours 0
Release the Library  Bloggs 2004 2004 9% Starti mins
1 Management Late aring
System 26% Mot
Started
This semace DJasks
pack fixes 0% On
Library identified Schedule
System Joe P . 13-Mar- | 30-Mar- 0% Running 176 hours 0
2 Release 1010 l:;gas”anda Smith 05-May-2004 N Y 2004 2004 0 3 1 0 3 Late ming
15P1 X 0% Starting
fjﬁle‘?;&bllny Late, 0% Not
Started

11.6.2. Release Detailed Report

This report displays all of the releases and iterations defined for the current project in the order they
appear in the release/iteration hierarchy. The release's details are displayed, along with sub-tables
containing the list of requirements added, mapped test cases, test runs executed, incidents resolved,
attached documents, scheduled tasks and the change history:
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Notes:

1.1.0.0 - Library System Release 1.1

This version adds additional reperting functionality to the 1.0 version

Version #: 1100
Creator: Fred Bloggs
Start Date: 16-0ct-2004
End Date: 27-0ct-2004
# Resources: 3

Hon-Werking Days: 6

Operating System:

Requirements Added:
Req# Name
RQ1 Functional System Requirements

RQ2 Online Library Management System

RQ3 Book Management

RQ7 Ability to agsociate books with different subjects

RQ8 Ability to associate books with different authors

RQY Ability to associate books with different editions

RQ13 Author Management

RQ17 Ability to link authors to their contact information
Mapped Test Cases:

Test# Name

TC4 Ability to create new author

TC2 Ability to create new book

TC5 Ability to edit existing author

Active:

Creation Date:
Planned Effort:
Available Effort:
Task Est. Effort:
Actual Effort:

Al

15-0ct-2004

168 hours 0 mins
82 hours 0 mins
86 hours 0 mins
85 hours 40 mins

Status
Failed
Failed
Blocked

Status

In Prograss
In Progress
Completed
Completed
Completed
Completed
In Progress
Requested

Priority

- Critical
- Critical
- Critical
- Critical
- High
- High

[P P

Last Execution Date

01-Dec-2003
04-Dec-2003
01-Dec-2003

11.6.3. Release Plan Report

This report displays a complete work breakdown structure of the project from a release perspective,

including all releases, iterations, requirements, tasks and incidents organized by schedule:

11.7.

Project 1: Library Information System

Sample application that allows users to manage books, authars and lending records for a typical branch library

ID# Name Type

RL1 1.0.0.0 - Library System Release 1 Release
RO4 Abiity to add new books to the system Requirement
ROS Abity to edit existing books in the system Requirement
ROQG Ability to delete existing books in the system Requirement
Rafz Abity to create different ediions Requirement
RO1S Abity to edit existing authers in the system Requirement
RO1E Abity to delete existing suthors in the system Requirement
RL2 1.0.1.0 - Library System Release 1 SP1 Release
2

INT Cannot 864 & new book 1o the System Bug

RL11 1.0.1.0.0001 - teration 001 Iteration
RL12 1.0.1.0.0002 - lteration 002 Iteration
RL13 1.0.1.0.0003 - Iteration 003 lteration
Bld 1020 Libian Suatem Ralogee 4 SD2 Baloocg

Status

Completed
Completed
Completed
n
Frogress
Flanned

n
Progress

New
New

Assigned

Priority  Owner

1. Critical

- Critical
- Criical
- Criical
- Critical

- High

High

Joe P Smith
Joe P Smith
Fred Bioggs
Fred Bioggs
Fred Bloggs

Fred Blogge

Joe P
Smith

Start Date
01-Mar-
2004

13-Mar-
2004

06-Nov-2003
13-Mar-
2004

21-Mar-
2004

25-Mar-
2004
01-Apr-

End Date % Complete Plan Effort

12-Mar-
2004

30-Mar-
2004

20-Mar-
2004

24-Mar-
2004

30-Mar-
2004

30-Apr-

216 hours 0
mins

15 hours O mins
15 hours 0 mins

14 hours 0 mins

15 hours 0 mins
10 hours O mins

176 hours 0

mins

Est. Effort Actual Effort
94 hours 0 93 hours 30

mins mins
16 hours @ ming | 15 hours 30 mins
18 hours O mins | 18 hours S0 mins

16 hours O mins 15 howrs 10 mins
18 hours § mins | 16 howrs 0 mins
15 hours § mins. | 16 hours 0 mins

t4hours O ming | 14 hours 0 mins:

0 hours 20 ming

80 hours 0 mins -

48 hours 0 ming -

64 hours 0 ming -

352 hours

Summary Graphs

11.7.1. Requirements Summary Graph

The requirements summary graph shows how many requirements are currently in a project. The number
of requirements is displayed according to the criteria that you specify. You can specify the type of data
displayed along the x-axis, and the requirement information which is used to group the data. When you
first open the graph you will be asked to pick the field that you would like to display on the x-axis and the
field that you would like to group the data by. Once you have chosen the appropriate fields the graph will

be displayed:

© Copyright 2006-2011, Inflectra Corporation

Page 149 of 167

This document contains Inflectra proprietary information




¥ Requirement Summary Graph X
X-Axis |Sttus ‘l’| Group-By: | Importance T|
Requirement Summary Graph
10
4 - Low
- 3 - Medium
High
Critical
Completed n Progress Planned Requested
> Display Data Grid | Save As: JPEG | BMP | PNG

In this version of the report, the x-axis represents the requirements’ status, and the individual bars are
grouped by requirement importance. Each data-value can be viewed by positioning the mouse pointer
over the bar, and a “tooltip” will pop-up listing the actual data value.

Clicking on the “Display Data Grid” link will display the underlying data that is being used to generate the

graph:
Requirement Summary Graph
Status 1 - Critical 2 -High 3 - Medium 4-Low
Completed 3 1 0 0
In Progress 2 2 0 0
Planned 0 2 3 0
Requested 0 1 4 2

> Download Data As CSV B

Clicking on the Download Data as CSV link will export the datagrid into Comma Separated Values (CSV)
format that can be opened in MS-Excel. Some browsers also support the ability to save the graph as an
image file (JPEG, PNG and GIF formats).

11.7.2. Test Case Summary Graph

The test case summary graph shows how many test cases are currently in a project. The number of test
cases is displayed according to the criteria that you specify. You can specify the type of data displayed
along the x-axis, and the test case information which is used to group the data. When you first open the
graph you will be asked to pick the field that you would like to display on the x-axis and the field that you
would like to group the data by. Once you have chosen the appropriate fields the graph will be displayed:
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¥ Test Case Summary Graph

Test Case Summary Graph

a
a

Blocked Caution Failed Hot Run

> Display Data Grid | Save As: JPEG | BMP | PN

In this version of the report, the x-axis represents the test case execution status, and the individual bars
are grouped by test case priority. Each data-value can be viewed by positioning the mouse pointer over
the bar, and a “tooltip” will pop-up listing the actual data value. Clicking on the “Display Data Grid” link will
display the underlying data that is being used to generate the graph. In addition, clicking on the Download
Data as CSV link will export the datagrid into Comma Separated Values (CSV) format that can be opened
in MS-Excel. Some browsers also support the ability to save the graph as an image file (JPEG, PNG and

GIF formats).

11.7.3. Test Run Summary Graph

The test run summary graph shows how many test runs are currently in a project. The number of test runs
is displayed according to the criteria that you specify. You can specify the type of data displayed along

the x-axis, and the test run information which is used to g
you will be asked to pick the field that you would like to di

roup the data. When you first open the graph
splay on the x-axis and the field that you would

like to group the data by. Once you have chosen the appropriate fields the graph will be displayed:

¥ Test Run Summary Graph

o X

X-Axis |Siatus ‘!’| Group-By: |Type

M

Test Run Summary Graph

Blocked Caution Failed

NG

> Display Data Gnd | Save As: JPEG | BMP |

Manual

Automated

In this version of the report, the x-axis represents the test run execution status, and the individual bars are

grouped by test run type. Each data-value can be viewed
and a “tooltip” will pop-up listing the actual data value. Cli
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the underlying data that is being used to generate the graph. In addition, clicking on the Download Data
as CSV link will export the datagrid into Comma Separated Values (CSV) format that can be opened in
MS-Excel. Some browsers also support the ability to save the graph as an image file (JPEG, PNG and

GIF formats).

11.7.4. Incident Summary Graph

The incident summary graph shows how many incidents are currently in a project. The number of
incidents is displayed according to the criteria that you specify. You can specify the type of data displayed
along the x-axis, and the incident information which is used to group the data. When you first open the
graph you will be asked to pick the field that you would like to display on the x-axis and the field that you
would like to group the data by. Once you have chosen the appropriate fields the graph will be displayed:

¥ Incident Summary Graph E+ I
X-Axis |SIE|U..|5 T| Group-By: |T3-pe T|
Incident Summary Graph

18

-r .
- Change Request

- -

Azzigned Closed Duplicate Mew Mot Reproducible Open Resolved

Training
Riske
Linnitation

Iszue

Incident

Enhancement

> Display Data Grid | Save As: JPEG | BMP | PNG

In this version of the report, the x-axis represents the incidents’ status, and the individual bars are
grouped by the type of incident. Each data-value can be viewed by positioning the mouse pointer over the
bar, and a “tooltip” will pop-up listing the actual data value. Clicking on the “Display Data Grid” link will
display the underlying data that is being used to generate the graph. In addition, clicking on the Download
Data as CSV link will export the datagrid into Comma Separated Values (CSV) format that can be opened
in MS-Excel. Some browsers also support the ability to save the graph as an image file (JPEG, PNG and
GIF formats).

11.7.5. Task Summary Chart

The task summary graph shows how many tasks are currently in a project. The number of tasks is
displayed according to the criteria that you specify. You can specify the type of data displayed along the
x-axis, and the task information which is used to group the data. When you first open the graph you will
be asked to pick the field that you would like to display on the x-axis and the field that you would like to
group the data by. Once you have chosen the appropriate fields the graph will be displayed:
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¥ Task Summary Graph X
X-Axis | Priority T| Group-By: |51atus T|
Task Summary Graph

12

M| Mot Started
17 o | InProgress
M| Completed
11
& -
(i} T T

1 - Critical 2 - High 3 - Medium 4 - Low

> Display Data Grid | Save As: JPEG | BMP | PNG

In this version of the report, the x-axis represents the tasks’ priority, and the individual bars are grouped
by the status of task. Each data-value can be viewed by positioning the mouse pointer over the bar, and a
“tooltip” will pop-up listing the actual data value. Clicking on the “Display Data Grid” link will display the
underlying data that is being used to generate the graph. In addition, clicking on the Download Data as
CSV link will export the datagrid into Comma Separated Values (CSV) format that can be opened in MS-
Excel. Some browsers also support the ability to save the graph as an image file (JPEG, PNG and GIF
formats).

11.7.6. Test Set Summary Graph

The test set summary graph shows how many test set are currently in a project. The number of test sets
is displayed according to the criteria that you specify. You can specify the type of data displayed along
the x-axis, and the test set information which is used to group the data. When you first open the graph
you will be asked to pick the field that you would like to display on the x-axis and the field that you would
like to group the data by. Once you have chosen the appropriate fields the graph will be displayed:

¥ Test Set Summary Graph # X
X-Poas |Sla|us T| Group-By: |Om'|er T|
Test Set Summary Graph

M Jo= P Smith

M Fred Bloggs

2_
14
[¥] . = -_Ll

Completed Deferred In Progress Hot Started

> Display Data Grid | Save As: JPEG | BMP | PNG

In this version of the report, the x-axis represents the test set status, and the individual bars are grouped
by the name of the tester (owner). Each data-value can be viewed by positioning the mouse pointer over
the bar, and a “tooltip” will pop-up listing the actual data value. Clicking on the “Display Data Grid” link will




display the underlying data that is being used to generate the graph. In addition, clicking on the Download
Data as CSV link will export the datagrid into Comma Separated Values (CSV) format that can be opened
in MS-Excel. Some browsers also support the ability to save the graph as an image file (JPEG, PNG and
GIF formats).

11.8. Snapshot Graphs

11.8.1. Requirements Coverage Graph

The requirements coverage graph shows how many requirements are currently in a project, according to
their test coverage status.

¥ Requirement Graphs E+ I
Graph Name: | Requirements Cove W |  Filter: | — All Releases — ‘!’|

Requirements Coverage

in
0

1 - Critical

-1
|
|
|
|

Passed Failed Blocked Caution Mot Run Mot Covered

> Display Data Gnd | Save As: JPEG | BMP | PNG

The x-axis of the report represents the various test execution statuses that a requirement can have as its
coverage status (plus the Not-Covered status), and the individual bars are grouped by the requirements
importance. Each data-value can be viewed by positioning the mouse pointer over the bar, and a “tooltip”
will pop-up listing the actual data value.

Clicking on the “Display Data Grid” link will display the underlying data that is being used to generate the
graph. You can also filter the graph to just display data for a specific release/iteration as well as for the
project as a whole. In addition, clicking on the Download Data as CSV link will export the datagrid into
Comma Separated Values (CSV) format that can be opened in MS-Excel. Some browsers also support
the ability to save the graph as an image file (JPEG, PNG and GIF formats).

11.8.2. Incident Aging Graph

The incident aging chart displays the number of days incidents have been left open in the system. The
chart is organized as a stacked histogram, with the count of incidents on the y-axis and different age
intervals on the x-axis. Each bar-chart color represents a different incident priority, giving a project
manager a snapshot view of the age of open project incidents by priority.
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¥ Incident Graphs T X

Graph Name: |Incident Aging ¥ | Filter: |- All— V]|

Incident Aging

13

07 814 15-21 22-28 29-35 36-47 43-49 A0-56 57-63 64-70 T1-77 TE-B4 2450 > 90

> Display Data Gnid | Save As: JPEG | BMP | PNG

This report can be filtered by the type of incident, so for example you can see the aging of just bugs, or
just issues for the project in question. Clicking on the “Display Data Grid” link will display the underlying
data that is being used to generate the graph. In addition, clicking on the Download Data as CSV link will
export the datagrid into Comma Separated Values (CSV) format that can be opened in MS-Excel. Some
browsers also support the ability to save the graph as an image file (JPEG, PNG and GIF formats).

11.8.3. Incident Turnaround Time Graph

The incident turnaround time chart displays the number of days incidents have taken to be closed (from
the time they were first raised) in the system. The chart is organized as a stacked histogram, with the
count of incidents on the y-axis and different turnaround time intervals on the x-axis. Each bar-chart color

represents a different incident priority, giving a project manager a snapshot view of the turnaround time of
project incidents by priority.

¥ Incident Graphs % X

Graph Name: |IncidenLTumaround ‘!’| Filter: | - All- ‘l’|

Incident Turnaround Time
12

4 - Low
3 - Medium
High
. £
Cr L
3
0-7 8-14 15-11 12-18 29-35 36-47 43-49 50-536 57-63 &4-70 T1-77 7E-B4 84-30 = %0

> Display Data Grd | Save As: JPEG | BMP | PNG

This report can be filtered by the type of incident, so for example you can see the turnaround time of just
bugs, or just issues for the project in question. Clicking on the “Display Data Grid” link will display the
underlying data that is being used to generate the graph. In addition, clicking on the Download Data as
CSV link will export the datagrid into Comma Separated Values (CSV) format that can be opened in MS-

© Copyright 2006-2011, Inflectra Corporation Page 155 of 167 This document contains Inflectra proprietary information




Excel. Some browsers also support the ability to save the graph as an image file (JPEG, PNG and GIF
formats).

11.8.4. Task Velocity Chart

The Task Velocity graph shows the total estimated and actual effort delivered in each project release
and/or iteration:

v Task Graphs % x
Graph Name: | Task Velocity v| Filter: | 1.1.0.0 - Library System Relezse 1.1 v|
Task Velocity
Actual Velocity
59 Expected Velocity
40
1.1.0.0.0004 1.1.0.0.0002 1.1.0.0.0003

> Display Data Grid | Save As: JPEG | BMP | PN

The y-axis of the graph displays the total estimated and actual effort delivered, and the x-axis can be
configured to display three different levels of granularity:

>» All Releases — This shows the total estimated and actual effort for each of the releases in the
project

» Specific Release — This shows the total estimated and actual effort for each of the iterations in
the selected release

» Specific Iteration — This shows the total estimated actual effort for each working day in the date-
range covered by the selected iteration.

Clicking on the “Display Data Grid” link will display the underlying data that is being used to generate the
graph. In addition, clicking on the Download Data as CSV link will export the datagrid into Comma
Separated Values (CSV) format that can be opened in MS-Excel. Some browsers also support the ability
to save the graph as an image file (JPEG, PNG and GIF formats).

11.8.5. Task Burnup Chart

The Task Burnup graph shows the cumulative amount of work outstanding for each release/iteration in
the project with separate lines for the estimated, remaining and completed effort:
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> Display Data Grd | Save As: JPEG | BME | BN
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The y-axis of the graph displays the cumulative increase in work for the project, broken down by effort
(estimated, remaining and completed) with a red line indicating the ideal burnup. The x-axis can be

configured to display two different levels of granularity:

>
release

covered by the selected iteration.

Specific Release — This shows the increase in work for each of the iterations in the selected

Specific Iteration — This shows the increase in work for each working day in the date-range

Clicking on the “Display Data Grid” link will display the underlying data that is being used to generate the
graph. In addition, clicking on the Download Data as CSV link will export the datagrid into Comma
Separated Values (CSV) format that can be opened in MS-Excel. Some browsers also support the ability

to save the graph as an image file (JPEG, PNG and GIF formats).

11.8.6. Task Burndown Chart

The Task Burndown graph shows the remaining work that needs to be done for each release/iteration in
the project with separate lines for the estimated, remaining and completed effort:

¥ Task Graphs

Graph Name: | TaskBundean V| Filter: |1.1.0.D—Libmr5-'5ystem Release 1.1 v|
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> Display Data Grid | Save As: JPEG | BMP |
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The y-axis of the graph displays the total remaining work that needs to be done, broken down by effort
(estimated, remaining and completed) with a red line indicating the ideal burndown. The x-axis can be
configured to display two different levels of granularity:

» Specific Release — This shows the total remaining work that needs to be done for each of the
iterations in the selected release

» Specific Iteration — This shows the total remaining work that needs to be done for each working
day in the date-range covered by the selected iteration.

Clicking on the “Display Data Grid” link will display the underlying data that is being used to generate the
graph. In addition, clicking on the Download Data as CSV link will export the datagrid into Comma
Separated Values (CSV) format that can be opened in MS-Excel. Some browsers also support the ability
to save the graph as an image file (JPEG, PNG and GIF formats).

11.9. Date-Range Graphs

11.9.1. Test Run Progress Rate Graph

The test run progress rate graph shows how many tests have been executed during a period of time, and
what execution status was recorded. The report can be displayed for a specific date-range and for the
entire project or for a specific release/iteration:

¥ Testing Date Range Graphs - 4
Graph Name: ‘Test Run Progress Rate Y| Filter | — All Releases — v Date Range:

Test Run Progress Rate

Failed
Passed
Mot Run

Sep1,03 Oct1, 03 Mov 1, 03 Dec 1,03 Jan i,

> Display Data Grid | Reset Zoom | Save As: JPEG | BMP | PNG

In this version of the report, the y-axis represents the number of test runs executed in each 24 hour
period, and the x-axis represents a specific week in the time-span. Each data-bar can be viewed by
positioning the mouse pointer over the point, and a “tooltip” will pop-up listing the actual data value. You
can filter the report by the release/iteration that the test run was executed against, and also change the
date range. If you choose a smaller date-range, the x-axis will switch from weekly to daily and if you
choose a larger date-range, the x-axis will switch to monthly.

Clicking on the “Display Data Grid” link will display the underlying data that is being used to generate the
graph. In addition, clicking on the Download Data as CSV link will export the datagrid into Comma
Separated Values (CSV) format that can be opened in MS-Excel. Some browsers also support the ability
to save the graph as an image file (JPEG, PNG and GIF formats).

11.9.2. Incident Progress Rate Graph

The incident progress rate chart displays the total number of incidents created and closed over a
particular date-range, either for all incident types or for a specific incident type:
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¥ Incident Date Range Graphs X

Graph Name: | Incident Progress Rate ¥ | Filter: |—AI— v Date Range-
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> Display Data Grid | Reset Zoom | Save As: JPEG | BMP | BNG

In this version of the report, the y-axis represents the number of incidents (either created or closed in a 24
hour period), and the x-axis represents a specific day in the time-span. Each data-point can be viewed by
positioning the mouse pointer over the point, and a “tooltip” will pop-up listing the actual data value. You
can filter the report by the type of incident, and also change the date range (e.qg. displaying only the bugs
for the date range). If you choose a smaller date-range, the x-axis will switch from weekly to daily and if
you choose a larger date-range, the x-axis will switch to monthly.

Clicking on the “Display Data Grid” link will display the underlying data that is being used to generate the
graph. In addition, clicking on the Download Data as CSV link will export the datagrid into Comma
Separated Values (CSV) format that can be opened in MS-Excel. Some browsers also support the ability
to save the graph as an image file (JPEG, PNG and GIF formats).

11.9.3. Cumulative Incident Count Graph

The cumulative incident count chart displays the cumulative total number of incidents logged in the
system for the current project over a particular date-range, either for all incident types or for a specific
incident type. The report displays two data series, one illustrating the total count of all incidents, the other
the total count of all open incidents (i.e. with status not set to fixed or closed):

~ Incident Date Range Graphs "X
Graph Name: | Incident Cumuiative Count v| Filter: [—AI- v| Date Range:

Incident Cumulative Count

Open Count

Sep 1, 03 Oct 1, 03 Mov 1, 03
> Display Data Grid | Reset Zoom | Save As: JPEG | BMP | PNG

In this version of the report, the y-axis represents the number of incidents, and the x-axis represents a
specific week in the time-span. Each data-point can be viewed by positioning the mouse pointer over the
point, and a “tooltip” will pop-up listing the actual data value. You can also filter the type of incident being
reported, as well as change the date interval. If you choose a smaller date-range, the x-axis will switch
from weekly to daily and if you choose a larger date-range, the x-axis will switch to monthly.

Clicking on the “Display Data Grid” link will display the underlying data that is being used to generate the
graph. In addition, clicking on the Download Data as CSV link will export the datagrid into Comma
Separated Values (CSV) format that can be opened in MS-Excel. Some browsers also support the ability
to save the graph as an image file (JPEG, PNG and GIF formats).
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11.9.4. Open Incident Count Graph

The open incident count chart displays the net number of open incidents in the system for the current
project over a particular date-range categorized by incident priority, either for all incident types or for a
specific incident type:

¥ Incident Date Range Graphs & x
Graph Name: | Incident Open Count ¥| Filter: |-a1- V| Date Range:

Incident Open Count

Sep 1,03 Oct 1,03 Mo

> Display Data Grd | Reset Zoom | Save As: JPEG | BMP | PN

In this version of the report, the y-axis represents the number of incidents, and the x-axis represents a
specific week in the time-span. The exact count of each bar in the stacked histogram can be viewed by
positioning the mouse pointer over the bar, and a “tooltip” will pop-up listing the actual data value. You
can also filter the type of incident being reported, as well as change the date interval. If you choose a
smaller date-range, the x-axis will switch from weekly to daily and if you choose a larger date-range, the
x-axis will switch to monthly.

Clicking on the “Display Data Grid” link will display the underlying data that is being used to generate the
graph. In addition, clicking on the Download Data as CSV link will export the datagrid into Comma
Separated Values (CSV) format that can be opened in MS-Excel. Some browsers also support the ability
to save the graph as an image file (JPEG, PNG and GIF formats).
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12. Source Code

This section outlines the source code integration features of SpiraPlan® and SpiraTeam® that can be
used to browse the source code repository associated with a particular project and link artifacts in
SpiraTeam to revisions / commits made in the source code repository. This functionality allows project
members to quickly view files in the repository through a convenient web interface and also to see the
end-to-end traceability from requirements, tasks and incidents to the code changes that addressed the
requirement, fulfilled the task or resolved the incident

The software can be integrated with a variety of different version control / Software Configuration
Management (SCM) systems by means of different plug-ins. This section will outline the general features
irrespective of the type of version control provider being used. For details on using a specific provider
(e.g. Subversion) please refer to the separate SpiraPlan/Team Version Control Integration Guide. This
section also assumes that an administrator has already configured the project to be integrated with the
version control provider. The steps for using the administrative interface are described in the separate
SpiraTeam Administration Guide.

12.1. Source Code File List

When you click on the Tracking > Source Code link on the global navigation bar, you will initially be taken
to the source code repository file list screen illustrated below:

i - Teamo Welcome, System Administrator | [y Profle | Administration | Log Out | |Library information System v Help?
e - My Page Project Home Planning Testing Tracking Reparting
Incidents | Tasks | Resources | Source Code Role: Project Owner
Repository Browser | Refresh Business Design > Refresh | Apply Filter | Claar Filters
test://MyRepository
5 B Design +  File Name AY Size AY Author AT Latest Revision AV Last Edited 4 ¥
= B Business Design O | | :Il
@ €2 Technical Design O | ® pocyment Filename1 doc 100 KB Fred Bloggs 0001 17-Jan-2010
¥ 3 Development O ) pocument Filaname 10 pptx 105 KB Fred Bloggs 1ev0005 17-Jan-2010
% & Test D | 8 pocument Filenameld him 75 KB Fred Bloggs 0006 17-Jan-2010
: gi::i:';"'a““" O | ) pocument Filename? xis 150 KB Fred Bloggs rev 17-Jan-2010
(] 4 Document Filename21 ¢cs 100 KB Fred Bleggs oy 1 17-Jan-2010
(] " Document Filename22 vb 150 KB Fred Bloggs 002 17-Jan-2010
Otfiér Cperafiors [) | % Document Filename23.cpp 180 KB Fred Bloggs 20001 17-Jan-2010
> View Revision Log o B Document Filename?4 javg 100 KB Fred Bloggs 20004 17-Jan-2010
O | B pacument Filename2s ol 125 KB Fred Bloggs 140001 17-Jan-2010
O | = pocument Filename26 oho 20KB Fred Bloggs 002 17-Jan-2010
O 1 pocument Fite: X 1005 KB Fred Bloggs rex001 17-Jan-20110
] 87 KB Fred Bloggs re1003 17-Jan-20110
0O 100 KB Fred Bloggs revdn0l 17-Jan-2010
O 180 KB Fred Bloggs rex0001 17-Jan-2010
] 105 KB Fred Bloggs rex0005 17-Jan-2010
Shaw E] rows per page « 4 Displaying page El Rof2em
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This screen consists of three main sections:

>» The top left-hand pane displays a hierarchical list of the various folders that exist in the source
code repository. Clicking on the [+] expand icon will expand the child folders and clicking on the
name of the folder will display the list of files in the folder in the main pane to the right.

» The main right-hand pane displays a list of all the files contained within the currently selected
folder. This list can be filtered and sorted, and you can choose how many rows of documents to
display on the page at one time.

>» The bottom left-hand pane contains the option to view the overall revision log for the project,
clicking on that will display the revision log page (see section 12.3 for details).
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12.2. Source Code File Details

When you click on a file in the source code file list described above, you are taken to the file details page
illustrated below:

Welcome, Fred Bloggs | Library Information System v

| My Profile | Administration | Log Out || S

Team

My Page Project Home Planning Testing Tracking Reporting
Incidents | Tasks | Resources | Source Code = File Details

<< Back to File List T Source Code File: Document Filename1 doc

E= Files . i IRoot/Files/Fi =
) Document Filename1.doc File Path: test://Server/Root/Files/Filename1.ext
] Document Filename10.pptx File Type (Size): Word Document &7 (100 KB) Last Edited: 12/20/2011 12:42:06 PM
| Document Filename11.htm Author: Fred Bloggs Latest Revision: ) rev0001

B Document Filename2 xls

S— S
<#] Document Filename21.cs Revisions Associations

This page is made up of three areas; the left pane is for navigation, the upper part of the main pane
contains the details of the file, and the bottom part of the right pane contains the list of file revisions stored
in the version control system.

The navigation pane consists of a link that will take you back to the source code file list, as well as a list of
other files in the current folder. This latter list is useful as a navigation shortcut; you can quickly view the
detailed information of all the peer files by clicking on the navigation links without having to first return to
the main file list page.

The top part of the main pane allows you to view the details of the particular file in the version control
system. Clicking on the “File Path” hyperlink will actually open the file in a separate window, and
depending on the type of file, it may display in the page or prompt you to download it to your local
computer. The “Latest Revision” hyperlink allows you to view details of the latest revision (see section
12.4 below).

The lower part of the main pane can be switched between two different views by clicking the appropriate
tab. Initially the pane will be in “Revisions” mode, but it can be switched to “Associations” as well. The
functionality in each of these two views is described below:

12.2.1. Revisions
This view displays the list of revisions that have been committed for the current file:

Revisions # Associations #
= Refresh | Apply Filter | Clear Filter
v/ Revision A ¥ Author AV Summary AV Commit Date AV~ Content A AY  Properties A 4 ¥
| | | | B [ Y] [ v
& rev0012 Fred Bloggs The artifact was changed in this version to fix th... 20-Dec-2011 Yes Mo
B rev0009 Fred Bloggs The artifact was changed in this version to fix th... 20-Dec-2011 Yes Yes
| rev0010 Fred Bloggs The artifact was changed in this version to fix th... 20-Dec-2011 Yes Yes
pin| rev0015 Fred Bloggs The artifact was changed in this version to fix th... 20-Dec-2011 Yes Mo
@ rev0016 Fred Bloggs The artifact was changed in this version to fix th... 20-Dec-20M Yes Mo
) rev0013 Fred Bloggs The artifact was changed in this version to fix th... 20-Dec-2011 Mo Yes

Each revision in the list is displayed with its name, the name of the person who made the revision, a
description of what was changed, the date the change was made and two flags that denote whether the
content was changed and/or if any of the properties of the file were changed. Clicking on the revision
name will take you to the appropriate revision details page (see section 12.4).
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12.2.2. Associations

This view displays a list of the SpiraTeam artifacts in the current project that are associated with the
current file. This allows you to see which requirements, test cases, incidents, tasks, etc. are linked to the
current file. Clicking on the hyperlink for the artifact will take you to the appropriate artifact page inside the
project (assuming your user has permissions to access that information).

Revisions # Associations #
Date Artifact Name Creator Comment Artifact Type 1D Operations
1-Sep-2010 ) Ability to add new books to the system Fred Bloggs Requirement RQO00004 | = Remove
25-May-2010 | ¥ Cannot add a new book to the system Joe P Smith Incident INOOODO7 | > Remove
6-May-2005 73 Create book object insert method Fred Bloggs  Take a look at this document and see if it clarifi... Task TK000002 > Remove

Add New Association

Please choose the artifact that you want to add an association to:

Artifact Type™ | Requiremert v
Comment:

= Add Association

In addition, you can use the “Add New Association” section to add a new association from the current
source code file to an existing artifact in SpiraTeam. To add the association, you just need to select the
type of artifact being associated (requirement, test case, incident, etc.) and the numeric ID of the artifact.
For example to add an association to Requirement RQ00005 you would choose Artifact Type =
Requirement and Artifact ID = 5.

12.3. Source Code Revision List

If you click on the “View Revision Log” hyperlink on the main Source Code page, it will take you to the
Revision List page that displays all the revisions made to the project in a sortable, filterable list:

T o . System Adi | My Profile | Administration | Log Out | |Library information System A Help?
- — My Page Project Home Planning Testing Tracking Reporting

Ingidents | Tasks | Resowrges | Source Code > Revisions Role: Project Owner

<< Back to Source Code Repository

~ Refresh | Apply Filter | Clear Filters

v Revision AV Author &Y Summary A ¥ Commit Date AV Content A A Y Properties A AY
O | I | [ o - ¥ ¥

O é]& Fred Bloggs The artifact was changed in this version to fix th 18-Jan-2010 Yes Mo

O é]ﬂ Fred Bloggs The artifact was changed in this version to fix th 18-Jan-2010 Yes Mo

O é]w Fred Bloggs The artifact was changed in this version to fix th 18-Jan-2010 Yes Yes

O é]ﬂ Fred Bloggs The artifact was changed in this version to fix th 18-Jan-2010 Yes Yes

[m] Qﬂ Fred Bloggs The artifact was changed in this version to fix th 18-Jan-2010 Yes Mo

[m] QM Fred Bloggs The artifact was changed in this version to fix th. 18-Jan-2010 Yes Mo

[m] Qw Fred Bloggs The artifact was changed in this version to fix th 18-Jan-2010 No Yes

0O | & evp1s Fred Bloggs The artifact was changed in this version to fix th 18-Jan-2010 No Yes

[m] Fred Bloggs The artifact was changed in this version to fix th 18-Jan-2010 Mo No

O Fred Bloggs The artifact was changed in this version to fix th. 18-Jan-2010 Yes No

O Fred Bloggs The artifact was changed in this version to fix th 18-Jan-2010 Yes Yes

0O | &0z Fred Bloggs The artifact was changed in this version to fix th 18-Jan-2010 Yes Ho

0O | &7 Fred Bloggs The artifact was changed in this version to fix th 18-Jan-2010 Yes Yes

O & e00s Fred Bloggs The artifact was changed in this version to fix th 18-Jan-2010 Yes Yes

O | & e00s Fred Bloggs The artifact was changed in this version ta fix th 18-Jan-2010 No Mo

Show 15| rows per page - -« Displaying page Z Taof 2w

Each revision in the list is displayed with its name, a description of what changed in the revision, the
name of the person who committed the revision, and whether the revision was a change of the actual
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content, or just a change of the properties of the content. Clicking on the hyperlink for the revision name
will take you to the Revision Details page for that revision (see section 12.4 below).

12.4. Source Code Revision Details

When you click on a revision hyperlink in either the project revision log or the file revisions tab described
above, you are taken to the revision details page illustrated below:

T ] Welcome, Fred Bloggs |hbmw Information System "| | My Profile | Administration | Log Out || Seard
My Page Project Home Planning Testing Tracking
Incidents | Tasks | Resources | Source Code = Revision Details
<< Back to Revision List b Source Code Revision: £1rev0012
8 rev0011
£ revon12 Notes: The artifact was changed in this version to fix the issue with the da 55 component
3 rev0009
B rev0010
B rev0015
rev0016 Edited By: Fred Bloggs Content A: Yes
Y 99
£ rev0013 Build: ) build 0011 Properties A: No
v0014
g remug Last Edited: 12120/2011 1:43:55 PM
res
1 rev0004 Files # Associations #
S oo 0004

This page is made up of three areas; the left pane is for navigation, the upper part of the main pane
contains the details of the revision, and the bottom part of the right pane contains the list of files that were
changed in this revision and the list of artifacts that the revision is associated with.

The navigation pane consists of a link that will take you back to the source code revision list, as well as a
list of other revisions associated with the current file. This latter list is useful as a navigation shortcut; you
can quickly view the detailed information of all the peer revisions by clicking on the navigation links
without having to first return to the main revision list page.

The top part of the main pane allows you to view the details of this revision in the version control system,
including the description of what was changed, the date that the change was made, and the name of the
person who made the change.

The lower part of the main pane can be switched between two different views by clicking the appropriate
tab. Initially the pane will be in “Files” mode, but it can be switched to “Associations” as well. The
functionality in each of these two views is described below:

12.4.1. Revision Files
This view displays the list of files that were changed in the current revision:

Files # Associations #

= Refresh | Apply Filter | Clear Filters |

v File Name AY Size AV Author A ¥ Latest Revision & ¥ Action AY Last Edited 4'F
O | I | I | I =l
O 9 bocument Filename doc 100 KB Fred Blogas rev001 Added 18-Jan-2010
O & Document Filename10 pptx 105 KB Fred Bloggs rev0005 Deleted 18-Jan-2010
O €] Document Filename11 htm 75 KB Fred Bloggs rev0006 Replaced 18-Jan-2010
O 5 bocument Filename? xls 150 KB Fred Bloggs rev0002 Added 18-Jan-2010
O 4 Document Filename?21.cs 100 KB Fred Bloggs rev0001 Undefined 18-Jan-2010

Each file in the list is displayed with its name, the file-size, who made changes to the file, what action was
performed on the file (added, deleted, replaced, updated, etc.) and the most revision that exists for that
file. Clicking on the filename will take you to the appropriate file details page (see section 12.2), and

clicking on the revision hyperlink will take you the appropriate revision.

© Copyright 2006-2011, Inflectra Corporation

Page 164 of 167

This document contains Inflectra proprietary information




12.4.2. Revision Associations

This view displays a list of the SpiraTeam artifacts in the current project that are associated with the
current revision. This allows you to see which requirements, incidents or tasks were affected by this
specific change to the source code:

Files *

Date
18-Jan-2010
18-Jan-2010

Associations *

Artifact Name
"Eﬁhililvm edit existing books in the system
) Develop new book entry screen

Created By Comment

Fred Bloggs

nfa

This requirement was implemented in this revision Requirement RQOO0005
This task was completed in this revision Task TKO00001

Artifact Type  Artifact #

Clicking on the hyperlink for the artifact will take you to the appropriate artifact page inside the project
(assuming your user has permissions to access that information). Note that these associations cannot be
modified in SpiraTeam as they are creating directly inside the version control system. If you want to
change/add associations, please refer to the appropriate section of the SpiraPlan/Team Version Control
Integration Guide.
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Legal Notices

This publication is provided as is without warranty of any kind, either express or implied, including, but not
limited to, the implied warranties of merchantability, fitness for a particular purpose, or non-infringement.

This publication could include technical inaccuracies or typographical errors. Changes are periodically
added to the information contained herein; these changes will be incorporated in new editions of the
publication. Inflectra® Corporation may make improvements and/or changes in the product(s) and/or
program(s) and/or service(s) described in this publication at any time.

SpiraTest®, SpiraPlan®, SpiraTeam® and Inflectra® are registered trademarks of Inflectra Corporation in
the United States of America and other countries. Microsoft®, Windows®, Explorer® and Microsoft
Project® are registered trademarks of Microsoft Corporation. All other trademarks and product names are
property of their respective holders.

Please send comments and questions to:
Technical Publications
Inflectra Corporation
8121 Georgia Ave
Suite 504
Silver Spring, MD 20910
U.S.A.

support@inflectra.com
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